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Preface
 

Purpose of This Document

This document describes how to use the Systemwalker Operation Manager.

 
Intended Readers

This document is intended to be used by users who schedule, operate, monitor and control jobs using Systemwalker Operation
Manager.

The reader of this document should be familiar with the general operating system and GUI operations.

 
Abbreviations and Generic Terms Used

- The term "Windows Server 2019 " is used to refer to all of the following products:

- Microsoft(R) Windows Server(R) 2019 Standard (x64)

- Microsoft(R) Windows Server(R) 2019 Datacenter (x64)

- The term "Windows Server 2016" is used to refer to all of the following products:

- Microsoft(R) Windows Server(R) 2016 Standard (x64)

- Microsoft(R) Windows Server(R) 2016 Datacenter (x64)

- The term "Server Core" is used to refer to all of the following products:

- Microsoft(R) Windows Server(R) 2019 Standard Server Core

- Microsoft(R) Windows Server(R) 2019 Datacenter Server Core

- Microsoft(R) Windows Server(R) 2016 Standard Server Core

- Microsoft(R) Windows Server(R) 2016 Datacenter Server Core

- The term "Windows Server 2008" is used to refer to all of the following products:

- Microsoft(R) Windows Server(R) 2008 Standard (x86)/(x64)

- Microsoft(R) Windows Server(R) 2008 Enterprise (x86)/(x64)

- Microsoft(R) Windows Server(R) 2008 Datacenter (x86)/(x64)

- Microsoft(R) Windows Server(R) 2008 Foundation (x64)

- Microsoft(R) Windows Server(R) 2008 Standard without Hyper-V(TM) (x86)/(x64)

- Microsoft(R) Windows Server(R) 2008 Enterprise without Hyper-V(TM) (x86)/(x64)

- Microsoft(R) Windows Server(R) 2008 Datacenter without Hyper-V(TM) (x86)/(x64)

- Microsoft(R) Windows Server(R) 2008 R2 Foundation (x64)

- Microsoft(R) Windows Server(R) 2008 R2 Standard (x64)

- Microsoft(R) Windows Server(R) 2008 R2 Enterprise (x64)

- Microsoft(R) Windows Server(R) 2008 R2 Datacenter (x64)

- The term "Windows(R) 10" is used to refer to all of the following products:

- Windows(R) 10 Home (x64)

- Windows(R) 10 Pro (x64)

- Windows(R) 10 Enterprise (x64)
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- The term "Windows(R) 8.1" is used to refer to all of the following products:

- Windows(R) 8.1 (x64)

- Windows(R) 8.1 Pro (x64)

- Windows(R) 8.1 Enterprise (x64)

- Windows Internet Explorer(R) is abbreviated as "Internet Explorer".

- Versions of Systemwalker Operation Manager that run on all of the following operating systems are referred to as
"Windows versions of Systemwalker Operation Manager" or simply "Windows versions":

- Windows

- 64-bit versions of Windows, except Itanium

- Articles specific to the version of Systemwalker Operation Manager that runs on 32-bit versions of Windows are referred
to as "Windows x86 version".

- Articles specific to the version of Systemwalker Operation Manager that runs on Itanium-compatible versions of
Windows are referred to as "Windows for Itanium version".

- Articles specific to the version of Systemwalker Operation Manager that runs on 64-bit versions of Windows, except
Itanium, are referred to as "Windows x64 version".

- Server Core, Windows Server 2019, and Windows Server 2016 may be abbreviated as "Windows servers".

- Oracle Solaris may be referred to as Solaris, Solaris Operating System or Solaris OS.

- Versions of Systemwalker Operation Manager that run on Solaris are referred to as "Solaris versions of Systemwalker
Operation Manager" or simply "Solaris versions".

- Articles specific to the version of Systemwalker Operation Manager that runs on 32-bit versions of Solaris are referred
to as "Solaris 32-bit version".

- Articles specific to the version of Systemwalker Operation Manager that runs on 64-bit versions of Solaris are referred
to as "Solaris 64-bit version".

- Versions of Systemwalker Operation Manager that run on HP-UX are referred to as "HP-UX versions of Systemwalker
Operation Manager" or simply "HP-UX versions".

- Versions of Systemwalker Operation Manager that run on AIX are referred to as "AIX versions of Systemwalker
Operation Manager" or simply "AIX versions".

- Articles specific to the version of Systemwalker Operation Manager that runs on 64-bit versions of Linux, except
Itanium, are referred to as "Linux x64 version" or simply "Linux versions".

- Articles specific to the version of Systemwalker Operation Manager that runs on 32-bit versions of Linux are referred to
as "Linux x86 version".

- Articles specific to the version of Systemwalker Operation Manager that runs on Itanium-compatible version of Linux
are referred to as "Linux for Itanium version".

- Solaris, HP-UX, AIX, Linux and Linux for Itanium versions of Systemwalker Operation Manager are referred to
collectively as "UNIX versions of Systemwalker Operation Manager" or simply "UNIX versions".

- Solaris, HP-UX, AIX and Linux may be referred to as "UNIX servers".

- Systemwalker Operation Manager Standard Edition may be abbreviated as "SE".

- Systemwalker Operation Manager Enterprise Edition may be abbreviated as "EE".

- Standard Edition may be abbreviated as "SE" and Enterprise Edition may be abbreviated as "EE".

- Arcserve(R) Backup for Windows is abbreviated as "Arcserve".

- Microsoft(R)-Mail that is provided as a standard feature with Windows NT(R) is abbreviated as "MS-Mail".

Export Restriction
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Exportation/release of this document may require necessary procedures in accordance with the regulations of your resident
country and/or US export control laws.

Trademarks

APC and PowerChute are trademarks or registered trademarks of Schneider Electric IT Corporation.

All products, service name, company name and logo of Arcserve are registered trademark or trademark of Arcserve (USA),
LLC.

HP-UX is a registered trademark of Hewlett-Packard Development Company.

AIX and HACMP are trademarks or registered trademarks of International Business Machines Corporation in the United
States.

Intel and Itanium are trademarks of Intel Corporation or its subsidiaries in the U.S. and/or other countries.

MC/ServiceGuard is a registered trademark of Hewlett-Packard Development Company, or L.P.

Microsoft, Windows, Windows Server and Azure, or the name and the product name of other Microsoft product are either
registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

Red Hat are registered trademarks of Red Hat, Inc. in the U.S. and other countries.

Linux(R) is a registered trademark of Linus Torvalds in the United States and/or other countries.

Oracle and Java are registered trademarks of Oracle Corporation or its subsidiaries in the U.S. and/or other countries.

R/3, SAP and all SAP trade name that are presented are registered trademarks or trademarks of SAP SE in Germany and in
several other countries.

UNIX is a registered trademark of The Open Group.

VMware and the VMware logo are registered trademarks or trademarks of VMware in the United States and/or other
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Amazon Web Services, Amazon Elastic Compute Cloud, Amazon CloudWatch and AWS Lambda are trademarks of
Amazon.com, Inc. or its affiliated company in the United States and/or other countries.

Short Mail is a registered trademark of NTT DoCoMo, Inc.
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Chapter 1 Startup / Shutdown
This chapter describes how to start up and shut down Systemwalker Operation Manager.

1.1 Startup
When using any of the various Systemwalker Operation Manager functions, perform the following procedures.

1. Starting Up the Systemwalker Operation Manager Servers

2. Starting Up the Systemwalker Operation Manager Clients

1.1.1 Starting Up the Systemwalker Operation Manager Servers
[Windows version]

Systemwalker Operation Manager is a client-server type system. Before using Systemwalker Operation Manager functions,
first turn on the power of the server where Systemwalker Operation Manager has been installed. When the power is turned
on, the services for each of the Systemwalker Operation Manager functions will start up automatically.

After startup is complete, you can use any of these functions from Systemwalker Operation Manager client.

To manually start up a Systemwalker Operation Manager server after shutting down a Systemwalker Operation Manager
server with the "poperationmgr" (service shutdown) command or stopping the Systemwalker Operation Manager services for
some reasons such as maintenance, start up with the "soperationmgr" (service startup) command.

Service designated as "automatic" in the Services dialog box on the Control Panel can be started up with the soperationmgr
command. If you need to individually start up a Systemwalker Operation Manager server for some reasons such as
maintenance, start up the services using the Services dialog box of the Control Panel in the following order.

 
Display name of service Function corresponding to each service

Systemwalker ACL Manager ACL Manager

Systemwalker MpAosfP Power Control (Power Control, Service/
Application Startup)

Systemwalker MpAosfX Auto-Operation Support (Action Execution)

Systemwalker MpAosfB Auto-Operation Support (Event Monitoring,
Action Management)

Systemwalker MpAHSO Systemwalker Operation Manager Base (Web
Console/Web API)

Systemwalker MpJmSrv Systemwalker Operation Manager Base

Systemwalker MpNjsosv Task Link

Systemwalker MpMjes Job Execution Control

Systemwalker MpJmCal Calendar

Systemwalker MpJobsch Jobscheduler

Systemwalker MpPmonO Process Monitoring

These services can be started up in a batch with the soperationmgr command. For details on the "soperationmgr" command,
see the "Shared Commands" section of the Systemwalker Operation Manager Reference Guide.

 

 Note

Operation startup modes for the Job Execution Control

The Job Execution Control starts its operation when the following two processes are completed in sequence.
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a. Activating the Job Execution Control service

b. Starting Job Execution Control operations

Process (a) is automatically activated when the Systemwalker Operation Manager server starts, followed by automatic
activation of process (b). While the following startup modes are available for the Job Execution Control operations, the
continuation mode is usually used.

Continuation mode:

In this mode, the definitions (i.e., initialization file details) from the Operating control sheet/Logging sheet/Options sheet/
Backward compatibility sheet/Cluster settings sheet/Network sheet/Print format sheet of the Define Operation Data
window cannot be read. Consequently, operation is started using the previous operation environments.

Initialization mode:

In this mode, the definitions (i.e., initialization file details) from the Operating control sheet/Logging sheet/Options sheet/
Backward compatibility sheet/Cluster settings sheet/Network sheet/Print format sheet of the Define Operation Data
window can be read, and restructure a queue configuration and so on. Consequently, all jobs remaining from the previous
operations are deleted.

Recovery Mode:

This mode is automatically adopted in situations where the system has become inoperable due to system downtime or
interruption of the power supply. When the stop operation of the Job Execution Control services/daemons is not executed
properly for some reason such as system downtime or power interruption, the Job Execution Control function is activated
with the recovery mode. When activated with the recovery mode, the demand job, which was in execution and with no
-nr option specified at the time the service/daemon was stopped, is automatically started up when the Job Execution
Control service/daemon is restarted. It is not possible for operators to specify the implementation of this mode.

If the Define Operating Information has been changed, the next Job Execution Control operation is activated with the
initialization mode.

 
How to start up multiple subsystems manually

With Systemwalker Operation Manager Enterprise Edition version, multiple subsystems can be started up. To start up
subsystems with corresponding subsystem numbers manually, follow the example below.

Example 1: To start up subsystem 1

Start up the following Systemwalker Operation Manager services from the Services dialog box of the Control Panel.

- Systemwalker MpMjes1

- Systemwalker MpJobsch1

Note)

- Make sure the Systemwalker MpJobsch1 is started up immediately after the Systemwalker MpMjes1 is started
up.

- For MpMjes and MpJobsch, start up the service with the same subsystem number.

 
Setting/canceling service execution suppression

To prevent the Systemwalker services from being started up automatically with the power on, use the service execution
suppression command to suppress service execution. Use the service execution suppression canceling command to cancel it.

To suppress service execution, execute the following command on the server on which you want to suppress service
execution.

 
Systemwalker installation directory:
\Mpwalker.JM\mpcmtool\bin\swstop

To cancel suppression of service execution, execute the following command on the server on which you want to cancel
suppression of service execution.
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Systemwalker installation directory:
\Mpwalker.JM\mpcmtool\bin\swstart

For the command details, see the Systemwalker Operation Manager Reference Guide.

 

 Point

Linking with SystemcastWizard

Using SystemcastWizard Professional, it is possible to back up the master computer disk contents and distribute them to
multiple target computers in a batch. This enables identical OS/Systemwalker Operation Manager environments to be
constructed in a short time. Also, IP address and computer name are automatically changed.

How to link with SystemcastWizard is shown below.

1. On the master computer, install Systemwalker.

2. On the master computer, set up each function.

3. On the master computer, execute the service execution suppression command.

4. On the master computer, run the advance setup program for the SystemcastWizard, and then specify the service
execution suppression canceling command for the module to be executed after login.

5. Perform restoration to the target computer.

See the SystemcastWizard Professional User's Guide for more information.

1.1.2 Starting Up the Systemwalker Operation Manager Servers
[UNIX version]

Systemwalker Operation Manager is a client-server type system. Before using the Systemwalker Operation Manager
functions, turn on the power to the Systemwalker Operation Manager server. When the power is turned on, the daemons for
each of the Systemwalker Operation Manager functions will start up automatically.

If multiple subsystems are operated, all the subsystems are started up automatically.

After startup is complete, you can use any of these functions from any Systemwalker Operation Manager client.

 

 Information

After startup of Systemwalker Operation Manager, you can confirm whether the daemon of each function is properly
operating by checking whether the process names shown below exist.

 
Process name Function corresponding to each process

MpFwsec ACL Manager

f3crhcs2 Calendar/Power Control

mpjmsrv Systemwalker Operation Manager Base

mjsdaemon Job Execution Control

tskmnsrv Jobscheduler

mppmon Process Monitoring

 

 Note

Operation startup modes for the Job Execution Control
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The Job Execution Control starts its operation when the following two processes are completed in sequence.

a. Activating the Job Execution Control daemon

b. Starting Job Execution Control operations

Process (a) is automatically activated when the Systemwalker Operation Manager server starts, followed by automatic
activation of process (b). While the following startup modes are available for the Job Execution Control operations, the
continuation mode is usually used.

Continuation mode:

In this mode, the definitions (i.e., initialization file details) from the Operating control sheet/Logging sheet/Options sheet/
Backward compatibility sheet/Cluster settings sheet/Network sheet of the Define Operation Data window cannot be read.
Consequently, operation is started using the previous operation environments.

Initialization mode:

In this mode, the definitions (i.e., initialization file details) from the Operating control sheet/Logging sheet/Options sheet/
Backward compatibility sheet/Cluster settings sheet/Network sheet of the Define Operation Data window can be read,
and restructure a queue configuration and so on. Consequently, all jobs remaining from the previous operations are
deleted.

Recovery Mode:

This mode is automatically adopted in situations where the system has become inoperable due to system downtime or
interruption of the power supply. It is not possible for operators to specify the implementation of this mode.

If the Define Operating Information has been changed, the next Job Execution Control operation is activated with the
initialization mode.

 
How to start up manually

The daemons of Systemwalker Operation Manager can be activated manually with the soperationmgr (daemon activation)
command. To activate the Systemwalker Operation Manager daemon manually for some reasons such as maintenance work,
execute the "soperationmgr" command. For details on the "soperationmgr" command, see the "Shared Commands" section
of the Systemwalker Operation Manager Reference Guide.

 
How to start up subsystems manually

It can be started on a per-subsystem basis.For multi-subsystem operations, to start up subsystems with corresponding
subsystem numbers manually, follow the example below.

Example 1: To start up subsystem 1

 
/bin/sh /etc/opt/FJSVMJS/etc/rc3.d/S99MJS -sys 1
/bin/sh /opt/FJSVJOBSC/etc/rc3.d/S99JOBSCH -sys 1

Note)

- Make sure S99JOBSCH is executed immediately after S99MJS is executed.

- For the -sys option of S99MJS and S99JOBSCH, specify the same subsystem number.

Example 2: To start up all the subsystems

 
/bin/sh /etc/opt/FJSVMJS/etc/rc3.d/S99MJS -sys all
/bin/sh /opt/FJSVJOBSC/etc/rc3.d/S99JOBSCH -sys all

 

 Information

S99MJS and S99JOBSCH storage paths
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The path to the S99MJS and S99JOBSCH storage varies depending on the OS used as follows. Change those paths according
to the OS you are using.

[S99MJS]

 
Solaris /etc/opt/FJSVMJS/etc/rc3.d

HP-UX system: /opt/FHPMJS/usr/lib/mjes

AIX /opt/FAIXMJS/usr/lib/mjes

Linux /etc/opt/FJSVMJS/etc/rc3.d

[S99JOBSCH]

 
Solaris /opt/FJSVJOBSC/etc/rc3.d

HP-UX system: /opt/FHPJOBSCH/bin

AIX /usr/FAIXJOBSC/bin

Linux /opt/FJSVJOBSC/etc/rc3.d

 
Setting/canceling daemon execution suppression

To prevent the Systemwalker daemons from being started up automatically with the OS startup, use the service execution
suppression command to suppress daemon execution. Use the daemon execution suppression canceling command to cancel
it.

To suppress daemon execution, execute the following command on the server on which you want to suppress daemon
execution.

 
/opt/FJSVftlo/bin/swstop

To cancel suppression of daemon execution, execute the following command on the server on which you want to cancel
suppression of daemon execution.

 
/opt/FJSVftlo/bin/swstart

For the command details, see the Systemwalker Operation Manager Reference Guide.

 

 Note

When you want to start daemons in a batch while automatic daemon execution is suppressed

If automatic daemon execution is suppressed using the swstop command, it is not possible to start daemons in a batch using
the soperationmgr command.

To start daemons in a batch using the soperationmgr command, refer to "Q: How Do I Prevent the Systemwalker Operation
Manager Daemons from being Started up Automatically at the Server Startup" in the Systemwalker Operation Manager Q
& A Guide for information on how to suppress automatic daemon execution and follow the procedure.

 

 Point

Linking with SystemcastWizard

Using SystemcastWizard Professional, it is possible to back up the master computer disk contents and distribute them to
multiple target computers in a batch. This enables identical OS/Systemwalker Operation Manager environments to be
constructed in a short time. Also, IP address and computer name are automatically changed.

How to link with SystemcastWizard is shown below.
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1. On the master computer, install Systemwalker.

2. On the master computer, set up each function.

3. On the master computer, execute the daemon execution suppression command.

4. On the master computer, run the advance setup program for the SystemcastWizard, and then specify the daemon
execution suppression canceling command for the module to be executed after login.

5. Perform restoration to the target computer.

See the SystemcastWizard Professional User's Guide for more information.

1.1.3 Starting Up the Systemwalker Operation Manager Clients
After startup of Systemwalker Operation Manager server has completed, any of Systemwalker Operation Manager functions
can be used from a Systemwalker Operation Manager client. Start up the Systemwalker Operation Manager client in the
following procedure.

 
Procedure

1. Displaying the Systemwalker Operation Manager [Login] window

Select Start/App >> Systemwalker Operation Manager >> Systemwalker Operation Manager.

Figure 1.1 Systemwalker Operation Manager [Login] window

2. Connecting to the Systemwalker Operation Manager servers.

Specify the destination host name, user ID and password on the Systemwalker Operation Manager [Login] window and
click the Login button.

When the Systemwalker Operation Manager window appears, the startup of Systemwalker Operation Manager client
has completed.

 

 Note

If the Extended User Management function is being used, specify an Operation Manager user.
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Figure 1.2 Systemwalker Operation Manager window

 

 Note

Note the following when connecting to a Systemwalker Operation Manager server.

- Number of clients to be connected:

You can simultaneously connect up to 62 (Note) Systemwalker Operation Manager clients per Systemwalker Operation
Manager server. The maximum number of connected clients can be restricted in the Use function 2 sheet of the Define
Jobscheduler Startup Parameters window. The limited clients include servers which are targeted for monitoring by the
multi-server monitoring client and Jobscheduler info print clients.

Note) The maximum number varies depending on the OS.

- Failure during connection to a Systemwalker Operation Manager server:

Connection to a Systemwalker Operation Manager server will end in failure in the following cases.

- When the host name that has been specified does not exist

Specify the correct host name on which the Systemwalker Operation Manager server has been installed.

- When the specified host name cannot be correctly interpreted (i.e., when it cannot be converted to an IP address)

Check the environments to resolve name. Or, directly specify the IP address.

- When the user ID that has been specified does not exist

Specify a user ID that can log in to the connection destination host.

- The user ID is more than 20 bytes

Enter a correct user ID.
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- When the password is incorrect

Specify the correct password.

- When the Systemwalker Operation Manager infrastructure services are not operating on any destination host

In the Windows system, start up the Systemwalker Operation Manager infrastructure service (Systemwalker
MpJmSrv) from the Windows' Services dialog box.

In the UNIX system, start up the Systemwalker Operation Manager infrastructure daemon (mpjmsrv).

- When the user that has been specified does not have the rights for local logon [Windows version]

If the Systemwalker Operation Manager server is a domain server, grant the user the Allow log on locally right in the
Local Security Policy window.

If the Systemwalker Operation Manager server is a domain controller, grant the user the Allow log on locally right in
Domain Controller Security Policy.

- When no user ID or password is specified [UNIX]

A user ID and password cannot be omitted if the connection destination host is running on UNIX. Specify the user
ID and password.

- Understanding default settings for the Systemwalker Operation Manager [Login] window [Windows version]:

A host name, user ID or password can be omitted in the Systemwalker Operation Manager [Login] window. When
omitted, the following values will be used:

- When host names are omitted:

The host name that is logged on

- When user IDs and passwords are omitted:

The user ID and password of the logged on user

- User ID search sequence [Windows]

User IDs that have been specified are searched in the following sequence:

- Local computers

- Domain

- Domains in trust relationships

1.2 Shutdown
Use the following procedure to shut down Systemwalker Operation Manager.

1. Shutting Down Systemwalker Operation Manager Clients

2. Shutting Down Systemwalker Operation Manager Servers

1.2.1 Shutting Down Systemwalker Operation Manager Clients
Select Exit from the File menu in the Systemwalker Operation Manager window. When the Systemwalker Operation
Manager window closes, the shutdown of Systemwalker Operation Manager client has completed.

 

 Note

- Do not forcibly terminate Systemwalker Operation Manager clients using Task Manager. It may not operate normally
after shutting down.
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- In the Windows system, while the Monitored Event Table window or Action control window is displayed, the
Systemwalker Operation Manager client has not been shut down. To shut down the Systemwalker Operation Manager
client, you must shut down both the Monitored Event Table window and the Action control window as well. The
following shows how to shut down each of these windows.

Monitored Event Table window:

Select Exit from the Environment Setup menu.

Action control window:

Select Exit Action control window from the File menu.

1.2.2 Shutting Down the Systemwalker Operation Manager Servers
[Windows version]

When you carry out the shutdown procedures, all of the services for various Systemwalker Operation Manager functions are
automatically stopped and the Systemwalker Operation Manager server terminates its operations.

 
How to shut down manually

If you need to manually shut down a Systemwalker Operation Manager server for some reasons such as maintenance work,
terminate the services using the Services dialog box of the Control Panel in the following order.

 
Display name of service Function corresponding to each service

Systemwalker MpPmonO Process Monitoring

Systemwalker MpJobsch Jobscheduler

Systemwalker MpJmCal Calendar

Systemwalker MpMjes Job Execution Control

Systemwalker MpNjsosv Task Link

Systemwalker MpJmSrv Systemwalker Operation Manager Base

Systemwalker MpAHSO Systemwalker Operation Manager Base (Web
Console/Web API)

Systemwalker MpAosfB Auto-Operation Support (Event Monitoring,
Action Management)

Systemwalker MpAosfX Auto-Operation Support (Action Execution)

Systemwalker MpAosfP Power Control (Power Control, Service/
Application Startup)

Systemwalker ACL Manager ACL Manager

These services can be terminated in a batch with the poperationmgr (service termination) command. For details on the
poperationmgr command, see the "Shared Commands" section of the Systemwalker Operation Manager Reference Guide.

 

 Note

To terminate the Systemwalker Operation Manager Auto Operation Support and ACL manager services in an environment
with Systemwalker Centric Manager is used together, terminate all the Systemwalker Centric Manager services as well. For
the service termination commands for Systemwalker Centric Manager, see the Systemwalker Centric Manager Reference
Guide.

If a job net with the Interstage attribute is being executed, do not terminate the Jobscheduler service without terminating that
job net. Be sure to cancel the job net before terminating the Jobscheduler service.
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How to shut down multiple subsystems manually

With Systemwalker Operation Manager Enterprise Edition version, multiple subsystems can be started up. To manually shut
down subsystems with corresponding subsystem numbers, follow the example below.

Example 1: To shut down subsystem 1

Shut down the following Systemwalker Operation Manager services from the Services dialog box of the Control Panel.

- Systemwalker MpJobsch1

- Systemwalker MpMjes1

Note)

- Make sure the Systemwalker MpMjes1 is shut down immediately after the Systemwalker MpJobsch1 is shut
down.

- For MpMjes and MpJobsch, shut down the service with the same subsystem number.

1.2.3 Shutting Down the Systemwalker Operation Manager Servers
[UNIX version]

When you carry out the shutdown procedures, all of the daemons for the various Systemwalker Operation Manager functions
are automatically stopped and the Systemwalker Operation Manager server terminates its operations.

 
How to shut down manually

If you need to manually shut down a Systemwalker Operation Manager server for some reasons such as maintenance work,
daemons of each function can be shut down in a batch with the poperationmgr (daemon termination) command. For details
on the poperationmgr command, see the "Shared Commands" section of the Systemwalker Operation Manager Reference
Guide.

 

 Note

Coexistence with Systemwalker Centric Manager

To terminate the Systemwalker Operation Manager in an environment with Systemwalker Centric Manager is used together,
terminate all the Systemwalker Centric Manager daemons as well. For the daemon termination commands for Systemwalker
Centric Manager, see the Systemwalker Centric Manager Reference Guide.

 

 Note

Stopping the Jobscheduler daemon

Note the following when stopping the Jobscheduler daemon.

- If a job net having the Interstage attribute is running

Do not stop the Jobscheduler daemon independently. Cancel the job net before stopping the Jobscheduler daemon.

- When stopping the process (tskmnsrv)

Do not use the "kill -9" command when stopping the process (tskmnsrv). Otherwise, the Jobscheduler daemon cannot be
stopped. Additionally, the Jobscheduler daemon may not work correctly in a cluster system.

If the process (tskmnsrv) is inadvertently terminated using the kill -9 command, restart the system.
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How to shut down subsystems manually

It can be stopped for each subsystem. Use the following example to manually stop the subsystem corresponding to a given
subsystem number, for example, in multi-subsystem operation.

Example 1: To shut down subsystem 1

 
/bin/sh /opt/FJSVJOBSC/etc/rc0.d/K00JOBSCH -sys 1
/bin/sh /etc/opt/FJSVMJS/etc/rc0.d/K00MJS -sys 1

Note)

- Make sure K00MJS is executed immediately after K00JOBSCH is executed.

- For the -sys option of K00MJS and K00JOBSCH, specify the same subsystem number.

Example 2: To shut down all the subsystems

 
/bin/sh /opt/FJSVJOBSC/etc/rc0.d/K00JOBSCH -sys all
/bin/sh /etc/opt/FJSVMJS/etc/rc0.d/K00MJS -sys all

 

 Information

K00JOBSCH and K00MJS storage paths

The path to the K00JOBSCH and K00MJS storage varies depending on the OS used as follows. Change those paths according
to the OS you are using.

[K00JOBSCH]

 
Solaris /opt/FJSVJOBSC/etc/rc0.d

HP-UX system: /opt/FHPJOBSCH/bin

AIX /usr/FAIXJOBSC/bin

Linux /opt/FJSVJOBSC/etc/rc0.d

[K00MJS]

 
Solaris /etc/opt/FJSVMJS/etc/rc0.d

HP-UX system: /opt/FHPMJS/usr/lib/mjes

AIX /opt/FAIXMJS/usr/lib/mjes

Linux /etc/opt/FJSVMJS/etc/rc0.d
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Chapter 2 Setting Up The System Calendar
This chapter describes how to set up the calendar.

 

 Point

The SYSTEM_CALENDAR defines the date when turning on the server power and day change times. One
SYSTEM_CALENDAR exists in the Systemwalker Operation Manager. To control the power, SYSTEM_CALENDAR
treats days on which the server power is turned on as weekdays and days on which the server power is not turned on as
holidays. The weekday/holiday pattern of the SYSTEM_CALENDAR can be browsed by the service/application execution
function, the Jobscheduler function, and the event monitoring function.

Calendars other than the SYSTEM_CALENDAR can be set up to operate the service/application execution function, the
Jobscheduler function, and the event monitoring function with patterns different from the SYSTEM_CALENDAR operation
pattern. The power control function cannot be used for calendars other than the SYSTEM_CALENDAR.

Note that only the system administrator can create or edit the calendar and change the day change time.

2.1 Setting Up the SYSTEM_CALENDAR
If you want to change operations on the server based on weekdays and holidays, you must set the holidays. To operate with
the same pattern everyday or with a different pattern everyday, you do not have to set holidays. Set days on which the server
is not operated as holidays in the SYSTEM_CALENDAR calendar. You can set holidays that fall on the same day every year
(i.e., national holidays) and substitute holidays by using the Yearly Holiday Setup dialog box. Then set holidays that are
specific to the current year using the Add Calendar window (SYSTEM_CALENDAR).

The specified weekday/holiday data can be used for the following functions in addition to the power control function.

- Service/application execution function

Allocation of starting servers and applications (for UNIX, starting applications only)

Set using the Service/Application Execution Pattern dialog box.

- Jobscheduler function

Allocation of job net schedules

Set using the Startup days sheet of the Job Net Properties window.

- Event monitoring function (Windows version)

Allocation of action execution conditions

Set with the Action Schedule dialog box

- Calendar API

Execution of calendar-oriented processes

For details on the calendar API, see the Systemwalker Operation Manager Reference Guide.

Use the following procedure to set holidays on the SYSTEM_CALENDAR:

 
Procedure

1. Set holidays that fall on the same day every year.

Set holidays that fall on the same day every year (i.e., national holidays) and substitute holidays using the Yearly
Holiday Setup dialog box.

2. Set holidays that are specific to the current year.

Set holidays that are specific to the current year using the Add Calendar window (SYSTEM_CALENDAR).
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 Note

Note the following when changing calendar information after scheduling power on/off, services (for Windows only),
application starts, and job net:

- Power schedule

If a day set for power schedule is changed to a holiday, the power schedule will be invalid. However, if changed to a
holiday after powering on, the power will not be turned off until the next power shutdown time. In this case, if the next
day is a holiday, the power is turned off at the day change time of this day.

- Service and application startup pattern

If a calendar is used in the service and application startup pattern, the service and application startup dates are set
according to content changes on the calendar.

- Job net schedule

- If an already-registered holiday calendar is changed, it is possible to set whether to re-create the job net execution day
specified in that holiday calendar. Set using the Use function2 sheet from the Define Jobscheduler Startup Parameters
window. To re-create the job net execution day, confirm or modify the execution day after changing the holiday
calendar.

- Even if the holiday calendar is changed, the already-executed groups will not be re-scheduled. The changed holiday
information will be reflected in scheduling from the next day.

2.1.1 Setting Every-Year Holidays
This section describes how to set holidays that fall on the same day every year (i.e., national holidays) and substitute holidays,
and how to cancel the holiday settings.

 
Procedure

1. Displaying the Add Calendar window

Perform any of the following:
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- Select Calendar from the Job Selection window of Systemwalker Operation Manager window. Double-click a
calendar in the Calendar List window.

Or, with a calendar selected, select Open from the File menu.

Figure 2.1 Calendar List Window
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- Select a calendar from Calendar in the Job Selection window of Systemwalker Operation Manager window.

Or, right-click while the mouse cursor is located on the calendar, then select Open from the pop-up menu.

Figure 2.2 Add Calendar Window
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2. Open the Yearly Holiday Setup dialog box.

While the Add Calendar window is displayed in the main Systemwalker Operation Manager window, select Yearly
Holiday Setup from the Option menu.

Figure 2.3 Yearly Holiday Setup Dialog Box

3. Selecting days/dates to be set as holidays

In the Yearly Holiday Setup dialog box, opened in the previous step, specify days and dates to be set as holidays using
the following procedure. The days and dates set as holidays are displayed in red.

- Specifying days/dates individually

Select one of the following 2 setting methods in Select Month:

- Set on All Months:

The specified day/date settings apply to all months from January to December.

- Set on Specified Month Only:

The specified day/date settings apply to the months specified in Month.

Then, specify days/dates to be set as holidays in Day Selection Area and Date Selection Area.

- Specifying in a batch

Selecting the Daily button specifies all the days as holidays in a batch. This selection is only valid when the Set on
All Months option button is selected in Select Month.

To cancel it, select the Daily button again.

- Setting Substitute Holidays

Checking the Activate Substitute Holidays check box specifies as holidays the day following the days of a week
already set as holidays.
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4. Saving the settings

Click OK in the Yearly Holiday Setup dialog box to reflect yearly holiday information in the Add Calendar window.
Then, select Save from the File menu of the Add Calendar window to save the specified holidays.

 

 Information

Canceling holiday settings

Use the following procedure to cancel holiday settings:

1. Select dates already selected in the Day Selection Area or Date Selection Area again.

2. Click OK.

 

 Information

Setting the reschedule date

When saving the holiday settings, the reschedule date on which the setting is reflected in the actual operations can be set in the
Save Calendar window. Once the reschedule date is set, the job net start date can be re-created only for the dates of or after
the reschedule date. For details, see "2.4 Setting the Calendar Reschedule Date".

2.1.2 Setting Holidays Specific to the Current Year
This section describes how to set holidays that are specific to the current year and how to cancel them.

 
Procedure

1. Displaying the Add Calendar window

Perform any of the following:
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- Select Calendar from the Job Selection window of the Systemwalker Operation Manager window. Double-click
a calendar in the Calendar List window.

Or, with a calendar selected, select Open from the File menu.

Figure 2.4 Calendar List Window
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- Select a calendar from Calendar in the Job Selection window of Systemwalker Operation Manager window.

Or, right-click while the mouse cursor is located on the calendar, then select Open from the pop-up menu.

Figure 2.5 Add Calendar Window

2. Selecting days/dates to be set as holidays

In the Add Calendar window opened in the previous step, use the following procedure to select days and dates to be
set as holidays. The days and dates specified as holidays remain selected.

- Click a day/date to individually select it.

- Click the starting day/date and click the ending day/date while pressing down the Shift key to select a range of
continuous days/dates.

- Click days/dates while pressing down the Ctrl key to individually select them.

- Click the selected days/dates again to cancel them.

3. Setting the selected days/dates as holidays

Right-click while the mouse cursor is on the Add Calendar window.

Selecting Holidays from the pop-up menu sets the selected days/dates as holidays and displays them in red.

Also, double-clicking on a day/date in the Add Calendar window specifies the day/date as a holiday without selecting
it and displays it in red.

4. Saving the settings

Select Save from the File menu of the Add Calendar window to save the specified holidays.
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 Information

Canceling holiday settings

Use the following procedure to cancel holiday settings:

- Click the days/dates specified as holidays in the Add Calendar window to select the days/dates, and select an appropriate
power control pattern or process date from the pop-up menu. The selected power control pattern or process date is applied
and the holiday setting is canceled.

- Double-click the day/date section in the Add Calendar window.

 

 Information

Setting the reschedule date

When saving the holiday settings, the reschedule date on which the setting is reflected in the actual operations can be set in the
Save Calendar window. Once the reschedule date is set, the job net start date can be re-created only for the dates of or after
the reschedule date. For details, see "2.4 Setting the Calendar Reschedule Date".

2.2 Setting Up Day Change Time
A day change time is the time when the date changes. Although the date generally changes at midnight, Systemwalker
Operation Manager allows this to be specified as any arbitrary time. The 24-hour period from the day change time is
considered a daily unit.

For example, at a center where batch job processing often spills over to the following day, settings are complicated because
services must be scheduled taking the change of date into account for power use and for businesses concerned with such jobs,
as well as Windows users. In such cases, pushing back the day change time to make it appear that all batch job processing was
completed by the end of the day will make power and job scheduling and service scheduling and monitoring easier.

Use the following procedure to set the day change time. For setting the day change time of subsystem, refer to "4.3.17 Setting
a Subsystem Day Change Time ".

 
Procedure

1. Displaying the Register Day Change Time dialog box

Select SYSTEM_CALENDAR from the Job Selection window of the Systemwalker Operation Manager window.
Then, select Day Change Time from the Options menu.

Figure 2.6 Register Day Change Time Dialog Box
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2. Setting day change time

Set the day change time using the Register Day Change Time dialog box displayed. The day change time specified is
applied regardless of whether it is a weekday or a holiday.

 

 Note

- Power schedule

- If day change time is changed to be within the already-defined time range of operation, the operation time will be
divided by the day change time. This may change the date and the time of power-on or shutdown. Confirm the
operation start and end times of each pattern after changing the day change time.

- If the specified day change time is between the time specified in Work end time if next day is a holiday in the Power
Control Pattern dialog box and the time 30 minutes before that, the operation end time becomes invalid. Also, if the
specified day change time is between the time - specified in Work start time if previous day was a holiday in the
Power Control Pattern dialog box and the time 30 minutes after that, the operation start time becomes invalid.

- If the day change time is changed beyond the times specified in Work end time if next day is a holiday or Work start
time if previous day was a holiday, note that the operation end time when the next day is a holiday or the operation
start time when the previous day is a holiday shifts 24 hours. If this will become an operational problem, return the
day change time to the original value or change Work end time if next day is a holiday or Work start time if previous
day was a holiday according to the operation.

- Job net schedule

- If the day change time is changed after the job net is registered, the job nets and groups of all users will be re-
scheduled. However, groups that are already executed for the day will not be re-scheduled. In this case, the changed
information will be reflected in scheduling from the next day.

- Changing the day change time may change the scheduled startup day of the job net because of the change in the
relationship with the startup time. Confirm the scheduled startup day after changing the day change time.

- If Execution interval is specified as a execution condition for the job net, do not set the day change time between the
start time and the end time. If you do so, the job net may not start up periodically. Confirm the start time and the end
time after changing the day change time.

2.3 Setting Calendars Other Than The SYSTEM_CALENDAR
To change operations on the server depending on weekdays and holidays, you must set holidays. To operate with the same
pattern everyday or with a different pattern everyday, you do not have to set holidays. Also, to change operations according
to SYSTEM_CALENDAR information, you do not need additional settings since the holiday information has already been
set with the power schedule.

If the SYSTEM_CALENDAR is not sufficient for allocating operations, create another calendar and set holidays on it. You
can set holidays that fall on the same day every year (i.e., national holidays) and substitute holidays by using the Yearly
Holiday Setup dialog box. Then, set holidays specific to the current year using the Add Calendar window (other than
SYSTEM_CALENDAR).

The specified weekday/holiday data can be used for the following functions.

- Service/application execution function

Allocation of starting servers and applications (for UNIX, starting applications only)

Set using the Service/Application Execution Pattern dialog box.

- Jobscheduler function

Allocation of job net schedules

Set using the Startup days sheet of the Job Net Properties window.
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- Event monitoring function (Windows version)

Allocation of action execution conditions

Set with the Action Schedule dialog box

- Calendar API

Execution of calendar-oriented processes

For details on the calendar API, see the Systemwalker Operation Manager Reference Guide.

 

 Note

- Note that weekday/holiday patterns set in any calendar other than the SYSTEM_CALENDAR cannot be browsed with
the power control function.

- However, if you have set a larger number of weekend/holiday patterns, the process may delay when the day change time
comes or when you edit the system calendar. It is recommendable that approximately up to 100 patterns should be set
although any number of calendar patterns can be stored.

Use the following procedure to set holidays on calendars other than the SYSTEM_CALENDAR.

 
Procedure

1. Create a calendar (it is not necessary to use an existing calendar).

Create a calendar using the Add Calendar window (other than SYSTEM_CALENDAR).

2. Set holidays that fall on the same day every year.

Set holidays that fall on the same day every year (i.e., national holidays) and substitute holidays using the Yearly
Holiday Setup dialog box.

3. Set holidays that are specific to the current year.

Set holidays that are specific to the current year using the Add Calendar window (other than SYSTEM_CALENDAR).

2.3.1 Creating a Calendar
To create a calendar other than the SYSTEM_CALENDAR, select Calendar from the Job Selection window of Systemwalker
Operation Manager window. Then, select New >> Calendar from the File menu. For saving the calendar, the Save Calendar
dialog box will appear. Click the Save As button and specify a name for the calendar to be created.
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Figure 2.7 Save Calendar Dialog Box

 

 Information

Setting the reschedule date

When saving the holiday settings, the reschedule date on which the setting is reflected in the actual operations can be set in the
Save Calendar window. Once the reschedule date is set, the job net start date can be re-created only for the dates of or after
the reschedule date. For details, see "2.4 Setting the Calendar Reschedule Date".

2.3.2 Setting Every-Year Holidays
This section describes how to set holidays that fall on the same day every year (i.e., national holidays) and substitute holidays,
and how to cancel the holiday settings.

 
Procedure

1. Displaying the Add Calendar window

Perform any of the following:
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- Select Calendar from the Job Selection window of the Systemwalker Operation Manager window. Double-click
a calendar in the Calendar List window.

Or, with a calendar selected, select Open from the File menu.

Figure 2.8 Calendar List Window
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- Select a calendar from Calendar in the Job Selection window of the Systemwalker Operation Manager window.

Or, right-click while the mouse cursor is located on the calendar, then select Open from the pop-up menu.

Figure 2.9 Add Calendar Window
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2. Open the Yearly Holiday Setup dialog box.

While the Add Calendar window is displayed in the Systemwalker Operation Manager's Main window, select Yearly
Holiday Setup from the Option menu.

Figure 2.10 Yearly Holiday Setup Dialog Box

3. Selecting days/dates to be set as holidays

In the Yearly Holiday Setup dialog box, opened in the previous step, specify days and dates to be set as holidays using
the following procedure. The days and dates set as holidays are displayed in red.

- Specifying days/dates individually

Select one of the following 2 setting methods in Select Month:

- Set on All Months:

The specified day/date settings apply to all months from January to December.

- Set on Specified Month Only:

The specified day/date settings apply to the months specified in Month.

Then, specify days/dates to be set as holidays in Day Selection Area and Date Selection Area.

- Specifying in a batch

Selecting the Daily button specifies all the days as holidays in a batch.

To cancel it, select the Daily button again.

- Setting Substitute Holidays

Checking the Activate Substitute Holidays check box specifies as holidays the day following the days of a week
already set as holidays.
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4. Saving the settings

Click OK in the Yearly Holiday Setup dialog box to reflect yearly holiday information in the Add Calendar window.
Then, select Save from the File menu of the Add Calendar window to save the specified holidays.

 

 Information

Canceling holiday settings

Use the following procedure to cancel holiday settings:

1. Select dates already selected in the Day Selection Area or Date Selection Area again.

2. Click OK.

 

 Information

Setting the reschedule date

When saving the holiday settings, the reschedule date on which the setting is reflected in the actual operations can be set in the
Save Calendar window. Once the reschedule date is set, the job net start date can be re-created only for the dates of or after
the reschedule date. For details, see "2.4 Setting the Calendar Reschedule Date".

2.3.3 Setting Holidays Specific to the Current Year
This section describes how to set holidays that are specific to the current year and how to cancel them.

 
Procedure

1. Displaying the Add Calendar window

Perform any of the following:
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- Select Calendar from the Job Selection window of the Systemwalker Operation Manager window. Double-click
a calendar in the Calendar List window.

Or, with a calendar selected, select Open from the File menu.

Figure 2.11 Calendar List Window
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- Select a calendar from Calendar in the Job Selection window of the Systemwalker Operation Manager window.

Or, right-click while the mouse cursor is located on the calendar, then select Open from the pop-up menu.

Figure 2.12 Add Calendar Window

2. Selecting days/dates to be set as holidays

In the Add Calendar window opened in the previous step, use the following procedure to select days and dates to be
set as holidays. The days and dates specified as holidays remain selected.

- Click a day/date to individually select it.

- Click the starting day/date and click the ending day/date while pressing down the Shift key to select a range of
continuous days/dates.

- Click days/dates while pressing down the Ctrl key to individually select them.

- Click the selected days/dates again to cancel them.

3. Setting the selected days/dates as holidays

Right-click while the mouse cursor is on the Add Calendar window.

Selecting Holidays from the pop-up menu sets the selected days/dates as holidays and displays them in red.

Also, double-clicking on a day/date in the Add Calendar window specifies the day/date as a holiday without selecting
it and displays it in red.

4. Saving the settings

Select Save from the File menu of the Add Calendar window to save the specified holidays.
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 Information

Canceling holiday settings

Use the following procedure to cancel holiday settings:

- Click the days/dates specified as holidays in the Add Calendar window to select them, and select an appropriate power
control pattern from the pop-up menu. The selected power control pattern is applied and the holiday setting is canceled.

- Double-click the day/date section in the Add Calendar window.

 

 Information

Setting the reschedule date

When saving the holiday settings, the reschedule date on which the setting is reflected in the actual operations can be set in the
Save Calendar window. Once the reschedule date is set, the job net start date can be re-created only for the dates of or after
the reschedule date. For details, see "2.4 Setting the Calendar Reschedule Date".

2.3.4 Deleting Calendars
A calendar other than SYSTEM_CALENDAR can be deleted by opening the Systemwalker Operation Manager window,
selecting the calendar to be deleted from the Job Selection window, and then selecting Delete in the File menu.

Alternately, after selecting the calendar to be deleted, select Delete from the pop-up menu displayed by right-click the mouse
on the calendar name.

 

 Note

- SYSTEM_CALENDAR cannot be deleted.

- The holiday calendar cannot be deleted if it is used by a job net or the service/application execution function.

2.4 Setting the Calendar Reschedule Date
If you want to reflect the holiday information in a calendar to the job net start date information of a specific day and after, use
the Save Calendar window to set the reschedule date.

When the reschedule date is set, the start dates of the job nets that use the holiday information in the saved calendar will be
replaced with a date of or after the reschedule date.

When the reschedule date is not set, the start dates of the job nets that use the holiday information in the saved calendar will
use the holiday information on the day of saving.

Use the following procedure to set the reschedule date.

 
Procedure

1. Open the Save Calendar window.

After setting the holiday information, display the Systemwalker Operation Manager window, select Save from the File
menu to open the Save Calendar window.
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2. Setting the reschedule date

In the Save Calendar window opened above, check the Specify the reschedule date and select the reschedule date from
the combo box.

Figure 2.13 Save Calendar Window

3. Saving the settings

Save using either Save or Save As.

 

 Note

Changes to the startup days, calendar or operation period information

When the startup day, calendar or operation period information on a job net that uses a calendar with a reschedule date setting
is changed using the Startup days sheet of the Job Net Properties window before the reschedule date comes, the reschedule
date setting in the Save Calendar window becomes invalid and the information changed in the Job Net Properties window
becomes valid.
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Chapter 3 Scheduling Power On / Off for Servers
This chapter describes how to schedule the power on/off for servers.

3.1 Procedure for Scheduling Power On / Off for Servers
Use the power control function to automatically control the power switch's on/off and the rebooting processing of a server.
The following power control methods can be used for servers.

- Not operating power control

Power control is not operated for servers. No setup is required.

- Operating power control with a single server

Power control is operated in a unit of a single server.

- Operating batch power control

Power control for multiple servers is operated in a batch.

Schedule power on/off for servers using the following procedure.

 
Procedure

1. Setting Holidays on the SYSTEM_CALENDAR

Set the days on which server is not operated (server power is not turned on) as holidays on the SYSTEM_CALENDAR.
To operate batch power control, set up the server which operates power control. On holidays of the
SYSTEM_CALENDAR, the power is turned off at the time defined in the power control schedule (the day change time
if not defined).

This operation can be done after the steps 2 to 5 below.

For details, see "2.1 Setting Up the SYSTEM_CALENDAR".

2. Setting day change time

Set the time of day at which the date changes on Systemwalker Operation Manager. Make sure the day change time
is set before setting power control method.

For details, see "2.2 Setting Up Day Change Time".

3. Setting Power Control Method

Set whether to operate power control for the Systemwalker Operation Manager servers, and if operating, whether to
operate power control for a single server or in a batch. To operate batch power control, information on the controlling
host and the control target host are also specified.

For details on setting, see "3.2 Power Control Setting".

4. Setting Power Schedule

Set the power schedule to define the server's power on/off and rebooting. Usual power schedule can be created with
"3.3 Power On/Off Scheduling" in "3.3.1 Creating and Applying Standard Patterns". For more complex or specific
setting, see "3.3.2 Creating and Applying Non-Standard Patterns" and "3.3.3 Setting Schedules Individually for
Specific Days".

5. Setting Shutdown Monitoring Options

Use the shutdown monitoring options to set the conditions when the system is shut down. For details, see "3.4 Setting
Shutdown Monitoring Options".

As soon as you set these options, they become valid. However, if you set them during shutdown monitoring, they become
valid the next time power is turned on.
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 Note

Manual operation

Even if the server's power on/off has been automated, you can manually perform the power on/off or shutdown. In such cases,
note the following.

- If the server is manually powered (Manual Power On), or a client's logon/login triggers the server's power on before the
scheduled power on time, the scheduled power on time is ignored. The server will not be powered off until the scheduled
power off time.

- When manually shutting down a server (Manual Shutdown), use the Systemwalker Operation Manager's Shut down
Server dialog box. If you shut down directly from Windows or UNIX server, the next scheduled power on time becomes
invalid and the power will not turn on automatically.

 

 Information

Batch power control

When operating batch power control, all the hosts to be power-controlled are treated as a single logical server. User must
specify the host which operates batch power control and the hosts to be power-controlled all together, and set up the
SYSTEM_CALENDAR, power control pattern and shutdown monitoring options for the controlling host. Manual operation
of server is possible only for the controlling host.

3.2 Power Control Setting
You can set whether to operate power control for server. When operating power control, whether to operate power control
for a single host or in a batch must be defined. To operate batch power control, information on the controlling host and the
control target host must also be specified.

 

 Note

Before setting power control method, confirm that the day change time is set appropriately for the operation. For details on
setting day change time, see "2.2 Setting Up Day Change Time".

Use the following procedure to set power control method.
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Procedure

1. Displaying the Power Control Setting window

Select SYSTEM_CALENDAR from the Job Selection window of the Systemwalker Operation Manager window, then
select Power Control Setting from the Options menu. The Power Control Setting window will appear.

Figure 3.1 Power Control Setting window

When a new Systemwalker Operation Manager is first installed, "Disable the power control" for the UNIX system or
"Control the power for this computer only" for the Windows system is set by default.

2. Specifying power control method

Specify the power control method.

Disable the power control:

Use this option when not operating power control. Click OK. No additional operation is needed.

Control the power for this computer only:

Use this option when operating power control for a single host computer. Click OK. When this option is selected,
then power schedule must also be set. For details, see "3.3 Power On/Off Scheduling".

Use this computer as a power control host:

Use this option when operating batch power control and registering the local server as the controlling host which
manages batch power control schedule. This is available when the connection destination server is a Windows
version. Checking this option button enables the Set the Specify Controlled Host button. When this option is
selected, set power schedule after performing the operations of procedure 3 and later. For details, see "3.3 Power
On/Off Scheduling".

Control as a target of batch power control:

Use this option when operating batch power control and registering the local server as a power control target host
which is controlled by the controlling host. This is available when the connection destination server is a Windows
version. Checking this option button enables the Power Control Host Name entry field. Specify name of the
controlling host which manages batch power control schedule, then click OK. When using this option, confirm that
the power schedule is appropriately set on the controlling host side. For details, see "3.3 Power On/Off
Scheduling".
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3. Displaying the Power Control Target Hosts window

When the Use this computer as a power control host option button is checked, click the Specify Controlled Host button.
The Power Control Target Hosts window will appear.

Figure 3.2 Power Control Target Hosts window

Power Control Target Hosts:

Displays the list of hosts targeted for power control. When no host is registered as power control target, nothing is
displayed.

Power on is executed in the order of the list after the controlling host is turned on. Power off is executed in the
opposite order of the list, then the controlling host is turned off.

Add:

Adds hosts to be targeted for power control. Clicking the Add button displays the Power Control Target Host Setup
window. Up to 10 hosts can be specified as the power control targets. The newly-added hosts appear at the far
bottom of the list.

Modify:

Changes the setting for the power control target hosts. Clicking the Modify button displays the Power Control
Target Host Setup window.

Delete:

Deletes the power control target host name from the list.

Up:

Moves up the power control target host in the list.

Down:

Moves down the power control target host in the list.
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4. Displaying the Power Control Target Host Setup window

Clicking the Add button in the Power Control Target Hosts window displays the Power Control Target Host Setup
window.

Figure 3.3 Power Control Target Host Setup window

5. Setting power control target host information

Set the following items.

Target Host Name:

Specifies the name of the host targeted for batch power control.

Startup Interval:

Specifies the interval between startup of one control target host and startup of the next host.

Shut Down Interval:

Specifies the interval between shutdown of one control target host and shutdown of the next host.

Power Control Software:

Specifies the power control software used for automatic startup and shutdown of the computer.

- [PowerChute]:

Select this option to use "PowerChute(R) " as the power control software. 
To use "PowerChute (R) Business Edition 10.0", execute the "jmsetauthinfo Common base credential setting
command" on the power-controlled host to register the PowerChute credentials. The registered credentials will
be used to access "PowerChute (R)". For more information about the jmsetauthinfo command, refer to the
"Systemwalker Operation Manager Reference Guide".
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- Other (PowerControl for Systemwalker):

Specify this if you want to use the PMAN model 100/PMAN model 50 Systemwalker linkage software (device
attachment) or the power control software for the power control devices certified in the linkage partner
program. You can specify this if the destination server is V 13.8.0 or earlier.

IP Address of UPS:

Specifies the IP address of the UPS connected to the control target host specified in Target Host Name.

 
Necessary Actions when Other (PowerControl for Systemwalker) is Selected (If the destination
server is V 13.8.0 or earlier)

When Other (PowerControl for Systemwalker) is selected in Power Control Software, take the following actions for the
linked commands (MpStpSv, MpStrSv).

[Windows]

Install the linked commands (MpStpSv, MpStrSv) to the directory specified as the path of the system environment variables.

[UNIX]

The linked command (MpStpSv, MpStrSv) checks whether a symbolic link is set in/opt/FJSVjmcal/bin, and if not, sets a
symbolic link.

If you are using power control software that is compatible with power control devices certified by the cooperative partner
program, and you want to use power control software from multiple companies for the power-controlled host, create the
following CSV file on the control host in advance (it is not necessary to use one software).

[Directory name]:

[Windows]:

 
Systemwalker Installation directory\mpwalker.jm\mpjmcal\caldb

[UNIX]:

 
/var/opt/FJSVjmcal/caldb

[File name]:

 
Aosf_PD.csv

[CSV File Format]:

Specify the UPS IP address in the first column and the installation directory of the power control software (MpStrSv
command) in the second column.

 
123.123.45.78 , D:\POWER\APP1
123.123.45.80 , D:\POWER\APP2
123.123.45.82 , D:\POWER\APP3

 

 Note

If you select any software product that has not been installed as the power control software, the power control will not be
performed properly.

3.3 Power On/Off Scheduling
Power schedule is the definition of power on/off and rebooting time of the server. The power control function operates power
on/off and rebooting according to this definition. Also, the power control function is linked to the power control software. For
information about required power control software, see Systemwalker Operation Manager Technical Guide.
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Use the following procedure to select the power control software.

 
Procedure

1. Displaying the Power Control sheet in the Power Control Schedule dialog box

Select SYSTEM_CALENDAR from the Job Selection window of the Systemwalker Operation Manager window, then
select Power Control Schedule from the Options menu.

2. Selecting power control software

Select the power control software to be used for the server in the Power Control Schedule dialog box.

Figure 3.4 Power Control sheet in Power Control Schedule dialog box

Select Power Control:

Specifies the power control software used for automatic startup and shutdown of the computer.

- Shut Down/Restart only:

Use this option when manually performing power on/off of the computer instead of power control by UPS.
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- PowerChute:

Select this option to use "PowerChute(R) " as the power control software. 
To use "PowerChute (R) Business Edition 10.0", execute the "jmsetauthinfo Common base credential setting
command" on the power-controlled host to register the PowerChute credentials. The registered credentials will
be used to access "PowerChute (R)". For more information about the jmsetauthinfo command, refer to the
"Systemwalker Operation Manager Reference Guide". This option is not selectable for UNIX.

- Other (PowerControl for Systemwalker):

Specify this if you want to use the PMAN model 100/PMAN model 50 Systemwalker linkage software (device
attachment) or the power control software for the power control devices certified in the linkage partner
program. You can specify this if the destination server is V 13.8.0 or earlier.

 

 Note

If you select any software product that has not been installed as the power control software, the power control will
not be performed properly.

Power Control Pattern:

Displays the names of the power control patterns and their corresponding colors. Double-clicking a power control
pattern displays the Power Control Pattern dialog box.

Pattern Setup:

Displays the Power Control Pattern dialog box for the pattern selected from the Power Control Pattern list. The
Power Control Pattern is classified into the following two types. The power on/off and rebooting times of the
system can be defined for each.

- Standard:

Registers basic operation patterns.

- Non-standard:

Registers operations other than basic patterns.

 

 Note

Note the following when setting the power schedule.

- When using a non-standard pattern or scheduling the power control for specific days, always create a standard pattern and
apply it to those schedules.

- After setting the power schedule, avoid changing day change times as much as possible. For the precautions if day change
time has been changed after setting the power schedule, see "2.2 Setting Up Day Change Time".

- When the power schedule for the day to be operated until the day change time and another power schedule for the next
day to be operated starting as the day change time have been set, the power shutdown and startup at the day change time
are not performed and the operations will be continued.

- Even the time when the operation for such change falls into the shutdown time zone as the result of the change in the
power schedule, the server will not be shut down at that point. In such case, the power control will become valid starting
at the next power shutdown time.

3.3.1 Creating and Applying Standard Patterns
Standard patterns are the generally-used patterns with timings for power on/off and rebooting for the week defined. Standard
patterns are automatically applied to days other than the holidays set for the SYSTEM_CALENDAR. Power on/off and
rebooting are performed with the same pattern every week. Use the following procedure to set a standard pattern of the power
schedule.
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Procedure

1. Displaying the Power Control sheet in the Power Control Schedule dialog box

Select SYSTEM_CALENDAR from the Job Selection window of the Systemwalker Operation Manager window, then
select Power Control Schedule from the Options menu.

Figure 3.5 Power Control sheet in Power Control Schedule dialog box

2. Displaying the Power Control Schedule dialog box (Standard)

Select Standard from the Power Control Pattern and click the Pattern Setup button.

3. Creating a standard pattern

Create Power Control Pattern (power on time/power off time/rebooting time) for the week using the Power Control
Pattern dialog box (standard).

The following is an example of how to set.
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- To set to operate power on/off at the same times every weekday
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- To set to continuously operate on weekdays

Pattern Name:

Displays the power control pattern name selected in the Power Control Schedule dialog box.

Working Time:

Specifies the operation range and the rebooting time of the computer with a time chart.

Work/Off/Reboot:

Selects and displays modes for editing time charts.

- Work:

Specifies the operation range.

- OFF:

Cancels the specified operation range. If the rebooting time is set within the operation range, the rebooting
time is canceled as well.

- Reboot:

Specifies or cancels rebooting time.

Action if holiday falls on planned date:

Specifies corrective action to be taken when power control is defined for continuous operation beyond the day
change time and the next day is set as a holiday.

- Work end time if next day is a holiday:

When an operation is scheduled for continuous operation beyond the day change time and the next day is set
as a holiday, the time to end operation can be set.
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- Work start time if previous day was a holiday:

When an operation is scheduled for continuous operation from the previous day and the previous day is set as
a holiday, the time to start operation can be set.

To create a more detailed power control pattern, use the Working Time dialog box. You can open the Working Time
dialog box by selecting the Working Time Details from the pop-up menu displayed by right-clicking on the time chart
in the Power Control Pattern dialog box.

Figure 3.6 Working Time dialog box

Day Change:

Displays day change time.

Start:

Specifies the time to turn the power on.

End:

Specifies the time to start the system termination processing

Reboot Time List:

Displays the rebooting time (in 30-minute units) specified in the time chart in the time order.

Add:

Adds the rebooting time definition. The Reboot Time dialog box is displayed by selecting the rebooting time from
the Reboot Time List display area and clicking the Add button. Specify the rebooting time according to the settings
of the Reboot Time dialog box shown below.

Change:

Changes the rebooting time. The Reboot Time dialog box is displayed by selecting the rebooting time from the
Reboot Time List display area and clicking the Change button. Specify the rebooting time according to the settings
of the Reboot Time dialog box shown below.
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Delete:

Deletes the rebooting time.

Setting the Reboot Time dialog box

Enter necessary information in the Reboot Time dialog box displayed by clicking the Add button or the Change
button in the Working Time dialog box.

Figure 3.7 Reboot Time dialog box (from the Add button)

Add Time:

Specifies the time to reboot.

Figure 3.8 Reboot Time dialog box (from the Change button)

Change Time:

Specifies the time to reboot.

4. Saving and applying the standard pattern

Click OK in the Power Control Schedule dialog box.

The standard pattern set here is automatically applied to all days other than holidays set in the Add Calendar window.

3.3.2 Creating and Applying Non-Standard Patterns
Non-standard patterns are the generally-used patterns with timings for power on/off and rebooting for the day defined. If the
server is operated only with the standard patterns, power on/off and rebooting are repeated with the same patterns every week.
For days on which power on/off and rebooting should be operated with other pattern than the standard patterns, you can set
non-standard patterns. Non-standard patterns are applied to days other than the holidays set for the SYSTEM_CALENDAR.
Use the following procedure to set a non-standard pattern of the power schedule.
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Procedure

1. Displaying the Power Control sheet in the Power Control Schedule dialog box

Select SYSTEM_CALENDAR from the Job Selection window of the Systemwalker Operation Manager window, then
select Power Control Schedule from the Options menu.

Figure 3.9 Power Control sheet in Power Control Schedule dialog box
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2. Displaying the Power Control Schedule dialog box (Non-standard)

Select an option other than Standard from the Power Control Pattern and click the Pattern Setup button.

Figure 3.10 Power Control Pattern dialog box (Non-standard)

3. Creating a non-standard pattern

Set a pattern name and create a power control pattern (power on time/power off time/rebooting time) for the day using
the Power Control Pattern dialog box (non-standard).

Then, click OK to close the Power Control Pattern dialog box (non-standard). The newly-created non-standard pattern
name will be added to the Power Control sheet in the Power Control Schedule dialog box. Up to 8 non-standard patterns
can be set.
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To create a more detailed power control pattern, use the Working Time dialog box. You can open the Working Time
dialog box by selecting the Working Time Details from the pop-up menu displayed by right-clicking on the time chart
in the Power Control Pattern dialog box.

Figure 3.11 Working Time dialog box

4. Saving the non-standard pattern

Click OK in the Power Control Schedule dialog box.

5. Selecting days to which the non-standard pattern is applied

Clicking a day (of week) section in the Add Calendar window selects all the dates of that day (of week). Clicking a dates
section selects that date.

Also, multiple dates can be selected by clicking dates while pressing down the Shift key (range selection) or the Ctrl
key (additional selection).
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Click the selected days/dates again to cancel them.

Figure 3.12 Add Calendar Window

6. Applying the non-standard patterns

Select a created non-standard pattern from the pop-up menu displayed by right-clicking on the Add Calendar window.
The non-standard pattern will be applied to the selected dates. The non-standard patterns created are displayed in the
form of "operation date ("pattern name")."

 

 Note

If non-standard pattern is applied to holiday, the day will change from the holiday to the weekday (process date).

3.3.3 Setting Schedules Individually for Specific Days
Individual patterns are patterns with timings for power on/off and rebooting for the day defined only for specific days. For
days on which power on/off and rebooting of server should be operated with other pattern than the standard or non-standard
patterns, you can set individual patterns. Also, individual patterns can be used for power on/off and rebooting on holidays set
in the SYSTEM_CALENDAR. Use the following procedure to set an individual pattern of the power schedule.

 
Procedure

1. Displaying the Power Control Pattern (Separate) dialog box

Select the Dates button in the Add Calendar window, then right-click and select Separate from the pop-up menu.
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2. Creating an individual pattern

Create power control patterns (power on time/power off time/rebooting time) for the selected date using the Power
Control Pattern (Separate) dialog box.

Figure 3.13 Power Control Pattern (Separate) dialog box

Working Time:

Specifies the operation range and the rebooting time of the computer with a time chart.

Work/Off/Reboot:

Selects and displays modes for editing time charts.

- Work:

Specifies the operation range.

- OFF:

Cancels the specified operation range. If the rebooting time is set within the operation range, the rebooting time
is canceled as well.

- Reboot:

Specifies or cancels rebooting time.

3. Applying an individual pattern

Click OK to close the Power Control Pattern (Separate) dialog box. The newly-created individual pattern will be
applied to the selected dates.

 

 Note

- Double-clicking a holiday resumes the standard pattern and it does not return to the previous pattern.

- If individual pattern is applied to holiday, it is set to holiday/individual. On the other hand, if the date on which an
individual pattern is applied is set as a holiday, the individual pattern setting will be canceled and it will become an
ordinary holiday.

- The holiday/individual is treated as a holiday for other functions than the power control function.
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- When the Separate button is selected from the pop-up menu while a date on which the individual pattern is set is selected,
information on the previously-set individual pattern will be displayed on the Power Control Pattern (Separate) dialog
box. Changing and setting information overwrite the previously-set individual pattern information.

- When the Separate button is selected from the pop-up menu while dates including the date on which the individual pattern
is set are selected, the Power Control Pattern (Separate) dialog box will be displayed without a time chart. Setting
individual pattern overwrites the previously-set individual pattern information.

3.4 Setting Shutdown Monitoring Options
In Systemwalker Operation Manager, it is possible to monitor logged in users via the network or notify the users still being
connected to a server via a network when the server is shut down. Also, the server shutdown can be delayed until the end-of-
wait notification is issued. For example, issuing an end-of-wait notification command enables an automatic delay of the
server shutdown based on how much delay is in the operation. In Systemwalker Operation Manager, this is called 'shutdown
monitoring'. The following shows the flow of the server shutdown processing.

When operating batch power control, the controlling host is the destination of shutdown monitoring notification.

The following explains the shutdown monitoring options.
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Procedure

1. Displaying the Completion Monitoring sheet in the Power Control Schedule dialog box

Select SYSTEM_CALENDAR from the Job Selection window of the Systemwalker Operation Manager window, then
select Power Control Schedule from the Options menu.

Figure 3.14 Completion Monitoring sheet in Power Control Schedule dialog box

Completion Monitoring:

Performs shutdown monitoring at the operation end time and rebooting time. The Details button is enabled.

Details:

Displays the Completion Monitoring dialog box.
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2. Displaying the Completion Monitoring dialog box

Check the Completion Monitoring check box in the Completion Monitoring sheet of the Power Control Schedule
dialog box, then click the Details button. In the Completion Monitoring dialog box, define the shutdown monitoring
options.

Figure 3.15 Completion Monitoring dialog box

Notify Completion To User:

Notifies the users who are connecting to the computer via a network when the time of shutdown is reached. This
option is not selectable for UNIX.

Execute Command:

Executes command at the time of shutdown.

Command Definition:

Displays the Execution Command Definition List dialog box. Specify the executed commands according to the
settings of the Execution Command Definition List dialog box shown below.

No User Connected:

Completes the shutdown monitoring only if no user is connected to the computer via network. This option is not
selectable for UNIX.

Notify Queuing Completion:

Completes the shutdown monitoring when end-of-wait is notified with the end-of-wait notification command.

Completion Notification:

Displays the Queuing Completion Notification Definition dialog box. Define end-of-wait notification according to
the Queuing Completion Notification Definition dialog box shown below.
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Notify to operator when monitoring target is incomplete:

Notifies the operator (administrator of the computer) if shutdown is not completed after a certain period of time
from the operation end time.

Incompletion Confirmation Clue Monitoring:

Specifies the time from the operation end time to wait before notifying the operator.

Notification Means:

Specifies the method (Popup or Mail) to notify the operator of shutdown incompletion.

- Popup:

Displays a pop-up message.

- Mail:

Notifies by a mail.

Details:

When Popup is selected as notification means, the Popup Notification Destination Definition List dialog box
will appear. (If a connection is made to a server running V13.2.0 or earlier, the Popup Notification Destination
Definition dialog box will be displayed.) When Mail is selected, the Mail Notification Destination Definition
dialog box will appear. Specify notification destination according to the Popup Notification Destination
Definition List dialog box or the Mail Notification Destination Definition dialog box shown below.

In the UNIX system, your setup of the "Notify to operator when monitoring target is incomplete" option is valid
only when any of the Operation Management Server, the Section Management Server or the Job Server of
Systemwalker Centric Manager has been installed.

Waiting Time Until Application Termination:

Specifies the monitoring time for shutdown monitoring. If the completion conditions are not satisfied within this
time, shutdown will be operated regardless of the completion conditions.

Monitoring Interval:

Specifies the interval to check the condition when No User Connected or Notify Queuing Completion is selected.

Setting the Execution Command Definition List dialog box

In the Execution Command Definition List dialog box displayed by clicking the Command Definition button in the
Shutdown Monitoring dialog box, necessary settings can be made.

Figure 3.16 Execution Command Definition List dialog box
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Command List:

Displays a list of commands executed when the operation end time has been reached.

Add:

Defines the executed command to be newly-added. Clicking this button displays the Execution Command
Definition dialog box. Add executed commands according to the settings of the Execution Command Definition
dialog box shown below.

Change:

Changes information of the command selected in the Command List display area. Clicking this button displays the
Execution Command Definition dialog box. Define command information according to the settings of the
Execution Command Definition dialog box shown below.

Delete:

Deletes information of the command selected in the Command List display area.

Setting the Execution Command Definition dialog box

In the Execution Command Definition dialog box displayed by clicking Add or Change in the Execution Command
Definition List dialog box, necessary settings can be made.

Figure 3.17 Execution Command Definition dialog box

Execution File:

Specifies the full path to the startup files of commands executed when the operation end time has been reached.

Parameter:

Specifies the parameters of commands executed when the operation end time has been reached.

Execution Directory:

Specifies the execution directory of commands executed when the operation end time has been reached.

Window Display at Application Start:

Specifies the display method when starting up the application. This cannot be set for UNIX.

- Normal:

Starts up with the window displayed.
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- Hide:

Starts up without the window displayed.

- Iconize:

Starts up with an icon displayed.

Setting the Queuing Completion Notification Definition dialog box

In the Queuing Completion Notification Definition dialog box displayed by clicking the Completion Notification
button in the Completion Monitoring dialog box, necessary settings can be made.

Figure 3.18 Queuing Completion Notification Definition dialog box

Queuing Completion Notification List display area:

Displays a list of queuing completion notifications used as shutdown monitoring completion conditions.

To wait on a server which is a batch power control target, the queuing completion notification definition for all the
target servers must be made on the controlling server. If a queuing completion notification command is issued on
a target server, it is notified to the controlling server.

Setting the Popup Notification Destination Definition List dialog box /Popup Notification Destination Definition
dialog box

In the Popup Notification Destination Definition List dialog box displayed by selecting the Popup as a notification
method in Notify to operator when monitoring target is incomplete in the Completion Monitoring dialog box and
clicking the Details button, necessary settings can be made.

If a connection is made to a server running V13.2.0 or earlier, the Popup Notification Destination Definition dialog box
will be displayed instead.

Note that if a client running V13.2.0 or earlier connects to a server running V13.3.0 or later, the information displayed
in the Popup Notification Destination Definition dialog box will be the first item of registered notification destination
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information (the first line of the Popup Notification Destination List in the Popup Notification Destination Definition
List dialog box).

Figure 3.19 Setting the Popup Notification Destination Definition List dialog box

Popup Notification Destination List

The Popup Notification Destination Definition displays a list of registered notification destinations.

- Notification Destination:

Displays popup notification destination.

- Notification kind:

Displays the type of notification destination as follows:
Computer name: Computer
Domain name: Domain

Add

Defines a new notification destination to be added. When this button is clicked, the Popup Notification Destination
Definition dialog box is displayed. Refer to the Popup Notification Destination Definition dialog box setup method
provided below when adding a notification destination.

Note that the maximum number of items that can be registered is 100.

Change

Changes the notification destination information selected in the Popup Notification Destination List display area.
When this button is clicked, the Popup Notification Destination Definition dialog box is displayed. Refer to the
Popup Notification Destination Definition dialog box setup method described below when changing a notification
destination.

Delete

Deletes the notification destination information selected in the Popup Notification Destination List display area.
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Figure 3.20 Popup Notification Destination Definition dialog box

Notify to Computer/User:

Specifies the name of the computer or the user to which the pop-up notification is made.

Notify to Domain:

Specifies the name of the domain to which the pop-up notification is made.

Setting the Mail Notification Destination Definition dialog box

In the Mail Notification Destination Definition dialog box displayed by selecting the Mail as a notification method in
Notify to operator when monitoring target is incomplete in the Completion Monitoring dialog box and clicking the
Details button, necessary settings can be made.

Figure 3.21 Mail Notification Destination Definition dialog box

Mail Address:

Specifies the destination e-mail address.

E-mail:

Specifies the use of E-mail for mail notifications (either E-mail or MS-Mail can be specified when V12.0L11/12.1
or previous version is connected).

3. Saving the definition

Click OK to save the definition.

4. Restart Systemwalker Operation Manager.

Restart Systemwalker Operation Manager to enable the settings.
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 Note

Make sure the commands and applications executed during the shutdown monitoring processing are the ones which complete
in a short time.

If all of preset commands and applications are started, the shutdown process may start even when any of them are not
completed. The process of commands and applications is interrupted if they are incomplete when the shutdown process has
started.

However, you can use a batch file or others and control the startup of shutdown process by calling the completion notification
command only after the command and application process has completed.

For details on the completion notification command, see the Systemwalker Operation Manager Reference Guide.

 

 Note

In the UNIX system, if you have selected "Popup" as the "Notification Means" in the "Notify to operator when monitoring
target is incomplete" option, you must make settings in the "Action Execution Host" tab of Systemwalker Centric Manager's
Action Environment Setup(Advanced) dialog box.

When Mail is selected as Notification Means in the Notify to operator when monitoring target is incomplete, the following
settings are also necessary.

[Windows version]

It is necessary to set up Mail in the Action Environment Setup dialog box.

[UNIX version]

It is necessary to set Mail in the Action Environment Setup(Advanced) dialog box for Systemwalker Centric Manager.
Additionally, if MS-mail is selected, it is also necessary to set Action Execution Host.

 

 Note

To perform completion notification to the users by pop-up messages, the Messenger Service must be running on the
notification destination computer and a user must be logged on to the target computer at the time.

If the notification destination computer is a Windows operating system, one of the following products (functions) must be
installed:

- Systemwalker Centric Manager

- Client [Selected option: Action Execution (Audio Notification)]

- Operation Management Client [Selected option: Action Execution (Audio Notification)]

- Job Server

- Section Management Server

- Asset Management Server

- Operation Management Server

- Systemwalker Operation Manager

- Client [Selected option: Action Execution (Audio Notification)]

- Server

To perform notification when the power is turned off in the environment where completion notification cannot be made by
pop-up messages, make it by means of E-mail.
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 Information

By using the completion notification command, a completion notification can be issued from fixed-form job operation
applications such as the Jobscheduler. By defining the end-of-wait notification in the Queuing Completion Notification
Definition dialog box, server shutdowns can be smoothly operated according to completion of batch jobs. This eliminates the
necessity for the system administrator to wait for the job completion, and uninhabited operation during night time becomes
possible.

For details on the Waiting Completion Notice command, see the Systemwalker Operation Manager Reference Guide.
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Chapter 4 Scheduling Jobs
This chapter provides the instructions and procedures to automatically run jobs by using Jobscheduler.

4.1 Job Scheduling Essentials
This section provides essential information necessary to schedule jobs.

4.1.1 Job Scheduling Values
Consider the following values when jobs are scheduled:

- Maximum number of Projects that can be registered in the Jobscheduler

- Maximum number of job nets that can be registered in a Project

- Maximum number of jobs that can be registered in a job net

- Maximum number of job nets that can be registered in a group

For details on each of these values, see the "Job Scheduling Values" section in the Systemwalker Operation Manager
Technical Guide.

4.1.2 Layering Job Nets
Job nets can be registered as jobs in other job nets. Registering a job net in another job net is referred to as "layering." The
job net where another job net has been registered is referred to as the "parent job net," and a job net registered in the parent
job net is referred to as a "child job net."

In layered job nets, the layer depth is expressed as the n-th layer. There can be as many as 5 layered job nets.

There is limit to the number of jobs that can be registered in a layer. For more details, see the "Maximum Values for Job
Scheduling" section in the Systemwalker Operation Manager Technical Guide.

By setting up startup days for child and linked job nets, the job net configuration can be changed for each operating day. To
set up startup days for child and linked job nets, select the Valid only on startup days check box in the Control information
sheet of the Add/Change - Job window, in addition to the normal procedure for specifying startup days for job nets that is
performed on child job nets and master linked job nets. Refer to "4.2.4 Registering Jobs" and "4.2.3 Registering Job Nets"
for details on the setup procedure. Also, refer to "4.1.3 Linked Job Nets" for information on linked job nets and master linked
job nets.

 
Procedures to layer job nets

Use the following procedure to layer job nets.
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When job nets are layered, parent and child job nets must meet the following conditions.

 
Parent job net conditions

Only job nets that meet the following conditions can be registered as a parent job net.

- The execution attribute is the Job Execution Control attribute.

 
Child job net conditions

Only job nets that meet the following conditions can be registered as a child job net.

- The job net belongs to the same Project as the parent job net.

- The execution attribute is the Job Execution Control attribute.

- The Execution condition is set to None.

- The job net must not belong to a group.

- The job net is not registered as a child job net to any other job net.

- Copy and start is not specified in the job net properties.

- The job net must not have been duplicated via a "copy and startup" operation.

- The job net must not be a linked job net.

- The job net must not be a master linked job net.

- The job net must not be a termination process job net. [Windows]

4.1.3 Linked Job Nets
A job net can be registered as a job in multiple job nets. A job net that has been registered in multiple job nets is called a "linked
job net". For each linked job net, there is another job net that holds the definition information for the linked job net. A job net
that contains definition information for linked job nets is called a "master linked job net". Linked job nets are registered as
a copy of their master linked job net, and refer to the definition information in that master linked job net. Multiple linked job
nets can be registered in a single parent job net.

There is a limit to the number of linked job nets that can refer to a single master linked job net. Refer to "Maximum Values
for Job Scheduling" in the Systemwalker Operation Manager Technical Guide for details on the maximum values.

Linked job nets can be layered by using child job nets to combine them into layers. Even if linked job nets are combined into
layers, there can only be up to five layers. The master linked job net that a linked job net refers to can also be layered without
any problems. However, it is not possible to register a linked job net within another linked job net.

 
Registering linked job nets

When there is a job net that will become a master linked job net, register a parent job net where a linked job net has been
allocated as a job. When the linked job net is registered, the job net specified as the reference job net becomes the master
linked job net. The master linked job net continues to be a top-layer job net. The procedure for registering linked job nets is
explained below.

Procedure for registering linked job nets

1. Register a master linked job net

Register the job net that will become the master linked job net in the same project as the project where the linked job
net will be registered. At this point, ensure that the job net meets the conditions for becoming a master linked job net
(see below).

2. Register the parent job net that will hold the linked job net as a job.

Linked job nets can be registered in a job net with the Job Execution Control attribute. Use either the New Job Net
window or the Change Job Net window to register a job net with the Job Execution Control attribute, where the linked
job net has been allocated as a job. Specify the job net that was registered in Step 1 as the reference destination for the
linked job net.
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Refer to "4.2.3 Registering Job Nets" and "4.2.4 Registering Jobs" for details on the setup procedure.

 
Conditions for becoming a master linked job net

To become a master linked job net, a job net must meet all the following conditions:

- The job net must be in the same project as the parent job net where the linked job net will be registered.

- The job net must have the Job Execution Control attribute.

- The Execution Condition for the job net must be set to None.

- The job net must not belong to a group.

- The job net must not be a child job net of another job net.

- Copy and start is not specified in the job net properties.

- The job net must not have been duplicated via a "copy and startup" operation.

- The job net must not be a linked job net.

- The job net must not have been layered using a linked job net.

- The job net must not be a termination process job net. [Windows]

 
Changing linked job nets

Master linked job nets contain definition information for all the linked job nets that refer to them. If a job net is registered as
a linked job net, changing the master linked job net allows changes to most of the definition information to be reflected to the
linked job nets that refer to that master linked job net.

 
Executing linked job nets

Executing a linked job net does not affect the execution of other linked job nets that refer to the same master linked job net.
Each linked job net is executed as a separate job net. This means that multiple linked job nets that refer to the same master
linked job net can be executed at the same time. Separate execution logs are saved for each linked job net. However, it is not
possible to change the master linked job net that a linked job net refers to while that linked job net (or a job net in a higher
layer) is executing.

 
Using linked job nets in Master Schedule Management environments

Linked job nets can be used in Master Schedule Management environments. Using linked job nets in Master Schedule
Management environments allows for more precise control, as compared to environments where the Master Schedule
Management function is not used.

Linked job nets can be registered in the "master project" and the "operation change project". Linked job nets that have been
registered in the master project or the operation change project are extracted by the Master Schedule Management function
and then registered and executed as normal child job nets of the "schedule by dates project". Thereafter, even if the definition
information in the master linked job nets in the master project is changed, this information will not be reflected to the normal
child job nets that have been registered in the schedule by dates project. This means that the master linked job nets in the
master project and the operation change project can be changed even if the normal child job nets that have been registered
in the schedule by dates project are executing. Note also that master linked job nets cannot be registered in the schedule by
dates project.

4.1.4 Job Nets Registered in a Group
Only job nets that meet the following conditions can be registered in a group.

- The job net belongs to the same Project as the group.

- The Execution condition is specified. The Execution condition is set to Time Startup. Only one execution time (one
startup per day) is registered.

- Copy and start is not specified in the job net properties.

- Enabled Valid during job net execution is not set as the message event execution condition.
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- No identical job net exists in the group (identical job nets cannot be registered in the same group).

- The job net is not registered in another group.

 

 Information

- When "start" is specified for a group, all job nets registered in the group start without waiting for an occurrence of the
message event or for the startup time. Also, see "14.1.7 Group Operations and Actions".

- If a job net residing in the preceding job net of the same group has been set to [Valid execution time], it waits for the
normal termination of the preceding job net regardless of the [Wait for startup time] setup. Also, it waits for an occurrence
of the message event and the Scheduled time. Also, see "4.3.1 Registering Groups".

4.1.5 How Jobs are Allocated after a Preceding Job is Code
Complete

When a job is completed in either normal or pseudo-normal mode, the completion code from this job is used to start
succeeding jobs. When a startup job is assigned the range of code completion that will be the execution condition is specified
on the succeeding job.

More than one job can be specified to start up after a preceding job, but these succeeding jobs can recognize only one
preceding job. If several jobs are specified to start up after the preceding job, then once the preceding job is completed in either
normal or pseudo-normal mode, all the succeeding jobs that meet the condition started up using the completion code of the
preceding job. If there is no applicable job, then no job starts up.

In the New/Change/Recovery Change Job Net window, the blue (arrow) line connects to the preceding job and indicates the
job in which the condition for the completion code of the preceding job is specified.

In the Monitor Job Net window, the blue (arrow) line connects to the preceding job and indicates the job in which the
condition for the completion code of the preceding job is specified. Jobs that are not started up are indicated by a gray
connection line (arrow), a light colored icon framed by a dotted circle.

Jobs that do not start because they do not meet the above conditions are in passed status. The job net ends normally when other
jobs not in passed status have been completed properly, even if some jobs remain in passed status.

The job net configuration in the figure below describes a job flow when the completion code of a job is assigned to succeeding
jobs.

1. The figure shows that after Job A starts up normally with completion code 10, Job B, (which has a startup value of less
than 10) starts up. Job C falls into "pass" status since it does not meet the execution conditions. Job E, which is waiting
for Job C to start up automatically falls into "pass" status and job F only waits for Job D to complete start up before it
starts up.

2. Once Job B has finished starting up, Job D starts up.

3. Once Job D has finished starting up, Job F starts up.
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4. Once Job F has finished starting up with completion code 5, Jobs G and H fall into "pass" status because they do not
meet the requirements to start up. Job I also falls into pass status since all the preceding jobs are in pass status. After
Job F has finished starting up, the job net finishes normally even if some jobs are still in pass status.

4.1.6 "Wait with OR" Condition
You can use the "wait with OR" condition to wait for multiple preceding jobs.

Register event wait jobs that will wait for execution conditions as the preceding jobs, and then configure the succeeding job
to wait using logical OR conditions. The succeeding job starts when all the preceding event wait jobs have met the execution
conditions and one has completed normally.

 
Notes on the "wait with OR" condition

- The "wait with OR" condition can be used only with job nets that have the Job Execution Control attribute.

- Only the following event wait jobs can be registered as preceding jobs with the "wait with OR" condition:

- Wait for file jobs

- Wait for message event jobs

- Wait for time jobs

- Wait until specified time jobs

- You cannot draw a connection line from a preceding event wait job to multiple succeeding jobs.

Refer to "14.2 Operations of Jobs with "Wait with OR" Condition" for information on operating jobs with the "wait with OR"
condition.

4.1.7 Recovery Jobs
A recovery job can be registered as a job. The recovery job is started if a job is abended.

In a recovery job, the executable file that carries out actions against unexpected termination is registered. Only one recovery
job can be connected to a job. The recovery job cannot connect more than one preceding job. No job can be connected after
a recovery job. After a recovery job is completed normally, the preceding job that has abended can be restarted. The job net
configuration in the screenshot below describes the flow of a recovery job.

1. When Job B abends, recovery Job D starts up.

2. After recovery Job D starts up normally, original Job B is restarted only once provided that restart of the original job
is specified.

3. After Job B starts up normally, the next job in succession, Job C starts up.

4. After Job C starts up, the job net starts up normally.

The job net is terminated abnormally if any of the followings has occurred.

- Recovery job D was abended.

- Restart of original job B is not specified in recovery job D.

- Although restart of original job B is specified in recovery job D, recovery job D was terminated normally but job B was
abended again after its restart.
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4.1.8 Scheduling Time of Job Nets
Job nets are scheduled when any of the following has occurred:

- The Jobscheduler service ("Systemwalker MpJobsch") or the Jobscheduler daemon is started

- The day change time is reached

- The day change time, the holiday calendar, or the schedule pattern is changed

- The Startup Days information of the job net is changed

- A job net is registered or deleted.

Schedule processing behavior when the day change time is reached may vary depending on the setting in Carry over the
process regardless of the day change time in the Job Net Properties window. Refer to "4.3.8 Carried Over the Job Net" for
details.

 

 Note

If schedule processing is performed for job nets, or job nets within a group, that have not yet started because the execution
conditions have not been met even when the scheduled time has been reached

If schedule processing is performed for job nets, or job nets within a group, that have not yet started because the execution
conditions have not been met even when the scheduled time has been reached, the previous scheduled time will be discarded.
Note the following:

- Job nets

The previous scheduled time is discarded, and the next scheduled time is used as the setting.

Accordingly, check if there are any job nets that have not yet started, even though the scheduled time has passed, when
making changes to the following:

- Day change time

- Information in the Job Net Properties window or Startup Days window.

If the day change time is changed to an earlier time, and the holiday calendar or schedule pattern is also changed, the
previous scheduled time will not be discarded, even if schedule processing is performed.

- Job nets within a group

The previous scheduled time is discarded, and the next scheduled time is used as the setting.

Accordingly, check if there are any job nets within a group that have not yet started, even though the scheduled time (on
the day) has passed, when making changes to the following:

- Day change time

- Information in the Job Net Properties window or Startup Days window

Also, check if there are any job nets within a group that have not yet started, even though the scheduled start time and
subsequent day change times (on the next day or later) have passed, when making changes to the following:

- Day change time, holiday calendar, or schedule pattern

- Information in the Job Net Properties window or Startup Days window

4.1.9 Startup Day Information
"Startup day information" is information retained by each job net about the startup days for three years including the current
year.

The startup day information is created based on the content set in the following windows:

- Startup days tab of the Job Net Properties window

- Startup Days window
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- Startup Days (Preview) window

- Application Plan window

 
Startup days and exception days

There are two types of job net startup day: startup days and exception days. The two types are treated differently depending
on the window used to set them. The following table explains the differences between startup days and exception days.

 
Type Description Set in:

Startup day Basic startup day (startup day set
semipermanently).

Startup days tab of the Job Net
Properties window

Exception
day

This may sometimes be cleared when the
calendar or startup day is changed.

It is also deleted when only Calendar is
distributed as policy information.

Startup days window

Startup days (Preview) window

Application Plan window

 
Triggers for the re-creation of startup day information and the deletion of the exception day

The startup day information that was created when the job net was registered is re-created according to the triggers shown
below.

If the startup day information is re-created, the exception day is deleted and the startup day is set again using the information
that was registered in the Startup days tab of the Job Net Properties window. For this reason, care should be taken when
performing the following operation.

The triggers for the re-creation of the startup day information, and of the target ranges, are shown below.

Note that if there is a "Y" for "Halt recreation of startup days" in the table below, you can halt the re-creation of the startup
day and the deletion of the exception day by using the halt re-creation of startup days function or by specifying the reschedule
day.

 
Re-creation trigger Target range for re-

creation
Halt re-creation of

startup days

When the following options in the Job Net
Properties window are changed (including
cases where the job net control statement is
used to change the relevant operands):

- Startup days

- Calendar

- Operation Period

Target job nets only N

Changing or deleting a holiday calendar that is
being referenced by a job net

A job net that is referencing
a holiday calendar that was
changed

Y (*1)

Changing a schedule pattern that is being
referenced by a job net

A job net that is referencing
a schedule pattern that was
changed

Y

- Changing the startup day or deleting the
startup day information of a base job net
that is being referenced by a job net

- Canceling the Base job net specification
for the job net that is being used as the
base job net

A job net that is referencing
the target base job net

N
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Re-creation trigger Target range for re-
creation

Halt re-creation of
startup days

- Deleting the base job net itself

*1: Specifying a reschedule date halts the re-creation of the startup day until the reschedule date.

Refer to "I Want to Fine Tune Startup Days" in the Systemwalker Operation Manager How-To Guide for information on halt
re-creation. Refer to "2.4 Setting the Calendar Reschedule Date" for information on specifying the reschedule date.

4.2 Job Schedule Registration
This section describes how to register a job schedule.

The basic procedure for registering a job schedule is as follows:

- 4.2.1 Registering Projects

- 4.2.3 Registering Job Nets

- 4.2.4 Registering Jobs

- 4.2.5 Job Net Information Settings

Set the project access rights and register the schedule pattern as required.

4.2.1 Registering Projects
When scheduling jobs, first register its project. The following describes how to register projects.

Projects can only be registered by Project system administrators (i.e. Users who are members of the Windows Administrators
Group, or who are a superuser in the UNIX system). If the Extended User Management function is valid in the UNIX system,
only the Operation Manager user having the administrative authority can perform it.

 

 Note

User Notes on Project

In order for a user to access project information, a member of the Administrators Group [Windows version], a system
administrator (superuser) [UNIX version] or an Operation Manager user with the administrator privilege [UNIX version]
must grant user access rights to project information in the Set Permissions window.

Refer to "4.2.2 Setting up Access Permissions for Projects" for details on how to specify access rights.

 
Procedure

1. To display the New Project window

Select Jobscheduler from the Job Selection window in the Systemwalker Operation Manager window. Then, select
Project in New of the File menu (or right click and select Project in New from the pop-up menu). The New Project
window appears.
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2. To specify Project information

Specify the Project name and owner in the New Project window, and then click OK.

Figure 4.1 New Project window

Project Name:

Specifies the Project name.

Owner:

Specifies the owner of the project.

Specify an operating system user here, regardless of which user management method is being used.

Owner password [Windows version]:

This is displayed if Execute jobs under the respective job owner's authority is enabled in the Define Operating
Information window. Enter the operating system password of the user specified in Owner.

If Effective user name has not been specified in the Detail information sheet of the Add/Change - Job window or the Monitor -
Job window, the owner specified here will become the execution user for jobs within the project.

4.2.2 Setting up Access Permissions for Projects
This section explains how to use the Set Permissions window to specify and remove users' access rights to individual projects
(update right, change right, operation right and reference right).

 

 Note

- Only the system administrators (Note) can set the access rights for projects. However, if the Extended User Management
function [UNIX] has been enabled, only Operation Manager users with administrator privileges can use the Set
Permissions window.

- If access rights have not been set up, only the project owner and system administrators (Note) can access the project.
However, if the Extended User Management function [UNIX] has been enabled, only Operation Manager users with
administrator privileges can access the project.

- Even if a user (for whom access rights to the project have been set up) is removed from the operating system, that user's
access rights to the project will not be deleted. If necessary, use the Set Permissions window to delete the access rights
for the user.

Note: Users belonging to the Administrators group [Windows], or superusers [UNIX]

 
Setting up access permissions
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Procedure

1. Open the Set Permissions window

Select a project in Job Selection of the Systemwalker Operation Manager window. Next, select Access Rights from the
Security menu. The Set Permissions window will be displayed.

2. Set up access permissions

In the Set Permissions window, select a user or group that will be able to access the project, and then specify an access
right (update right, change right, operation right or reference right).

Figure 4.2 Set Permissions window

NetBios computer name:

The content displayed here varies depending on the destination server.

- If the destination server is a Windows system, select a domain or computer for a registered group or user ID
displayed in the User ID/Group list.

- If the destination server is a UNIX system, the host name for the destination server will be displayed.

User ID/Group list:

The content displayed here varies depending on the destination server.
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- If the destination server is a Windows system, this area will display a list of the groups and user IDs that have
been registered in the domain or computer selected in the NetBios computer name field. Use this list to select
a user or group for which an access right will be specified.

- If the destination server is a UNIX system, this area will display a list of the user IDs and groups that have been
registered on the computer. Use this list to select a user for which an access right will be specified.

Access rights:

Use this item to select which access right to set for the selected user or group.

- Update Right:

Users with update rights can execute operations with all the privileges associated with change rights, operation
rights and reference rights.

- Change Right:

Users with change rights can register job nets and groups in projects. This access right includes reference rights.
However, users with only change rights cannot perform operations such as starting and canceling job nets and
groups.

- Operation Right:

Users with operation rights can perform operations such as starting and canceling job nets and groups. This
access right includes reference rights. However, users with operation rights cannot register job nets or groups
in projects.

- Reference Right:

Users with reference rights can monitor the execution status of job nets and groups, and look up the execution
results.

 

 Information

Refer to "Usage Restrictions Based on Access Rights" in the Systemwalker Operation Manager Installation Guide
for details on the Systemwalker Operation Manager operations that can be performed by users with different access
rights.

Add:

This button is used to set the selected access right for the group or user ID that has been selected in the User ID/
Group list field.

Access account list:

This area displays a list of the user IDs and groups whose access rights have already been specified, as well as their
access rights.

 

 Information

To use change rights, connect from a client running Systemwalker Operation Manager V13.2.0 or later.

Note the following points when a client running Systemwalker Operation Manager V13.1.0 is connected to a server running
Systemwalker Operation Manager V13.2.0, V13.3.0 or V13.3.1:

- Projects for which change rights have been set cannot be displayed if the connection is made by an ordinary user. To view
these projects, connect to the server as a user with access rights.

- Change Right does not appear in the Access Rights combo box in the Set Permissions window if a connection is made
by a system administrator.

 
Deleting access rights
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Procedure

In the Set Permissions window, select the user or group whose access right is to be deleted from the Access account list, and
then click the Delete button.

4.2.3 Registering Job Nets
A job net is a collection of jobs for which an execution sequence is specified. The following describes procedures and
precautions to register a job net.

 
Procedure

1. Displaying the New Job Net window

Call the New Job Net window by performing one of the following operations.

- Select the desired project from the Job Selection window of the Systemwalker Operation Manager window. Then,
select the execution attribute of the job net from Job Net in New of File menu (or right click to show the pop-up
menu and select the execution attribute of the job net from Job Net in New.

- Select Job Net Management from the Tools menu of the Systemwalker Operation Manager window. Then, select
the execution attribute of the job net from New in the File menu of the Systemwalker Operation Manager window.
When the Select Project window appears, specify a Project name to create a job net.

Figure 4.3 Select Project window
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Project name:

Specifies a Project name to create a job net.

Figure 4.4 New Job Net window

2. Placing a job in the job net

Select a category from the select category combo box in the New Job Net window. The icons displayed in the icon
selection area vary depending on the category selected.

Then, click the Set Mode button to switch to the Set mode (the mode in which the icons can be laid out in the job flow
display area). (The Set mode is automatically applied when an icon is selected in the icon selection area.)

In set mode, select a job icon to be registered in the job net from the icon selection area. Then, use the mouse to click
and drag an allocated job icon on the job flow display area. Child or linked job nets can also be registered by selecting
the job net or linked job net icons.

Placing the job displays the Add/Change-Job window.

 

 Note

Notes on registering linked job nets

Every time a linked job net is registered, the number of job nets in the project increases (the linked job net plus any child
job nets that the linked job net may have). This may cause scheduling performance to deteriorate. Design the job net
configuration, taking the number of job nets into consideration, before registering the job net.

3. Registering the job

Use the Standard information, Control information and Detail information sheets of the Add/Change - Job window to
set the job information and register the job. Refer to "4.2.4 Registering Jobs" for details on job registration.

4. Registering multiple jobs to the job net

Repeat Steps 2 and 3 for the number of jobs you want to register in the job net.
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5. Setting the job execution order

After jobs are assigned in the Job Flow display area, click the Connect Mode button to switch to the connect mode.
While in the connect mode, draw a connection line (arrow) from the preceding job to the succeeding job to specify the
job execution order.

A line (arrow) connecting one normal job to another normal job is indicated in black. Lines connected to a recovery
job (indicated by a red diamond-shaped symbol) are shown in red. Lines connected to a job in which its execution
condition depends on a specified completion code (indicated by a blue diamond-shaped symbol) are shown in blue.
Lines connected to a job with "wait with OR" condition are shown in orange.

 

 Note

Connection of child job nets and linked job nets with startup day schedules

A job where an Execution condition has been specified cannot connect to a preceding job (a child or linked job net) for
which Valid only on startup days has been specified in the Control information sheet of the Add/Change - Job window).

For modification (addition, copy, cutting, pasting, deletion, removal, interruption, overwriting, replacement or
reconnection) of jobs, see "4.4.6 Changing the Jobs".

6. Saving to the project

Select Save As from the File menu. The Save As window will appear. Specify the job net name and any job net
comments, then click Save. The job net will be saved in the project.

Figure 4.5 Save As window

Project name:

Specifies a Project to which the job net will be saved.

If the job net is registered as a job, it cannot be selected.

Job net name:

Specifies a job net name.
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Job net comment:

Specifies a job net comment.

Job net list:

Displays a list of job net names registered in the project selected in Project name.

 

 Note

Add/Change-Job window

- How to set the command field

Jobs with the Job Execution Control attribute registered in the Jobscheduler are submitted to Job Execution Control as a
qsub command. Therefore, for a file name registered in the Add/Change-Jobs window to be executed, the qsub command
options for Job Execution Control must be included. Since the Jobscheduler automatically sets "qsub" options "-x", "-nr",
"-j", "-cu", "-rh", "-jft", "-q", "-R", "-e", "-o", "-eo", "-lt" and "-dp", do not set them in the Command field.

 
[qsub-command-option] executable-filename

- Search conditions of jobs

The storage destination of an executable file is searched in the following order:

Command field >> Directory field >> job folders

If the file name to be executed is specified with the full path name in the Command field, the Directory field is not
searched even if the storage destination directory is specified in the Directory field.

- Completion code

The job completion code is the return value of the executable file (for example the value specified by the exit function
if written in the C language). For a Windows batch file, it will be the return value of the last command in the batch file (the
setecode command can be written in the batch file to control the return values. For details on the setecode command, see
"A.6.2 Using Batch Files as Jobs [Windows version]"). The maximum value for the completion code that can be accepted
by the Jobscheduler is 256. However, since the Jobscheduler uses completion code values from 201 to 256, the job
completion code should be 200 or less. A return value larger than 256 is treated as 255.

- Standard output file and standard error output file

Do not specify the same name of standard output file or standard error output file for multiple jobs simultaneously. If
specified, the previous log may be displayed incorrectly.

- Commands to be registered in the command field [Windows version]

If the Jobscheduler shutdown process is registered and executed, the job or job net execution may be "closed" (with
completion code 239) when the Jobscheduler is started in the next time.

Shutdown the system from the shutdown exit by using the termination process job net. For details of termination process
job net, see "A.6.1 Shutting Down the System at Optional Times [Windows version]."

- qsub command of Job Execution Control

In the Command field, do not specify the qsub command of Job Execution Control or batch files/shell scripts calling the
qsub command.

 

 Note

Notes for registering large numbers of job nets

For notes on registering a large number of job nets, see "Reference Information (Expert Information, etc.)" in the
Systemwalker Operation Manager Technical Guide. A Caution message appears when so specified, warning that the number
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of job nets for a given Project exceeds the maximum value specified Project. The content of the warning message can be
specified using the Use function2 settings in the Define Jobscheduler Startup Parameters window.

Figure 4.6 Define Jobscheduler Startup Parameters window - Use function2 Sheet

4.2.4 Registering Jobs
This section explains the job registration procedure and provides other related information.

Refer to "Designing Executable Files" and "Execution Attributes and Executable Jobs for Job Nets" in the Systemwalker
Operation Manager Design Guide for information on files that can be registered as jobs and the differences between jobs that
can be registered using the execution attribute.

 
Procedure

1. Display the Add/Change - Job window.

Open the New Job Net window and then use the mouse to drag the icon of the job to be registered with a job net from
the icon selection area to the job flow display area.

The Add/Change - Job window will appear.

2. Use the Standard information, Control information and Detail information sheets of the Add/Change - Job window to
set the job information and register the job.

Use the Control information sheet to register a recovery job or to use the completion code of a preceding job to
determine the execution of a succeeding job. Refer to "Registering control information" for details.

 
Jobs with the "Job Execution Control" execution attribute

If the Command Wizard is not used, the following sheet will be displayed.

If the Command Wizard is used, the following sheet will be displayed only when the icon type is "Command execution". For
all other icon types, the relevant Standard information sheet will appear. The Command Wizard item in the View menu of the
New Job Net, Change Job Net, Recovery Change Job Net or Monitor Job Net window can be used to determine whether
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Command Wizard is to be used. Refer to the Systemwalker Operation Manager Online Help for details on the use of the
Command Wizard.

Note that the Command Wizard cannot be used when the connection destination server is running Systemwalker
OperationMGR V10.0L21/V10.1 or earlier.

Figure 4.7 Standard information sheet of the Add/Change - Job window

Command:

Specifies the batch file, shell script, command, executable program, Systemwalker script or JCL to be run as a job.

Parameters:

Specifies a character string to be passed to the command specified in Command as command arguments. Up to 29
parameters can be specified. If the value contains spaces, enclose it in double quotation marks.

Directory:

Specifies the directory that will be used as the current directory when running a job.
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Comment:

Specifies a comment.

Job name:

Specifies the name of the job. The job specified here will be handled as a Job Execution Control job.

You can omit this specification, in which case the string specified for Command will be treated as the Job Execution
Control job name. Therefore, if the Command string contains Japanese characters in a UTF-8 environment (an
environment where the submitting server or execution server for network jobs uses UTF-8 encoding), in this option you
must specify a string that does not contain Japanese encoding.

Submit the job as a network job:

Select this check box to submit the job as a network job. If this check box is not selected, the job will be run as a local job.

Request host:

Specifies the host name of the server that will run the network job. This field can be specified only when the Submit the
job as a network job check box is selected.

You can use an execution subsystem name if you have defined one. If the specified name also exists as a host name and
execution subsystem name, it will be treated as an execution subsystem name.

Queue name:

Specifies the queue where the job will be submitted.

Upper limit of completion code:

Specifies the value to be used to determine whether the job terminated normally or abnormally.

Ignore completion code:

If this check box is selected, the job will be deemed to have completed normally regardless of the completion code. Note,
however, that the job will still terminate abnormally if it is closed before it completes.

Do not save standard/error output:

If this check box is selected, the standard output (stdout) and standard error output (stderr) of the job will not be saved.
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Figure 4.8 Detail information sheet of the Add/Change - Job window

Effective user name:

Specifies the name of the user who will execute the job. An Operation Manager user cannot be specified.

If an execution user name is specified, the following settings must also be specified: [Windows]

- Open the Define Job Owner's Information window from the Systemwalker Operation Manager Environment Setup
window, and define a user ID and password.

- Access Local Security Policy from the Administrative Tools dialog box through the Control Panel and assign Log on
as a batch job rights to the user specified here.

When specifying a domain user name, the above steps need to be performed on both the job submission destination
server and the execution server.

Resource name:

Specifies the name of the resource to be used. The resource name can be up to 64 bytes long and may contain alphanumeric
characters, underscores ("_") and hyphens ("-").
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Resource type:

Select the resource allocation method (Shared or Exclusive).

Default log file:

Specifies the name of the file where standard output generated by the execution of the job will be sent.

Default error log file:

Specifies the name of the file where standard error output generated by the execution of the job will be sent.

Redirect default error log to the default log file:

Select this check box to redirect standard error output generated by the execution of the job to the default log file. When
this check box is selected, the Default error log file check box will be disabled.

Transmission of execution command:

Select this check box to send the executable file specified in the Command field of the Standard information sheet to the
server specified in the Request host field of the Standard information sheet.

Priority:

Specifies the job execution priority. If the connection destination server is running Windows, select a value between 0 and
4, and if the connection destination server is running UNIX, select a value between 0 and 39. The higher the number, the
greater the priority.

Estimated processing time:

Select this check box to set an expected execution time for the job.

Cut-off execution time:

Specifies the job execution time limit in minutes. Any value between 1 and 1666666 can be specified. Job execution will
be cut off at the specified time. In this case, the completion code for the job will be 0x40000322.

Set the job output information "NAME=VALUE" in the job net variable

Select this check box to automatically set the "NAME=VALUE" line (which is output to job output information) in the
job net variable.

Job net variable prefix

Specify this string to prevent duplication of the job net variable name.

If a job net contains multiple jobs that output with the same variable name, you can prevent name duplication by
specifying a prefix.

Environment variables:

Displays a list of the environment variables that the job will use when it runs.

Click the Add button to create a new environment variable. To modify an environment variable that has already been set,
select the environment variable in the list and click the Change button. Similarly, to delete an environment variable from
the list, click the environment variable concerned and click the Delete button. If the Add or Change button is clicked, the
Set Environment Variables window will be displayed. Use this window to enter or change environment variables.

Up to 32 environment variables can be specified.

Figure 4.9 Set Environment Variables window
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Variable name:

Specifies the name of the environment variable that will be used in a job. Do not set an environment variable with the same
name as an operating system environment variable.

Value:

Specifies the value of the environment variable that will be used in a job. This field cannot be left blank.

 
Child job nets (Only when execution attribute is "Job Execution Control")

Figure 4.10 Standard information sheet of the Add/Change - Job window

Job net list:

Displays a list of job nets that exist within the same project and can be registered as child job nets. Select the job nets to
be registered as child job nets from this list.
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Linked job nets (Only when execution attribute is "Job Execution Control")

Figure 4.11 Standard information sheet of the Add/Change - Job window

List of master linked job net candidates:

This area displays a list of job net names and job net comments for the job nets that can be registered as the master linked
job net.

linked job net name:

Specify the name of the linked job net using no more than 50 bytes.

When a job net is selected in the List of master linked job net candidates, the name of the selected job net will be inserted
automatically, followed by an underscore ("_"). However, an underscore will not be added if adding it would cause the
name of the linked job net to exceed 50 bytes.

The following message will be displayed if a job net that has not yet become a master linked job net is selected from the List
of master linked job net candidates. Check the message, and click the OK button if it is OK to register the job net as a master
linked job net.

- 81 -



 

 Information

Child job net names for linked job nets

If a master linked job net contains multiple layers, the child job nets for the linked job nets that refer to that master linked job
net will be registered in the project using the following name: <name of the child job net in the master linked job net> + "_"
+ <name of the linked job net>.

 

 Note

Registering linked job nets

When registering a linked job net, make sure that the name of the linked job net does not coincide with the name of another
job net or linked job net. If the master linked job net contains multiple layers, also make sure that the names of its child job
nets do not coincide with the names of other job nets or linked job nets.

 
When the execution attribute is "Interstage"

Use the following window when submitting Interstage WorkUnits.
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Figure 4.12 Standard information sheet of the Add/Change - Job window

Workunit name:

Specifies the name of the job (WorkUnit) to be requested from Interstage.

System name:

Specifies the system name of the WorkUnit.

Comment:

Specifies a comment.

Submit the job as a network job:

Select this check box to submit the job as a network job. If this check box is not selected, the job will be run as a local job.

Request host:

Specifies the host name of the server that will run the network job. This field can be specified only when the Submit the
job as a network job check box is selected.

You cannot use an execution subsystem name even if you have defined one.

Queue name:

Specifies the job submission destination as a queue dedicated to online business.

Resource name:

Specifies the name of the resource to be used. The resource name can be up to 64 bytes long and may contain alphanumeric
characters, underscores ("_") and hyphens ("-").

Resource type:

Select the resource allocation method (Shared or Exclusive).
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Upper limit of completion code:

Specifies the value to be used to determine whether the job terminated normally or abnormally.

Ignore completion code:

If this check box is selected, the job will be deemed to have completed normally regardless of the completion code. Note,
however, that the job will still terminate abnormally if it is closed before it completes.

 

 Note

Registering jobs that have the "Interstage" attribute

- Only jobs with the Interstage icon can be registered with job nets that have the Interstage attribute. Jobs with other icons
cannot be registered.

- Only one job can be registered with a job net with the Interstage attribute.

- Jobs with the Interstage icon cannot be registered with job nets that do not have the Interstage attribute.

 
When the execution attribute is "Normal" [UNIX version]

Figure 4.13 Standard information sheet of the Add/Change - Job window

Command:

Specifies the shell script, command or executable program to be run as a job.

Directory:

Specifies the directory that will be used as the current directory when running a job.
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Comment:

Specifies a comment.

Upper limit of completion code:

Specifies the value to be used to determine whether the job terminated normally or abnormally.

Ignore completion code:

If this check box is selected, the job will be deemed to have completed normally regardless of the completion code. Note,
however, that the job will still terminate abnormally if it is closed before it completes.

Do not save standard/error output:

If this check box is selected, the standard output (stdout) and standard error output (stderr) of the job will not be saved.

 

 Note

Add/Change - Job window

- How to specify the Command field

Jobs that have the "Job Execution Control" attribute and are registered with Jobscheduler are submitted to Job Execution
Control using qsub command format. For this reason, the executable file name of a job registered in the Add/Change - Job
window must contain the executable file name of the job to be run and qsub command options for Job Execution Control.
Note that because Jobscheduler sets the "-x", "-nr", "-j", "-cu", "-rh", "-jft", "-q", "-R", "-e", "-o", "-eo", "-lt" and "-dp"
qsub command options automatically, do not specify them in the Command field.

 
[qsub command options] Executable file name

- Job search conditions

Executable file storage locations are searched in the following order:

Command field > Directory field > Job folder

If the full pathname of an executable file is specified in the Command field, any storage location specified in the Directory
field will not be searched.

- Completion codes

The completion code of a job is the value returned by the executable file (for example, if the executable file is written in
C, the value specified by the exit function will be returned). In the case of a batch file in Windows, the completion code
is the return value of the final command executed within the batch file. (The setecode command can be specified within
batch files to control the return value. Refer to "A.6.2 Using Batch Files as Jobs [Windows version]" for details on the
setecode command.) Jobscheduler can handle completion codes up to 256. Note, however, that because completion codes
201 to 256 are used by Jobscheduler itself, ensure that the completion codes of jobs are no greater than 200.

If a value within the range of 201 to 256 is used as the return value for the executable file, it will be difficult to distinguish
whether the completion code was configured by the executable file or by the Jobscheduler. Note that if the return value
of the executable file is 255 or greater, it will be handled as 255.

- Standard output files and standard error output files

Do not specify the same standard output file and standard error output file for more than one job or the previous log may
not be displayed correctly.

- Commands registered with the Command field [Windows version]

If a process that halts both the system and Jobscheduler is registered and executed, the status of jobs and job nets may
become "Closed" (completion code 239) the next time that Jobscheduler runs.

When shutting down the system, use a shutdown job net and run it from a shutdown exit. Refer to "A.6.1 Shutting Down
the System at Optional Times [Windows version]" for details on shutdown job nets.
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- Job Execution Control command "qsub"

Do not specify the Job Execution Control command qsub or a batch file or shell script that invokes the qsub command
in the Command field.

 
Registering control information

Use the Control information sheet to register a recovery job or to use the completion code of a preceding job to determine the
execution of a succeeding job.

Figure 4.14 Control information sheet of Add/Change - Job window

Restart point:

Select this check box to start execution from this job when the job net restarts.

Invalid at next restart:

Select this check box to disable the job when the job net restarts.

Recovery:

Specifies that the job is a recovery job to be started if the preceding job abends. This check box can also be selected when
the preceding job is a job net.

Restart previous job:

Select this check box to restart the original job (that abended) only once after the recovery job completes normally.
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Execution condition:

Select this check box to determine whether to use the job completion code to determine whether a job should be started
when the preceding job terminates normally or pseudo-normally. This check box can be selected only when there is just
one preceding job.

When Execution condition is selected, select either by Value or by Range from the Condition concerning completion code
of preceding job combo box.

by Value:

Select the operator that will be used as an execution condition from the combo box. Enter a value that will be used in
the comparison.

by Range:

Select the operator that will be used as an execution condition from the combo box. Enter a range of completion codes
for the preceding job that will be used as an execution condition.

Wait for preceding job using OR condition:

Specify this item to make multiple preceding jobs wait with the OR condition. You can specify this item if the preceding
jobs are any of the following event wait jobs:

- Wait for file

- Wait for Message Event

- Wait for time

- Wait until Specified Time

If you specify this item, you cannot draw a connection line from the event wait jobs listed above to multiple succeeding
jobs.

Valid only on startup days:

When specifying startup days for child or linked job nets, select this checkbox to enable the specified startup days and
update the configuration of the job net for each operation day. This checkbox is only displayed for jobs with the job net
or linked job net icons.

It is not possible to select the Restart point, Recovery or Execution condition check box at the same time as the Valid only
on startup days check box.

If the Valid only on startup days check box is selected, the Execution condition check box cannot be selected for the
succeeding job. Similarly, if the Execution condition check box is selected, the Valid only on startup days check box cannot
be selected for the preceding job.

If the Execution condition checkbox is selected when the preceding job is a child or linked job net, the completion code of
the child or linked job net will be treated as the completion code of the preceding job.

4.2.5 Job Net Information Settings
Configure the schedule information such as the job net execution condition and startup days in the Job Net Properties window.

You can specify the items indicated below in each sheet of the Job Net Properties window:

- Standard information tab

Specifies standard job net information including comments, execution conditions (None/Execute at/Execution interval/
Start at the time of server startup/Start only when message event has occurred), host name submitting jobs to the job net,
etc.

Refer to "4.2.5.1 Setting the Execution Condition" for details.

- Message sheet

Specifies message events to be used as startup triggers. A message event is a character string waiting for the job net to
execute and can be issued by using the jobschmsgevent command.

- 87 -



Refer to "4.2.5.2 Setting Message Events for details.

- Startup Days sheet

Defines basic job net execution schedules (i.e., startup days) when job nets start automatically on specific days. The detail
mode windows can also be used to select which calendar to use, specify what to do if a startup day coincides with a
holiday, and register information about the operating period.

Refer to "4.2.5.3 Setting Startup Days" for details.

 
Displaying the Job Net Properties window

Display the Job Net Properties window by performing one of the following operations:

- Select the desired job net from the Job Selection window of the Systemwalker Operation Manager window. Then, select
Properties from the File menu (or select Properties from the pop-up menu displayed by right-clicking).

- Select Job Net Management from the Tools menu of the Systemwalker Operation Manager window. Select the desired
job net from the Job Net Management window. Then, select Properties from the File menu (or select Properties from the
pop-up menu displayed by right-clicking).

 

 Note

Day change time

If any change is made to the day change time settings after the job net startup schedule has been set (i.e., after the job net
information has been set), then any previously scheduled days and hours are reset. Day change time should be specified before
setting the job net startup schedules.

4.2.5.1 Setting the Execution Condition
Set the execution condition that will determine the condition for executing a job net. Display the Job Net Properties window,
click the Standard information sheet, and set the job net execution condition.

 
Procedure

Under Execution condition in the Standard information sheet, select the conditions for executing the job net.
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Figure 4.15 Standard information Sheet (for attributes other than Interstage attributes)

Job net comment:

Specifies a job net comment.

Day change time:

Displays the set day change time.

Execution condition:

Specifies execution conditions.

- 89 -



None:

Use this option to avoid any settings at startup.

Be sure to specify this option when registering child job nets and job nets that will become master linked job nets.

Execute at:

Specifies a time when the job net starts.

Estimated end time:

Specifies the estimated end time of the job net.

Startup on power-on if power is off during scheduled execution:

Use this option to start the job net when the server of the Jobscheduler is started if the job net cannot start up due to
some reason such as the server is turned off at the expected startup time.

Execution interval:

Specifies a start time, an end time and a startup interval to start a job net within a specified time period.

Start at the time of server startup:

Use this option to start a job net when the server of Jobscheduler starts.

Once in a day:

Use this option to start a job net only once a day (from one day change time to the next day change time).

When not specified, the job net starts every time the server of the Jobscheduler starts.

Start only when message event has occurred:

Use this option to start a job net only when a specific message event occurs.

Once in a day:

Use this option to start a job net only once a day (from a day change time to the next day change time).

When not specified, the job net is started every time the conditions for message events are met.

The message events for which the job net to start is waiting are cleared at the day change time.

Scheduled start time:

Specifies the scheduled start time of the job net.

Estimated processing time:

Specifies the estimated processing time to process a job net, from start to completion.

Instruction:

Specifies the operation instruction for job nets that have been carried over when using the Master Schedule Management
function. This option cannot be specified if an environment for the Master Schedule Management function has not been
created.

Copy and start:

Specify this item to copy and start the job net.

Number of saved copy destination job nets:

Specify the number of copy destination job nets you want to save.

If the number of copy destination job nets that terminated normally exceeds the specified value, job nets are
automatically deleted in order, starting with the oldest.

This item is for the job nets that were copied by specifying Copy and start.

This item is not for the job nets that were copied and started using the variable parameters and suffixes (the
jobschmsgevent command with the -c option specified).

Submit the jobs of the job net as a network job:

Specifies a job of the job net to be submitted as a network job. If this option is omitted, the job is submitted as a local job.
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Default host name:

Specifies a default value of the server (host name) that executes a network job of the job net. This option can be specified
only when the "Submit the jobs of the job net as a network job" box has been checked.

You can use an execution subsystem name if you have defined one. If the specified name also exists as a host name and
execution subsystem name, it will be treated as an execution subsystem name.

 

 Note

Once in a day

Any change to the properties, start day, or any temporary change made to a job net that has already started for the day,
cancels the "already started" status of the job net. Therefore, if the execution condition is set to Start at the time of server
startup, the job net starts once the server restarts even if Once in a day is specified. If Start only when message event has
occurred is specified, the job net restarts once a message event occurs.

 

 Note

Execution condition: None

- The Execution condition must be set to None for a job net to be registered as a child job net or master linked job net.

- If the Execution condition is set to None, the Message settings are invalid. If the Execution condition is set to None
while an execution condition has already been set, the entire execution condition of the already-set Message sheet is
cleared.
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Figure 4.16 Standard information sheet (for Interstage attributes)

Job net comment:

Specifies a job net comment.

Day change time:

Displays the set day change time.

Execution condition:

Specifies execution conditions.
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Execution time:

Specifies a time to start the job net.

Stop time:

Specifies a time to stop the job net.

Submit the jobs of the job net as a network job:

Specifies that a job of the job net is to be submitted as a network job. If this option is omitted, the job is submitted as a
local job.

Default host name:

Specifies a default value of the server (host name) that executes a network job of the job net. This option can be
specified only when the Submit the jobs of the job net as a network job box has been selected.

You cannot use an execution subsystem name even if you have defined one.

4.2.5.2 Setting Message Events
Set the message events that will trigger execution of a job net. Display the Job Net Properties window, click the Message
sheet, and set the message events.

You can register message events by specifying Start only when message event has occurred as the job net execution condition
in the Standard information sheet or by selecting an option other than None in Execution condition. In this case, the job net
starts whenever each of the conditions (other execution conditions or messages) is met.

Wait for startup time can be specified in the Message sheet only if Execute at is specified in Execution condition for the job
net and only one execution time (Once in a day) is specified. When this is specified, the job net starts only once a day even
if message events occur several times. When Once in a day is specified for Start only when message event has occurred in
Execution condition of the Standard information sheet, the job net starts only once a day when the first message event occurs.

When Wait for startup time is specified in the Message settings as the execution condition of a job net, then Valid during job
net execution cannot be specified.
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Figure 4.17 Message sheet (when "Start only when message event has occurred" is not specified)

Wait for startup time:

Specifies to wait for starting a job net only at its start time even if a message event has occurred.

Carry over the process regardless of the day change time:

Use this option to carry over the scheduled time of the previous day when the day change time has been reached
without the job net executed.

Valid during job net execution:

Use this option to allow a message event to occur while a job net is being executed and to continue to restart a job net for
a number of times after the message event has been received.
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Valid only on startup days:

Use this option to start a job net only when a message event occurs on the startup day.

Queuing condition:

Use this option to select a condition for a message event to wait if you have registered multiple message events.

Start when all message events have occurred:

Starts the job net only when all the registered message events have occurred.

Start when a message event occurs:

Starts the job net when any of the registered message events has occurred.

Message event name:

Specifies a name of up to 12 characters for the message event being waited for as a condition for starting the job net. The
name cannot contain commas (,), colons (:), spaces, halfwidth kana, and user-defined characters. When using functions
(jobschdeftocsv command, jobschcsvtodef command, Job Designer, import and export functions) that handle message
events in CSV files, the name cannot contain commas (,). You can specify up to 70 message event names.

Queuing message event:

Displays a list of message events used as job net start conditions.

When Start only when message event has occurred has been specified in the Standard information sheet of the Job Net
Properties window, set the message event in the following Message sheet:
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Figure 4.18 Message sheet (when "Start only when message event has occurred" is specified)

When starting only when message event has occurred

Carry over the process regardless of the day change time:

Use this option to carry over the scheduled time of the previous day when the day change time has been reached
without the job net executed.
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4.2.5.3 Setting Startup Days
To start a job net automatically on certain days, set the job net startup days. These settings are located in the Startup days sheet
of the Job Net Properties window.

The selected option button determines how the startup days will be specified. That is, the content of the Startup days sheet
differs depending on the selected option button.

- Select Schedule pattern to set startup days using a preregistered schedule pattern. If Schedule pattern is selected, the
Startup days sheet for specifying the basis of the schedule pattern will be displayed.

- Select Another job net to reuse the schedule that was set for another job net. If Another job net is selected, the Startup days
sheet for specifying startup days based on another schedule will be displayed.

- Select Other to set startup days directly by specifying the date or day of the week. If Other is selected, the Startup days
sheet for direct specification will be displayed.

The simple mode view is explained below.
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Figure 4.19 Startup days (Standard schedule pattern) sheet

The screenshot above is for the simple mode view. The simple mode view is the initial window displayed when no settings
have been entered. Refer to "4.3.15 Specifying Detailed Settings for Startup Day Information" for information on the detail
mode view.

Startup days:

This section is used to specify the method for setting up startup days.

Base job net:

Select this checkbox to make this job net the reference startup days for another job net.
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Schedule pattern:

Select this option to use information about a predetermined schedule pattern as a reference.

Unselected calendar / Selected calendar:

Specifies the schedule pattern to be used. Select the schedule pattern to be used from the Unselected schedule pattern list,
and then click Add to move it to the Selected schedule pattern list. Select a schedule pattern from the Selected schedule
pattern list, and then click Delete to move it to the Unselected schedule pattern list. It is also possible to move schedule
patterns from one list to the other by double-clicking them. Up to four schedule patterns can be selected.

Method to combine the schedule patterns:

When multiple schedule patterns have been selected, this item specifies the condition for combining the schedule patterns.

Consider startup days in selected schedule patterns as startup days:

This option determines startup days by combining the schedule patterns with a logical "AND" condition, so that only
those days that are startup days in all the selected schedule patterns will be startup days.

Consider only exclusive startup days in the selected schedule pattern as startup days:

This option determines startup days by combining the schedule patterns with a logical "OR" condition, so that those
days that are startup days in any of the selected schedule patterns will be startup days.

Another job net:

Select this option to use the startup days of another job net as reference. This option is not available if the Base job net
checkbox is selected. If Another job net is selected, the Startup days (Another base job net) sheet will be displayed. Refer
to "Startup days (Another base job net) sheet" for details.

Other:

This option is used to specify startup days directly. If Other is selected, the Startup days (Other) sheet will be displayed.
Refer to "Startup days (Other) sheet" for details.

Detail Mode:

Click this button to change the display to a detail mode view where detailed startup day settings can be specified. This
button is only displayed in the simple mode view. Refer to "4.3.15 Specifying Detailed Settings for Startup Day
Information" for information on the detail mode view.

Preview:

A preview of the startup day information that has been set up in the Startup days sheet is displayed in the Startup days
(Preview) window. It is also possible to set an "exception day" (a non-standard manual change to the predefined pattern
settings) by switching between startup days and unscheduled days in the Startup days (Preview) window.

Operations cannot be performed in the Startup days sheet while the Startup days (Preview) window is displayed.

 

 Note

Switching the detail mode view and simple mode view to set up startup days

The following message will be displayed if items that cannot be specified in the simple mode view are entered and displayed
in the detail mode view and then the display is switched to the simple mode view by clicking the Simple Mode button: There
is a hidden items in edited detailed setting. Note that although the settings edited in the detail mode view are hidden when a
user switches to the simple mode view, the contents of these settings are still retained. Similarly, when a user switches from
the simple mode view to the detail mode view, the settings entered in the simple mode view are also retained.
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Figure 4.20 Startup days (Another base job net) sheet

The screenshot above is for the simple mode view. The simple mode view is the initial window displayed when no settings
have been entered. Refer to "4.3.15 Specifying Detailed Settings for Startup Day Information " for information on the detail
mode view.

Startup days:

This section is used to specify the method for setting up startup days.

Base job net:

This checkbox cannot be selected if Another job net has been selected in the Startup days section.
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Schedule pattern:

Select this option to use information about a predetermined schedule pattern as a reference. Refer to "Startup days
(Standard schedule pattern)" sheet for details.

Another job net:

Select this option to use the startup days of another job net as a reference.

Another base job net:

Use the list of job nets to select which job net to use as the basis for the startup days for the job net for which settings
are being specified.

Other:

This option is used to specify startup days directly. If Other is selected, the Startup days (Other) sheet will be displayed.
Refer to "Startup days (Other) sheet" for details.

Detail Mode:

Click this button to change the display to a detail mode view where detailed startup day settings can be specified. This
button is only displayed in the simple mode view. Refer to "4.3.15 Specifying Detailed Settings for Startup Day
Information" for information on the detail mode view.

Preview:

A preview of the startup day information that has been set up in the Startup days sheet is displayed in the Startup days
(Preview) window. It is also possible to set an "exception day" (a non-standard manual change to the predefined pattern
settings) by switching between startup days and unscheduled days in the Startup days (Preview) window.

Operations cannot be performed in the Startup days sheet while the Startup days (Preview) window is displayed.
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Figure 4.21 Startup days (Other) sheet

The screenshot above is for the simple mode view. The simple mode view is the initial window displayed when no settings
have been entered. Refer to "4.3.15 Specifying Detailed Settings for Startup Day Information" for information on the detail
mode view.

Startup days:

This section is used to specify the method for setting up startup days.

Base job net:

Select this checkbox to make this job net the reference startup days of another job net.
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Schedule pattern:

Select this option to use information about a predetermined schedule pattern as a reference. If Schedule pattern is selected,
the Startup days (Standard schedule pattern) sheet will be displayed. Refer to "Startup days (Standard schedule pattern)
sheet" for details.

Another job net:

Select this option to use the startup days of another job net as a reference. This option is not available if the Base job net
checkbox is selected. If Another job net is selected, the Startup days (Another base job net) sheet will be displayed. Refer
to "Startup days (Another base job net) sheet" for details.

Other:

This option is used to specify startup days directly.

Standard set:

When this button is clicked, the information that forms the basis for the startup days ("yearly", "monthly", or "business
days") is displayed automatically.

Edit:

Click this button to display the Startup days (Other) window.

Detail Mode:

Click this button to change the display to a detail mode view where detailed startup day settings can be specified. This
button is only displayed in the simple mode view. Refer to "4.3.15 Specifying Detailed Settings for Startup Day
Information" for information on the detail mode view.

Preview:

A preview of the startup day information that has been set up in the Startup days sheet is displayed in the Startup days
(Preview) window. It is also possible to set an "exception day" (a non-standard manual change to the predefined pattern
settings) by switching between startup days and unscheduled days in the Startup days (Preview) window.

Operations cannot be performed in the Startup days sheet while the Startup days (Preview) window is displayed.
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Figure 4.22 Startup days (Other) (Yearly standards) window

Basis settings:

Specifies the basis for the startup day information.

Yearly:

Select this option to uses a pattern of predetermined annual dates such as April 1st of each year.

Monthly:

Enables the monthly mode. The selected date (or day of week) setting is reflected to all months.

Select all:

Click this button to select all days of all months.
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Startup days:

If this check box is selected, the specified days will be job net startup days.

Figure 4.23 Startup days (Other) (Monthly standards) window

Basis settings:

Specifies the basis for the startup day information.

Monthly:

If this option is selected, the basis for specifying startup days will be a fixed monthly pattern, such as "the 5th of each
month" or "every Wednesday".
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Monthly standards:

Weekly Settings:

Sets the startup days to a specific week (from the first week to the fifth week), last day, or every day of week.

Daily settings:

Sets the startup days to a specific date.

Set the month end as startup day:

Sets the last day of each month as the startup days.

Startup days:

If this checkbox is selected, the specified days will be the job net startup days.
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Figure 4.24 Startup days (Other) (Business day standards) window

Basis settings:

Specifies the basis for the startup day information.

Business days:

If this option is selected, the basis for specifying startup days will be patterns based on the day of the month, such as
"x days from the first business day of the month" or "y days before the end of the month."

Business day standards:

Month's start date:

Specify the first date of business days in a month. A figure between 1 and 28 or the Month end can be selected.
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Month's end date:

The date before the Month's start date is set automatically after it has been specified.

Criteria:

Month's start date:

Select this option to count the business days forward from the month's start date. If this option is selected, business
days will be displayed in the Unselected business days and Selected business days lists as, for example, "5th business
day". When the month's start date is a business day, the 1st business day indicates the month's start date.

Month's end date:

Select this option to count the business days backward from the month's end date. When this is selected, the Selected
business days and Unselected business days lists show an item in the format of Day before 25th business day, for
example. When the month's end date is a business day, the Day before 1st business day(Month's end) indicates the
month's end date.

Selected business days / Unselected business days:

To select a business day as the startup day, select the desired day in the Unselected business days list and click the Add
button to move it to the Selected business days list. To unselect a business day, select the desired day in the Selected
business days list and click the Delete button to move it to the Unselected business days list. A business day can also
be moved between the Selected business days and Unselected business days lists by double-clicking the desired day
in either list.

Set only business days of the month as startup days:

Specify this option to schedule only the business days of a month as the startup days. If the date of a set business day
changes to the previous or next month due to holidays, etc., the date is not scheduled as a startup day.

A month:

The period from the month's start date to the month's end date is displayed automatically according to the specification
of Month's start date.

 

 Point

"Calendar information" as the standard of business days

The "Calendar information" that is used as the basis for determining business days can be specified in the detail mode view
that is displayed by clicking the Detail Mode button in the Startup days sheet of the Job Net Properties window.

 

 Point

Overlapped startup days

Using Startup days shift setting in the Startup days sheet of the Job Net Properties window may result in an overlap of job
net startup days. In this case, the overlap is ignored and the job net is started in the usual way for one day.

 
Confirming startup days

Perform the following procedure to confirm that the startup days have been set properly:

- Items that you specified in the Startup days sheet of the Job Net Properties window

Click Preview and confirm the items in the Startup Days(Preview) window.
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- Items that you set in the Startup Days(Other) windows

Click OK to return to the Startup days sheet of the Job Net Properties window, click Preview, and confirm the items in the
Startup Days(Preview) window.

Figure 4.25 Startup Days(Preview) window

Refer to "4.2.6 Customizing Registered Job Net Startup Days" for information on how to customize the basic startup schedule
(startup days) you have registered for the job net and how to register irregular startup days.

4.2.6 Customizing Registered Job Net Startup Days
After registering the basic startup days for the job net, you can customize them or set irregular startup days.

The procedure depends on your purpose.

- To confirm and customize the startup days per job net

Use the Startup Days window or Startup days(Preview) window. You can customize each job net individually while
checking the yearly schedules.

- To confirm and customize the startup days for all job nets in a project at one time

Use the Application Plan window. Startup days for all registered job nets can be confirmed in a list for each project. The
startup days can be customized so the system is not overloaded on any specific day.
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However, note that all startup days that you set in these windows will be treated as exception days, so they may be cleared
when the calendar or the startup days are changed. Refer to "4.1.9 Startup Day Information" for details.

Each of these customization procedures is explained below.

 
Procedure in the Startup Days/Startup Days(Preview) window

1. Displaying the Startup Days window or Startup Days(Preview) window

Use either of the following operations to display the Startup Days window:

- Select the desired job net from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Startup days from the File menu or right-click to display the pop-up menu and select Startup days.

- Select the desired job net from the Job Net Management window. Then, select Startup days from the File menu or
right-click to display the pop-up menu and select Startup days.

The Startup Days(Preview) window can be displayed by performing the following operation:

- Select the target job net from either of the windows above, and then select Properties from the File menu. Click
Preview in the Startup days sheet of the Job Net Properties window.

2. Registering startup days

Left-click a date in the calendar displayed in the Startup Days window or the Startup Days(Preview) window, and then
right-click to register the date as either a startup day or an unscheduled day. (Click a day of the week in the calendar
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to select all the dates that fall on that day of the week.) You can also select the date and set the startup or unscheduled
day with a single operation by double-clicking the date or the day of week.

Figure 4.26 Startup Days window

Startup days:

The job net startup days.

Holiday startup days:

The Startup days overlapped by a holiday.

Unscheduled days:

The non startup days.

Other than application period:

The day or days outside of the operation period specified in the settings under the Startup days sheet in the Job Net
Properties window.

Select all:

Click to select all date buttons of all months of the year displayed.

Monthly:

Enables the monthly mode. Creates a recurrence of settings for successive months.
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Procedure

1. Displaying the Application Plan window:

Select the desired Project from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Application Plan from the Tools menu. The Application Plan window will appear.

The Application Plan window shows information about job net startup days for three years (this current year, the next
year, and the year following).

2. Changing the startup days

Startup days (shown in blue) and non startup days (shown in white) are set by clicking the date of desired job net in the
Application Plan window. Clicking a startup day changes it to a non startup day, and clicking a non startup day changes
it to a startup day.

Figure 4.27 Application Plan window

Set Year and Month:

Specifies the year and month for which the operation schedule is to be displayed.

Application Plan:

Click a day in the desired job net to set it as the job net startup days.

- Blue:

Indicates the startup days. The job net Startup days.

- White:

Indicates the non startup days. This is not the job net startup days.

- 112 -



- [X]:

Indicates that setup is not allowed. This is the date you cannot set as it is in the past.

- [*]:

Indicates a changed date. This is the date you have changed to either a startup or non startup days.

- Red:

Indicates a holiday. These are holidays that have been set for each job net.

- Gray:

Indicates an unavailable period. These are days outside the operation period.

The colors of days are the same as those used in the power control pattern of SYSTEM_CALENDAR.

 

 Note

The display of linked job nets and master linked job nets

Master linked job nets are displayed, but linked job nets are not displayed in this window. To change the startup days for a
linked job net, change the startup days for the master linked job net that it refers to.

 

 Note

Registering startup days after a message event occurred

Message events that occurred on job nets for which a startup day was registered are all cleared.

Therefore, these message events must be reissued if a startup day is registered after message events occur.

4.2.7 Registering the Schedule Pattern
If multiple job nets have similar startup days patterns, simplify job net startup days registrations by registering a schedule
pattern.

Only the system administrator (in Windows users who are members of the Administrators Group or superusers in the UNIX
system) can register Schedule Patterns. If the Extended User Management function is valid in the UNIX system, only the
Operation Manager user having the administrative authority can perform it.

The following describes how to register a schedule pattern.
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Procedure

1. Displaying the Select Schedule Pattern Information window

Select Schedule Pattern from the Tools menu of the Systemwalker Operation Manager window. The Select Schedule
Pattern Information window will appear.

Figure 4.28 Select Schedule Pattern Information window

A list of registered schedule pattern names is displayed.

New:

Creates a new schedule pattern information.

Open:

Opens the Schedule Pattern Information window and displays the information on the selected schedule pattern.

Delete:

Deletes the selected schedule pattern.

Status:

Opens the Job Nets Using EveryDay window and displays the job net that uses the selected schedule pattern.

2. Displaying the Schedule Pattern Information window

Click Open in the Select Schedule Pattern Information window to open the Schedule Pattern Information window.
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3. To register schedule pattern information

Registering a schedule pattern involves selecting the basis for the schedule pattern (yearly, monthly, or business days),
and then specifying startup days and unscheduled days.

Figure 4.29 New Schedule Pattern Information (Yearly standards) window

Basis settings:

Specifies the basis for the startup day information.

Yearly:

If this option is selected, the basis for specifying startup days will be a fixed yearly pattern, such as "April 1 every
year".
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Left-click to select the calendar date shown in the Schedule Pattern Information window (when you click the day of week
in the calendar, the corresponding day of week is selected). Then, right-click to register the startup days or unscheduled
day. You can also select the date and set the startup or unscheduled day with a single operation by double-clicking the date
or the day of week.

Monthly:

If this option is selected, the basis for specifying startup days will be a fixed monthly pattern, such as "the 5th of each
month" or "every Wednesday".

Business Days:

If this option is selected, the basis for specifying startup days will be patterns based on the day of the month, such as
"x days from the first business day of the month" or "y days before the end of the month".

Yearly Standards:

Monthly:

Enables the monthly mode. The selected date (or day of week) setting is reflected to all months.

Select all:

Clicking this button selects all days of all months.

Startup Days:

If this checkbox is selected, the specified days will be job net startup days.
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Figure 4.30 New Schedule Pattern Information (Monthly standards) window

Monthly standards:

Weekly Settings:

Use this section to specify startup days that fall on a particular week (the first, second, third, fourth or fifth week of
every month), the final week of every month, or on particular weekdays every month.

Daily Settings:

Use this section to specify startup days that fall on a particular day of each month.

Set the month end as startup day:

Use this checkbox to make the last day of each month a startup day.
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Startup Days:

If this checkbox is selected, the specified days will be job net startup days.

Figure 4.31 New Schedule Pattern Information (Business day standards) window

Business day basis:

Month's start date:

Specify the first date of business days in a month. Either the end of the month, or a day between the 1st day of the month
and the 28th day of the month, can be specified.

Month's end date:

This item is automatically set to the day before the date specified as "Month's start date".
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Criteria:

Month's start date:

Select this option to count the business days forward from the month's start date. If this option is selected, business
days will be displayed in the Unselected business days and Selected business days lists as, for example, "5th business
day". When the month's start date is a business day, the 1st business day indicates the month's start date.

Month's end date:

Select this option to count the business days backward from the month's end date. When this is selected, the Selected
business days and Unselected business days lists show an item in the format of Day before 25th business day, for
example. When the month's end date is a business day, the Day before 1st business day(Month's end) indicates the
month's end date.

Unselected business days / Selected business days:

To select a business day as the startup day, select the desired day in the Unselected business days list and click the Add
button to move it to the Selected business days list. To unselect a business day, select the desired day in the Selected
business days list and click the Delete button to move it to the Unselected business days list. A business day can also
be moved between the Selected business days and Unselected business days lists by double-clicking the desired day
in either list.

Set only business days of the month as startup days:

Specify this option to schedule only the business days of a month as the startup days. If the date of a set business day
changes to the previous or next month due to holidays, etc., the date is not scheduled as a startup day.

A month:

The period from the month's start date to the month's end date is displayed automatically according to the specification
of Month's start date.

4.3 Settings According to Necessities
This section explains settings that may be required in certain situations.

4.3.1 Registering Groups
By registering a number of job nets as a single group, the startup, monitoring, and operation of these job nets can be handled
jointly as a group. This section describes how to register in a group and execution conditions for the job nets registered in a
group.

 
Procedure

1. Displaying the New Group window

Call the New Group window by performing one of the following operations.

- Select the desired project from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Group from the New of the File menu (or select Group from New in the pop-up menu displayed by right-
clicking).

- 119 -



- Select Group Management from the Tools menu of the Systemwalker Operation Manager window. Then, select
New from the File menu of the Group Management window. When the Select Project window appears, specify a
name of the project in which a new group is to be created.

Figure 4.32 Select Project window

Project Name:

Specifies a name of the project to which a new group is to be created.

Figure 4.33 New Group window

2. Displaying the Add/Change-Job Net window

In the New Group window, click the Set Mode button to switch to the set mode (the mode in which the icons can be
laid out in the job flow display area). (The set mode is automatically applied by selecting a job net icon.)

Then, allocate the job net in the job flow display area using the mouse. Allocating the job net displays the Standard
information sheet of the Add/Change-Job net window.

3. Registering the job net in a group

Select the job net you want to register using the Standard information sheet of the Add/Change-Job net window.
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Repeat Steps 2 and 3 for the number of job nets you want to register in the group.

Figure 4.34 Add/Change-Job Net window - Standard information sheet

Job net list:

Select a job net to be registered.

Execution time:

The start time of the job net registered. The start time becomes valid by specifying the Valid execution time option.
The startup time for the first job net in the group that is to be started is valid regardless of this setting.

Message:

Indicates whether a message event is registered as an execution condition of job net.

- Yes:

A message event is registered as the execution condition.

- No:

No message event is registered.

4. Setting the job net execution sequence

After allocating job nets in the Job Flow display area of the New Group window, click the Connect Mode button to
switch to the Connect mode. While in the Connect mode, draw a connection line (arrow) from the preceding job net
to the succeeding job net to specify the job net execution order.
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5. Saving to the project

Click Save As from the File menu. When the Save As window appears, specify the group name and the group comment,
then click Save. The group will be saved in the project.

Figure 4.35 Save As window

Project name:

Indicates the project where the group is saved.

Group name:

Specifies a group name.

Group comment:

Specifies a group comment.

6. Registering the group information

Call the Group Properties window by performing one of the following operations.

- Select the desired group from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Properties from the File menu (or select Properties from the pop-up menu displayed by right-clicking).

- Select Group Management from the Tools menu of the Systemwalker Operation Manager window. Select the
desired group from the Group Management window. Then, select Properties from the File menu (or select
Properties from the pop-up menu displayed by right-clicking).

Register the group information (including the group comment and actions at power off) in the Group Properties
window.

Figure 4.36 Group Properties window

Group comment:

Specifies a group comment.
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Startup on power-on if power is off during scheduled execution:

Use this option to start the group when the server of the Jobscheduler is started if the group cannot start up due to
some reason such as the server is turned off at the expected startup time.

 

 Note

Execution conditions for job nets in a group

The job net is started when all the following conditions are met. The Startup on power-on if power is off during scheduled
execution condition specified in the Standard information sheet of the Job Net Properties window and the Wait for startup
time condition specified in the Message sheet of the Job Net Properties window will be ignored.

- The startup time has been reached (when the startup time is valid).

- The execution conditions for message events are met.

- The preceding job net has completed normally.

 

 Note

Queuing condition of job nets in a group

If a job net residing in the preceding job net of the same group has been set to [Valid execution time], it waits for the normal
termination of the preceding job net, an occurrence of the message event and the Scheduled time, regardless of the [Wait for
startup time] setup.

 

 Note

Group startup time

If the scheduled startup time has already been passed when the group is registered, it is assumed as already-started for the day
and the operations scheduled for the day will not be executed. The registered information will be enabled from the next day.

For the already-started groups (including the above), the operations scheduled for the day will not be executed even if the
startup time is changed. The changed information will be enabled from the next day.

4.3.2 Adding User-Defined Job Icons/Categories
The user-defined icons and categories can be used as the job icons and categories used in the New/Change Job Net window.
The created icons and categories are displayed in the icon selection area and the category selection combo box in the New/
Change Job Net window.

The user-defined icons and categories are defined in the Jobicon.ini file.

The following describes the Jobicon.ini file.

 
Storage path

The Jobicon.ini file is stored in the following location of a machine with the client functions installed.

Systemwalker Operation Manager installation directory \Mpwalker.JM\mpjmcl\etc\icon

 
Description Format

[category-name]

JOB

explain description

iconID ID-number

jobname job-name
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parameter parameters

jobcomment comment

iconPath file-path

;

 
Definition items

Category Name

Specify with a string of 64 bytes or less. This is a mandatory item.

explain:

The explanation displayed after placing the mouse cursor on an icon for a while in the icon selection area. Specify with
a string of 64 bytes or less.

iconID:

The ID to identify user-defined jobs. Enter a number from 1 to 100. It is not allowed to specify the same iconID to jobs
with different definitions. This is a mandatory item.

jobname:

Specifies a batch file (Window version) or shell script (UNIX version), a command, an execution program, a
Systemwalker script or a JCL to be started as a job. Specify with a string of 64 bytes or less. The double quotation symbol
cannot be used.

parameter:

The parameter to be passed to the command. Specify with a string of 1024 bytes or less. You cannot use the double
quotation symbol.

jobcomment:

The comment displayed in the comment field in the Standard information sheet of the Add/Change/Monitor-Job window.
Specify with a string of 64 bytes or less. You cannot use the double quotation symbol.

iconPath:

Specifies the path to the icon image file. When the image file is stored under the Systemwalker Operation Manager
installation directory \Mpwalker.JM\mpjmcl\etc\icon, just specify the file name. When stored in somewhere else, specify
the full path.

The file extensions that can be specified are ico, exe and dll. When omitted, the command execution icon will be set.

 
Entry rules

- Only one definition item can be described in one line.

- When describing jobs, be sure to enclose each job with "JOB" and ";".

- After describing the category name, describe the jobs to be registered in the category.

- Any lines starting with "#" will be treated as comments.

 
Sample definition

The following shows the sample definition to register two jobs each to the "Customer data update" and "Server log collection"
categories and one job to the "Other operations" category.

[Update the customer data]

JOB

explain Update_customer_data_of_Kawasaki_Branch

iconID 1

jobname c:\copyData.exe

parameter -p -l c:\copylog -g Kawasaki

jobcomment Update_customer_data_of_Kawasaki_Branch

iconPath copyKawasaki.ico

;
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JOB

explain Update_customer_data_of_Tokyo_Headquarter

iconID 2

jobname c:\updateData.exe

parameter -g Tokyo

jobcomment Update_customer_data_of_Tokyo_Headquarter

iconPath update.ico

; 

[Collect server logs] 

JOB

explain Collect_logs_of_local_servers

iconID 3

jobname c:\getlog -d -m 'Kawasaki Kyoto Tokyo'

jobcomment Collect_logs_of_local_servers

iconPath c:\Getlog\getlog.ico

; 

JOB

explain Collect_logs_of_basic_systems

iconID 4

jobname c:\getlogEx

jobcomment Collect_logs_of_basic_systems

iconPath c:\Getlog\getlog.exe

; 

[Other operations] 

JOB

explain Operate_customer_data

iconID 5

iconPath C:\MyIcon\opData.ico

;

 
Notes

- Note that this cannot be used if the connection destination server operates the Systemwalker OperationMGR V10.0L21
(Windows version)/V10.1 (UNIX version) or earlier versions.

- Up to 100 categories can be registered.

- Up to 20 jobs can be registered in a category.

- This must be specified on the machine with the client functions installed.

- The user-defined icons/categories definition information is only valid in the client with the definition information
registered. If you want to use the information on other clients as well, the Systemwalker Operation Manager installation
directory \Mpwalker.JM\mpjmcl\etc\icon folder and its subordinate components must be copied to the location of the
same path in other clients.

4.3.3 Using File Creation, Update, and Deletion as Startup Triggers
Job startup can be triggered by a particular file creation, update (update time or size is changed), or deletion. This section
explains how to use these changes in the file status as triggers for starting jobs.

The table below lists the changes in file status and the corresponding job type. Depending on the job type, you may be able
to specify multiple changes in file status at one time.

 
Operation that changes the file status Name of corresponding job

Determine the existence of the file Determine File Existence job

Wait for file creation
Wait for file job

Wait for file deletion

Wait for file update (update time or size)
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To start a job by using a change in its status, define a Determine File Existence job or Wait for file job as the preceding job
of the job you want to start.

You can use a wildcard character (*) when specifying the file name of a Wait for file job.

The Determine File Existence job and Wait for file job correspond to the chkfile command in the Windows version and the
jobschchkfile command in the UNIX version respectively.

Refer to the Systemwalker Operation Manager Reference Guide for details such as the synopsis of the chkfile and
jobschchkfile commands.

 
Using a change in file status as a trigger to execute jobs

To use a change in file status as a trigger to execute jobs, register a Determine File Existence job or Wait for file job as the
first job in the job net. When the job net meets the execution conditions, the existence, creation, update, or deletion of a file
can be used as a startup trigger for processing the succeeding job net.

By combining this type of trigger with the jobschmsgevent command, you can automatically start other job nets after they
have waited for a file to be created, updated, or deleted.

4.3.4 Operating in the Test Mode
You can set an example time (or virtual time) in the subsystem to be operated in the test mode and check the expected schedule
execution.

In the Standard Edition version, however, you can set the virtual time but you cannot operate the subsystem in the test mode.

The following describes how to operate the subsystem in the test mode.

 
Procedure

1. Extracting and distributing the schedule information

Distribute the policy of schedule information you have extracted from the actually operating subsystem to the
subsystem to be operated in the test mode. For the policy distribution, see the Systemwalker Operation Manager
Installation Guide.
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2. Setting the virtual time

Set the virtual time (an example time) in the subsystem to be operated in the test mode. The virtual time can be set by
defining on the Test mode sheet of Define Jobscheduler Startup Parameters window.

Figure 4.37 Define Jobscheduler Startup Parameters window - Test mode sheet

Test mode:

Displays a shift from the system time if the virtual time is set.

Change the virtual time:

Use this option to change the virtual time setup.

Set the virtual time:

Specifies the date and time of virtual time. You cannot set a past time.

Release the virtual time:

Releases the date and time of virtual time.

3. Disabling the job

Disable the jobs you must not execute in the subsystem in the test mode. For details on how to disable, see "Chapter 7
Operating Jobs".

4. Restarting the service/daemon

Restart the Jobscheduler service/daemon and operate it in the test mode.

 

 Note

Setting the virtual time beyond the year end

If you set a virtual time beyond the year end, the calendar showing three years from the year set for the virtual time is
temporarily displayed during the test mode operation. The calendars before the year set for the virtual time are erased.

If you release the test mode in the virtual time and return to the current clock time, the Startup days calendar showing three
years including the current year will be created. When this three-year startup day calendar is created, new startup days will
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be created for years where startup days had not been created. For years where startup days had already been created, the
existing startup day information will be retained. At this time, the calendars already erased during virtual time setup may not
be different from the previous ones even when re-created.

The following gives examples when the calendars are re-created and when not re-created.

- If you set the startup day on the calendar automatically generated (such as schedule patterns and the Startup days sheet
of the Job Net Properties window), the same calendar as before will be automatically created when you release the test
mode operation.

- For the startup day individually set in the Startup Days window, its calendar will not be automatically created when you
release the test mode operation. You must individually set the startup day again.

 

 Note

Registering new job nets when a virtual time has been set up

If the date is moved forward by setting a virtual time and then a job net is registered, past dates cannot be specified as startup
days. This means that it may be necessary to specify startup days again if a job net has been registered in this kind of situation
and then virtual time has been cleared.

4.3.5 Monitoring the Estimated Processing Time of the Job
The estimated processing time of the job is the period of time from the expected job startup to its end.
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If the job does not end within the estimated processing time, you can output a notification message to the event log or the
SYSLOG.

To output notification messages, make sure that the Notify when job is not terminated even after the specified time is lapsed
check box is selected in Watching delay of job/job net of the Advanced Settings for Event Output window. For UNIX system,
the message is notified in the daemon.warning level. Set the syslog.conf of the system so that the daemon.warning level
messages are notified to the SYSLOG.

Estimated processing time of jobs should be defined using one of the following methods. The estimated processing time of
job should be defined when you register jobs with the Job Execution Control attribute. The following describes how to define
it.

- Defining on the Detail information sheet of the Add/Change-Job window

Figure 4.38 Add/Change-Job window - Detail information sheet
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Estimated processing time:

Specifies the estimated processing time of the job.

- [Windows version]

Outputs a message to the event log if the job execution time has exceeded the estimated processing time.

- [UNIX version]

Outputs a message to the SYSLOG if the job execution time has exceeded the estimated processing time.

- Defining with the jobschsetnet command

The following describes how to define using the jobschsetnet command and how to display the estimated processing time
of the job defined.

- Defining using the jobschsetnet command

1. Specify the predictiontime operand in the job control statement to set an estimated processing time of the job.

2. Specify either a -nent operand, a -nche operand or a -ncheall operand to execute the jobschsetnet command.
Specify the file name having the job control statement edited in Step 1 in the definition file.

For details on the jobschsetnet command and job control statements, see the "Jobscheduler Commands" section of
the Systemwalker Operation Manager Reference Guide.

- Displaying (already-defined) estimated processing time of the job

The already-defined estimated processing time of the job can be displayed by specifying the -i (-I) or the -r option
to the jobschprint command. If you set the -i (-I) option, the time is displayed in Prediction Time, or if you set the -
r option, the time is displayed in predictiontime.

For details on the jobschprint command, see the "Jobscheduler Commands" section of the Systemwalker Operation
Manager Reference Guide.

4.3.6 Monitoring the Start Delayed of the Job Net that is Started at a
Message Event Occurrence

When the job net to be started upon a message event occurrence does not start even if the expected start time has passed, the
job net status can be confirmed as a start delay using the monitoring window such as Gantt chart, or command for job net
status. It is also possible to output a notification message to the event log or the SYSLOG.

Only for those job nets that have startup days specified and meet any of the following conditions, the start delay can be
monitored.

- For job nets that are awaiting using the AND criteria (start time AND message event)*, expected message events have
never occurred even though the scheduled start time has arrived.

*: The Wait for startup time option is selected with message conditions.

- For job nets in a group, the scheduled startup time has passed while awaited messages have never occurred.

- For job nets for which the scheduled startup time has been defined by selecting the Start only when message event has
occurred option, the scheduled startup time has passed while awaited message events have never occurred.

To output notification messages, make sure that the Notify when job net is not started even after the specified start time is
lapsed check box is selected in Watching delay of job/job net of the Advanced Settings for Event Output window. For UNIX
system, the message is notified in the user.warning level. Set the syslog.conf of the system so that the user.warning level
messages are notified to the SYSLOG.

The startup delay can be defined using one of the following methods. The following describes how to define it.
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- Defining in the Standard information sheet of the Job Net Properties window

Figure 4.39 The Job Net Properties window - the Standard information sheet

Once in a day:

Use this option to start a job net only once a day (from a day change time to the next day change time).

Scheduled start time:

Specifies the scheduled start time.

- Defining with the jobschsetnet command

The following describes how to define using the jobschsetnet command and how to display the already-defined job net.
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- Defining using the jobschsetnet command

1. To set to be executed once in a day, specify the msgonlymode operand in the job net control statement. To set
the scheduled start time, specify the scheduled start time of the job net using the msgstarttime operand in the
job net control statement.

2. Specify either a -nent operand, a -nche operand or a -ncheall operand to execute the jobschsetnet command.
Specify the file name with the job net control statement edited in Step 1 in the definition file.

For details on the jobschsetnet command and job net control statements, see the "Jobscheduler Commands" section
of the Systemwalker Operation Manager Reference Guide.

- Displaying the already-defined job net

The already-defined schedule start time of the job net can be displayed by specifying the -a (-A) or the -r option to the
jobschprint command. If you set the -a (-A) option, the once in-a-day setting is displayed in MSG Mode, and if you
set the scheduled start time, the time is displayed in Msg Start Time;. If you set the -r option, the once-in-a-day setting
is displayed in msgonlymode, and the scheduled start time is displayed in msgstarttime.

For details on the jobschprint command, see the "Jobscheduler Commands" section of the Systemwalker Operation
Manager Reference Guide.

 

 Information

- Even if Once in a day is selected, it is possible to start the job net several times a day by startup or restart operation.

- The scheduled time can be set as follows for job nets with the execution condition of Start only when message event has
occurred.

When not specifying Once in a day:

No scheduled time is displayed.

When specifying Once in a day:

The date of the day (Scheduled time) is displayed when the job net has not started yet for the day, or the next startup
date is (Scheduled time) displayed when the job net has already started for the day, both in the form of MM/DD/
YYYY.

When specifying Once in a day and Scheduled start time:

The date and time of the day (Scheduled time) are displayed when the job net has not started yet for the day, or the
next startup date and time (Scheduled time) are displayed when the job net has already started for the day, both in the
form of MM/DD/YYYY HH:MM.

- By executing the reinstating operation for the job nets which has already executed for the day, the job nets, for which the
execution condition is set to Start only when message event has occurred and Once in a day is specified, can wait for a
message event again.

4.3.7 Monitoring the End Delayed of the Job Net
There are two methods to monitor the end delay of the job net; to monitor with the relative time from the startup time, or to
monitor with the absolute time specifying the estimated end time.

When a delay occurs, the job net status can be confirmed as an end delay using the monitoring window such as Gantt chart,
or command for job net status. It is also possible to output a notification message to the event log or the SYSLOG.

- Monitoring the delay with the relative time

The estimated end date and time are calculated as the relative time from the start date and time and the estimated
processing time of the specified job nets. When the job nets do not end even though the estimated end time has already
passed, an end delay occurs.
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- Monitoring the delay with the absolute time

When the job nets do not end even though the estimated end time specified has already passed, an end delay occurs. This
means that the job net is being executing, warning, waiting status.

To output notification messages, make sure that the Notify when job is not terminated even after the specified time is lapsed
check box is selected in Watching delay of job/job net of the Advanced Settings for Event Output window. For UNIX system,
the message is notified in the user.warning level. Set the syslog.conf of the system so that the user.warning level messages
are notified to the SYSLOG.

The end delay can be defined using one of the following methods. The following describes how to define it.
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- Defining in the Standard information sheet of the Job Net Properties window (the figure below only applies to the delay
monitoring with the relative time)

Figure 4.40 Job Net Properties window - Standard information sheet

Estimated end time (to be specified for delay monitoring with the absolute time):

Specifies the estimated end time of the job net.

Estimated processing time (to be specified for delay monitoring with the relative time):

Specifies the relative from start to completion of the job net.
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- Defining with the jobschsetnet command

The following describes how to define using the jobschsetnet command and how to display the already-defined job net.

- Defining using the jobschsetnet command

1. Make the following settings in the job net control statement.

When monitoring with the absolute time, specify the alarmtime operand to set the estimated processing time.

When monitoring with the relative time, specify the estimatetime operand to set the estimated end time of the
job net.

2. Specify either a -nent operand, a -nche operand or a -ncheall operand to execute the jobschsetnet command.
Specify the file name with the job net control statement edited in Step 1 in the definition file.

For details on the jobschsetnet command and job net control statements, see the "Jobscheduler Commands" section
of the Systemwalker Operation Manager Reference Guide.

- Displaying the already-defined job net

The already-defined job net can be displayed by specifying the -a (-A) or the -r option to the jobschprint command.
If you set the -a (-A) option, the estimated end time is displayed in Alarm Time, and the estimated processing time
is displayed in <Estimate Time>. If you set the -r option, the estimated end time is displayed in alarmtime, and the
estimated processing time is displayed in estimate time.

For details on the jobschprint command, see the "Jobscheduler Commands" section of the Systemwalker Operation
Manager Reference Guide.

4.3.8 Carried Over the Job Net
When the day change time has been reached without the job net scheduled to start today has not started yet, it is possible to
carry over the schedule to the next day without rescheduling. When the schedule is carried over to the next day, the execution
conditions which have not been met will be waited.

When a carried over occurs, the job net status can be confirmed as the carried over using the monitoring window such as Gantt
chart, or command for the job net status.

The job net must meet all the following conditions to be carried over to the next day.

- In Execution condition in the Standard information sheet of the Job Net Properties window, only the time startup is
specified or Start only when message event has occurred is specified.

- In the Message sheet of the Job Net Properties window, Carry Over the process regardless of the day change time is
specified.

- The day change time has passed without any startup since the message events waited for have not occurred.

 

 Note

Carrying over job nets for which Valid only on startup days is specified

When a job net for which Valid only on startup days in the Message sheet of the Job Net Properties window has been specified
is carried over, message event occurrences will be ignored if the day to which the job net has been carried over is not a startup
day. To make the job net start when message events occur even if the day to which it has been carried over is not a startup
day, cancel the Valid only on startup days setting in the Message tab of the Job Net Properties window before registering the
job net.

The carried over can be defined using one of the following methods. The following describes how to define it.
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- Defining in the Standard information sheet and the Message sheet of the Job Net Properties window

Figure 4.41 Job Net Properties window - Standard information sheet (when Start only when
message event has occurred is not specified)

Execute at:

Specifies a time when the job net starts.

Start only when message event has occurred:

Use this option to start a job net only when a specific message event occurs.
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Figure 4.42 Job Net Properties window - Message sheet

Wait for startup time:

Specifies to wait for starting a job net only at its start time even if a message event has occurred.

Carry over the process regardless of the day change time:

Use this option to carry over the scheduled time of the previous day when the day change time has been reached
without the job net executed.
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When Start only when message event has occurred has been specified in the Standard information tab of the Job Net
Properties window, the Message tab of the Job Net Properties window will be displayed.

Figure 4.43 Message tab (when Start only when message event 
has occurred is specified)

When starting only when message event has occurred:

Specify this option to carry over the scheduled execution time of the previous day if the day change time is reached
without the job net having executed. This is not available when connecting to a server running Systemwalker
Operation Manager V13.1.0 or earlier.
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- Defining with the jobschsetnet command

The following describes how to define using the jobschsetnet command and how to display the already-defined job net.

- Defining using the jobschsetnet command

1. Make the following settings in the job net control statement.

For the time startup (Selecting Execute at time), specify the starttime operand to set the start time of the job
net.

To start the job net only when a certain message event is generated, specify ON in the msgonly operand.

To execute the carried over operation at the day change time, specify SET in the carryover operand.

2. Specify either a -nent operand, a -nche operand or a -ncheall operand to execute the jobschsetnet command.
Specify the file name with the job net control statement edited in Step 1 in the definition file.

For details on the jobschsetnet command and job net control statements, see the "Jobscheduler Commands" section
of the Systemwalker Operation Manager Reference Guide.

- Displaying the already-defined job net

The already-defined job net can be displayed by specifying the -a (-A) or the -r option to the jobschprint command.
If you set the -a (-A) option, the time startup is displayed in Start Time, and the Start only when message event has
occurred is displayed in <MSG> and if you set so that the carried over operation is executed at the day change time,
it is displayed in Carry Over. If you set the -r option, the time startup is displayed in starttime and the Start only when
message event has occurred is displayed in <MSG>, and if you set so that the carried over operation is executed at
the day change time, it is displayed in carryover.

For details on the jobschprint command, see the "Jobscheduler Commands" section of the Systemwalker Operation
Manager Reference Guide.

To carry over the process when the day change time is reached, it also can be set by specifying SET in the carryover operand
in the message event control statement and registering this control statement by using the -sent operand in the jobschsetnet
command.

For details, see "Jobscheduler Commands" in the Systemwalker Operation Manager Reference Guide.

 

 Information

By executing the revoke (carried over release) operation to the carried over job net, the carried over schedule can be discarded
and a new schedule can be created.

4.3.9 Using Mail Receipt as a Startup Trigger
The job net can be started upon a mail receipt.

Send the following mail to the Jobscheduler exclusive user to start a job net. The keyword "msgevent" has been specified in
advance. Specify a message event name which the job net to start is waiting for.

- Subject:

msgevent: Message event name[:project name]

- Destination:

The Jobscheduler exclusive user name specified in the Mail sheet of the Define Jobscheduler Startup Parameters window.

- Contents:

(optional)

Upon receipt of this mail, the specified message event occurs and the job net starts. Checking for a new mail is executed in
every 5 minutes.
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 Note

- The first character of the subject must be a space. Some email sending software does not automatically add the required
space character. In such cases, add a space after "Subject:", and then continue with the keyword "msgevent".

- The mail subjects are not decoded. Therefore, only alphabetical characters can be specified for the message event and
project names. If any Japanese character is used, the job net will not start even upon mail receipt.

- Upon receipt of an e-mail, the whole contents of the mail are stored as a text file named "message event name.text" in the
mail directory under the database directory of the installation destination. The entire mail is stored in this file. The mails
with the same message event name cannot be received until this file is deleted. Usually, this file must be deleted within
the job net that starts upon the mail receipt.

- The files attached to the mail are decoded and stored in the mail directory under the database directory of the installation
destination. If the attached file has a file name specified, this name will be used. If no file name is specified, the file name
will be "message event name.binary." If the file already exists, it is overwritten.

- For MIME format version 1.0, the contents of attached files are sent as the mail body contents. However, it does not
support multi-part mails. Send single-part mails only.

- Also note that the split mails are not supported. The split mails are treated as different mails.

- Decoding of the attached files supports 7-bit, base64, quoted-printable and uuencode.

4.3.10 Requesting Network Jobs from a Subsystem
When multiple subsystems are used, requests for network jobs can be sent to any subsystem, regardless of whether the
subsystem exists on the own host or another host.

Use one of the following specification methods to send a network job request to any given subsystem.

 
Specifying the -rsys option with the GUI

Use the Standard information sheet of the Add/Change - Job window.
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Figure 4.44 Standard information sheet of the Add/Change - Job window

Command

Specify the -rsys option at the beginning of the Command field. The command specification method is as follows:

 
-rsys <subsystem number> <command>

-rsys subsystem number: Specify the number of the subsystem to which a network job request is to be sent.

Submit the job as a network job

Select this check box to send network job requests to subsystems on a host other than the own host. When sending a
network job request from a subsystem on the own host, there is no need to select this check box.

Request host

Specify the name of the host where the request is to be sent. This item does not need to be specified when submitting a
network job to a subsystem on the own host.
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Specifying the -rsys option with a command

Specify the subsystem number of the request destination in the -rsys option of the qsub Job Submit Command. The following
is a specification example:

 
qsub [-rh request host [-rsys subsystem number]] 
job file

-rh request host: Specify the host name of the request destination.
-rsys subsystem number: Specify the number of the subsystem to which a network job request is to be sent.

When sending network job requests to subsystems on a host other than the own host, specify both the -rsys option and the -
rh option. When sending a network job request to a subsystem on the own host, the -rh option does not need to be specified.

Refer to "qsub Job Submit Command" in the Systemwalker Operation Manager Reference Guide for details.

 
Specifying the -rsys option with the API

The argument of the qsub command can be specified for the submitinf argument in the Job Submission API (Mp_SubmitJob).
The -rsys option of the submitinf argument can be used to specify the subsystem on the execution server. The format used to
specify the argument is the same as that used to specify the -rsys option in the qsub command.

Refer to "Job Submission API" in the Systemwalker Operation Manager Reference Guide for details on the Job Submission
API (Mp_SubmitJob).

 
Using execution subsystem names

Using an execution subsystem name enables you to issue a request for a network job to the host and subsystem that correspond
to that name.

Perform the following procedure to use an execution subsystem name:

1. Define an execution subsystem name. Refer to "Defining an Execution Subsystem Name" in the Systemwalker
Operation Manager Installation Guide for details.

2. Specify the execution subsystem name in the settings that specify the execution server. You can use the execution
subsystem name in the following settings:

- Job Net Properties window >> Standard information sheet >> Default host name

- Add/Change/Monitor Job window >> Standard information sheet >> Request host

- -rh option of the qsub command, and submitinf parameter of the Job Submission API (Mp_SubmitJob)

Refer to "qsub Job Submit Command" in the Systemwalker Operation Manager Reference Guide for details.

Refer to "Job Submission API" in the Systemwalker Operation Manager Reference Guide for details on the Job
Submission API (Mp_SubmitJob).

 

 Note

Jobs that cannot be submitted to any specified subsystem, and queues that prohibit job submission

- It is not possible to submit a network job to any given subsystem in the case of the following jobs. (The subsystem number
cannot be specified on the submission source server when requesting the network job.) Any specified subsystem number
will be ignored.

- Jobs with the Interstage attribute

- JCL (Job Control Language) jobs

- Jobs cannot be submitted to an arbitrary subsystem in the case of a distributed execution queue or a backward
compatibility load distribution queue. Job submission will fail.

- If the schedule server or execution server is V13.2.0 or earlier, network jobs cannot be submitted to any subsystem. Job
submission will fail.
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- It is not possible to use the -rsys option to submit a network job to any given subsystem in the case of the jobs indicated
below. The subsystem number cannot be specified on the submission source server when the network job is requested.

- Demand jobs (jobs submitted from a job folder or from a job outside folder management)

- It is not possible to use an execution subsystem name to submit a network job to any given subsystem in the case of the
jobs indicated below. Any specified subsystem name will be ignored.

- Jobs that specify first and second candidate execution servers that are duplicated

 

 Note

Specifying both the -rsys option and an execution subsystem name

If you specify both the -rsys option and an execution subsystem name when requesting a job, the subsystem number that you
defined in the execution subsystem name has priority and the subsystem number that you specified in -rsys will be ignored.

 

 Note

Treatment of a name that exists as both a host name and an execution subsystem name

If a name that you specified as an execution server also exists as a host name and an execution subsystem name, it will be
treated as an execution subsystem name.

 

 Note

Behavior when an execution subsystem name is specified in a job that cannot use execution subsystem names

If you specify an execution subsystem name in a job that cannot use execution subsystem names, the name will be treated as
a host name and the job will be submitted without the name being replaced with the host name that you defined in the
execution subsystem name.

 

 Information

- If the job submission source (schedule server) is running the Standard Edition of Systemwalker Operation Manager and
the destination server (execution server) is running the Enterprise Edition of Systemwalker Operation Manager, this
function can be used to specify the subsystem of the execution server to which the job is to be submitted.

 

 Point

How to specify the -rh option and the Submit the job as a network job check box when using the -rsys option

- When operating with a single server that is not in a cluster configuration

- When submitting a job to the same host as the server submitting the job, the job can be submitted without selecting the
Submit the job as a network job check box and specifying the -rh option.

- When operating in a cluster configuration

- When submitting a job to a subsystem operating in a cluster system, it is necessary to either select the Submit the job
as a network job check box and specify the logical IP address in the Request host field or to specify the logical IP
address with the -rh option.
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- When submitting a network job to a subsystem that is not operating in a cluster system, it is necessary to either select
the Submit the job as a network job check box and specify the physical IP address in the Request host field or to
specify the IP address of the physical node with the -rh option.

4.3.11 Using Job Definition Variables to Replace Job Registration
Information Together

It is possible to define a job that uses job definition variables in advance so that when the job is executed, the values of the
job definition variables can all be replaced at the same time. This makes it easy to replace path environment and other job
definitions, thereby enabling assets to be transferred between systems in different operating environments.

A job that uses job definition variables is defined by setting the job definition variable name "@variable name@" and the
value of the job definition variable. The job definition variable "@variable name@" in the job definition will be replaced with
the value of the job definition variable when the job is executed.

Only a system administrator (a member of the Administrators group in Windows and the superuser in UNIX) can add, change
or delete job definition variables.

Note that if a job definition variable is changed while a job net is running, the new value of the job definition variable may
become active while the job net is operating. For this reason, changes to job definition variables should not be made while
a job net is running.

 
Procedure

1. Open the Job Definition Variables window.

Select Jobscheduler in the Job Selection window and use one of the following methods to display the Job Definition
Variables window:

- Select Job Definition Variables from the File menu.

- Click the right mouse button and select Job Definition Variables from the pop-up menu.
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2. Open the Job Definition Variable Settings window.

Click the Add button in the Job Definition Variables window to display the Job Definition Variable Settings window.

Figure 4.45 Job Definition Variables window

System job definition variables

This lists the job definition variables that have been set.

3. Set the job definition variable and its value.

Set the job definition variable name (the variable name component in "@variable name@") and the value of the job
definition variable and click the OK button.

Figure 4.46 Job Definition Variable Settings window

Job definition variable name

Specifies the name of the job definition variable.

Job definition variable value

Specifies the value of the job definition variable.

4. Define job information.

Set the job information by specifying "@variable name@" for the item where the job definition variable will be used
in the Standard information or Detail information sheet of the Add/Change - Job window. (Job information can also
be defined with the jobschsetnet command.)
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Job definition variables (@variable name@)

- Job definition variables are specified using the format "@variable name@".

- "@variable name@" can be used with the following items. There is no limit to the number of items for which variables
can be specified. Variables can be specified for multiple items, and multiple variables can also be specified for each item.

- Standard information sheet

- Command

- Parameters

- Directory

- Request host

- Queue name

- Detail information sheet

- Effective user name

- Default log file

- Default error log file

- Value of the environment variable (Value in the Set Environment Variables window)

- Variables cannot be used in jobs with the following attributes.

- Interstage attribute

- PowerAIM attribute

- Normal attribute

 
Job definition variable values

- Strings in the job definition variable format "@variable name@" that are not specified in the Job Definition Variables
window are treated as "@variable name@" strings without being replaced.

- Strings in the format "@variable name@" specified as the value of a job definition variable in the Job Definition
Variables window are not treated as job definition variables, job net variables, or variable parameter variables but as
normal character strings. For example, if the value of the job definition variable "a" is "aa @b@ cc" and the value of the
job definition variable "b" is "dd", replacement of "@a@" will result in "aa @b@ cc".

- When a job definition variable of the form "@variable name@" in a job definition for an active job net replaces the value
of a job definition variable, the value must not contain any characters that cannot be used in the definition item and that
the length of the character string must not exceed the maximum limit. If a replacement results in an invalid job definition,
the job will terminate abnormally without running.

4.3.12 Executing a Job Net Concurrently Using Copy and Startup
You can specify copy and startup in a job net definition and then use copy and startup to execute the job net concurrently.

A job net for which you specified copy and startup (hereafter referred to as a copy source job net) is always copied and started.
A suffix is automatically appended to the job net name and job net comment of the copied job net (hereafter referred to as a
copy destination job net). This ensures that the job net name and job net comment are not duplicated, and enables the job net
to be executed concurrently. In addition, the execution results are not overwritten.
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As shown above, specify copy and startup in the property information of the job net that you want to execute concurrently
using copy and startup.

 
Copy and startup

The following explains copy and startup that uses a job net definition.

- The job net is copied when it is to be started.

- If the job net is layered, the second and subsequent layers are also copied.

- If the status of the copy source job net is one of the following, the job net is not copied and started.

- "Disabled"

- "Paused"
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- When the job net is copied and started, the copy source job net is not started and its status becomes "Waiting". A suffix
is automatically appended to the copy destination job net, which changes to the "Executing" status.

- If copy and startup fails, the copy source job net terminates abnormally.

- An estimated end time may have been set for the copy source job net when delay monitoring is performed for a job net,
and the estimated end time may be reached before the execution conditions are met. In this case, the following
information for the copy source job net is set if copy and startup has not yet been performed, and the following
information for the copy destination job net is set if copy and startup has been performed:

- Job net name output to the end delayed message

- The following parameters passed to the exit program of the end delayed exit:

- Job net name

- Job net comment

- Job net status

- If the jobschmsgevent command is executed with the -c option for the copy source job net, the job net is copied
accordingly.

 

 Note

"Copy and start" operation of job nets containing linked job nets

Parent job nets containing linked job nets can be started by a "copy and start" operation.

Linked job nets that have been duplicated by a "copy and start" operation do not run as linked job nets, nor do the duplicate
job nets of any job nets at lower layers below such job nets. Even if changes are made to a master linked job net, the changes
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will not be reflected to duplicate linked job nets. Duplicate job nets run according to the specification for "copy and start"
operations.

Automatic deletion of copy destination job nets

To prevent the impact on performance caused by the number of saved copy destination job nets becoming too high,
obsolete copy destination job nets must be deleted. Therefore, if the number of saved copy destination job nets exceeds
the number specified in Number of saved copy destination job nets, copy destination job nets are automatically deleted
in order, starting with the oldest.

Automatic deletion is explained below.

- Each copy destination job net is deleted when the job net is copied and started. The number of saved copy destination job
nets at this time is counted as follows:

- Copy destination job nets that terminated normally are counted.

- If the copy destination job net is layered, only the top parent job net is counted. Child job nets are not counted.

- Job nets with a status listed below at the time of deletion are not counted or deleted. The number of saved copy
destination job nets may therefore temporarily exceed the specified value.

- "Executing"

- "End delayed"

- "Warning"

- "Abended" (when Validate job net confirmation is specified in the Advanced Settings for Verification window)

- "Canceled" (when Validate job net confirmation and Check canceled are specified in the Advanced Settings for
Verification window)

- If the copy destination job net is layered, all layers are deleted.

- In addition, the execution result history of deleted copy destination job nets cannot be referenced.

- When the copy destination job net is automatically deleted, it is not updated immediately in the job tree. If the deleted
job net is selected in the job tree or the Job List window is updated automatically to display the information about the
deleted job net, the following error message will be displayed.

 
Job net information not registered.

In this case, click View >> Refresh Tree to update the automatic deletion result in the job tree.

 
Defining job nets (copy source job nets) to be copied and started

Open the Job Net Properties window, click the Standard information tab, specify Copy and start, and specify the property
information of the job net. Refer to "4.2.5 Job Net Information Settings" for details.

All job nets and jobs for which you specify copy and startup, except for those in the "Paused" or "Disabled" status, change
to the "Waiting" status.

Job nets for which copy and startup cannot be specified

You cannot specify copy and startup for the following job nets:

- Job nets that do not have the Job Execution Control attribute

- Termination processing job nets (with the job net name JSHEND or JSHFORCE) [Windows]

- Job nets with a job net name exceeding 35 bytes or a job net comment exceeding 85 bytes (if the job net is layered,
you cannot specify copy and startup if the job net name or job net comment of a job net in a lower layer exceeds the
upper limit)
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 Note

- If you specify Copy and start, Valid during job net execution in the Message tab is ignored.

- Temporary job changes to a copy source job net are not reflected in the copy destination job net.

- To delete the calendar or schedule pattern specified for a copy source job net, you must delete the copy destination job
net.

 
Copied job nets (copy destination job nets)

The following explains copy destination job nets that were copied and started using a job net definition.

- The copied job net name and job net comment are as follows:

 
<copy source job net name>_<suffix>

The system time (*1) at which the job net was executed is appended as a suffix in the YYMMDDhhmmssfff (year, month,
day, hour, minute, second, and millisecond) format.

*1: The system time is used to guarantee uniqueness but not the accuracy of the time. If virtual time is being used, the
time in the suffix will be the virtual time.

 

 Note

If a job net with the same name <copy source job net name>_<suffix> already exists, copy and startup may fail. In this
case, the copy source job net terminates abnormally with the job net completion code 242 (copy and startup failed).

- A copy destination job net does not inherit the execution condition of the copy source or the settings of the base job net.
The execution condition reverts to None.

- The jobs in a copy destination job net inherit the status ("Disabled" or "Paused") resulting from the operation.

- You cannot perform the following operations for a copy destination job net using the GUI, commands, APIs, or Web API:

- Pause, Continue, Disable, Enable, Reinstate, or Revoke in the Operation menu

However, if the job net is a child of the destination job net, you can Pause, Continue, Disable, or Enable it.

- Modify

- Reuse

- Copy

- Startup Days

- Changes in the Job Net Properties window

- Job Net Temporary Change

- Return to Normal Schedule

- The -nent, -nche, -ncheall, -ncpy, -sent and -sdel options of the jobschsetnet command

- The pause, continue, disable, enable, reinstate and revoke options of the jobschcontrol command

- jobschprint -s command

- jobschprint -l(-L) command

- jobschprint -m(-M) command

- jobschprintcsv -l command

- Job net Operations with the jobnets Resource (control=pause/continue/disable/enable/reinstate/revoke)

- 150 -



- After copy and startup, the copy destination job nets are not updated immediately in the job tree of the job selection
window. They appear in the tree when the window is refreshed. Therefore, click View >> Refresh Tree before confirming
the latest status of the copy destination job nets.

- Deleting the parent job net of a copy destination job net also deletes all job nets in the parent job net.

- Copy destination job nets are not carried over.

- Exporting job net definition information using the GUI does not output the copy destination job nets.

- If you import the control statement of a copy destination job net that was output using the jobschprint -r command, the
job net will be normal after the import.

4.3.13 Using Variable Parameters to Link to a Job Net when a
Message Event Occurs

This section explains how to use the jobschmsgevent command to perform job net linkage using variable parameters
simultaneously when a message event is notified.

4.3.13.1 Using variable parameters to start a job net
It is possible to link to a job net to pass variable parameters at the same time that a message event is notified. This removes
the need to define a large number of job nets when running multiple job nets (businesses) that only differ in the commands
or parameters that they use, or in the host that is requesting execution of a job.

For job nets that are triggered by a message event, register job that pass variable parameters as well as message event
notifications. By defining in advance the variables for a job in the job net that receives variable parameters, it is also possible
to start the job with the received variable parameters that replace the variables.

Job nets that satisfy all the following conditions can receive variable parameters:

a. The job nets are not registered with a group.

b. The job nets have the Job Execution Control attribute.

c. Start only when message event has occurred is specified as an execution condition and the job nets satisfy one of the
following conditions:

- The job nets are waiting for a single message event.

- The job nets are waiting for one of a number of registered message events.

Even if the content of a definition satisfies the above conditions as a result of a temporary change, the job net can still receive
variable parameters.

Note also that in the case of a job net in a nested structure, variable parameters will also be inherited by and can be used by
the job nets at the second and subsequent levels.

 
Defining jobs

The following sections explain how to define jobs when variable parameters are used. The definition method is explained for
both jobs that pass variable parameters and jobs that receive variable parameters.
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Refer to "7.4 Starting a Job Net with Variable Parameters" for information on specifying variable parameters manually when
starting a job net.

 
Defining a job that passes a variable parameter

Set the job information by specifying jobschmsgevent (the Message Event Generation Command) with a variable parameter
(-p option) in the Standard information sheet of the Add/Change - Job window. Job information can also be set with the
jobschsetnet command.

Refer to the Systemwalker Operation Manager Reference Guide for details on the jobschmsgevent and jobschsetnet
commands.

Variable parameters

- Strings in the format "@variable name@" in a variable parameter are treated as normal strings, not as job net variables
or job definition variables.

- If a variable parameter is replaced by a "@.VPARAM@" variable in the job definition of a running job net, ensure
that the definition item does not contain invalid characters and that the resultant character string is not longer than the
maximum limit. If a replacement results in an invalid job definition, the job will terminate abnormally without
running.

Refer to "jobschmsgevent Command" in the Systemwalker Operation Manager Reference Guide for details on variable
parameters.

 
Defining a job that receives a variable parameter

Set job information by specifying the "@.VPARAM@" variable for the items to be replaced by the received variable
parameter in the Standard information sheet of the Add/Change Job window. Alternatively, use the jobschsetnet command
to define the job.

@.VPARAM@ variable

- The "@.VPARAM@" variable can be used with the following items in the Standard information sheet. There is no
limit to the number of items for which variables can be specified. Variables can be specified for multiple items, and
multiple variables can also be specified for each item.

- Command

- Parameters

- Request host

- Value of the environment variable (Value in the Set Environment Variables window)

- The "@.VPARAM@" variable cannot be used in the following jobs:

- Jobs with the Interstage attribute

- Jobs with the PowerAIM attribute

- Jobs with the Normal attribute

- If a job net that uses a variable within its job definitions is started without any variable parameter specified, its jobs
will start with the variable component replaced by an empty character string.

4.3.13.2 Using Variable Parameters and Suffixes to Copy and Start Job Nets
If a job net is to be started by passing a variable parameter simultaneously when a message event is notified, it is possible to
make a copy of the job net to be started and to start the copy instead. The specified suffix is appended to the copied job net
name and job net comment. This enables multiple job nets with different parameters to have different suffixes and run in
parallel, and allows job nets with different parameters to run without any danger of execution results being overwritten.
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As the above diagram shows, to copy and start a job net, use the Message Event Generation Command (jobschmsgevent) with
a variable parameter (-p option) and suffix (-c option) to set the job information.

Refer to the Systemwalker Operation Manager Reference Guide for details on the jobschmsgevent command.

 
Copy and startup

The following explains how to copy and start a job net using the variable parameters and suffixes.

- The job net will be copied when it is started.

- If the job net is in a nested structure, job nets at the second and subsequent levels will also be copied.

- Copy and startup cannot be performed in the following cases:

- The job net exists within a group.

- The status of the job net to be copied is any of the following:

- Disabled

- Paused

- Executing (Copy and startup will not take place even if Valid during job net execution is specified.)

- End delayed

- Warning

- Abended (when Validate job net confirmation is selected in the Advanced Settings for Verification window)

- Canceled (when Validate job net confirmation and Check canceled are selected in the Advanced Settings for
Verification window)

- A job net of the same name has been created manually in the copy destination.

- A job net of the same name exists in the copy destination and the status of the job net is one of the following:

- Executing (when Validate job net confirmation is selected in the Advanced Settings for Verification window)

- End delayed
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- Warning

- Abended (when Validate job net confirmation is selected in the Advanced Settings for Verification window)

- Canceled (when Validate job net confirmation and Check canceled are selected in the Advanced Settings for
Verification window)

- If copy and startup is performed for a job net for which Carry over the process regardless of the day change time is selected
in the Message sheet of the Job Net Properties window, that job net will be treated as having started if even one of the
copy destination job nets is already active. This is true even if the original job net has not started.

 

 Note

"Copy and start" operation of job nets containing linked job nets

A "copy and start" operation can be performed on parent job nets containing linked job nets.

Linked job nets that have been duplicated by a "copy and start" operation do not run as linked job nets, nor do the duplicate
job nets of any job nets at levels below such job nets. Even if changes are made to a master linked job net, the changes will
not be reflected to duplicate linked job nets.

 
Duplicate job nets (copy destination job nets)

The following explains copy destination job nets that were copied and started using the variable parameters and suffixes.

- The job net name and job net comment of a copy destination job net are as follows:

name of job net to be copied_suffix specified with -c option

- A copy destination job net does not inherit the execution condition of the copy source or the settings of the base job net.
The execution condition reverts to None.

- Jobs within a copy destination job net inherit the operational status ("Disabled" or "Paused").

- The following operations cannot be performed on a copy destination job net:

- Pause, Continue, Disable, Enable, Reinstate and Revoke in the Operate menu

However, if the job net is a child of the destination job net, you can Pause, Continue, Disable, or Enable it.

- Modify

- Reuse

- Copy

- Startup Days

- Changes to the Job Net Properties window

- Job Net Temporary Change

- Return to Normal Schedule

- The -nent, -nche, -ncheall, -ncpy, -sent and -sdel options of the jobschsetnet command

- The pause, continue, disable, enable, reinstate and revoke options of the jobschcontrol command

- Copy destination job nets are not updated immediately in the job tree of the job selection window. They appear in the tree
when the window is refreshed.

- Copy destination job nets are not deleted automatically. Delete them as required.

4.3.13.3 Receiving Variable Parameters and Accepting Message Events
When a variable parameter (-p option) or a suffix (-c option) is specified for the Message Event Generation Command
(jobschmsgevent), the operation for receiving variable parameters and accepting message events may differ from the normal
operation.
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Job nets that cannot receive variable parameters

In some cases, variable parameters (-p option) and suffixes (-c option) may be ignored even when a message event is accepted.

When the following job nets receive a message event that has variable parameters, the variable parameter and suffix
information will be ignored:

- When there are two or more message events that the job net waits for and when the Start when all message events have
occurred option is selected in the Queuing condition frame of the Message sheet of the Job Net Properties window

- When there is more than one message event that the job net waits for and the Execution condition frame in the Standard
information sheet of the Job Net Properties window is as follows:

- The Execute at option is specified

- The Execution interval option is specified

- The Start at the time of server startup option is selected

 
Job nets that cannot receive message events

In some cases message events cannot be received when a variable parameter (-p option) or suffix (-c option) is specified.

The following table lists the job net settings and status combinations that prevent job nets from receiving message events.

Refer to "14.4.3 Receiving Message Events" for information about the normal reception of message events.

 
Status of job net receiving

event (Status of job net to be
copied)

Status of job net
that was copied

and started

Message event count Remarks

With variable
parameters

With variable
parameters and

suffixes

Not executing Executing/End
delayed/
Warning

Y N

Not abended or canceled Abended/
Canceled

Y N *1

Executing/End delayed/
Warning

Not executing N N *2

Paused Not paused N N

Y: Message events can be received in the normal way

N: Message events cannot be received

*1: "Abend" applies when Validate job net confirmation is selected in the Advanced

    Settings for Verification window.

    "Canceled" applies when Validate job net confirmation and Check canceled are

    selected in the Advanced Settings for Verification window.

*2:  Message events are not received even when Valid during job net execution is

     selected in the Message sheet of the Job Net Properties window.

4.3.14 Using Job Net Variables to Pass Information between Jobs
To share information across jobs in a job net, pass it as a job net variable and use it on succeeding jobs. This allows for flexible
job operations. For example, message event and file name information for which a job waits can be passed as job net variables,
enabling processing for the succeeding job to be changed to suit specific requirements.
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Flow for using job net variables

If you set a job net variable in a job definition, you can use the line with the format "<string>(NAME)=<string>(VALUE)"
from the job output information as a job net variable.

In addition, specify a definition for the succeeding jobs in the same job net so that they use the job net variable. The succeeding
jobs can use the job net variable to perform specific processing.

In jobs that will use job net variables, specify the portion to be replaced with a job net variable value at execution in the format
"@job net variable name@". When the jobs are executed, that portion will automatically be replaced with the value of the
specified job net variable and operations will continue.

The following figure illustrates the definition, operation, and result of jobs that set the job net variables, and jobs that use the
job net variables when you define job net variables for a job in a job net.
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4.3.14.1 Job net variables
Job net variables can be used between jobs within the same job net. They are shared by the jobs within a job net and can be
handled individually for each job net. You can also use job net variables between the parent job net and the child job nets of
a layered job net.
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There are two types of job net variable:

- Job net variables that can be obtained from job output information

This information is dynamically rewritten while the job net is running.

- Job net variables automatically set by the system

This information contains predetermined variable names and variable values. It also contains variable parameters. This
information cannot be rewritten while the job net is running.

 
Job net variables obtained from job output information

If a line with the format "<string>(NAME)=<string>(VALUE)" is output as the job execution result, you can replace the
portion in the format "@job net variable name@" in the succeeding job with "<string>(VALUE)" before using the job. Job
net variables that thus use variable information obtained from job execution results are explained below.

 
Job net variable names

The format of a job net variable name is as follows:

 
<job net variable prefix>.<string>(NAME)

 
Example job net variable name and value

 
Definable strings

The following strings can be defined for the job net variable name and job net variable value:

 
Type Definable string

Job net variable prefix Alphanumeric string of up to 13 bytes

- 158 -



Type Definable string

Job net variable name 
(<string>(NAME))

String of up to 50 bytes containing alphanumeric characters
and underscores ("_")
Leading and trailing spaces and tabs are ignored.

If the string exceeds 50 bytes excluding leading and trailing
spaces and tabs, it is not treated as a job net variable.

Job net variable value
(<string>(VALUE))

String of 0 to 512 bytes (*1)
User-defined characters cannot be used. The line feed
character at the end of the string is not included, but leading
and trailing spaces and tabs are included.
If the string exceeds 512 bytes excluding the line feed
character at the end of the string and if it contains any user-
defined character, the string will not be treated as a job net
variable.

*1: When defining a value for the job net variable, ensure that the definition

    item that will replace "@variable name@" in the definition of the job to be 

    started does not contain any invalid characters or exceed the maximum string 

    length. If a replacement results in an invalid job definition, the job will 

    terminate abnormally without running.

 
Limit values of job net variables

Job nets can import up to 640 job net variables from job output information.

The upper limit on the number of job net variables that can be used by a layered job net is 640 for the parent job net and child
job nets combined.

 
Job net variables automatically set by the system

The variable name of a job net variable automatically set by the system is fixed. The variable value is set specifically for each
job net or job and does not change while the job net is running. The types of job net variable automatically set by the system
are explained below.

Job net variables automatically set by the system

 
Variable name Variable value

@.VPARAM@ Variable parameter. This is variable information that can be specified
each time a job net is started. If no variable parameter value has been
set, this variable is replaced with a blank string.

@.PROJECT@ Name of the project in which the job to be executed is registered.
If the Master Schedule Management function is being used, this
variable is the name of the schedule by dates project.

@.JOBNET@ Name of the job net in which the job to be executed is registered.

@.JOBNAME@ Job name if Job name was registered in job registration information.
If Job name was not registered, this variable is replaced with a space.

@.SUB_SYSTEM@ [SE]
Not replaced.
[EE]
Number (0 to 9) of the subsystem in which the job to be executed is
registered.
For non-multi-subsystem operations, "0" is set.

@.MASTER_PROJECT
@

[SE]
Not replaced.
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Variable name Variable value

[EE]
(when the Master Schedule Management function is enabled)
Name of the master project of the Master Schedule Management
function. If the name of the project in which the job to be executed is
registered ends with a date in the format "+mmdd" or "=mmdd" (where
mmdd is a 4-digit number), this name excludes "+mmdd" or "=mmdd".
If the project name does not end with "+mmdd" or "=mmdd", it is
replaced with a space.
(when the Master Schedule Management function is disabled)
This variable is replaced with a space.

4.3.14.2 Setting Job Net Variables by using a Job
This section explains how to set job net variables by using a job.

 
Defining a job that sets job net variables

This section explains the steps required when creating and defining a job for setting job net variables.

1. Create a job (execution file)

Create a job that outputs the variables and associated values at execution in the format
"<string>(NAME)=<string>(VALUE)"

2. Configure the settings in the Add/Change - Job window

- Standard information tab

- Clear Do not save standard/error output

If this check box is specified, job output information is not output and so no job net variables are set.

- Detail information tab

- Select Set the job output information "NAME=VALUE" in the job net variable

- In Job net variable prefix, set a value that is unique to the job
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Figure 4.47 Standard information tab of the Add/Change - Job window
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Figure 4.48 Detail information tab of the Add/Change - Job window

 
Types of jobs that can be set for job net variables

Set job net variables using the strings described in "Definable strings".

Event wait jobs and some criterial jobs provided by Systemwalker Operation Manager output information in the format
"<string>(NAME)=<string>(VALUE) ", which can be used for job net variables.

The types, variable names, and output values of these jobs are explained below. Information is output to standard output in
the format "<variable name>=<output value>".

Wait for file job/file existence criterial job (chkfile/jobschchkfile command)
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Variable name Output value Condition for output

CF_FILENA
ME

File name of the file that was
changed (full path)

When any of the following is specified:
Create (-fwait)/delete (-fdelete)/update (-
fupdate)/change size (-fsize)

CF_CHKTYP
E

One of the following change types:
"fwait"/"fdelete"/"fupdate"/"fsize"

When any of the following is specified:
Create (-fwait)/delete (-fdelete)/update (-
fupdate)/change size (-fsize)

CF_FILESIZE File size (bytes) When any of the following is specified:
Create (-fwait)/update (-fupdate)/change
size (-fsize)

CF_FILEYEA
R

File update year "yyyy" When any of the following is specified:
Create (-fwait)/update (-fupdate)/change
size (-fsize)

CF_FILEDAT
E

File update date "mmdd" When any of the following is specified:
Create (-fwait)/update (-fupdate)/change
size (-fsize)

CF_FILETIM
E

File update time "hhmm" When any of the following is specified:
Create (-fwait)/update (-fupdate)/change
size (-fsize)

Wait for message event job (jobschchkmsgevt command)

 
Variable name Output value Condition for output

CM_MSGEVEN
T

Name of the message event that
was generated

This information is always output.

CM_PRJNAME Name of the project in which the
message event was generated

When a project name is specified and a
message event is generated

CM_NETNAME Name of the job net in which the
message event was generated

When a job net name is specified and a
message event is generated

CM_VPARAM Variable parameter specified
when the message event was
generated

When a variable parameter is specified and a
message event is generated

CM_EVLOGSR
C

Source name of the event log
defined in the message table

When a message event is generated by the
message table definition

CM_EVLOGEI
D

Event ID of the event log
defined in the message table

When a message event is generated by the
message table definition

CM_MAILFILE Mail file name of the message
event generated upon mail
receipt

When a message event is generated by mail
receipt

Check log file job (jobschchecklog command)

 
Variable name Output value Condition for output

CL_FILENAME Name of the log file to be
checked (specified in the -f
option)

This information is not output when the -h
or -v option is specified.
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Variable name Output value Condition for output

CL_LOGCOUNT Number of lines that match
the conditions according to
the check results

This information is not output when the -h
or -v option is specified.

CL_LOGTEXT Content of the last line that
matches the conditions
according to the check
results

This information is not output under the
following conditions:
- The -h or -v option is specified
- When the check finds 0 lines that match the
conditions

Wait for time job (jobschchecktime command)

 
Variable name Output value Conditions for output

CT_WTIME Specified wait time
"hhmm"

This information is always output.

CT_LTIME Specified maximum wait
time "hhmm"

When the -lt option is specified

Wait until specified time job (jobschsleep command)

 
Variable name Output value Conditions for output

SL_SLEEPSEC Specified wait time
(seconds)

This information is always output

 
Setting job net variables

- If the job completion status is not "Completed" or "Pseudo-normal", no job net variables are set even if the job output
information is output.

- If, while a job net is running, the succeeding job sets the variable value of a job net variable with the same name as a job
net variable already set by the preceding job, the job net variable value is overwritten.

- If a job terminates abnormally and is restarted, the job net variable is replaced with the latest variable value.

4.3.14.3 Replacing the Job Net Variables and Executing a Job
A value specified for a job net variable can be used in a succeeding job. To do this, specify the job net variable name and define
the succeeding job.

This section explains how to define jobs that use job net variables.

 
Defining jobs that use job net variables

In the Add/Change - Job window, define job net variables for the items you want to be replaced with job net variables when
the job is executed.
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Figure 4.49 Standard information tab of the Add/Change - Job window

 
Using a job net variable (@variable name@)

- To use a job net variable, specify it in the format "@variable name@".

- You can use the job net variable "@variable name@" for the items listed below. There is no limit on the number of items
for which you can specify a variable. You can specify a job net variable for multiple items, or even specify multiple
variables within one item.

- Standard information tab

- Command

- Parameters

- Directory

- Request host

- Queue name
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- Detail information tab

- Effective user name

- Standard output file

- Standard error output file

- Value of each environment variable (Value in the Set Environment Variables window)

- You can use a job net variable together with a job definition variable.

- You cannot use variables with the following jobs:

- Interstage attribute job

- PowerAIM attribute job

- Normal attribute job

 
Job net variable values

- Strings in the format "@variable name@" for which no job net variable name has been set are not replaced. They are
treated as strings with the format "@variable name@".

- If strings in the format "@variable name@" exist as job net variable values, they will not be treated as job net variables,
job definition variables, or variable parameter variables but as normal strings. For example, if the value of the job net
variable "JOB.a" is "aa @JOB.b@ cc" and the value of the job net variable "JOB.b" is "dd", replacement of "@JOB.a@"
will result in "aa @JOB.b@ cc".

- When defining a value for the job net variable, ensure that the definition item that will replace "@variable name@" in
the definition of the job to be started does not contain any invalid characters or exceed the maximum string length. If a
replacement results in an invalid job definition, the job will terminate abnormally without running.

 
Checking the job net variable value that is used

When jobs that use job net variables are executed, the job net variables are replaced with the variable values and operations
continue. You can check the job net variable values that were actually substituted by opening the Previous log tab of the
Monitor - Job window.
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Figure 4.50 Previous log tab of the Monitor - Job window

Job net variable

This information was used as the job net variable when a job was executed. It is not displayed if the job net variable
"@variable name@" is not used in the job definition.

Job net variables automatically set by the system are not always displayed.

Parameter information specified at variable parameter startup is displayed regardless of whether it is used in the job
definition.

 

 Information

Using job net variable criterial jobs

Use job net variable criterial jobs to check if the values of job net variables set at execution of the preceding job are the
expected string and numeric values.
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Job net variable criterial jobs can be used, for example, to allocate the processing of succeeding jobs based on the result of
the check by the job net variable criterial job.

Job net variable criterial jobs can perform the following comparisons:

- String comparison

- Checks if the variable value matches the comparison string, or contains the comparison string

- Numeric comparison

- Checks if the variable value matches the specified value, or compares the size of the values

- Numeric range comparison

- Checks if the variable value is between two specified values

Note that the job net variable criterial jobs cannot be used to determine the job net variables automatically set by the system.

 

 Information

Job net variable information file

Information about variables used during job execution and the result of importing the job net variables are stored in the job
net variable information file. If the job net variables must be investigated because, for example, the job terminated
abnormally, directly reference the job net variable information file. The following information can be checked in the job net
variable information file:

- Variables imported by each job from its job output information

- Variables used by each job when it is run

- List of variables in effect when the job net ends

The job net variable information file is updated as required while the job net is running. Do not reference the relevant job net
variable information file while the job net is running.

Refer to the Systemwalker Operation Manager Reference Guide for information on the job net variable information file.

4.3.15 Specifying Detailed Settings for Startup Day Information
The detail mode windows can be used to select which calendar to use, specify what to do if a startup day coincides with a
holiday, and register information about the operating period.
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Figure 4.51 The Startup days sheet

Startup days shift setting:

This section specifies how to shift startup days, according to the basis that was specified in the Basis settings section of the
Startup days (Standard schedule pattern) sheet, the Startup days (Another base job net) sheet, or the Startup days (Other)
sheet.

Shift:

This item specifies the processing for shifting startup days.

- Do not shift: The reference day continues to be a startup day.

- Shift to previous day: The startup day is shifted backwards.
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- Shift to next day: The startup day is shifted forward.

Shifted days:

This item specifies how many days to shift the starting day, in the direction specified by the Shift item. Any value
between 0 and 99 can be specified.

Shift the working day:

Specify this option to take holidays into account when shifting startup days.

Shift the base day when it falls on a holiday:

This section is used to specify whether to count reference days during shift processing if the reference day falls on
a holiday.

Consider as a holiday:

Specify this option to exclude holidays when counting the number of days to shift the startup day.

Consider as a working day:

Specify this option to include holidays when counting the number of days to shift the startup day.

Holiday Operation:

This section specifies what to do if a startup day coincides with a day that has been specified as a holiday in the
Calendar section.

Shift:

This item is used to select what to do (whether or not to start the job net, and whether to shift the job net forward
or backwards).

Number of maximum shifts:

If Shift to previous day or Shift to next day has been selected for Shift, this item specifies the upper limit for the
number of days to shift the startup day. Any value between 0 and 99 can be specified. If "0" is specified, there will
be no upper limit.

Calendar:

This section is used to specify which calendars to use, and which condition to use when combining the selected calendars.

Unselected calendar / Selected calendar:

Specifies the calendar to be used. Select the calendar to be used from the Unselected calendar list, and then click the
Add button to move it to the Selected calendar list. Select a calendar from the Selected calendar list, and then click the
Delete button to move it to the Unselected calendar list.

It is also possible to move calendars from one list to the other by double-clicking them.

Method to combine the calendars:

When multiple calendars have been selected, this item specifies the condition for combining the calendars.

Consider holidays in all the calendars:

This option determines holidays by combining the calendars with a logical "AND" condition, so that only those
days that are holidays in all the selected calendars will be holidays.

Consider holidays only in the selected calendar:

This option determines holidays by combining the calendars with a logical "OR" condition, so that those days that
are holidays in any of the selected calendars will be holidays.

Operation period:

This section is used to specify the periods when the job net will or will not operate.

Valid period:

This section specifies the period when the job net will operate.
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Start:

This item specifies the starting date for the valid period.

End:

This item specifies the ending date for the valid period.

Invalid period:

This section specifies the period when the job net will not operate.

Start:

This item specifies the starting date for the invalid period.

End:

This item specifies the ending date for the invalid period.

Simple Mode:

Click this button to switch to the simple mode view, where only startup day settings can be specified. This button is only
displayed in the detail mode view.

Preview:

A preview of the startup day information that has been set up in the Startup days sheet is displayed in the Startup days
(Preview) window. It is also possible to set an "exception day" (a non-standard manual change to the predefined pattern
settings) by changing the calendar in the Startup days (Preview) window.

Operations cannot be performed in the Startup days sheet while the Startup days (Preview) window is displayed.

 

 Note

- If startup days are changed in this window, the startup day information that has been specified in the Startup Days window
will be deleted, and new startup day information will be set up based on the information that has been registered in this
window.

- The following message will be displayed if items that cannot be specified in the simple mode view are entered and
displayed in the detail mode view and then the display is switched to the simple mode view by clicking the Simple Mode
button: There is a hidden item in edited detailed setting. Note that although the settings edited in the detail mode view are
hidden when a user switches to the simple mode view, the contents of these settings are still retained. Similarly, when a
user switches from the simple mode view to the detail mode view, the settings entered in the simple mode view are also
retained.

4.3.16 Using Exclusive Control for Jobs
You can use exclusive control to adjust operations if you do not want to run a job in one job net at the same time as a job in
another job net.

The example below explains the adjustment method.
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The above example displays five job nets: "stockA", "stockB", "stockC", "stockD", and "stockE". Each of these job nets
contain jobs relating to inventory management.

Of these, the jobs below are configured to prevent other jobs relating to inventory management from running simultaneously
while these jobs are running.

- Job "stockA" in Job net A

- Job "stockC" in Job net C

If using exclusive control within a job net, you can modify the startup times in the schedule. If a job extends across multiple
job nets, adjust the startup time by using exclusive control for the job.

 
Adjustment method overview

Exclusive control can be set in the resource of each job.

Firstly, register the resource "InventoryControl" using the same name in all jobs, so that all five jobs relating to inventory
management use the same resource.

At the same time, configure the resource attribute as shown below:

 
Shared

attribute
stockB, stockD, stockE

Exclusive
attribute

stockA, stockC

If configured as shown above, "stockA" and "stockC" will not run at the same time as any other jobs relating to inventory
management.

Jobs that specify a shared attribute (such as the combination of "stockD" and "stockE") will run simultaneously with other
jobs relating to inventory management. However, if the jobs that run simultaneously contain even a single exclusive attribute
job, they will not run simultaneously.

 

 Information

Exclusive control can also be set by specifying the resource name and attribute (exclusive or shared) using JCL.

 
Procedure

1. Specify the exclusive attribute

Specify Resource name in the Detail information sheet when registering a job in the Add/Change - Job window.
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To prevent "stockA" and "stockC" from running simultaneously with other related jobs, select Exclusive as the
Resource type.
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Conversely, to run the related jobs "stockB", "stockD", and "stockE" simultaneously, select Shared as the Resource
type.

After the settings are complete, click OK.

4.3.17 Setting a Subsystem Day Change Time
When using multi-subsystem operation, you can set a day change time per subsystem.

Use a subsystem day change time when you want to set a different day change time for each job. Using a different subsystem
for each job enables you to set a different day change time for each subsystem. If you do not set a subsystem day change time,
the system day change time that you set in SYSTEM_CALENDAR is used.

Refer to "2.2 Setting Up Day Change Time" for information on the system day change time.
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Procedure

1. Display the Register Day Change Time - subsystem dialog box

In the Job Selection window of the Systemwalker Operation Manager window, select Jobscheduler of the subsystem
for which you want to set a day change time. Then, select Day Change Time from the Options menu.

Figure 4.52 Register Day Change Time - subsystem dialog box

2. Set the day change time

Set the day change time using the Register Day Change Time - subsystem dialog box. The day change time specified
is applied regardless of whether it is a weekday or a holiday.

 

 Note

Job net schedule

- If the day change time is changed after the job net is registered, the job nets and groups of all users will be rescheduled.
However, groups that are already executed for the day will not be rescheduled. In this case, the changed information will
be reflected in scheduling from the next day.

- Changing the day change time may change the scheduled startup day of the job net because of the change in the
relationship with the startup time. Confirm the scheduled startup day after changing the day change time.

- If Execution interval is specified as an execution condition for the job net, do not set the day change time between the start
time and the end time. If you do so, the job net may not start up periodically. Confirm the start time and the end time after
changing the day change time.

4.3.18 Executing Jobs on a Remote Machine
Defining the mjrmtjob command as a job to be registered in the Jobscheduler enables you to execute commands or scripts on
a remote machine where Systemwalker Operation Manager has not been installed.

Define the mjrmtjob command in the Command field of the Standard information tab of the Add/Change - Job window that
is displayed when you click the Execute command job icon in the New Job Net window.

If you specify the mjrmtjob command in the Add/Change - Job window, all the values that you specify including Directory,
Request host, and execution user are used for the mjrmtjob command. Specify values for the command or script to be executed
on the remote machine in the command or parameter parameter of the mjrmtjob command.
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The output of executing the command or script that you specified in the arguments of the mjrmtjob command is displayed in
the Jobscheduler.

The completion code (return value) of the command or script will be the completion code that is displayed in the Jobscheduler.
However, completion codes 201 to 256 are used by the mjrmtjob command and the Jobscheduler, so ensure that the
completion codes (return values) of commands and scripts on the remote machine are not above 200. If the specified
command or script has a negative value and is returned with a value of 256 or higher, the job completion code will be 255.

 
Example of a command to be registered in the Jobscheduler

The following describes the definition to be used for registering the mjrmtjob command in the Jobscheduler.

Click the Execute command job icon in the New Job Net window, and then define the command in the Command field of the
Standard information tab of the Add/Change - Job window.

The following shows an example definition and describes its values.

Example definition in the Command field [Unix]

mjrmtjob -h HOSTB -p Linux -l UTF-8 -u UserA -d '/work' '/user/command/keisan aaa bbb ccc'

Description of the example definition

  Host name of the remote machine: HOSTB

  Type of OS on the remote machine: Linux

  Character encoding on the remote machine: UTF-8

  Name of the user who will execute the command or script on the remote machine: UserA

  Current directory that will execute the command or script on the remote machine: /work

  Example command to be executed on the remote machine: /user/command/keisan aaa bbb ccc

Refer to the Systemwalker Operation Manager Reference Guide for information on the mjrmtjob command.

 

 Note

- You must configure the settings before using the mjrmtjob command. Refer to "Definition of SSH Communication" in
the Systemwalker Operation Manager Installation Guide for details.

- If the operating system of the server that executes the mjrmtjob command is Windows and the operating system of the
remote machine is Solaris 11.3 or later, JRE8 or later is required for the server that executes the mjrmtjob command. Set
the installation path of the JRE8 or later to the environment variable "MJRMTJOB_JAVA_HOME". Refer to
"Configuring SSH Communication" in the Systemwalker Operation Manager Installation Guide for details.

If the following error is output when the mjrmtjob command is executed, it means that the SSH key exchange algorithm
may not match the algorithm supported in the remote machine.

 
Failed to access remote machine. Error: session.connect: SSH_MSG_DISCONNECT: 2
Protocol error: no matching DH grp found

In this case, perform the following on the server that executes the mjrmtjob command.

1. Install JRE8 or later.

2. Add "MJRMTJOB_JAVA_HOME" as a system environment variable and set the installation path of JRE installed
in 1.

3. Restart Job Execution Control.

4.3.19 Linking with cloud services by using REST execution jobs
[Windows] [Linux]

By using REST execution jobs, you can execute, wait for completion, or forcibly terminate a job (API) on a cloud service for
which a REST interface is provided.

This subsection describes how to use REST execution jobs.
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Procedure

1. Setting Credentials

Set the credentials for the cloud service to which the REST execution job connects in the credentials control statement.

For more information about credential control statements, refer to the "Systemwalker Operation Manager Reference
Guide".

2. Registering Credentials

Execute the jobschsetauthinfo command with the -add option. The -add option specifies the name of the file that
contains the credential control statements you edited in step 1.

The jobschsetauthinfo command manages authentication information securely by encrypting and managing passwords
and other credential. For more information about jobschsetauthinfo command, refer to the "Systemwalker Operation
Manager Reference Guide".

3. Creating Credentials

The connection information file describes the connection information for the REST execution job to connect to the
cloud service. The connection information includes the credentials you registered in step 2. Store the connection
information file in any directory.

For more information about connection information file, refer to the "Systemwalker Operation Manager Reference
Guide".

4. Registering REST Execution Jobs

In the New Job Net window, select the Execute REST job icon. The jobschrestexec command is set to Command in the
Add/Change - Job window - Standard information sheet that appears. For Parameter, specify the full path of the
connection information file created in step 3.

For more information about jobschrestexec command, refer to the "Systemwalker Operation Manager Reference
Guide".

4.4 Changing the Job Schedule Information
This section describes how to change the job schedule information during operation.

 

 Note

When any job net in the first layer is under execution, all the job nets under that layer and their job net information cannot
be changed.

4.4.1 Changing Projects
The project owner can be changed as necessary.

The project names, however, cannot be changed. To change a project name, use the job net duplication function to copy all
the job nets in the project with a different name, and then delete the original job nets and project.

The following describes how to change the project owner.

 
Procedure

1. Displaying the Change Owner window

Select the desired project from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Owner from the Security menu. The Change Owner window will appear.
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2. Changing the project owner

Change the project owner using the Change Owner window.

Figure 4.53 Change Owner window

Project Name:

Displays the project name. This cannot be changed.

Owner:

Specifies the owner of the project. Specify the OS user.

The user specified here will become the execution user for jobs within the project if the Effective user name has not
been specified in the Detail information sheet of the Add/Change - Job window or the Monitor - Job window.

If the Extended User Management function is enabled with the UNIX version, be sure to specify OS users as
owners.

Owner password [Windows version]:

This is displayed if Execute jobs under the respective job owner's authority is enabled in the Define Operating
Information window. Enter the operating system password of the user specified in Owner.

 

 Note

Changing the project owner

- Projects owner can only be changed by the system administrator (the users who are members of the Windows
Administrators Group, or a superuser in the UNIX system). If the Extended User Management function is valid in the
UNIX system, only the Operation Manager user having the administrative authority can perform it.

- Do not change project owners from more than one client simultaneously.

4.4.2 Changing the Job Nets
The job nets can be changed (added, duplicated or deleted) as necessary. The following describes procedure and cautions for
changing (adding/duplicating/deleting) a job net.

 
Adding a job net

The following describes how to add a job net.

Select a project to which you want to add a job net from the Job Selection window of the Systemwalker Operation Manager
window, then register jobs in the job net using the New Job Net window.

For the details of operation, see "4.2.3 Registering Job Nets" and "4.2.4 Registering Jobs".
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Duplicating a job net

The following describes how to duplicate a job net.

The following two methods can be used to duplicate a job net:

- Select Copy and Paste from the menu

- Select Reuse from the menu

 
Procedure (when using Copy and Paste)

1. Copying a job net

Select the job net to copy in the job selection window of the Systemwalker Operation Manager window. Any of the
following operations can be used to copy the job net:

- Select Copy from the File menu.

- Click the right mouse button and select Copy from the pop-up menu.

- Press the C key while holding down the Ctrl key.

2. Pasting a job net

Select the project where the copy of the job net is to be pasted in the job selection window of the Systemwalker
Operation Manager window. Any of the following operations can be used to paste a copy of the job net:

- Select Paste from the File menu.

- Click the right mouse button and select Paste from the pop-up menu.

- Press the V key while holding down the Ctrl key.

Note that if a job net of the same name already exists in the target project, the Set name window shown below will
appear. Specify the name of a job net that does not already exist in the target project.

Job net name:

Specifies the name of the job net to be pasted.

Job net comment:

Specifies a comment relating to the job net to be pasted.

 
Procedure (when using Reuse)

1. Displaying the Job Net Copy Destination Specification window

Displaying the Job Net Copy Destination Specification window by performing one of the following operations.

- Select the job net to duplicate from the Job Selection window of the Systemwalker Operation Manager window.
Then, select Reuse from the File menu (or select Reuse from the pop-up menu displayed by right-clicking).
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- Select Job Net Management from the Tools menu of the Systemwalker Operation Manager window. Click the job
net to duplicate from the Job Net Management window. Then, select Reuse from the File menu (or select Reuse
from the pop-up menu displayed by right-clicking).

2. Setting the duplication destination job net information

Specify the project name, job net name and job net comment of the duplication destination using the Specify the Job
Net Copy Destination Specification window. It is also possible to change the job net information to be duplicated.

Figure 4.54 Job Net Copy Destination Specification window

Copy source project name:

Displays the duplication source project name.

Copy source job net name:

Displays the duplication source job net name.

Copy destination project name:

Selects the duplication destination project name.

Copy destination job net name:

Specifies the duplication destination job net name.

Copy destination job net comment:

Specifies the duplication destination job net comment.

Change:

Displays the Job Net Properties window.

3. Duplicating the job net

Click OK. The job net will be duplicated.

 

 Note

Copy of layered job nets

In case of layered job nets, the parent job nets cannot be duplicated. Only the child job nets of the lowest layer can be
duplicated.

Copying master linked job nets

If a master linked job net, and job nets at levels below the master linked job net, are copied, the duplicate job nets will be
copied as normal job nets. However, master linked job nets that contain child job nets cannot be copied.
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Copying linked job nets

Linked job nets, and job nets at levels below the linked job nets, cannot be copied. Also, parent job nets that contain linked
job nets cannot be copied, just as parent job nets that contain normal child job nets cannot be copied.

Status of copied job nets

The status of a copied job net becomes "Disabled", so click Enable for copied job nets as required.

Copying job nets for which Copy and start is specified

An error occurs if you specify 85 bytes or more for Job net comment in the Set name window or Copy destination job net
comment in the Job Net Copy Destination Specification window when copying job nets for which Copy and start is
specified in the Standard information tab of the Job Net Properties window. The job nets are copied but the job net
comments and job net properties are the same as the copy source job nets. Change the definitions of the created job nets
as required.

 
Deleting a job net

The following describes procedure and cautions for deleting a job net.

 
Procedure

Delete a job net by performing one of the following operations.

- Select the job net to delete from the Job Selection window of the Systemwalker Operation Manager window. Then, select
Delete from the File menu (or select Delete from the pop-up menu displayed by right-clicking). The window to confirm
deletion will appear. Click OK to delete the job net.

- Select the job net to delete from the Job Net Management window. Then, select Delete from the File menu (or select
Delete from the pop-up menu displayed by right-clicking). The window to confirm deletion will appear. Click OK to
delete the job net.

If Also delete the child job nets is selected and OK is clicked in the window to confirm deletion, all the job nets in the parent
job net will also be deleted.

However, the Also delete the child job nets check box will not be displayed in the following cases:

- Child job nets do not exist in the parent job net

- Connected to a server running V13.8.0 or earlier

- The parent job net is a copy destination job net. (If there are child job nets in the copy destination job net, all the child
job nets will be deleted even though the check box will not be displayed.)

 

 Note

Deletion of layered job nets

If Also delete the child job nets is not selected

If a job net in the first layer is deleted in layered job nets, the second layer job nets will become the first layer job nets.

If Also delete the child job nets is selected

If a job net in the first layer is deleted in layered job nets, all the job nets in the second layer or lower will also be
deleted.

If deletion fails, no job nets will be deleted, including the job nets in the parent job net.

Deletion of a child job net

Use the following procedure to delete a child job net from the parent job net.

1. Displaying the Change Job Net window of the parent job net

Display the Change Job Net window of the parent job net.
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2. Deleting a child job net

Select the job net to delete in the Job Flow display area of the Change Job Net window, then select Delete from the
Edit menu (or select Delete from the pop-up menu displayed by right-clicking).

As a result, the targeted child job net will get out of the parent job net and become a job net of the first layer. It is displayed
right under the belonging projects in the Job Selection window of the Systemwalker Operation Manager window. To
further delete job nets, see "Procedure" in the "Deleting a job net" section.

Deleting linked job nets

If a parent job net where a linked job net has been registered as a job is deleted, the linked job net, and any job nets at levels
below the linked job net, will also be deleted.

To delete only the linked job net, use the following procedure:

1. Open the Change Job Net window

2. Delete linked job nets

Select the linked job net to be deleted in the job flow display area of the Change Job Net window, and then select
Delete from either the Edit menu or the right-click popup menu.

3. Save the parent job net

Select Save from the File menu of the Change Job Net window.

As a result, the linked job net and any job nets at layers below the linked job net will be deleted.

Deleting master linked job nets

Master linked job nets cannot be simply deleted. All the linked job nets that refer to the master linked job net must be
deleted before the master linked job net can be deleted. Job nets that have been copied via a "copy and start" operation do
not need to be deleted in order to delete a master linked job net.

The Master Linked Job Net List window can be used to check which linked job nets refer to a master linked job net.
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Figure 4.55 Master Linked Job Net List window

Master linked job net list:

This area displays a list of master linked job nets.

If a subsystem is selected in the job selection tree, this list will display all the master linked job nets in the subsystem.
If a project is selected, this list will display all the master linked job nets in the project.

Project name:

This column displays the names of the projects where the master linked job nets have been registered.

Job net name:

This column displays the job net names of the master linked job nets.

Job net comment:

This column displays the job net comments of the master linked job nets.

Linked job net list:

This area displays a list of the linked job nets that refer to the master linked job net that is selected in the Master linked
job net list area.

Project name:

This column displays the names of the projects where the linked job nets have been registered.

Job net name:

This column displays the job net names of the linked job nets.
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Parent job net comment:

This column displays the job net comments for the parent job nets of the linked job nets.

Refer to "Deleting linked job nets" for details on how to delete linked job nets. After all the linked job nets that refer to
the master linked job net, the master linked job net will return to ordinary job net. Then, delete it by referring to "Deleting
a job net".

 

 Note

Deletion of base job nets

When the job net declared as the base job net is deleted, the startup days of the job net for which the deleted job net is specified
as the Standard Information for the startup days are also deleted. Be sure to check for any problem before deleting the base
job net.

4.4.3 Changing the Job Net Information
The job net information (standard information, message information, and startup day information) can be changed as
necessary. This section describes the job net information that can be changed. For procedure and cautions on changing the
job net information, see "4.2.5 Job Net Information Settings".

- Standard information

Changes standard information on the job net including the job net comment, the execution conditions (None/Execute at/
Execution interval/Start at the time of server startup/Start only when message event has occurred), the name of the host
submitting the jobs in the job net, etc.

The job net name cannot be changed in the Standard information sheet of the Job Net Properties window. To change the
job net name, duplicate the job net and save it with a different name, and then delete the original job net.

For child and master linked job nets, the Execution condition cannot be changed to any settings other than None.

- Message Information

Adds or deletes the message events (generated by the jobschmsgevent command) to wait for as the startup timings of job
nets. The job net execution conditions for situations where message events are issued are also changed here.

- Startup Days Information

Changes the basic startup schedules (or startup days) for job nets. The startup days can be specified by either of the
following two methods. Use each method to change the settings.

Basic startup schedule:

Change in the Startup days sheet of the Job Net Properties window.

Irregular startup schedule:

Change (fine tune) using the Startup Days window or Startup Days (Preview) window.

 

 Note

When changing the execution condition to None

If you have set the Execution condition and if you set this Execution condition to None, all the settings made in the Message
sheet of the Job Net Properties window are cleared.

 

 Note

Changing the job net information after message events have occurred
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Changes made to the job net information clear any message events that have already occurred. These message events must
be reissued once the job net information is changed.

However, message events that have occurred will not be cleared when only the following information is changed:

Standard information sheet >> Job net comment, Startup on power-on if power is off during scheduled execution, Start at the
time of server startup >> Once in a day, Default host name

 

 Note

Changing the job net information if its scheduled time has passed

- If the startup conditions are not satisfied when the scheduled time is reached and if the information of a non-started job
net is changed, the job nets are rescheduled and the next scheduled time is set for them. (The previous scheduled time is
cleared.)

- If the startup conditions are not satisfied when the scheduled time is reached and if the information of a group-internal
job net is changed, the group is also rescheduled and the next scheduled time is set for them. (The previous scheduled time
is cleared.)

 

 Note

Changes to information when job was abended

If the job information is changed, the status of all jobs in the job net is set to "Waiting" using Change Job Net window. In this
case, the job net restarts from the first job.

 

 Note

Changes to the startup days, calendar, or operation period information

When the startup day, calendar or operation period information for a job net (that uses a calendar with a reschedule date
setting) is changed using the Startup days sheet of the Job Net Properties window before the reschedule date comes, the
reschedule data setting in the Save Calendar window becomes invalid and the information changed in the Job Net Properties
window becomes valid.

Also note that the above change will affect on all the job nets that are using this startup day if the job net to be changed is the
base job net.

 

 Note

Changing linked job nets

Job net information for linked job nets, and job nets at levels below the linked job nets, cannot be changed. To change the job
net information for a linked job net, change the master linked job net that the linked job net refers to.

 

 Information

Changing the startup days of child job nets

The startup days of child job nets can be changed even when the parent job net is started. The change is effective from the
next startup unless the job net confirmation operation is enabled and the parent job net is abended.
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4.4.4 Changing Information for Linked Job Nets and Master Linked
Job Nets

Linked job nets refer to master linked job nets, and so care is required when changing the job net information.

 
Changing the job flow for linked job nets

The job flow for linked job nets, and job nets at levels below the linked job nets, cannot be changed directly.

If the job flow for a master linked job net, or any job nets below the master linked job net is changed, the changes will be
reflected to all the linked job nets that refer to the changed job net, except for linked job nets that have been duplicated via
a "copy and start" operation. The status of all the jobs in the linked job nets where the changes are reflected will be "Waiting".

 

 Note

If linked job nets or job nets (except for job nets that have been duplicated via a "copy and start" operation) at higher levels
above the linked job nets are executing, the job flow for the master linked job net that the linked job nets refer to cannot be
changed. Make the changes after the job net has terminated.

 
Changing job net information for linked job nets

Job net information for linked job nets, and job nets at levels below the linked job nets, cannot be changed. To change the job
net information for a linked job net, change the master linked job net that the linked job net refers to.

The execution conditions for master linked job nets, and job nets at levels below the master linked job nets, cannot be changed.
For other items, job net information can be changed in the same way as for normal child job nets. Except for the following
items, the changes will be reflected to all the linked job nets that refer to the changed job net. However, the changes will not
be reflected to job nets that have been duplicated via a "copy and start" operation.

Items that are not reflected to linked job nets as a result of changes to the master linked job net

- Instruction

The value will continue to be the value that was specified for the master linked job net when the linked job net was
registered.

- Base job net

This item is never specified regardless of the settings for the master linked job net.

 

 Note

If linked job nets or job nets (except for job nets that have been duplicated via a "copy and start" operation) at higher levels
above the linked job nets are executing, the job net information for the master linked job net that the linked job nets refer to
cannot be changed. Make the changes after the job net has terminated.

 
Recovery-change for linked job nets

Recovery-change can be performed for linked job nets, and job nets at levels below the linked job nets.

However, it is not possible to perform recovery-change for master linked job nets, and job nets at levels below the master
linked job nets.

 
Temporarily changing job information for linked job nets

Job information for linked job nets, and job nets at levels below the linked job nets, can be temporarily changed.

Job information for master linked job nets, and job nets at levels below the master linked job nets, cannot be temporarily
changed.
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Exception days for linked job nets

The startup days for linked job nets, and job nets at levels below the linked job nets, cannot be changed directly.

For master linked job nets, and job nets at levels below the master linked job nets, exception days can be specified in the
Startup Days window. Exception days will be reflected to all the linked job nets that refer to the changed job net, except for
those job nets that have been duplicated via a "copy and start" operation. Exception days are reflected even if a linked job net
that refers to the job net to be changed is running.

 
Changing remarks for linked job nets

Remarks for master linked job nets, linked job nets, and job nets at levels below these linked job nets, can be changed. Even
if the remarks for a master linked job net, or a job net at a level below the master linked job net, are changed, the changes will
not be reflected to the linked job nets that refer to the changed job net. However, if remarks for a master linked job net, or a
job net at a level below the master linked job net, are registered or changed, the remarks will be reflected to any new linked
job nets that are subsequently registered.

 
List of changes that can be made

The following table shows the changes that can be made to master linked job nets and linked job nets, and whether changes
to master linked job nets are reflected to linked job nets.

 
Change Master linked

job net
Linked job

net

Job flow ++ -

Items in the Standard information
sheet of the Job Net Properties
window

Items other than
Instruction

++ -

Instruction + (*1) -

Items in the Startup days sheet of
the Job Net Properties window

Items other than Base
job net

++ -

Base job net + (*1) -

Recovery-change - +

Temporary changes to job information - +

Exception days ++ -

Remarks + (*1) +

++: These changes can be made, and are reflected to linked job nets.

+: These changes can be made.

-: These changes cannot be made

*1: The changes are not reflected to linked job nets.

4.4.5 Temporarily Changing the Job Net Startup Settings
The already-defined job net execution conditions (Execute at/Estimated end time/Execution interval/Start at the time of
server startup/Start only when message event occurred) can be temporarily changed as necessary. This section describes how
to temporarily change the job net execution conditions and how to cancel the temporary changes.

The temporarily-changed execution conditions are valid only during the changed period. After the temporarily-changed
execution conditions are released, the job nets start according to the original execution conditions.

To check the content of the temporary changes, reopen the Temporary Change Properties window for the job net.

 

 Note

None of Execution conditions
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The job nets with None specified as the execution condition cannot be temporarily changed. Also, the job net execution
conditions set to other option than None cannot be temporarily changed to None.

 
Temporarily changing the job net execution conditions

 
Procedure

1. Displaying the Temporary Change Properties window

Display the Temporary Change Properties window by performing one of the following operations.

- Select the desired job net from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Job Net Temporary Change from the Tools menu.

- Select Job Net Management from the Tools menu of the Systemwalker Operation Manager window. Select the
desired job net from the Job Net Management window. Then, select Job Net Temporary Change from the Tools
menu (or select Job Net Temporary Change from the pop-up menu displayed by right-clicking).

2. Specifying the execution conditions and temporary change period

Specify the job net execution conditions applied temporarily and the application period (temporary change period)
using the Temporary Change Properties window.

Figure 4.56 Temporary Change Properties window (for other execution attributes than the
Interstage attributes)

Execution condition:

Specifies the condition to start the job net. The setting method is the same as the one in the Standard information
sheet of the Job Net Properties window.
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If the job net is registered in a group, the execution conditions cannot be changed.

Temporary change period:

Specifies the period in which the temporary change is applied.

- Start:

Specifies the day to start the temporary change.

- End:

Specifies the day to end the temporary change.

 

 Note

When the estimated processing time of the job net is specified, the estimated end time specified in the Temporary
Change Properties window is ignored.

Figure 4.57 Temporary Change Properties window (for the Interstage execution attributes)

Execution condition:

Specifies the condition to start the job net. The setting method is the same as the one in the Standard information
sheet of the Job Net Properties window.

Temporary change period:

Specifies the period in which the temporary change is applied.

- Start:

Specifies the day to start the temporary change.
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- End:

Specifies the day to end the temporary change.

 
Canceling the temporary change

 
Procedure

1. Displaying the Return to Normal Schedule window

Display the Return to Normal Schedule window by performing one of the following operations.

- Select any of the following in the Job Selection window of the Systemwalker Operation Manager window, then
select Return to Normal Schedule from the Tools menu.

- Jobscheduler

- The project having the job net for which you wish to cancel the temporary change.

- The job net or group in the project having the job net for which you wish to cancel the temporary change.

- Select Job Net Management from the Tools menu of the Systemwalker Operation Manager window. Select the job
net in the project having the job net for which you want to cancel the temporary change in the Job Net Management
window, then select Return to Normal Schedule from the Tools menu (or select Return to Normal Schedule from
the pop-up menu displayed by right-clicking).

2. Selecting the job net for which the temporary change is to be canceled

A list of job nets for which the temporary change is specified in the Return to Normal Schedule window. To cancel the
temporary change, double-click the desired job net or select the desired job net and click Cancel. You cannot select
multiple job nets at a time.

Figure 4.58 Return to Normal Schedule window

Job net list:

Displays a list of job nets for which the temporary changes have been applied.
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4.4.6 Changing the Jobs
Jobs can be changed (added, duplicated, cut, pasted, deleted, removed, interrupted, overwritten, replaced or reconnected) as
necessary. The following describes procedure and cautions for changing a job.

 
Adding a job

The following describes how to add a job. When adding a job, see cautions on "4.1 Job Scheduling Essentials" "4.2.3
Registering Job Nets" and "4.2.4 Registering Jobs".

 
Procedure

1. Displaying the Change Job Net window

Display the Change Job Net window appears by performing one of the following operations.

- Select the desired job net from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Change from the File menu (or select Change from the pop-up menu displayed by right-clicking).

- Select Job Net Management from the Tools menu of the Systemwalker Operation Manager window. Select the
desired job net from the Job Net Management window. Then, select Change from the File menu (or select Change
from the pop-up menu displayed by right-clicking).

Figure 4.59 Change Job Net window

2. Adding a job to the job net

In the Change Job Net window, click the Set Mode button to switch to the set mode. (The set mode is automatically
applied by selecting an icon you want to allocate.)

In the set mode, select the jobs to be registered in the job net in the icon selection area. You can also register as a child
job net by selecting the job net icon.
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Then, allocate the job in the job flow display area using the mouse. Placing the job displays the Add/Change-Job
window.

3. Setting the job information

Specify the job information using the Standard information, Control information and Detail information sheets of the
All/Change-Job window. Use the Control Information sheet if you want to register your job as a recovery job or to
allocate startup of the succeeding job/job net with the completion code of preceding job/job net.

4. Registering multiple jobs to the job net

Repeat Steps 2 and 3 for the number of jobs you want to add to the job net.

5. Setting the job execution order

After placing jobs in the Job Flow display area, click the Connect Mode button to switch to the Connect mode. While
in the Connect mode, draw a connection line (arrow) from the preceding job to the succeeding job to specify the job
execution order.

6. Saving to the project

Select Save from the File menu. The job net will be saved in the project.

 

 Note

A job with Execution condition specification cannot connect to a preceding job (or child or linked job net) for which Valid
only on startup days has been specified in the Control information sheet of the Add/Change - Job window.

 
Copying, cutting, pasting or deleting a job

The following describes how to copy, cut, paste or delete a job.

When the job is cut or deleted, the connection lines before and after the job will be deleted. For example, if the job B is cut/
delete from the jobs which are in the order of A, B and C, a connection line must be newly drawn between the jobs A and C
since the connection lines before and after the job B is also deleted.

 
Procedure

1. Display the Change Job Net window.

2. In the Change Job Net window, click the Modify Mode button to switch to the modify mode.

Select the job to be copied, cut or deleted in the Job Flow display area, then select the desired operation from the Edit
menu (or select the desired operation from the pop-up menu displayed by right-clicking).

When pasting, specify a location on the flow and select Paste from the Edit menu (or select Paste from the pop-up menu
displayed by right-clicking on the desired location.

3. Select Save from the File menu. The job net will be saved in the project.

 

 Note

The job nets (child job nets) registered as jobs cannot be copied, cut or pasted. They can only be deleted. Refer to "Deletion
of layered job nets" and "Deleting linked job nets" for details on deleting job nets.

 
Removing a job

The following describes how to remove a job.

When the job is removed, the connection lines before and after the job will remain. For example, if the job B is removed from
the jobs which are in the order of A, B and C, the connection line between the jobs A and C will remain.
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Procedure

1. Displaying the Change Job Net window

Display the Change Job Net window.

2. Removing a job

In the Change Job Net window, click the Modify Mode button to switch to the modify mode.

To delete the removed icon, select Remove from the pop-up menu displayed by right-clicking on the icon to be
removed. To keep the removed icon without deleting, select Remove to from the pop-up menu displayed by right-
dragging the removed job to the desired location.

3. Saving to the project

Select Save from the File menu. The job net will be saved in the project.

 
Interrupting a job

This section describes how to interrupt an allocated job with another job.

After the interruption, the connection lines before and after the job will be automatically drawn again to suit the new
connection order. For example, if a job called X is placed before the job B in the job which are in the order of A, B and C,
the connection lines will be drawn again to the order of A, X, B and C. If placed after B, the order will be A, B, X and C.

 
Procedure

1. Displaying the Change Job Net window

Display the Change Job Net window.

2. Interrupting a job

In the Change Job Net window, click the Modify Mode button to switch to the modify mode.

In the Job Flow display area, drag the icon to interrupt it onto the destination icon with the mouse. Select Interrupt
Before or Interrupt After from the pop-up menu displayed.

At this time, the control information set for the interrupting and interrupted jobs in the Control information sheet of the
Add/Change - Job window is deleted.

3. Saving to the project

Select Save from the File menu. The job net will be saved in the project.

 

 Note

For the job interruption, enough space for allocation is needed on the grid around the destination icon. If the grid space is not
enough, the interruption operation cannot be executed.

 
Replacing/overwriting a job

The following describes about replacing a job with another job and overwriting a job with a new job.

 
Procedure

1. Displaying the Change Job Net window

Display the Change Job Net window.

2. Replacing/overwriting the job

For replacing, click the Modify Mode button in the Change Job Net window to switch to the modify mode. For
overwriting, click the Set Mode button to switch to the set mode.
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To replace a job, drag a new icon onto the old icon in the Job Flow display area. To overwrite a job, place a new icon
onto the old icon. Select Replace object or Overwrite object from the pop-up menu displayed.

3. Saving to the project

Select Save from the File menu. The job net will be saved in the project.

 

 Note

A job with the Restart point/Recovery/Execution condition specification in the Control information sheet of the Add/Change
- Job window cannot be replaced with a job (child job net or linked job net) with the Valid only on startup days specification.

 
Reconnecting a job

The following describes how to reconnect a job.

 
Procedure

1. Displaying the Change Job Net window

Display the Change Job Net window.

2. Setting the job execution order again

For disconnection, click the Disconnect Mode button in the Change Job Net window to switch to the Disconnect mode.
Drag over the connection line to be disconnected in the Job Flow display area.

To reconnect, click the Connect Mode button to switch to the Connect mode. Draw a connection line (arrow) from the
preceding job to the succeeding job in the Job Flow display area to specify the job execution order.

3. Saving to the project

Select Save from the File menu. The job net will be saved in the project.

4.4.7 Changing the Job Information
The job information (Standard information, Control information and Detail information) can be changed as necessary. The
following describes how to change the job information.

 

 Point

Job net and job status after the job information is changed

If the job information is changed using any of the methods described here, the status of the job net and its jobs will be reset
and in the waiting status. However, if the status prior to the change is "Paused" or "Disabled", the status remains the same.

To change the job information without changing the status of the job net and its jobs, execute the recovery change of the job
information. For details, see "4.4.9 Recovery-Changing the Job Information".

 
Procedure

1. Displaying the Change Job Net window

Display the Change Job Net window appears by performing one of the following operations.

- Select the desired job net from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Change from the File menu (or select Change from the pop-up menu displayed by right-clicking).
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- Select Job Net Management from the Tools menu of the Systemwalker Operation Manager window. Select the
desired job net from the Job Net Management window. Then, select Change from the File menu (or select Change
from the pop-up menu displayed by right-clicking).

Figure 4.60 Change Job Net window

2. Displaying the Add/Change-Job window

Click the Modify Mode button in the Job Net Management window. Double-click the job or job net you want to change
in the Job Flow display area while in the modify mode, or select the job or job net you want to change and select
Properties from the File menu (or select Properties from the pop-up menu displayed by right-clicking). The Add/
Change-Job window will appear.

3. Changing the job information

Change the job information using the Standard information, Control information or Detail information sheet of the
Add/Change-Jobs window. For details and cautions on the Add/Change-Job window, see "4.2.3 Registering Job
Nets". and "4.2.4 Registering Jobs"

4. Saving to the project

Select Save from the File menu. The job net will be saved in the project.

4.4.8 Temporarily Changing the Job Information
The information of job properties can be changed temporarily while the status of each job and its job net remain. The
temporarily changed information is only valid when the job net is "restart." If the job net is "start," the temporarily changed
information of the entire job net is cleared. When the job net is being executed or when its alarm is reported, you cannot
temporarily change the job information.

You can use this option when recovering a job.

The following describes how to do so.
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Job information that can be changed

The following items can be temporarily-changed.

- Upper limit of code completion/Ignore completion code/Do not save standard/error output in the Standard information
sheet of Monitor-Job window

- Restart point/Invalid at next restart/Restart previous job/Execution condition in the Control information sheet of
Monitor-Job window

- Estimated processing time in the Detail information sheet of the Monitor-Job window

 
Procedure

The following gives the procedure.

1. Displaying the Monitor-Job window

Display the Monitor-Job window by performing one of the following operations.

- Select the job you want to change, then select Properties from the File menu.

- Select the job you want to change, then select Properties from the shortcut menu.

- Double-click the job you want to change.

2. Changing the job temporarily

Change the job information using the Standard information, Control information or Detail information sheet of the
Monitor-Job window.

 

 Point

Property information of temporarily changed jobs

The property information of a temporarily changed job is reset when the job net is "start." However, the property information
of the job is not changed. If you need to change the property information of a job while keeping the status of each job and its
job net, use the Change Recovery option for the job. For details, see "4.4.9 Recovery-Changing the Job Information".

 

 Point

Required rights for Temporarily change of the job

The Operation Right or Update Right is required to temporarily change a job.

4.4.9 Recovery-Changing the Job Information
The job information (Standard information, Control information and Detail information) can be changed while the status of
each job nets and its jobs remain. The following describes how to do so.

 
Job information that can be changed

The job information that can be recovery-changed is the information that can be registered in the Add/Change - Job window.

The following information, however, cannot be changed.

- The recovery job cannot be changed to the ordinary job. Therefore, the Recovery checkbox is grayed out in the Control
information sheet of Add/Change - Job window. The Restart previous job check box can be changed.

- Wait for preceding job using OR condition in the Control information tab of the Add/Change Job window cannot be
changed.

- For jobs with the job net or linked job net icon, the job net name cannot be changed. Therefore, Job Net List is not
displayed in the Standard information sheet of the Add/Change - Job window, and the job net name and the job net
comment is displayed in text.
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- Valid only on startup days specified for a child or linked job net cannot be changed. The Valid only on startup days
checkbox in the Control information sheet of the Add/Change - Job window is grayed out.

 
Procedure

The following gives the procedure.

1. Displaying the Recovery Change Job Net window

Select Change Recovery from the File menu of Monitor Job Net window.

The Monitor Job Net window will change to the Recovery Change Job Net window.

Figure 4.61 Recovery Change Job Net window

2. Displaying the Add/Change-Job window

Display the Add/Change-Job window by performing one of the following operations.

- Select the job you want to change, then select Properties from the File menu.

- Select the job you want to change, then select Properties from the pop-up menu displayed by right-clicking.

- Double-click the job you want to change.

3. Changing the job information

Change the job information in the Add/Change-Job window.

4. Saving the changes

Select Save from the File menu.

The job property information is changed without changing the status of the job net and its jobs.

Exiting from the Recovery Change Job Net window resumes the Monitor Job Net window.
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 Note

When the job net is under execution, you cannot overwrite it in the Recovery Change Job Net window. If the job net is under
execution, an error message will be output.

When the information is saved in the Recovery Change Job Net window, the temporary change information of all the jobs
in the job net will be deleted.

4.4.10 Changing the Schedule Patterns
The schedule pattern can be added, changed or deleted as necessary. The schedule pattern can only be added, changed or
deleted by the system administrator (the user belonging to the Administrators group in the Windows system, or the superuser
in the UNIX system). If the Extended User Management function is valid in the UNIX system, only the Operation Manager
user having the administrative authority can perform it.

The following describes procedure and cautions for adding, changing or deleting a schedule pattern.

 
Adding/changing a schedule pattern

The following describes how to add or change a schedule pattern.

 
Procedure

1. Displaying the Select Schedule Pattern Information window

Select Schedule Pattern from the Tools menu of the Systemwalker Operation Manager window. The Select Schedule
Pattern Information window will appear.

Figure 4.62 Select Schedule Pattern Information window
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2. Displaying the Schedule Pattern Information window

Double-click the schedule pattern you want to change from the schedule pattern list in the Select Schedule Pattern
Information window or select the schedule pattern you want to change and select Open to display the Schedule Pattern
Information window.

Figure 4.63 Schedule Pattern Information window

3. Adding/changing the schedule pattern information

Adding or changing schedule pattern information involves selecting the basis for the schedule pattern (yearly, monthly,
or business days), and then adding or changing startup days and unscheduled days. For the procedures on adding or
changing schedule pattern information, refer to "4.2.7 Registering the Schedule Pattern".
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Deleting a schedule pattern

The following describes how to delete a schedule pattern.

 
Procedure

1. Displaying the Select Schedule Pattern Information window

Select Schedule Pattern from the Tools menu of the Systemwalker Operation Manager window. The Select Schedule
Pattern Information window will appear.

Figure 4.64 Select Schedule Pattern Information window

2. Deleting the schedule pattern information

Select the schedule pattern you want to delete from the schedule pattern name list in the Select Schedule Pattern
Information window and click Delete.

To browse the list of job nets that use the selected schedule pattern, click the Status button to display the Job Net Using
window.

Figure 4.65 Job Net Using window
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 Note

- It is possible to specify whether to re-create startup days of job nets that are using the schedule pattern as this
schedule pattern information is changed. The setting can be made by using the Use function2 sheet from the Define
Jobscheduler Startup Parameters window. If re-creating startup days is specified, the startup days that have been
set in the Startup days window or the Startup days (Preview) window will be deleted when the schedule pattern is
changed. Before changing the schedule pattern, be sure to check the job nets that are specified to use the schedule
pattern for any problem.

Figure 4.66 Define Jobscheduler Startup Parameters window - Use function2 sheet

Halt re-creation of startup days:

Use this option when not re-creating the startup days for the job nets which use the changed holiday calendar or the
schedule pattern when the holiday calendar or the schedule pattern is changed.

- The schedule pattern name cannot be changed in the Schedule Pattern Information window. To change the
schedule pattern name, save it with a different name in the Save As window, then delete the original schedule
pattern. Also specify a new schedule pattern name for each job net that uses the original schedule pattern name.

- The schedule pattern information is stored in the file db_calendar_ex.default under the database directory of the
Jobscheduler. Regularly back up the data in case it is accidentally deleted or destroyed.

4.4.11 Changing Groups
The groups can be changed (added or deleted) as necessary. Also, the job nets composing the groups can be changed (added,
deleted, removed, interrupted, overwritten, replaced or reconnected) as necessary. The following describes procedure and
cautions for changing groups and job nets composing groups.

 

- 201 -



 Note

Changing the group whose startup time has passed

If the startup conditions are not satisfied when the startup time is reached and if a non-started group is changed, the group and
job nets of this group are rescheduled and the next scheduled time is set for them. (The previous startup time is cleared.)

 
Adding a group

The procedure for adding a group is the same as the procedure for creating a new group. For details on creating a new group
(including the conditions for the job nets registered in a group and the execution conditions for the job nets in the group), see
"4.3.1 Registering Groups".

 
Deleting a group

The following describes how to delete a group.

 
Procedure

Delete a group by performing one of the following operations.

- Select the group to delete from the Job Selection window of the Systemwalker Operation Manager window. Then, select
Delete from the File menu (or select Delete from the pop-up menu displayed by right-clicking). The window to confirm
deletion will appear. Click OK to delete the group.

- Select Group Management from the Tools menu of the Systemwalker Operation Manager window. The Group
Management window will appear. Click to select the group to delete from the Group List window. Then, select Delete
from the File menu (or select Delete from the pop-up menu displayed by right-clicking). The window to confirm deletion
will appear. Click OK to delete the group.

Figure 4.67 Group Management window

 

 Note

Deleting a group does not delete the job nets registered in the group. If the job nets in the group are not necessary, delete them
also.

 
Adding a job net contained in a group

The following describes how to add a job net contained in a group. For details on the conditions for the job nets registered
in a group and the execution conditions for the job nets in the group, see "4.3.1 Registering Groups".

- 202 -



 
Procedure

1. Displaying the Change Group window

Display the Change Group window by performing one of the following operations.

- Select the desired group from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Modify from the File menu (or select Modify from the pop-up menu displayed by right-clicking).

- Select Group Management from the Tools menu of the Systemwalker Operation Manager window. Select the
desired group from the Group Management window. Then, select Modify from the File menu (or select Modify
from the pop-up menu displayed by right-clicking).

Figure 4.68 Change Group window

2. Displaying the Add/Change-Job net window

In the Change Group window, click the Set Mode button to switch to the Set mode. (The Set mode is automatically
applied by selecting a job net icon in the icon selection area.)
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Select Job Net from the icon selection area while in the set mode. Then, allocate the job net in the job flow display area
using the mouse. Placing the job net displays the Add/Change-Job net window.

Figure 4.69 Add/Change - Job net window

3. Registering the job net in a group

Select the job net you want to add using the Add/Change-Job net window. Repeat Steps 2 and 3 for the number of job
nets you want to add in the group.

4. Setting the job net execution sequence

After allocating job nets in the Job Flow display area of the Change Group window, click the Connect Mode button to
switch to the Connect mode. While in the Connect mode, draw a connection line (arrow) from the preceding job net
to the succeeding job net to specify the job net execution order.

Specify the execution sequence of the job nets again (disconnect/connect) as necessary. To disconnect, click the
Disconnect Mode button and drag over the connection line you want to disconnect in the Job Flow display area.

5. Saving to the project

Select Save from the File menu. The group will be saved in the project.

 
Deleting a job net contained in a group

The following describes how to delete a job net contained in a group.
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Procedure

1. Displaying the Change Group window

Display the Change Group window.

2. Deleting a job net

Select the job net to delete in the Job Flow display area of the Change Group window, then select Delete from the Edit
menu (or select Delete from the pop-up menu displayed by right-clicking).

3. Saving to the project

Select Save from the File menu. The group will be saved in the project.

 
Removing a job net from the group

The following describes how to remove a job net from the group it belongs to.

When the job net is removed, the connection lines before and after the job net will remain. For example, if the job net B is
removed from the job nets which are in the order of A, B and C, the connection line between the job nets A and C will remain.

 
Procedure

1. Displaying the Change Group window

Display the Change Group window.

2. Removing a job net

In the Change Group window, click the Modify Mode button to switch to the modify mode.

To delete the removed icon, select Remove from the pop-up menu displayed by right-clicking on the icon to be
removed. To keep the removed icon without deleting, select Remove to from the pop-up menu displayed by right-
dragging the removed job net to the desired location.

3. Saving to the project

Select Save from the File menu. The group will be saved in the project.

 
Interrupting a job net in a group

This section describes how to interrupt a job net in a group by another job net.

After the interruption, the connection lines before and after the job net will be automatically drawn again to suit the new
connection order. For example, if a job net called X is placed before the job net B in the job nets which are in the order of A,
B and C, the connection lines will be drawn again to the order of A, X, B and C. If placed after B, the order will be A, B, X
and C.

 
Procedure

1. Displaying the Change Group window

Display the Change Group window.

2. Interrupting a job net

In the Change Group window, click the Modify Mode button to switch to the modify mode.

In the Job Flow display area, drag the icon to interrupt it onto the destination icon with the mouse. Select Interrupt
Before or Interrupt After from the pop-up menu displayed.

3. Saving to the project

Select Save from the File menu. The group will be saved in the project.
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 Note

For the job net interruption, enough space for allocation is needed on the grid around the destination icon. If the grid space
is not enough, the interruption operation cannot be executed.

 
Replacing/overwriting a job net contained in a group

The following describes how to replace a job net contained in a group with another job net and how to overwrite a job net with
a new job net.

 
Procedure

1. Displaying the Change Group window

Display the Change Group window.

2. Replacing/overwriting the job net

For replacing, click the Modify Mode button in the Change Group window to switch to the modify mode. For
overwriting, click the Set Mode button to switch to the set mode.

To replace a job, drag a new icon onto the old icon in the Job Flow display area. To overwrite a job, place a new icon
onto the old icon. Select Replace object or Overwrite object from the pop-up menu displayed.

3. Saving to the project

Select Save from the File menu. The group will be saved in the project.

 
Reconnecting a job net contained in a group

The following describes how to reconnect a job net contained in a group.

 
Procedure

1. Displaying the Change Group window

Display the Change Group window.

2. Setting the job net execution sequence again

For disconnection, click the Disconnect Mode button in the Change Group window to switch to the Disconnect mode.
Drag over the connection line to be disconnected in the Job Flow display area.

To reconnect, click the Connect Mode button to switch to the connect mode. Draw a connection line (arrow) from the
preceding job net to the succeeding job net in the Job Flow display area to specify the job net execution order.

3. Saving to the project

Select Save from the File menu. The group will be saved in the project.

4.4.12 Changing the Group Information
The group information (including the group comment and actions at power off) can be changed as necessary. The following
describes how to change the group information.

 
Procedure

1. Displaying the Group Properties window

Display the Group Properties window by performing one of the following operations.
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- Select the desired group from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Properties from the File menu (or select Properties from the pop-up menu displayed by right-clicking).

- Select Group Management from the Tools menu of the Systemwalker Operation Manager window. Select the
desired group from the Group Management window. Then, select Properties from the File menu (or select
Properties from the pop-up menu displayed by right-clicking).

2. Changing the group information

Change the group information (including the group comment and actions at power off) in the Group Properties
window.

Click OK to save the changes in the group information.

Figure 4.70 Group Properties window

4.5 Importing and Exporting Definition Information
The definition information of Systemwalker Operation Manager jobs/ job nets and groups can be imported and exported.

Importing definition information

Job/job net definition information and group definition information is imported from a job net definition CSV file or group
definition CSV file into a Systemwalker Operation Manager server (schedule server).

Exporting definition information

The definition information of jobs/job nets and groups is exported to job net definition CSV files and group definition
CSV files from a Systemwalker Operation Manager server (schedule server).

Refer to "jobschcsvtodef command" in the Systemwalker Operation Manager Reference Guide for details on job net
definition CSV files and group definition CSV files.

 

 Note

When exporting startup day bit patterns, do not export or import definition information spanning two years.

It will result in error if exported files are imported spanning two years from one year to the next year or later.

 
Overview of import/export procedure

Information can be imported and exported by means of commands or via the GUI.

Importing with the GUI

A Systemwalker Operation Manager client can be used to register job/job net definition information contained in a job
net definition CSV file and group definition information contained in a group definition CSV file with a Systemwalker
Operation Manager server directly.

- 207 -



Exporting with the GUI

A Systemwalker Operation Manager client can be used to convert job/job net definition information and group definition
information in a Systemwalker Operation Manager server to job net definition CSV files and group definition CSV files.

Importing with commands

Commands can be used to register job/job net definition information contained in job net definition CSV files and group
definition information contained in group definition CSV files with a Systemwalker Operation Manager server.

First the jobschcsvtodef command is used to convert the job net definition CSV files to job net control statement format
and job control statement format, and then this information is registered with a Systemwalker Operation Manager server
using the jobschsetnet command. Similarly, group definition CSV files are converted to group control statement format
and in-group job net control statement format using the jobschcsvtodef command, and then this information is registered
with a Systemwalker Operation Manager server using the jobschsetgrp command.

Exporting with commands

Commands can be used to convert job/job net definition information and group definition information in a Systemwalker
Operation Manager server to job net definition CSV files and group definition CSV files.

Job net and job definition information in a Systemwalker Operation Manager server can be converted to job net control
statement and job control statement format using the jobschprint -r command, then the jobschdeftocsv command can be
used to turn this information to job net definition CSV files. Similarly, group definition information in a Systemwalker
Operation Manager server can be converted to group control statements and in-group job net control statements using the
jobschprint -R command, and then the jobschdeftocsv command can be used to turn this information into group definition
CSV files.

For details on job net control statements, job control statements, group control statements and in-group job net control
statements, refer to "Jobscheduler Commands" in the Systemwalker Operation Manager Reference Guide.

 

 Note

Refer to "4.5.2 Importing and Exporting Definition Information from the GUI (when Connected to a Server Running V13.8.0
or Earlier)" for information on how to import or export the definition information in the following cases:

- Connected to a server running Systemwalker Operation Manager V13.8.0 or earlier.

- In the client operating environment file (Jobschr.ini), "0" is set for the key name "ImportExportLargeScale".

4.5.1 Importing and Exporting Definition Information from the GUI
This section explains how to import and export the job/job net definition information from a Systemwalker Operation
Manager client window.

 
Privileges needed for execution

To import or export information, the user who connects to the Systemwalker Operation Manager server must be one of the
following:

- A user with administrator privileges

- A system administrator (a member of the Administrators group or the superuser)

- An Operation Manager user with administrator privileges [UNIX version]

- A user who has update rights or change rights with respect to the project

4.5.1.1 Importing Definition Information
This section explains the procedure used to import a job net definition CSV file or group definition CSV file to the
Systemwalker Operation Manager server from a Systemwalker Operation Manager client window.

Note that if a job net is layered, child job nets can be specified with the parent job net.
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 Point

You can define multiple items of definition information in a single job net definition CSV file or group definition CSV file.
Defining multiple items of definition information in a single CSV file and thereby reducing the number of CSV files to be
imported can reduce the import time.

Note that it is not possible to specify both job/job net definition information and group definition information in a single CSV
definition file. If they are both included, an error will occur.

 

 Note

Resources required for import

- When you use batch transfer, the CSV files to be imported are transferred in a batch from a Systemwalker Operation
Manager client to the Systemwalker Operation Manager server. Therefore, at least the following disk space is required:

- Disk space equal to the total size of the CSV files to be imported on both the Systemwalker Operation Manager client
and the Systemwalker Operation Manager server.

If the disk space is insufficient, transfer of the CSV files may fail. Therefore, using the above explanation as a guide,
secure the required disk space beforehand.

- When importing a large number of job nets, the memory required on the server increases. Therefore, it is recommended
to perform import when other jobs are not being executed.

If the import fails due to an insufficient memory error, decrease the number of job nets (job net definition CSV files)
specified for import at a time, and perform import multiple times. As a guide, the following is the memory required for
import:

For 15000 job nets (1 job net 1 job): Approximately 1GB

Import behavior

- If a definition CSV file is imported into a project that have job nets with identical names already registered, the definitions
in the imported CSV file will be overwritten for each of the job nets that have identical names. 
For example, if a project contains job nets named A, B and C, and three CSV files define job nets named C, D and E
respectively, job net C will be overwritten and the project will end up with job nets A, B, C, D and E registered.

- Only projects in the Job Selection window can be selected as an import destination. If the Master Schedule Management
function is enabled, only the master project in the Job Selection window can be selected.

- Import takes precedence over other operations for the target project, so other operations (such as starting a job net) will
wait until the import completes.

Import with layer changes

- Do not perform import with layer (parent-child) changes to the definition of the job nets that have already been layered
and registered. An error may occur. Refer to "Import with layer changes" for details.

-

Import that includes the group definition CSV file

- When importing group definition CSV files, import job net definition CSV files containing the job nets within a group
first and then the group definition CSV files. If a group definition CSV file is imported when the relevant job nets do not
exist, an error will occur.
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Procedure

1. Select the import destination project.

Connect to the Systemwalker Operation Manager server that contains the CSV file to be imported and select the import
destination project in the job selection window of the Systemwalker Operation Manager window. If the Master
Schedule Management function is enabled, select a master project.

2. Display the Systemwalker Operation Manager Import window.

Select Import from the File menu or click the right mouse button and select Import from the pop-up menu.

Figure 4.71 Systemwalker Operation Manager Import window

Server type/Server/Subsystem/Project

These sections display information about the import destination.

Import

Displays the selected CSV file and directory.

Select File/Select Directory

Displays the Open and Browse for Folder dialog boxes.

Delete

Deletes the CSV file selected in Import from the display area.

3. Select the CSV file.

Select the job net definition CSV file or group definition CSV file to be imported.
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- To select the CSV file, click the Select File button in the Systemwalker Operation Manager Import window.

The Open dialog box will be displayed.

Figure 4.72 Open dialog box

Select one or more files and click the Open button. Multiple CSV files can be selected at the same time.

The selected CSV file(s) will be added to the Systemwalker Operation Manager Import window.
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- To select all the CSV files in a directory, click the Select Directory button in the Systemwalker Operation Manager
Import window.

The Browse for Folder dialog box will be displayed.

Figure 4.73 Browse for Folder dialog box

Select a directory and click the OK button.

The selected directory will be added to the Systemwalker Operation Manager Import window.

 

 Note

- The only file types that can be specified for importation are CSV files with the extension "csv" or "CSV". If a
directory is specified, only the files in that directory with the extension "csv" or "CSV" will be imported.

- No more than 260 bytes can be specified for the absolute path to the file that is selected using the Open and Browse
for Folder dialog boxes.

- UNC paths are not available. Assign a UNC path to a network drive, or save the CSV file to a local disk before
specifying it.

4. Import the files.

Click the OK button in the Systemwalker Operation Manager Import window to start the import.

While the import process is running, a dialog box displays the progress of the import process.

If you click the Cancel button in the dialog box, the import process will be interrupted.

 

 Note

- Cancels the import of all job net definition CSV files if an error occurs during job net definition CSV file
processing.
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- If the same job net name exists in the specified job net CSV definition file, an error results.

5. Check results.

The definition information is imported under the selected project.

When the import is complete, a completion dialog is displayed.

In addition, the application associated with the text (.txt) is automatically launched on the client OS to display the
results of the import.

Import results will be stored in the following text file:

 
Systemwalker Operation Manage client installation directory
\MPWALKER.JM\mpjmcl\work\jmimpexp\impinfo.txt

The following is an example of execution result output:

[Normal]

Subsystem number=0

Project name= Sales

Definitions were successfully registered.

[Error]

Subsystem number=0

Project name= Sales

Failed to register definitions.

MpJobsch: ERROR: 0350: Import ended abnormally. JobNetName=jobnet1 Operand= starttime 

Code=0084

Remarks: If you select multiple jobnet definition CSV files, they are processed together in one CSV file. Therefore,
messages are output to a single processed CSV file. If an error is detected, processing ends when the error is detected,
so even if there are multiple errors, an error message for the previously detected problem is output.

For detail information about messages, refer to the "Messages Output by Jobscheduler Command" in the
"Systemwalker Operation Manager Message Guide".

The text file containing the execution results will be overwritten during the next import process.

If a message indicating that "MpJobsch: ERROR: 0412" is out of memory is output, divide the number of job nets
specified at one time (job net definition CSV file) and import them.

 
Import with layer changes

Import with layer (parent-child) changes may cause an error. In such a case, delete the layered job nets, and then perform
import. 
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When performing import in order to newly register the layered job nets of which the child job nets have already been defined,
no issue occurs as long as the number of layers does not exceed five.
An error may occur in the following cases:

<Example 1> The sixth layer is temporarily created during the process

In this example, job net definitions are changed like below through import.

 
[Job net definition changes through import]

- Delete a child job net (Job net C) from a job in Job net B

- Set Job net C as a child job net in Job net Z

- Delete a child job net (Job net E) from a job in Job net D

The job net configuration and import process details before and after import are described below. The definitions of the
yellow Job nets B, D, and Z will be changed through import.

If the definitions of Job nets B, D, and Z are changed through import at a time, the import process fails when the sixth layer
is temporarily created as below:
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Therefore, follow the procedure below to perform import in multiple times so that the sixth layer will not be created.

[Import procedure]

1. Delete a child job net (Job net C) from a job in Job net B, also delete a child job net (Job net E) from a job in Job
net D, and then import Job nets B and D.

2. Set Job net C as a child job net in Job net Z, and then import Job net Z.

<Example 2> The loop structure is temporarily created during the process

In this example, job net definitions are changed like below through import.
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[Job net definition changes through import]

- Delete a child job net (Job net B) from a job in Job net A

- Delete a child job net (Job net E) from a job in Job net D

- Set Job net A as a child job net in Job net D

The job net configuration and import process details before and after import are described below. The definitions of the
yellow Job nets A and D will be changed through import.

If the definitions of Job nets A and D are changed through import at a time, the import process fails when the loop structure
is temporarily created as below:

Therefore, follow the procedure below to perform import in multiple times so that the loop structure will not be created.

[Import procedure]
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1. Delete a child job net (Job net B) from a job in Job net A, and import Job net A.

2. Delete a child job net (Job net E) from a job in Job net D, set Job net A as a child job net in Job net D, then import
Job net D.

4.5.1.2 Exporting Definition Information
This section explains the procedure used to export definition information relating to Systemwalker Operation Manager server
jobs/job nets and groups to CSV files using a Systemwalker Operation Manager client window.

 
Export target range

The following objects can be selected individually as the target range of job/job net definition information or group definition
information to be exported:

- Job nets

- Parent job nets

- Child job nets

- Master linked job nets

- Groups

- Projects

- Subsystems

The definition information for the target range of job nets or groups will be exported individually.

 
Created CSV file names

CSV files are created with the following names.

Job net definition CSV files:

Job net name.CSV

Group definition CSV files:

Group name.CSV

If a file of the same name already exists in the export definition specified in the Systemwalker Operation Manager Export
window, a number will be appended to the end of the file name as shown in the following example. Job net names that are
distinguished by case in UNIX, such as two files named "ABC" and "abc", would be indistinguishable when exported to a
Windows platform, so a number is appended to the file name to avoid the problem of duplicate files.

job net name_1.csv

 
CSV file output format

CSV files are output in the following directory structure:

<Export destination directory>

  |-<Subsystem number>

        |-<Project name>

        |   |-Job net definition CSV file

        |   |-Job net definition CSV file

        |   |            :

        |   |            :

        |   |-Group definition CSV file

        |   |-Group definition CSV file

        |

        |-<Project name>

                    :

                    :
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 Note

When you use batch transfer, the CSV files to be exported are transferred in a batch from the Systemwalker Operation
Manager server to a Systemwalker Operation Manager client. Therefore, at least the following disk space is required:

- Disk space equal to the total size of the exported CSV files on the Systemwalker Operation Manager server

If the disk space is insufficient, transfer of the CSV files may fail. Therefore, using the above explanation as a guide, secure
the required disk space beforehand.

 
Procedure

1. Select the export target range.

Connect to the Systemwalker Operation Manager server where the definition information to be exported is located and
select the export target range in the Job Selection pane of the Systemwalker Operation Manager window. The
following objects can be specified individually as definition information export ranges:

- Job nets

- Parent job nets

- Child job nets

- Master linked job nets

- Groups

- Projects

- Subsystems
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2. Systemwalker Operation Manager Export window.

Select Export from the File menu or click the right mouse button and select Export from the pop-up menu.

Figure 4.74 Systemwalker Operation Manager Export window

Server type/Server/Subsystem/Project/Group/Job net

These sections display information about the export target range.

Export destination

Displays the selected export destination directory.

Select Directory

Displays the Browse for Folder dialog box.

Export startup day bit patterns

Specify that the startup day bit pattern (the value of the jobschprintr operand) is to be output to the jobnet definition
CSV file.

If the check box is cleared and the exported job net definition CSV file is imported, the exception days are deleted.

For more information about the jobschprintr operand, refer to the "Job Net Control Statement" in the
"Systemwalker Operation Manager Reference Guide".

Export stopped/disabled status

Specify this option to output the job net status (the value of the operate operand) to the output job net definition CSV
file. The group status (the value of the operate operand) is not output to the group definition CSV file.

- 219 -



Note that job net control statements exported with this item specified cannot be imported into V13.8.0 or earlier
versions. Do not specify this item when importing to V13.8.0 or earlier.

For more information about the operate operand, refer to the "Job Net Control Statement" or "Job Control
Statement" in the "Systemwalker Operation Manager Reference Guide".

3. Specify the export destination.

Use one of the following methods to specify the export destination directory:

- Enter the export destination directory into the Export destination field of the Systemwalker Operation Manager
Export window directly.

The name of the export destination directory can be up to 200 bytes long. An error will occur if a longer name is
specified.

- Click the Select Directory button and specify the target directory name in the Browse for Folder dialog box.

Figure 4.75 Browse for Folder dialog box

Select a directory and click the OK button.

The selected directory will be added to the Systemwalker Operation Manager Export window.

4. Export the files

In the Systemwalker Operation Manager Export window, click OK to start exporting.

The progress is displayed in a dialog box while export processing is running.

Clicking Cancel in the dialog box cancels export processing.

 

 Note

- If the CSV file created during the export process is 260 bytes or more in absolute path, an error occurs during the
export process.
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- Because job net definition information is processed in a batch operation for each project, if an error occurs during
the operation, the job net definition information for the project in which the error occurred is not output. If a
subsystem is specified, the job net definition information for the project that did not result in an error is output.

- If the same file name exists in the destination directory, it is overwritten.

5. Check results.

CSV files will be created in the selected directory.

When the export is complete, a completion dialog appears.

In addition, the application associated with the text (.txt) is automatically started on the client OS to display the results
of the export.

Export results will be stored in the following text file:

 
Systemwalker Operation Manager client installation directory
\MPWALKER.JM\mpjmcl\work\jmimpexp\expinfo.txt

The following is an example of execution result output:

[Normal]

Subsystem number=0

Project name= Sales

Definitions were successfully obtained.

[Error]

Subsystem number=0

Project name= Sales

Failed to obtain definitions.

MpJobsch: ERROR: 0483: Failed to write job net definition statement CSV.

Remarks: The message indicates whether the export succeeded or failed.

The resulting text file is overwritten the next time the export process is executed.

4.5.2 Importing and Exporting Definition Information from the GUI
(when Connected to a Server Running V13.8.0 or Earlier)

This section explains how to import and export the definition information from a Systemwalker Operation Manager client
window in the following cases:

- Connected to a server running Systemwalker Operation Manager V13.8.0 or earlier

Note however, refer to "4.5.1 Importing and Exporting Definition Information from the GUI" for the following cases:
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- The key name "ImportExportLargeScale" is not specified in the client environment operating file (Jobschr.ini), and
Batch transfer the CSV files for faster processing is selected.

In this case, the following Systemwalker Operation Manager Import/Systemwalker Operation Manager Export
windows will be displayed, and Export startup day bit patterns and Export stopped/disabled status in the
Systemwalker Operation Manager Export window will be like below:

- Export startup day bit patterns

It is grayed out with this option selected, and the setting cannot be changed.

- Export stopped/disabled status

It is grayed out without this option selected, and the setting cannot be changed.

Figure 4.76 Systemwalker Operation Manager Import window
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Figure 4.77 Systemwalker Operation Manager Export window

- In the client operating environment file (Jobschr.ini), "0" is set for the key name "ImportExportLargeScale".

The client operating environment file is stored in <Systemwalker Operation Manager installation directory>
\MpWalker.JM\mpjmcl\etc on the client. If the following settings are made, the import and export behavior will be as
described in this section.

 
Section name: OPTIONAL_FUNC

Key name: ImportExportLargeScale

- Setting example

 
[OPTIONAL_FUNC]

ImportExportLargeScale=0

Note that the above settings are enabled when the Systemwalker Operation Manager Import window is displayed.

 
Privileges needed for execution

To import or export information, the user who connects to the Systemwalker Operation Manager server must be one of the
following:

- A user with administrator privileges

- A system administrator (a member of the Administrators group or the superuser)
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- An Operation Manager user with administrator privileges [UNIX version]

- A user who has update rights or change rights with respect to the project

4.5.2.1 Importing Definition Information
This section explains the procedure used to import a job net definition CSV file or group definition CSV file to the
Systemwalker Operation Manager server from a Systemwalker Operation Manager client window.

 

 Point

You can define multiple items of definition information in a single job net definition CSV file or group definition CSV file.
Defining multiple items of definition information in a single CSV file and thereby reducing the number of CSV files to be
imported can reduce the import time.

Note that it is not possible to specify both job/job net definition information and group definition information in a single CSV
definition file. If they are both included, an error will occur.

 

 Note

Resources required for import

- When you use batch transfer, the CSV files to be imported are transferred in a batch from a Systemwalker Operation
Manager client to the Systemwalker Operation Manager server. Therefore, at least the following disk space is required:

- Disk space equal to the total size of the CSV files to be imported on both the Systemwalker Operation Manager client
and the Systemwalker Operation Manager server.

If the disk space is insufficient, transfer of the CSV files may fail. Therefore, using the above explanation as a guide,
secure the required disk space beforehand.

Import behavior

- You cannot include registration and change definition information in the same definition file. If a single definition file
contains both registration and change definition information, the definition file will cause an error and import will be
skipped.

- If a definition CSV file is imported into a project that have job nets with identical names already registered, the definitions
in the imported CSV file will be overwritten for each of the job nets that have identical names. 
For example, if a project contains job nets named A, B and C, and three CSV files define job nets named C, D and E
respectively, job net C will be overwritten and the project will end up with job nets A, B, C, D and E registered.

- Only projects in the Job Selection window can be selected as an import destination. If the Master Schedule Management
function is enabled, only the master project in the Job Selection window can be selected.

-

Import when job nets are layered

- For layered job nets, begin importing job nets at the deepest level first. For example, if a job net structure has three levels,
import the third level first, then the second level and finally the top level. An error will occur if the import process
commences from a level above the deepest level.

Import that includes the group definition CSV file

- When importing group definition CSV files, import job net definition CSV files containing the job nets within a group
first and then the group definition CSV files. If a group definition CSV file is imported when the relevant job nets do not
exist, an error will occur.
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Procedure

1. Select the import destination project.

Connect to the Systemwalker Operation Manager server that contains the CSV file to be imported and select the import
destination project in the job selection window of the Systemwalker Operation Manager window. If the Master
Schedule Management function is enabled, select a master project.

2. Display the Systemwalker Operation Manager Import window.

Select Import from the File menu or click the right mouse button and select Import from the pop-up menu.

Figure 4.78 Systemwalker Operation Manager Import window

Server type/Server/Subsystem/Project

These sections display information about the import destination.

Import

Displays the selected CSV file and directory.

Select File/Select Directory

Displays the Open and Browse for Folder dialog boxes.

Delete

Deletes the CSV file selected in Import from the display area.

- 225 -



Batch transfer the CSV files for faster processing

- When connected to a server running V13.8.0 or earlier

Specify this item to batch transfer CSV files and speed up processing.

When this item is specified, you cannot cancel processing for individual CSV files.

- When connected to a server running V17.0.0 or later

This check box will not be displayed but the system will behave as it is specified.

3. Select the CSV file.

Select the job net definition CSV file or group definition CSV file to be imported.

- To select the CSV file, click the Select File button in the Systemwalker Operation Manager Import window.

The Open dialog box will be displayed.

Figure 4.79 Open dialog box

Select one or more files and click the Open button. Multiple CSV files can be selected at the same time.

The selected CSV file(s) will be added to the Systemwalker Operation Manager Import window.
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- To select all the CSV files in a directory, click the Select Directory button in the Systemwalker Operation Manager
Import window.

The Browse for Folder dialog box will be displayed.

Figure 4.80 Browse for Folder dialog box

Select a directory and click the OK button.

The selected directory will be added to the Systemwalker Operation Manager Import window.

 

 Note

- The only file types that can be specified for importation are CSV files with the extension "csv" or "CSV". If a
directory is specified, only the files in that directory with the extension "csv" or "CSV" will be imported.

- Up to 1,000 files can be imported at a time by using the Systemwalker Operation Manager Import window.

- No more than 260 bytes can be specified for the absolute path to the file that is selected using the Open and Browse
for Folder dialog boxes.

- UNC paths cannot be used. Map the UNC path to a network drive, or save the CSV file to a local disk and then
specify the location.

4. Import the files.

In the Systemwalker Operation Manager Import window, click OK to start importing.

The progress is displayed in a dialog box while import processing is running.

Clicking Cancel in the dialog box cancels import processing.
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 Note

- CSV files are imported one by one. If an error occurs while a CSV file is being processed, that file will be skipped
and the importation process will continue from the following file.

- The dialog box displayed during import processing depends on whether Batch transfer the CSV files for faster
processing is specified.

5. Check results.

The definition information will be imported into the selected project.

When the import process is complete, the application associated with text files (*.txt) on the client operating system
will run automatically to display the import results.

Import results will be stored in the following text file:

 
Systemwalker Operation Manager client installation directory
\MPWALKER.JM\mpjmcl\work\jmimpexp\impinfo.txt

The following is an example of execution result output:

Subsystem number=0

Project name= Sales

C:\OMGR_Definition\DEF1\Jnet1\Jnet001.csv

MpJobsch: ERROR: 6071: Systemwalker MpJobsch failed to open the definition file.

C:\OMGR_Definition\DEF1\Jnet1\Jnet002.csv

MpJobsch: ERROR: 7072: The keyword is incorrect. XXXX line.

C:\OMGR_Definition\DEF1\Jnet1\Jnet0031.csv

MpJobsch: INFO: 2300: XXXX command ended normally.

                        :

                        :

Remarks: Messages are output for each CSV file that is processed. Because the jobschcsvtodef and jobschsetnet/
jobschsetgrp commands are executed during the import process, command execution result messages will be output.

Refer to "Import execution result file" in the Systemwalker Operation Manager Reference Guide and "Messages
Output by Jobscheduler Command" and "Text messages that are output during import processing" in the Systemwalker
Operation Manager Message Guide for details on the information contained in execution results.

The text file containing the execution results will be overwritten during the next import process.

4.5.2.2 Exporting Definition Information
This section explains the procedure used to export definition information relating to Systemwalker Operation Manager server
jobs/job nets and groups to CSV files using a Systemwalker Operation Manager client window.

 
Export target range

The following objects can be selected individually as the target range of job/job net definition information or group definition
information to be exported:

- Job nets

- Parent job nets

- Child job nets

- Master linked job nets

- Groups
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- Projects

- Subsystems

The definition information for the target range of job nets or groups will be exported individually.

 
Created CSV file names

CSV files are created with the following names.

Job net definition CSV files:

Job net name.CSV

Group definition CSV files:

Group name.CSV

If a file of the same name already exists in the export definition specified in the Systemwalker Operation Manager Export
window, a number will be appended to the end of the file name as shown in the following example. Job net names that are
distinguished by case in UNIX, such as two files named "ABC" and "abc", would be indistinguishable when exported to a
Windows platform, so a number is appended to the file name to avoid the problem of duplicate files.

job net name_1.csv

 
CSV file output format

CSV files are output in the following directory structure:

<Export destination directory>

  |-<Subsystem number>

        |-<Project name>

        |   |-Job net definition CSV file

        |   |-Job net definition CSV file

        |   |            :

        |   |            :

        |   |-Group definition CSV file

        |   |-Group definition CSV file

        |

        |-<Project name>

                    :

                    :

 

 Note

When you use batch transfer, the CSV files to be exported are transferred in a batch from the Systemwalker Operation
Manager server to a Systemwalker Operation Manager client. Therefore, at least the following disk space is required:

- Disk space equal to the total size of the exported CSV files on the Systemwalker Operation Manager server

If the disk space is insufficient, transfer of the CSV files may fail. Therefore, using the above explanation as a guide, secure
the required disk space beforehand.

 
Procedure

1. Select the export target range.

Connect to the Systemwalker Operation Manager server where the definition information to be exported is located and
select the export target range in the Job Selection pane of the Systemwalker Operation Manager window. The
following objects can be specified individually as definition information export ranges:

- Job nets

- Parent job nets

- Child job nets
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- Master linked job nets

- Groups

- Projects

- Subsystems

2. Display the Systemwalker Operation Manager Export window.

Select Export from the File menu or click the right mouse button and select Export from the pop-up menu.

Figure 4.81 Systemwalker Operation Manager Export window

Server type/Server/Subsystem/Project/Group/Job net

These sections display information about the export target range.

Export destination

Displays the selected export destination directory.

Select Directory

Displays the Browse for Folder dialog box.

Batch transfer the CSV files for faster processing

- When connected to a server running V13.8.0 or earlier

Specify this item to batch transfer CSV files and speed up processing.

When this item is specified, you cannot cancel processing for individual CSV files.
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- When connected to a server running V17.0.0 or later

This check box will not be displayed but the system will behave as it is specified.

Export startup day bit patterns

- When connected to a server running V13.8.0 or earlier

It is grayed out with this option selected, and the setting cannot be changed.

- When connected to a server running V17.0.0 or later

Specify this item to output the startup day bit patterns (jobschprintr operand value) to the job net definition CSV
file.

If the job net definition CSV file exported without this option selected is imported, exception days will be
deleted.

Refer to "Job Net Control Statement" in the Systemwalker Operation Manager Reference Guide for
information on the jobschprintr operand.

Export stopped/disabled status

- When connected to a server running V13.8.0 or earlier

It is grayed out without this option selected, and the setting cannot be changed.

- When connected to a server running V17.0.0 or later

Specify this item to output the job net status (operate operand value) to the job net definition CSV file. The
group status (operate operand value) is not output to the group definition CSV file.

Note that the job net control statement exported with this option specified cannot be imported to V13.8.0 or
earlier versions. Do not specify this option when importing to V13.8.0 or earlier versions.

Refer to "Job Net Control Statement" and "Job Control Statement" in the Systemwalker Operation Manager
Reference Guide for information on the operate operand.

3. Specify the export destination.

Use one of the following methods to specify the export destination directory:

- Enter the export destination directory into the Export destination field of the Systemwalker Operation Manager
Export window directly.

The name of the export destination directory can be up to 200 bytes long. An error will occur if a longer name is
specified.
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- Click the Select Directory button and specify the target directory name in the Browse for Folder dialog box.

Figure 4.82 Browse for Folder dialog box

Select a directory and click the OK button.

The selected directory will be added to the Systemwalker Operation Manager Export window.

4. Export the files

In the Systemwalker Operation Manager Export window, click OK to start exporting.

The progress is displayed in a dialog box while export processing is running.

Clicking Cancel in the dialog box cancels export processing.

 

 Note

- An error will occur if the absolute path of a CSV file created by the export process exceeds 260 bytes.

- If the job net name contains the following symbols that are not supported for a file name on the Windows operating
system set as the export destination, the symbols in the CSV file name will be converted to fullwidth symbols, and
then the file will be exported.
[UNIX version]

[Characters that will be converted to fullwidth symbols]

\ < > | :

- Items of job net or group definition information are exported from the export target range one by one. If an error
occurs while an item of definition information is being processed, that item will be skipped and the export process
will continue from the following item of definition information.

- The dialog box displayed during export processing depends on whether Batch transfer the CSV files for faster
processing is specified.
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- If you connect to a Systemwalker Operation Manager server running a version prior to V13.3.0, and the definition
information to be exported contains double quotes, the double quotes may disappear after the definition
information is exported, or importing the definition information may fail. 
In this case, use a spreadsheet program such as Excel to edit the CSV file created during the export processing so
that double quotes can be displayed, and then import the CSV file.

5. Check results.

CSV files will be created in the selected directory.

When the export process is complete, the application associated with text files (*.txt) on the client operating system
will run automatically to display the export results.

Export results will be stored in the following text file:

 
Systemwalker Operation Manager client installation directory
\MPWALKER.JM\mpjmcl\work\jmimpexp\expinfo.txt

The following is an example of execution result output:

Subsystem number=0

Project name= Sales

Job net name=WorkRecord

CSV file name=D:\Sales\WorkRecord.csv

Completed successfully.

Job net name = JNET001

The export process has been completed successfully. 

              :

              :

Remarks: Messages are output for each job net or group that is processed. Because the jobschprint and jobschdetocsv
commands are executed during the export process, command execution result messages will be output.

Refer to "Export execution result file" in the Systemwalker Operation Manager Reference Guide and "Messages
Output by Jobscheduler Command" and "Text messages that are output during export processing" in the Systemwalker
Operation Manager Message Guide for details on the information contained in execution results.

The text file containing the execution results will be overwritten during the next export process.

4.5.3 Using Commands to Import and Export Definition Information
This section explains how to use commands to import and export Systemwalker Operation Manager server definition
information.

4.5.3.1 Importing Definition Information
Use the following procedure to import definition information from CSV files to a Systemwalker Operation Manager server
by means of a command.

 
Procedure

1. Create CSV files.

Create the job net definition CSV files and group definition CSV files.

It is possible to modify CSV files created by exporting information from a Systemwalker Operation Manager server.

2. Convert CSV files to control statements.

Use the jobschcsvtodef command to convert job net CSV files or group definition CSV files to control statement
format.
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jobschcsvtodef CSV file

Control statements will be sent to standard output. The output can be redirected to a file if necessary.

3. Register the control statements with the Systemwalker Operation Manager server.

Job net control statements and job control statements are registered using the jobschsetnet command, and group control
statements and in-group job net control statements are registered using the jobschsetgrp command.

Example of a new registration:

Using the job net control statement "net.txt" to register the definition information with a new project named "ABC":

 
jobschsetnet -nent ABC net.txt

Example of a change to existing information:

Using the group control statement "group.txt" to correct the definition information in a project where an existing group
named "ABC" is registered:

 
jobschsetgrp -che ABC group.txt

Refer to the Systemwalker Operation Manager Reference Guide for details on the jobschcsvtodef, jobschsetnet and
jobschsetgrp commands.

4.5.3.2 Exporting Definition Information
The following procedure uses commands to export Systemwalker Operation Manager server definition information to CSV
files:

 
Procedure

1. Outputting from Systemwalker Operation Manager server to a control statement

Job net control statements and job control statements are output by specifying the project name or job net name with
the jobschprint -r command. Group control statements and in-group job net control statements are output by specifying
the project name or group name with the jobschprint -R command.

[To output job net control statements and job control statements]

 
jobschprint -r project name/job net name

[To output job net control statements and job control statements (when the status of operation stop/invalidation is to
be output)]

The operational stop/disable state corresponds to the operate operand in the control statement. Information about the
operate operand can be output by specifying the -operate option.

 
jobschprint -r project name/job net name -operate

[To output job net control statements and job control statements (when the startup day bit pattern is to be output)]

The start date bit pattern corresponds to the jobschprintr operand in the control statement. Information about the
jobschprintr operand can be output by specifying the - detail option.

 
jobschprint -r project name/job net name -detail
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[ To output group control statements and intra-group job net control statements]

 
jobschprint -R project name/group name

In either of the above cases, the control statement is sent to standard output. If necessary, the output can be redirected
to a file.

2. Convert from control statement to CSV file.

Use the jobschdeftocsv command to convert from control statements to job net definition CSV files or group definition
CSV files.

 
jobschdeftocsv control statement file

Control statements will be sent to standard output. The output can be redirected to a file if necessary.

Refer to the Systemwalker Operation Manager Reference Guide for details on the jobschprint -r, jobschprint -R and
jobschdeftocsv commands.
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Chapter 5 Registering and Submitting Demand Job
A job which automates execution is managed as a scheduled job by the Jobscheduler. On the other hand, a job which is to be
submitted without being scheduled is managed as a demand job by the Job Execution Control.

This chapter describes how to register and submit demand job.

5.1 Registering and Submitting Demand Job
The Job Execution Control manages demand job in job folders. By registering multiple related jobs in a single job folder,
these jobs can be managed.

- Registering Demand Job in Job Folders

- Submitting Job in Job Folders

The demand job not managed in job folders are submitted as Job outside Job Folder Control.

- Submitting Job outside Job Folder Control

When registering demand job, pay attention to the job to be registered. For details about executable file that can be registered
as job, see "Designing Executable Files" In the Systemwalker Operation Manager Design Guide.

5.2 Registering Demand Job in Job Folders
The Job Execution Control can manage demand job in job folders. By registering multiple related job in a single job folder,
these job can be managed. The following describes procedure to register job in job folders.

 
Registering job folders

The following describes how to register job folders. Up to 255 job folders can be registered.

 
Procedure

1. Creating a job folder

Create a job folder for storing demand job information in a desired local path on the server.

2. Setting access rights

Assign the following access rights to the job folder path to enable Systemwalker Operation Manager to browse or
update the job folder.

[Windows version]

User ID: Administrators group

Access rights: Change or full-control

[UNIX version]

User ID: All users

Access rights: Read and write
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3. Displaying the Define Job Folder dialog box

Select Jobs from the Job Selection window of the Systemwalker Operation Manager window. Then, select Create New
>> Job Folder from the File menu. The Define Job Folder dialog box will appear. Enter necessary information and click
OK. The job folder name will appear under Jobs in the Job Selection window.

Figure 5.1 Define Job Folder dialog box

Job Folder Name:

Specifies the name of the job folder.

Job Folder Path:

Selects an existing file name (Windows system) or an existing directory name (UNIX system) as the target to be
defined as a job folder. Specify an existing folder or directory name in the full path. [UNIX version]

 
Creating and registering job in job folders

The following describes procedure to create and register job in job folders.
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Procedure

1. Displaying the Edit Job Information/Submit dialog box

Select a job folder from Jobs in the job selection window of the Systemwalker Operation Manager window. Then,
select Create New >> Job File of File menu (or select Create New >> Job File from the pop-up menu displayed by right-
clicking).

Figure 5.2 Edit Job Information/Submit dialog box - Basic information sheet

Basic information such as job file name, job name, and queue for job submission destination can be edited.

Get file from the client (own machine):

This option is available only when the Non-Folder-Managed Job is selected.

Job File Name:

Job file names displayed vary depending on the display operations.

- If this is displayed by selecting Create New >> Job File in the Select/Submit Job window, specify a job file
name to be created.

- If this is displayed by selecting an existing job file in the Select/Submit Job window, the name of the selected
job file will be displayed.

Also, do not specify the qsub command of Job Execution Control or batch files/shell scripts calling the qsub
command.

Parameters:

Displays the parameter to be passed to the job. If the value contains spaces, enclose it in double quotation marks.

Job Name:

Displays the job name.
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Comments:

Displays the comment describing the Comments.

Queue name:

Displays the queue name.

Confirm Queue:

Displays the Display/Operate Queues dialog box in which you can confirm the queue status.

Figure 5.3 Edit Job Information/Submit dialog box - Output Information sheet

Output destination of job results, standard output files and standard error output files can be specified.

Result Output Destination:

Selects whether to output the job results to files.

- Save As File:

A result file will be created upon completion of job execution.

- No Save:

No result file will be created. Selecting this option will disable the Save to File field.

Standard Output:

Specifies the standard output destination file name with a full path.

Give standard error output in standard output:

When checked, standard error output will be sent to standard output. Checking this option disables the Standard
Error Output input area.
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Standard Error Output:

Specifies the standard error output destination file name with a full path.

Figure 5.4 Edit Job Information/Submit dialog box - Additional Information sheet

Detailed information such as execution priority ranking can be edited.

Set Execution Priority:

Specifies execution priority ranking within the queue.

Set Dispatch Priority:

Specifies job execution priority.

Set Time Lapse Limit:

Specifies elapsed execution time limit.

Re-execute Job:

Specifies whether to restart after the system shutdown.

Resource Used:

Specifies a resource name to useSpecify it within 64 bytes. English alphanumeric characters, "_" (under bar) and
"-" (hyphen) are available.

Type:

Selects a usage attribute (shared/occupied) of selected resource.

Execution Server Name:

It is possible to submit a job as a network job and send an execution request to any server other than the currently-
connected server. Specify a host name of another server to execute the job.
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You can use an execution subsystem name if you have defined one. If the specified name also exists as a host name
and execution subsystem name, it will be treated as an execution subsystem name.

Execute job file on the Execution Server:

This option is available only when the Non-Folder-Managed Job is selected.

Retry on network errors:

Specifies whether to retry upon a line failure during network job execution.

Retry Number:

Specifies a retry count when the Retry after Line Failure check box is checked.

Figure 5.5 Edit Job Information/Submit dialog box - Job File sheet

It is possible to edit job files such as batch files and JCLs (Windows system) or shell scripts and JCLs (UNIX system).

Job File:

Job files displayed vary depending on the display operations.

- If this is displayed by selecting Create New >> Job File in the Select/Submit Job window, edit the job file.

- If this is displayed by selecting an existing job file in the Select/Submit Job window, the contents of the selected
job file will be displayed.

2. Setting information on the job to be registered

Enter the job information to be registered and click Save.

 

 Information

Number of jobs to be registered in a job folder
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Number of jobs that can be registered in a job folder is not limited. However, more registered jobs can make
management more difficult.

In Systemwalker Operation Manager, the number of jobs that can be displayed in the Select/Submit Job window is
limited to 4096. Therefore, make sure the number of jobs to be registered in a job folder is up to 4096.

 

 Information

Job execution rights [Windows version]

Normally the execution right of the submitted job belongs to the logon account of the Job Execution Control service
on the server, but it is possible to grant it to the user who has actually submitted the job by environment definition
(selecting Execute jobs under the respective job owner's authority in the Options sheet of the Define Operating
Information window).

Execute jobs under the respective job owner's authority:

Executes all the jobs with the owner right.

 
Renaming a job folder

The following describes procedure to change a registered job folder name.

 
Procedure

1. Displaying the Rename Job Folder dialog box

Select the desired job folder from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Modify from the File menu (or select Modify from the pop-up menu displayed by right-clicking the mouse).

2. Changing the job folder name

Specify a new name in the Rename Job Folder dialog box, then click OK.

Figure 5.6 Rename Job Folder dialog box

From:

Displays the current job folder name.

To:

Specifies a new name.

 
Browsing job folder information

The following describes procedure to browse the job folder information.
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Procedure

- Displaying the Refer Job Folder Information dialog box

Select the desired job folder from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Properties from the File menu (or select Properties from the pop-up menu displayed by right-clicking).

Figure 5.7 Refer Job Folder Information dialog box

Job Folder Name:

Displays the job folder name.

Location:

Displays the location where the job folder actually exists with a full path.

Job Files:

Displays the number of job files managed under the job folder.

 

 Information

If you add a file under the job folder on the server directly, after displaying the job folder information in this dialog box,
the number of job files in the Refer Job Folder Information dialog box will not be updated immediately.

In this case, perform the following operation to update the number of job folders displayed:

- Select other function such as Jobscheduler in the Job Selection window, select Job again, and browse the job folder
information.

 
Deleting a job folder

The following describes how to delete a job folder.

 
Procedure

- Select the desired job folder from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Delete from the File menu.

The job folder will be deleted from the Job Selection window, but the actual folder/directory will not be deleted.

5.3 Submitting Demand Jobs
If you have already registered demand jobs in a job folder using the Job Selection window of the Systemwalker Operation
Manager window, you can submit them only by selecting them. It is also possible to temporarily change the information
registered in "5.2 Registering Demand Job in Job Folders" and submit them.
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The temporally jobs that do not have to be managed in job folders can be submitted as "Jobs outside Job Folder Control".

 

 Note

If a demand job with temporarily-changed contents is submitted as a network job from a UNIX system server to a Windows
system server, the job will be abended. In such a case, save the job comments first, then submit the job.

 

 Information

Job submission from the server

When submitting demand job from the server side, use the qsub command. For details of the command, see the Systemwalker
Operation Manager Reference Guide.

 

 Information

Job execution rights [Windows version]

Normally the execution right of the submitted job belongs to the user who has started the Job Execution Control service on
the server, but it is possible to grant it to the user who have actually submitted the job by environment definition (selecting
Execute jobs under the respective job owner's authority in the Options sheet of the Define Operating Information
window).Title (if necessary)

5.3.1 Submitting jobs in job folders
The demand jobs which have registered in a job folder using the Job Selection window of Systemwalker Operation Manager
window, can be executed the desired jobs by selecting them from the Select/Submit Jobs window and by clicking Submit. It
is also possible to temporarily change the registered job information and submit the job.

 
Submitting Jobs in Job Folders

The following describes how to submit jobs in job folders.

 
Procedure

1. Displaying the Select/Submit Jobs window

Select a job folder from Jobs in the job selection window of the Systemwalker Operation Manager window. The Select/
Submit Jobs window will appear in the main window with a list of jobs registered in the job folder.
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2. Submitting jobs

Click the desired jobs in the Select/Submit Jobs window, and click Submit.

Figure 5.8 Select/Submit Jobs window

File Name:

Displays the job file name.

Job Name:

Displays the job name.

Updated On:

Displays the date and time of job file update.

Comments:

A comment is displayed as the job comments.

The order of the job files in the list in the Select/Submit Jobs window can be changed to the following (ascending)
order. Select any of the following in the View menu >> Sort Job Files or Sort Job Files from the pop-up menu. Selecting
the same item again aligns in the descending order.

by File Name:

Sorts in the order of file names.

by Job Name:

Sorts by job name.
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by Date:

Sorts by update date and time.

by Comments:

Sorts by comments.

 
Temporarily changing the registered demand job contents and executing the job

The following describes how to temporarily change the registered demand job information and submit the job.

 
Procedure

1. Displaying the Select/Submit Jobs window

Select a job folder from Jobs in the job selection window of the Systemwalker Operation Manager window. The Select/
Submit Jobs window will appear in the main window with a list of jobs registered in the job folder.

Figure 5.9 Select/Submit Jobs window

2. Displaying Edit Job Information/Submit dialog box

Click the desired jobs in the Select/Submit Jobs window, and click Open.

For details on the Edit/Submit Job Information dialog box, see "5.2 Registering Demand Job in Job Folders".

3. Changing registered contents

Change the registered contents, and click Submit. The job will be executed with the changed contents.
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Changing the registered demand job contents and executing the job

The following describes how to change the registered demand job information.

 
Procedure

1. Displaying the Select/Submit Jobs window

Select a job folder from Jobs in the job selection window of the Systemwalker Operation Manager window. The Select/
Submit Jobs window will appear in the main window with a list of jobs registered in the job folder.

2. Displaying the Edit Job Information/Submit dialog box

Click the desired jobs in the Select/Submit Jobs window, and click Open.

For details on the Edit/Submit Job Information dialog box, see "5.2 Registering Demand Job in Job Folders".

3. Changing registered contents

Change the registered contents, and click Save.

5.3.2 Submitting Jobs outside Job Folder Control
In the Job Selection window of the Systemwalker Operation Manager window, the demand jobs not managed in job folders
must be submitted as "Jobs outside Job Folder Control".

 
Procedure

1. Displaying the Edit Job Information/Submit window

Select Jobs outside Job Folder Control under Job in the Job Selection window of the Systemwalker Operation Manager
window. The Edit/Submit Job Information window will appear in the main window.

Figure 5.10 Edit Job Information/Submit window - Basic information sheet

Basic information such as job file name, job name, and queue for job submission destination can be edited.

Get file from the client (own machine):

This option is available only when the Non-Folder-Managed Job is selected.
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- If this check box is checked, the job files existing on the own machine executing this operation will be
transferred to the connected server and the jobs will be submitted.

- If not checked, the job files existing on the connected server will be submitted.

Job File Name:

Specifies the job file to be submitted or edited with a full path.

Parameters:

Specifies a parameter when an optional parameter is to be passed to job.

Job Name:

Specifies a job name when an optional job name is desired.

Comments:

Displays the comment describing the Comments.

Queue name:

Displays the queue name.

Confirm Queue:

Displays the Display/Operate Queues dialog box in which you can confirm the queue status.

Figure 5.11 Edit/Submit Job Information window - Output Information sheet

Output destination information for job result files such as standard output file and standard error output file can be
edited.

Result Output Destination:

Selects whether to output the job results to files.

- When Save As File is selected, a result file will be created upon completion of job execution.

- When No Save is selected, no result file will be created.

- Selecting No Save will disable the Save As File field.

Standard Output:

Specifies the standard output destination file name with a full path.
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Give standard error output in standard output:

When checked, standard error output will be sent to standard output.

Standard Error Output:

Specifies the standard error output destination file name with a full path.

Figure 5.12 Edit/Submit Job Information window - Additional Information sheet

Detailed information such as execution priority ranking can be edited.

Set Execution Priority:

Specifies execution priority ranking within the queue.

Set Dispatch Priority:

Specifies job execution priority.

Set Time Lapse Limit:

Specifies elapsed execution time limit.

Re-execute Job:

Specifies whether to restart after the system shutdown.

Resource Used:

Specifies a resource name to useSpecify it within 64 bytes. English alphanumeric characters, "_" (under bar) and
"-" (hyphen) are available.

Type:

Selects a usage attribute (shared/occupied) of selected resource.

Execution Server Name:

It is possible to submit a job as a network job and send an execution request to any server other than the currently-
connected server. Specify a host name of another server to execute the job.

You can use an execution subsystem name if you have defined one. If the specified name also exists as a host name
and execution subsystem name, it will be treated as an execution subsystem name.
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Execute job file on the Execution Server:

This option is available only when transited from the Non-Folder-Managed Job.

- If this check box is checked, the job files existing on the server specified for the execution server name will be
executed.

- If not checked, the job files existing on the currently-connected server will be transferred to the execution
server and executed.

Retry on network errors:

Specifies whether to retry upon a line failure during network job execution.

Retry Number:

Specifies a retry count when the Retry after Line Failure check box is checked.

Figure 5.13 Edit/Submit Job Information window - Job File sheet

It is possible to edit job files such as batch files and JCLs (Windows system) or shell scripts and JCLs (UNIX system).

Job File:

Edits a job file.

2. Setting the job information to be submitted

Enter the job information to be submitted and click Submit.
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Chapter 6 Monitoring Jobs
This chapter describes job monitoring.

6.1 Monitoring Job Nets
The execution status of job nets can be monitored using the windows listed below.

 
Window name Purpose

Gantt Chart Check the status (such as "Completed"/"Abended", "Delayed", and "End
delayed") and execution schedule of a job net using the time chart format with
the current time in the center.

Job List Check the details of the execution status of a specific job net while it is being
monitored using a Gantt chart. For example, check the following information
or the precise time in hours, minutes, and seconds:

- List of jobs that constitute the job net

- Previous job net execution results (start time and end time)

- Next schedule start time

- Message event occurrence etc.

Job Net
Management

Check job net definition information and actual result values in a list, such as
the scheduled start time, scheduled end time, and memos.

In addition, you can operate job nets that were scheduled to start today or
started today. It is also possible to batch-operate multiple job nets.

You can filter the displayed job nets to suit your purpose. Therefore, if a large
number of job nets are running, for example, you can filter the job nets in
"Waiting" status and check if all job nets were completed today.

When using memos for notes on job net operations or handover information
from the previous operator, you can monitor job nets while checking the
memo information.

Monitor Job Net Check the status of job nets using a flow diagram.

For example, if a job net terminates abnormally, you can use the flow
diagram to check the point (job) where the job net terminated abnormally. If
a job net is delayed, you can check how far the job has progressed.

The following describes each window.

 
The Gantt Chart window

The Gantt Chart window displays the job net execution schedule and the current status on a 25-hour time chart (or time span)
including the current time.

The execution schedule shows the schedule for the next 24 hours after the display start time.

Color coding is used to indicate the current job net status. Specifying a past date displays the history information in a chart.

The job nets that are not set to start up on the day are not displayed. To identify whether a child or linked job net (with a startup
day schedule) is started up today, select Child Job Nets in the View menu.

 

- 251 -



Procedure

- Displaying the Gantt Chart window

Select Jobscheduler or a desired project from the Job Selection window of the Systemwalker Operation Manager
window.

Figure 6.1 Gantt Chart window

Date Setting:

Specifies the date of information to be displayed in the Gantt chart. By clicking the Previous Day or Next Day on the
right of the date selection area can select the previous day or the next day of the currently displayed date.

- Selecting any past date displays the history information in the Gantt chart.

- No future date can be specified.

- The date cannot be specified if the master information folder or the operation change information folder has been
selected.

Name:

Displays the job net name or the group name. The job nets registered in groups are classified in groups and displayed
just after the group. If Child Job Nets in the View menu is selected, the child job nets and linked job nets of the second
layer or lower will be displayed together immediately after the first layer.

Double-clicking the name displays the Monitor Job Net window or the Monitor Group window. If the history
information is displayed, the Job History window will appear.

Status:

Displays the job net status with color coding.
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Condition:

Displays the execution progress of the jobs in the job net.

Gantt Chart:

Displays today's execution results and startup schedule in a time chart.

Update time:

This is the system time when the information was updated. However, if a virtual time is set, the update time becomes
the virtual time.

 
Indications on the time chart and status field

- Specifying a past date displays the history information in a chart.

- Up to 24 results of today's execution are displayed. When a past date is specified by using such as Previous Day, all the
execution results of that day will be displayed. However, execution schedules, log information and execution results for
the current day will not be displayed if either the master information folder or the operation change information folder
is selected.

- The length of the result part graph indicates the actual execution time of the job net.

- The length of the graph of the startup schedule and under-execution parts indicates the previous actual execution time of
the job net.

- The estimated execution time of the job net to be executed for the first time is shown as 15 minutes.

- If the current day is specified as any startup date, the job nets with Start at the time of server startup or Start only when
message event has occurred specified as the execution condition are also displayed.

- If no job net startup schedule is specified, the progress field is indicated in the color showing the previous end status of
the job net.

- If a project is selected, only information on that project is displayed.

- When information on the current date is displayed, the information is refreshed to the latest information in a certain
interval.

 

 Note

While the history information is displayed, you cannot display the Monitor Job Net window or operate on job nets.

 

 Information

Display of child job nets and linked job nets with the "Valid only on startup days" setting (when Child Job Nets is selected
in the View menu)

The child job nets or linked job nets that are not set to start up on the day are not displayed, except when they are forced to
start up by the start/restart operation. The child job nets or linked job nets registered in the job nets that have been in
"abended", "canceled", "carried-over", "paused" or "waiting for execution" status, since the previous day or earlier, are
displayed using the startup days for the previous day or earlier.

Even when the startup day of a child job net or linked job net is changed after startup of the parent job net, the change is not
reflected in the Gantt chart. The Gantt Chart display is based on the startup day immediately before the startup of the parent
job net.

 
The Job List window

The Job List window displays the following information for the selected job net.
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- Current status

- Scheduled startup time

- Estimated end time or estimated stop time

- Previous execution start time and end time

- Constituent job list/Previous execution start time

 
Procedure

- Displaying the Job List window

Select a job net from the Job Selection window of the Systemwalker Operation Manager window.

The screenshots below show the Job List window in two different cases, first when a job net other than child job nets and
linked job nets is selected, and then when a child job net or linked job net is selected.

Figure 6.2 Job List window (when a job net other than child job nets and linked job nets is selected)

Project name:

The project name where the job net is registered.

Group comment:

The group comment where the job net is registered.

Job net name:

The registered job net name.
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Job net comment:

The registered job net comment.

Scheduled time:

The date and time on which the next startup is scheduled.

Estimated end time:

The estimated end date and time of the specified job net.

Estimated stop time:

For the job nets with the Interstage attribute, the estimated end time is indicated as the estimated stop time. This is the
estimated time at which the job net with the Interstage attribute will be terminated by the Jobscheduler. Since it is
applied to the manually-started job net as well, it may be before the scheduled startup time.

Start time:

The date and time on which the previous execution has been started.

End time:

The date and time on which the previous execution has been completed.

Message:

The message generation status. One of the following strings will be displayed:

All message events for this job net have occurred:

All the message events have occurred.

Some message events for this job net have occurred:

Some of the message events have occurred.

No message events for this job net have occurred:

No message events have occurred.

No:

The job net is not waiting for any message events.

A character string indicating the system's ability to receive messages is displayed in the Message section. This string
will appear unless No is displayed in the Message section.

Able to receive messages:

Messages will be received.

Unable to receive messages (because today is not a startup day):

Messages will not be received because no run is scheduled for today.

Unable to receive messages (because the job net is running):

Messages will not be received because the job net is running.

Unable to receive messages (because the job net is in a warning state):

Messages will not be received because the job net is in a warning state.

Unable to receive messages (because the job net has not been confirmed):

Messages will not be received because the job net has not been confirmed.

Unable to receive messages (because the job net has been disabled):

Messages will not be received because the job net has been disabled.

Unable to receive messages (because the job net is a "once a day" job net and it has already run once
today):

Messages will not be received because the job net is a "once-a-day" job net that has already run once. If the
execution conditions are both Start only when message event has occurred and Once in a day, or both Execute at
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(single startup) and Wait for startup time, this message will be displayed when all messages have occurred and
the job net has been started.

Unable to receive messages (because the job net is treated as master information or operation changes):

Messages will not be received because the definition information of the job net is associated with master
information or operation change information.

Unable to receive messages (because the job net uses "@.VPARAM@" definitions):

Messages are normally received if "Valid during job net execution" is specified and the status of a job net is
"Executing", "End delayed", "Warning" or "Paused", but they will not be received in this case because
"@.VPARAM@" is being used.

Event Details:

Displayed when Message is set to All message events for this job net have occurred, Some message events for this
job net have occurred or No message events for this job net have occurred. Clicking this button displays the Message
Event List window.

Execution condition:

The execution conditions for the job net.

Execution attribution:

The execution attribute for the job net.

Status:

The current status. "(Confirmation required)" is displayed when the job net is "Abended" or "Canceled" while the
confirmation operation is enabled.

Job List:

Lists the jobs which belong to the job net.

Job Name:

The job name. The job name will be displayed depending on the job net execution attribute.

[Windows version]

- For the " Job Execution Control" attribute:

Displays the job name. When no job name is specified, the command name will be displayed.

- For the "Interstage" attribute:

Displays the work unit name.

[UNIX version]

- For the " Job Execution Control" attribute:

Displays the job name. When no job name is specified, the command name will be displayed.

- For the "PowerAIM" or "Interstage" attribute:

Displays the work unit name.

- For the "Compatible with the earlier versions (Normal)" attribute:

Displays the command name.

Type:

The type of the job.

Status:

The current status.

Start time:

The date and time on which the previous execution has been started.
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End time:

The date and time on which the previous execution has been completed.

Code:

Displays the code of the previous execution.

 

 Information

If verification is enabled in the Advanced Settings for Verification window and a job net abends or is canceled,
(Confirmation required) will be displayed in the Status field.

Figure 6.3 Job List window (when a child job net or linked job net is selected)

Project name:

The project name where the job net is registered.

Parent job net comment:

The job net comment for the parent job net where the job net is registered.

Job net name:

The registered job net name.

Job net comment:

The registered job net comment.

Scheduled time:

Nothing is displayed.
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Estimated end time:

The estimated end date and time of the specified job net.

Start time:

The date and time on which the previous execution has been started.

End time:

The date and time on which the previous execution has been completed.

Message:

Always displayed as "No".

Execution condition:

Always displayed as "None".

Execution attribution:

"Job Execution Control" is always displayed.

Status:

The current status.

Job List:

Lists the jobs which belong to the job net.

Job Name:

Displays the job net comment.

Type:

The type of the job.

Status:

The current status.

Startup time:

The date and time on which the previous execution has been started.

End time:

The date and time on which the previous execution has been completed.

Code:

Displays the code of the previous execution.

 

 Note

Even when the current job status is "Abended" or "Canceled", "(Confirmation required)" is not displayed in the following
cases:

- When the job net belongs to a group.

- When the job net is a child job net.

- When the job net is a linked job net.

 
The Job Net Management window

The Job Net Management window displays the following information on the job nets that can be browsed by client-connected
users.

- Current status
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- Scheduled startup time

- Previous execution start time and end time

Display targets can be filtered by setting the job net name, job name, execution condition, and status. Specify the filtering
conditions in the Job Net Filtering Conditions window.

 
Procedure

- Displaying the Job Net Management window

Select Job Net Management from the Tools menu of the Systemwalker Operation Manager window.

Figure 6.4 Job Net Management window

Job net comment:

The registered job net comment.

Job net name:

The registered job net name.

Remarks:

The contents of the job net memo.

Status:

The current status. The status can be displayed using either text or colors.

Project name:

The name of the project where the job net is registered.

Scheduled time:

The next scheduled startup date and time.

Estimated end time:

The estimated end date and time of the job net.

Start Time:

The date and time on which the previous execution has been started.

End time:

The date and time on which the previous execution has been completed.
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Execution condition:

The execution condition of the job net.

Message:

Whether to wait for a message event occurrence as the execution condition.

Group comment/Parent job net comment:

The group comment where the job net is registered. For child job nets and linked job nets, the job net comment for
the parent job net will be displayed.

 

 Note

Remarks are not displayed if the destination server is in any of the following versions:

- Versions V10.0L21 or before [Windows version]

- Versions V10.1 or before [UNIX version]

 
Displaying the Job Selection window

If the Jobscheduler functions have been selected from the Systemwalker Operation Manager window, you can rearrange and
refresh the job selection tree.

- Rearranging the Job Selection window

Select Sort Tree from the View menu of Systemwalker Operation Manager window, and select by Entry or by Name. If
you have selected the by Name, job nets are rearranged in the ascending order of Job net comment. Also, groups are
rearranged in the ascending order of Group comment.

- Refreshing the Job Selection window

Select Refresh Tree from the Tools menu of the Systemwalker Operation Manager window. The job selection tree will
be updated with the latest information.

 

 Note

If you have registered a large number of job nets and groups, the refresh time of the Job Selection window may increase.

When Jobscheduler in the job selection tree takes time to display

If a large number of job nets and groups are registered, displaying Jobscheduler in the job selection tree of the Operation
Manager client may take time.

Choosing just one of the projects you want to display from Jobscheduler in the job selection tree may improve the display
performance of the job selection tree.

Refer to "A.3.9 Restricting Jobscheduler display in the job selection tree" for information on how to change the display
mode.

6.2 Monitoring Scheduled Jobs
Scheduled jobs (jobs that have been registered in the Jobscheduler) can be monitored using either Previous process result
sheet of the Monitor Job Net window, or the Job List window.

The configuration of a job net that contains child job nets or linked job nets, for which startup days have been specified, is
displayed in the Process flow sheet of the Monitor Job Net window.

The following describes the contents displayed in each window.
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Previous process result sheet of the Monitor Job Net window

The Job Flow area in the Previous process result sheet of the Monitor Job Net window indicates the job status using color
coding. For the job nets under execution, the current status of the jobs are displayed. For the job nets which are waiting for
execution or completed, the completion results of the previous execution are displayed. In the case of restarting, whether job
nets are included in the target of startup can be identified. However, when a job net is started for the first time, the
configuration of the started jobs is displayed.

If restart point, recovery or execution conditions are specified for the job using the Control information sheet of the Add/
Change-Job window, arrows or diamond-shaped symbols are displayed respectively. For child job nets or linked job nets that
have the Valid only on startup days setting and are not started up, status frames are displayed as pin-only icons framed by
dotted circles.

If animation is enabled, jobs and job nets whose status is "Executing", "Warning" or "Abended" will be shown animated.

Detailed information on the jobs displayed in this window can be browsed using the Monitor-Job window. The Start time,
End time, End code and Description as well as the contents of the standard output and the standard error output at the previous
execution are displayed in the Previous log sheet of the Monitor-Job window.

For details on the status of jobs, see "14.1.1 Job Status".

 
Procedure

1. Displaying the Previous process result sheet of the Monitor Job Net window

- Double-click the desired job net in the Job Selection window of the Systemwalker Operation Manager window,
or select the desired job net and select Open from the File menu (or select Open from the pop-up menu displayed
by right -clicking.

- Select Job Net Management from the Tools menu of the Systemwalker Operation Manager window. Double-click
the desired job net in the Job Net Management window, or select the desired job net and select Job Net Monitoring
from the Tools menu (or select Job Net Monitoring from the pop-up menu displayed by right-clicking).
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- Select Previous process result sheet from the Monitor Job Net window.

Figure 6.5 Monitor Job Net window - Previous process result sheet

 

 Information

Perform the following operations to display the Monitor Job Net window for the child job net or linked job net from the
Monitor Job Net window of the parent job net.

- Select the desired child job net or linked job net from the Monitor Job Net window for the parent job net, then select
Jobflow from the File menu (or right-click and select Jobflow from the pop-up menu displayed).
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2. Displaying the Monitor-Job window

Double-click the job to be monitored in the Monitor Job Net window, or select the desired job and select Properties
from the File menu (or select Properties from the pop-up menu displayed by right-clicking).

Figure 6.6 Monitor-Job window - Previous log sheet

Previous log sheet:

Displays the history information for the previous execution.

Start time:

The date and time on which the previous execution has been started.

End time:

The date and time on which the previous execution has been completed.

Code:

The code for the previous execution.
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If the actual completion code for jobs in job nets (where the execution attribute is either the Job Execution
Control attribute or the Interstage attribute) is 256 or more, the value for the actual completion code will be
displayed as below. However, this will not be displayed for child job nets or linked job nets.

255 (actual completion code)

Description:

When the job is in the completed status, the meaning of Code is explained here. However, this will not be
displayed for child job nets or linked job nets.

Job net variable:

Displays the job net variable, and parameter information specified for startup with variable parameters.

Job result (Standard output or standard error output):

Displays the Default log or default error log for the previous execution.

Nothing is displayed in the following cases:

- When the job net is a child job net.

- When the job net is a linked job net

- When the job net is disabled and skipped.

- When the job is in the Canceled status (only when the execution attribute is Normal)". [UNIX version]

Copy All button:

Copies all the contents displayed as the output data.

Font button:

Displays the Font dialog box.

 
Process flow sheet of the Monitor Job Net window

The Process flow sheet of the Monitor Job Net window shows the job net configuration information. For job nets containing
child job nets or linked job nets for which Valid only on startup days has been specified, this can be used to determine whether
the job net will start if the startup conditions are met, or if a startup operation is performed.

 
Procedure

Display the Process flow sheet of the Monitor Job Net window as follows:

- In the Job Selection window from the Systemwalker Operation Manager window, double-click the target job net or select
the target job net and select Open from the File menu (alternately, right-click the mouse on the target job net name and
select Open from the pop-up menu).

- In the Tools menu of the Systemwalker Operation Manager window, select Job Net Management to open the Job Net
Management window, and double-click the target job net or select the target job net and select Job Net Monitoring from
the Tools menu (alternately, right-click the mouse on the target job net name and select Open from the pop-up menu).
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- Select Process flow sheet from the Monitor Job Net window.

Figure 6.7 Monitor Job Net window - Process flow sheet

 
The Job List window

The Job List window displays a list of the jobs contained in the selected job net and the start date and time, the end date and
time and the code of previous execution.

 
Procedure

- Displaying the Job List window

Select a job net from the Job Selection window of the Systemwalker Operation Manager window.

For display examples of the Job List window, see "The Job List window" in "6.1 Monitoring Job Nets."

6.3 Monitoring Demand Jobs
The execution status of demand jobs submitted under Job in the Job Selection window of the Systemwalker Operation
Manager window is displayed in the View Job Status/Operate window. The View Job Status/Operate window displays a list
of jobs including scheduled jobs. Detailed information on any of these jobs are displayed in the View Job Details dialog box.
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Procedure

1. Displaying the View Job Status/Operate window

Select Jobs from the Job Selection window of the Systemwalker Operation Manager window. The View Job Status/
Operate window will appear in the main window.

Figure 6.8 View Job Status/Operate window

User Name:

Either the administrative user who has called the Systemwalker Operation Manager window or All Users can be
selected. If All Users is selected, the job information of all users will be listed.

If the Extended User Management function is valid in the UNIX system and if the Operation Manager user is
specified, the job information of the OS user which is associated with the specified Operation Manager user is
listed. In addition to the information on the specified Operation Manager user, the job information of all Operation
Manager users associated with this OS user is listed.

Job Name:

Displays the job name and job status.

Job Number:

Displays the job number.

Status:

Displays the job status. The job statuses are as follows.

Waiting/Holding/Executing/Output held
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Queue:

Displays the queue name with jobs.

Host Name:

For a job being executed, the host name of the server on which the job is executed is displayed. For a job not being
executed, nothing will be displayed.

User Name:

Displays the name of the user who has submitted the job. For the scheduled job, the user who has executed the job
will be displayed.

If the Extended User Management function is valid in the UNIX system and if the Operation Manager user submits
a job, the OS user name associated with this Operation Manager user is displayed.

Elapsed Time:

For a job being executed, the elapsed time from the execution start time is displayed. For a job not being executed,
nothing will be displayed.

The order of the jobs in the list in the View Job Status/Operate window can be changed to the following (ascending)
order. Select any of the following in the View menu >> Sort Jobs or Sort Jobs from the pop-up menu. Selecting the same
item again aligns in the descending order.

by Job Name:

Aligns in the order of job names (in alphabetical order).

by Job Number:

Aligns in the ascending order of job numbers.

by Queue Name:

Aligns in the order of queue names.

by Status:

Aligns in the order of job status. The order is as follows.

Executing >> Waiting >> Holding >> Output held

by Host Name:

Aligns in the order of host names.

by Submit User:

Aligns in the order of submitters.

by Elapsed Time:

Aligns in the order of elapsed time.
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2. Displaying the View Job Details dialog box

Select the desired job from the View Job Status/Operate window, then select Open from the File menu (or select Open
from the pop-up menu displayed by right-clicking).

Figure 6.9 View Job Details dialog box

Job Name:

Displays the job name.

Job Number:

Displays the job number.

Project Name:

If the job is a scheduled job, the project name will be displayed. If it is a demand job, nothing will be displayed.

Job Net Name:

If the job is a scheduled job, the job net name will be displayed. If it is a demand job, nothing will be displayed.

Status:

Displays the job status (Waiting/Holding/Executing/Output held).

Execution Priority:

Displays the execution priority ranking of the job.

Dispatch Priority:

Displays the dispatch priority of the job.
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Submitted On:

Displays the submission date and time of the job.

Submitted From:

Displays the name of the host which has submitted the job.

User Name:

Displays the user who has submitted the job.

Started On:

Displays the start date and time of the job.

Execution Server:

Displays the execution server of the job.

Execution Queue:

Displays the execution queue name of the job.

End time:

Displays the end date and time for a job in the Output held status.

Code:

Displays the code for a job in the Output held status.

 

 Information

When monitoring jobs from the server side, use the qjstat command. For details of the command, see the Systemwalker
Operation Manager Reference Guide.

 

 Note

For distributed execution jobs or network jobs, the submitting host name is displayed in the Host Name of View Job Status/
Operate window until the execution request to the execution server is complete. When the request has completed, the host
name of the actually executing server is displayed.

6.4 Monitoring Multiple Servers
It is possible to monitor job net status on multiple servers using the Multi-server Monitoring window on the multi-server
monitoring client. This window displays the total number of job nets starting on the current day, sorted by status and by server.
Any change in the server or job net status will be output to the monitoring window as a status message. It is also possible to
monitor in the unit of server groups or multiple subsystems. Batch monitoring of job nets on multiple servers is also possible.

More than one monitored host definition can be registered. It is also possible to switch the monitored host definitions while
the multi-server monitoring client is running.

The following provides the Multi-server Monitoring window as follows.

- Procedure for Monitoring Multiple Servers

- Confirming Details by Connecting to the Server to be Monitored

- Setting Filtering Conditions for the Server to be Monitored

- Batch Monitoring the Job Nets on Multiple Servers
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6.4.1 Procedure for Monitoring Multiple Servers
Start the multi-server monitoring client, and monitor multiple servers from the Multi-server Monitoring window. The
following describes procedure to start up the multi-server monitoring client.

 
Procedure

1. Displaying the Multi-server Monitoring (Login) window

Select Start/App >> Systemwalker Operation Manager >> Multi-server Monitoring.

2. Displaying the Select Monitored Host Tree window

In the Multi-server Monitoring (Login) window, specify the destination host name, user ID and its password, then click
Login. When the Select Monitored Host Tree window appears, select the Monitored host configuration name and click
OK.

If the monitored host definition is only "DEFAULT," the Select Monitored Host Tree window is not displayed.

Figure 6.10 Select Monitored Host Tree window

Monitored host configuration name:

The registered monitored host definitions are displayed in the combo box. Select a monitored host definition you
want to monitor.

For registration of monitored host definition, see the Systemwalker Operation Manager Installation Guide.
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3. Displaying the Multi-server Monitoring window

The multi-server monitoring client is started up displaying the Multi-server Monitoring window.

Figure 6.11 Multi-server Monitoring window

Monitored host configuration name:

The combo box displays the monitored host definitions. The monitoring target can be switched by selecting one of
the monitored host definitions registered here.

Name (Host summary pane):

The display name of the server or server group to be monitored. When a host is selected in the host tree, the
subsystem on the host is displayed in the form of "Display name: Subsystem number."

Status:

Displays the status of the server group or the server to be monitored with color coding.

If the server group or the server to be monitored operates on multi-subsystem operation, the status of the subsystem
will be displayed with color coding.

Condition:

Displays the execution progress of the job net in the following format.

"Total number of already-executed job nets/Number of job nets scheduled to be executed"

Abended - Confirmed:

Displays the number of job nets in each status. If one or more job nets are in Abended, Warning, Start delayed, End
delayed or Carried over status, they will be indicated in red. Note that information about job nets in projects to
which the user does not have access privileges will not be collected.
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Time:

Displays the client date and time on which the status message is output.

Name (Status message list):

Displays the server name to be monitored for which the status message is output. It is displayed in the form of
"Display name: Subsystem number." If not operating on multi-subsystem operation, the subsystem number will be
indicated as zero.

Message:

Displays changes in the server status or the job net status number as messages.

 

 Information

Structure of the Multi-server Monitoring window

The Multi-server Monitoring window consists of the following three sub windows.

- Host tree (upper-left part)

Displays a tree structure of the server and server group of the selected monitored host definition.

- The Host summary pane (upper-right part)

Lists the status of the job nets under the node selected in the host tree and the server and the server group to be monitored.
When a host is selected in the host tree, the status of the job nets on that host is displayed in the subsystem units.

- Status message list (bottom part)

Displays a status message when the status number of job nets has increased or the server status has changed after refresh.

 

 Note

- To monitor multi-servers, monitoring permitted host must be defined in the environment definition for each server to be
monitored.

- Up to 62 servers can be monitored. If the number of servers exceeds 62, it will be indicated as "Not running" or
"Requesting" and cannot be monitored. Note that one subsystem is counted as one server.

- If the upper limit value of the Jobscheduler servers specified with Warn at jobnet registration count in the Use function2
sheet of the Define Jobscheduler Startup Parameters window is exceeded, "Access denied" will be displayed and the
server will not be able to be monitored.

- The monitored host definition cannot be switched while the Job Nets Management window is displayed.

- If switching of monitored host definition failed due to shutdown of the monitoring server, etc., the operation cannot be
continued any more. The multi-server monitoring client should be terminated for the present.

- When a connection to a monitored server is made, authentication processing is performed using the user ID and password
for the user that has logged in to the monitoring server. Therefore, to log in to the monitoring server as a general user and
obtain information from the monitored server, register the same user ID and password on the monitored server (as was
used to log in to the monitoring server).
When logging in as a general user, the user ID and password cannot be omitted. If the user ID and password are omitted,
the monitored server will normally deny access.

6.4.2 Confirming Details by Connecting to the Server to be
Monitored

To confirm details of the job nets on the server to be monitored or to take any action while multi-server monitoring is being
executed on the multi-server monitoring client, start up the Systemwalker Operation Manager client on the target server.
Multiple Systemwalker Operation Manager clients can be started up simultaneously.
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The following describes the procedure. The item numbers in the figure correspond to the steps 1 to 4.

 
Procedure

1. Starting up the Systemwalker Operation Manager client on the server to be monitored

Start up the Systemwalker Operation Manager client using the following procedure.

- From the host selection tree of the Multi-server Monitoring window

Select the server to be monitored, then select Start Operation Manager Client or Start Operation Manager Client
as Specified User from the Tools menu. Or, right-click the server to be monitored and select Start Operation
Manager Client or Start Operation Manager Client as Specified User from the pop-up menu.

- From the host summary display area of the Multi-server Monitoring window

Select the server to be monitored, then select Start Operation Manager Client or Start Operation Manager Client
as Specified User from the Tools menu. Or, right-click the server to be monitored and select Start Operation
Manager Client or Start Operation Manager Client as Specified User from the pop-up menu.

If displayed in the subsystem units, it is possible to connect to the subsystem by directly selecting it with a double-
click.
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- From the status message list of the Multi-server Monitoring window

Select the status message, then double-click it or select Start Operation Manager Client or Start Operation Manager
Client as Specified User from the Tools menu. Or, right-click the status message and then select Start Operation
Manager Client or Start Operation Manager Client as Specified User from the pop-up menu.

- From the Job Nets Management window

Select the job net from the job net information list, then double-click or select Monitor Job Net from the Tools
menu. Or, select Monitor Job Net from the pop-up menu.

2. Connecting to the server to be monitored

Connect to the target server to be monitored with the same user ID and password as are used to connect to the
monitoring server currently connected to execute authentication.

If the same user ID is used for the monitoring server and the monitored server:

After authentication, connection to the target server will be established.

If different user IDs are used for the monitoring server and the monitored server:

The Enter Password of Connected Host window will be displayed. Enter a user ID and password that are permitted
on the monitored server to connect to the server.

If Start Operation Manager Client as Specified User is selected, the Enter Password of Connected Host window will
appear. Enter an appropriate user ID and password to connect to the target server.

Figure 6.12 Enter Password of Connected Host window

User ID:

Specify the ID of the user to connect to the server.

Password:

Specify the password for the user ID that was specified in the User ID field.

3. Specifying subsystem connection

If the target server operates multiple subsystems, the Specify Subsystem Connection window will appear after
authentication. Specify the subsystem number to connect.
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Subsystem number:

Specifies the subsystem number.

4. Displaying the Gantt Chart or Monitor Job Net window

If the Systemwalker Operation Manager client is started up from the Multi-server Monitoring window, the Gantt Chart
window will appear. If started up from the Job Nets Management window, the Monitor Job Net window will appear.

Investigate the job nets and solve problems if any in these windows.

 

 Information

Second and subsequent connection attempts to a monitored server where the user ID does not match

The user ID and password that are used to connect to the first server after the multi-server monitoring client has started will
be saved until the multi-server monitoring client is restarted. Accordingly, for the second and subsequent connections to
monitored servers with different user IDs, authentication processing will be performed automatically using the user ID
information that has been saved. In this case, the Enter Password of Connected Host window (the above procedure 2) will not
appear.

However, if Start Operation Manager Client as Specified User has been selected or the multi-server monitoring client has
been restarted, the user ID and password must be entered again.

 

 Information

Displaying the monitored server name

When the Systemwalker Operation Manager client on the monitored server is started from the multi-server monitoring client,
the names of the servers (monitored server names) displayed in both windows below may be different:

- Name of the monitored server on the multi-server monitoring client's Multi-server Monitoring window

- Name of the server displayed as Connected host name: in the monitored server's Systemwalker Operation Manager
window

If you wish to make the server names the same, you must match the display names in the respective monitored host definitions
on the monitoring server and the monitored server. Refer to "Information - Monitored host definitions when performing
multi-server monitoring" in "Defining the Monitored Host in Systemwalker Operation Manager" in the Systemwalker
Operation Manager Installation Guide for details.

6.4.3 Setting Filtering Conditions for the Server to be Monitored
It is possible to filter the status message list to be output to the status message list in the Multi-server Monitoring window.
Two levels of filtering can be applied to the messages to be displayed.

- Filtering to the Server status or Job net status tab
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- Filtering to the Filtering condition 1 to Filtering condition 5 tabs

 
Filtering to the server status or job net status tab

The status message to be output to the Server status tab and the Job net status tab can be limited by specifying filtering
conditions. The messages matching the conditions are output to the Server status or the Job net status tab.

As default, the following status messages are output.

Job Net Status tab:

Abended/Warning/Canceled/Paused/Start delayed/End delayed/Carried over

Server Status tab:

All server statuses

Procedure

1. Displaying the Message Filter Settings window

Select Message Filter Settings from the Options menu of the Multi-server Monitoring window.
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2. Setting filter condition

Specify conditions and click OK.

Figure 6.13 Message Filter Settings window

Filter job net status:

Specify the job net status to be output.

- Select Status button:

Displays the Select Status window. Select the job net status to be output.

- Conditions:

Displays the job net conditions selected in the Select Status window.

Filter server status:

Specify the server status to be output.

- Select Status button:

Displays the Select Status window. Select the server status to be output.

- Conditions:

Displays the server conditions selected in the Select Status window.

 
Filtering to the Filtering condition 1 to Filtering condition 5 tabs

The messages output to the Server status tab and the Job net status tab can be further filtered to the Filtering condition 1 to
Filtering condition 5 tabs by specifying desired monitoring conditions. The messages matching the conditions will be
displayed in the Filtering condition 1 to Filtering condition 5 tabs.

Procedure

1. Displaying the Filtering Conditions for Status Messages window

Select Filter Status Messages from the View menu of the Multi-server Monitoring window.
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2. Specifying filtering conditions

Specify the filtering conditions in the Filtering Conditions for Status Messages window.

Figure 6.14 Filtering Conditions for Status Messages window

Select a tab:

Selects a tab on which the filtering conditions are to be set.

Condition tab name:

Specifies the name of the tab selected in Select a tab.

Enable filtering conditions:

Use this option to set the filtering conditions. It is not possible to select Filter job net status and Filter server status
at the same time.

Filter job net status:

Specifies the filtering conditions for job nets.

- Select Status button:

Displays the Select Status window. Specify the filtering conditions.

- Conditions:

Displays the display conditions for the job net status selected in the Select Status window.

Filter server status:

Specifies the filtering conditions for server.

- Select Status button:

Displays the Select Status window. Specify the filtering conditions.

- 278 -



- Conditions:

Displays the display conditions for the server status selected in the Select Status window.

Select host:

Use this option to specify the host name.

Host Name:

Displays the server to be monitored specified in the Select Host window.

Select Host button:

Displays the Select Host window.

Specify the time period:

Specifies a time range for the filtering condition.

3. Displaying the Select Status window

After selecting Filter job net status or Filter server status in Select Status, click the Select Status button.

4. Setting status

Specify the filtering conditions. If Filter job net status is selected in Select Status, a list of job net statuses will be
displayed. If Filter server status is selected in Select Status, a list of server statuses will be displayed.

Figure 6.15 Select Status window

Status List:

Specifies one or more filtering conditions. Multiple conditions can be selected.
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5. Setting the server to be monitored

When you click the Select Host button, the Select Host window appears. Specify the server to be monitored.

Figure 6.16 Select Host window

Host Name:

Displays the list of servers to be monitored in the subsystem units.

Subsystem number:

Displays the subsystems under the server to be monitored.

Clicking a title sorts by number.

6.4.4 Batch Monitoring the Job Nets on Multiple Servers
It is possible to monitor job nets on multiple servers using the Job Nets Management window.

The following describes the Job Nets Management window.

 
The Job Nets Management window

It is possible to specify filtering conditions for job nets on multiple servers and monitor related job nets in a batch.

This window also lets you operate job nets on multiple servers in a batch. For details on batch operation, see "7.3 Batch
Process of Job Nets Management on Multiple Servers".
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Procedure

1. Displaying the Filtering Conditions for Job Nets Management window

In the Multi-server Monitoring window of the multi-server monitoring client, select the Job Nets Management from the
Tools menu. Specify the conditions to filter job nets to be displayed in the Job Nets Management window.

Figure 6.17 Filtering Conditions for Job Nets Management window

Condition name:

Specify the title of a character string which is used to save the filtering conditions. Specify with a string of 64 bytes
or less.

Read button:

Displays the Filtering Conditions window.

Select Host button:

Displays the Select Host window.

Host Name:

Displays the condition specified in the Select Host window.

Project Name:

Specifies a project name for filtering condition.

Job Net Name:

Specifies a job net name for filtering condition.

Job net comment:

Specifies a job net comment for filtering condition.
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Remarks:

Specifies a memo for filtering condition.

Select Status button:

Displays the Select Status window.

Job net status:

Displays the filtering conditions specified in the Select Status window.

Number of job nets to obtain for a host:

Specifies the number of job nets obtained per host.

Obtain button:

Obtains the list of job nets with the specified conditions.

Save and Obtain button:

Obtains the list of job nets after saving the specified conditions.

2. Reading the filtering conditions

To specify an already-saved filtering condition, click the Read button. When the Filtering Conditions window appears,
specify the desired filtering condition and click OK.

Figure 6.18 Filtering Conditions window

Filtering Conditions:

Displays the list of filtering conditions that have been saved.

Condition name:

Displays the titles of filtering conditions that have been saved.

Host Name:

The host name to be filtered.

Project Name:

The project name to be filtered.
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Job Net Name:

The job net name to be filtered.

Job net comment:

The job net comment to be filtered.

Remarks:

The memo to be filtered.

Job net status:

The job net status to be filtered.

Number of job nets to obtain for a host:

The number of job nets to be obtained per host.

3. Setting the server to be monitored

When you click the Select Host button, the Select Host window appears. Specify the server to be monitored in the
Select Host window.

Figure 6.19 Select Host window

4. Filtering the job net status

Clicking the Select Status button displays the Select Status window. Then specify the filtering conditions to filter the
job nets to be displayed in the Job Nets Management window.

Figure 6.20 Select Status window
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5. Displaying the Job Nets Management window

Clicking OK in the Filtering Conditions for Job Nets Management window displays the job nets filtered with the
specified conditions in the Job Nets Management window.

Figure 6.21 Job Nets Management window

Job Net Information:

Lists the information related to the job net. Note that job net information relating to projects that the user is not
permitted to access will not be retrieved or displayed.

Job net comment:

The Job net comment.

Host Name:

The name of the server to be monitored.

Remarks:

The job net memo.

Job Net Name:

The Job net name.

Project Name:

The name of the project where the job net is registered.

Status:

The current job net status.

Scheduled time:

The next scheduled startup date and time.

Estimated end time:

The estimated schedule end date and time. If the execution attribute is "Interstage," it is indicated as the
estimated stop time.

Startup time:

The date and time on which the previous execution has been started.
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End time:

The date and time on which the previous execution has been completed.

Execution conditions:

The execution condition of the job net.

Message:

Whether to wait for a message event occurrence as the execution condition.

Group comment/Parent job net comment:

The group comment where the job net is registered. For child job nets or linked job nets, the parent job net
comment will be displayed.

Filtering condition text box:

Displays the filtering conditions specified in the Filtering Conditions for Job Nets Management window.

Status text box:

Displays status messages in such cases as an error while obtaining information, or the obtainable number exceeded.

Line(s) text box:

Displays the number of lines existing in the list.

 

 Note

- The number of job nets that can be obtained for each server to be monitored in the Job Nets Management window is the
number specified as Number of job nets to obtain for a host in the Filtering Conditions for Job Nets Management window.
The job net information exceeding it will not be displayed.

- If the job net information cannot be obtained in the Job Nets Management window even after three minutes from the start
of communication with the server, a time out will occur.

- A general user with registration and reference rights cannot manipulate job nets from the Job Nets Management window.

6.5 Monitoring Groups
Groups can be monitored using the windows listed below.

- The Gantt Chart window

- The Monitor Group window

- The Job Net List window

- The Group Management window

The following describes each window.

 
The Gantt Chart window

This window displays the current status of groups using color coding.
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Procedure

- Displaying the Gantt Chart window

Select Jobscheduler or a desired project from the Job Selection window of the Systemwalker Operation Manager
window.

Figure 6.22 Gantt Chart window

Date Setting:

Specifies the date of information to be displayed in the Gantt chart. By clicking Previous day or Next day on the right
of the date selection area, the previous day or the next day of the currently-displayed date can be selected.

- Selecting any past date displays the history information in the Gantt chart.

- No future date can be specified.

- The date cannot be specified if the master information folder or the operation change information folder has been
selected.

Name:

Displays the job net name or the group name. The job nets registered in groups are classified in groups and displayed
just after the group. Double-clicking the name displays the Monitor Job Net window or the Monitor Group window.
If the history information is displayed, the Job History window will appear.

Status:

Displays the group status with color coding.

Condition:

Not displayed for groups.
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Gantt Chart:

Displays today's execution results and startup schedule in a time chart.

Update time:

This is the system time when the information was updated. However, if a virtual time is set, the update time becomes
the virtual time.

 

 Note

Indications on groups

- No time chart (time range) is displayed.

- If the history information has been displayed in a chart by specifying a past date, no group information is displayed.

For details on the group scheduling, see "14.3.2 Group Scheduling Method."

 
The Monitor Group window

This window displays the current status of job net system making up the groups and each job net using color coding. If
animation is enabled, job nets whose status is "Executing", "Warning" or "Abended" will be shown animated.

Detailed information on any of the job nets displayed in this window can be browsed using the Monitor-Job net window. The
basic information on the job nets is displayed in the Standard information sheet. The start date and time, the end date and time
and the code of the previous execution of the job nets are displayed in the Previous log sheet.

 
Procedure

1. Displaying the Monitor Group window

- Select the desired group from the Job Selection window of the Systemwalker Operation Manager window, then
select Open from the File menu (or select Open from the pop-up menu displayed by right-clicking).

- Select Group Management from the Tools menu of the Systemwalker Operation Manager window. Double-click
the desired group in the Group Management window, or select the desired group and select Group monitoring from
the Tools menu (or select Group monitoring from the pop-up menu displayed by right-clicking).

Figure 6.23 Monitor Group window
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2. Displaying the Monitor-Job net window

Double-click the job net to be monitored in the Monitor Group window, or select the desired job net and select
Properties from the File menu (or select Properties from the pop-up menu displayed by right-clicking).

Figure 6.24 Monitor-Job net window - Standard information sheet

Job Net Name:

The registered job net name.

Job net comment:

The registered job net comment.

Execution time:

The registered start time.

Valid execution time:

Checked if the execution time is validated.

Message:

Displays the waiting conditions when message events are registered.
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Message event list:

The list of message events registered as job net execution conditions. The status of occurrence is also displayed.

Figure 6.25 Monitor-Job net window - Previous log sheet

Previous log sheet:

Displays the history information for the previous execution.

Start time:

The date and time on which the previous execution has been started.

End time:

The date and time on which the previous execution has been completed.

Code:

The code for the previous execution.

Job result (Default log or default error log):

Nothing is displayed.

 
The Job Net List window

This window displays the following information for the selected groups.
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- Current status

- Scheduled time

- Previous execution start time and end time

- List of the constituent job nets, current status, next scheduled startup date and time, start date and time of previous
execution and presence or absence of message waiting

 
Procedure

- Displaying the Job Net List window

Select a group from the Job Selection window of the Systemwalker Operation Manager window.

Figure 6.26 Job Net List window

Project Name:

The project name where the group is registered.

Group name:

The registered group name.

Group comment:

The registered group comment.

Scheduled time:

The date and time on which the next startup is scheduled.
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Start time:

The date and time on which the previous execution has been started.

End time:

The date and time on which the previous execution has been completed.

Status:

The current status. "(Confirmation required)" is displayed when the job net is "Abended" or "Canceled" while the
confirmation operation is enabled.

Job net list:

Displays the list of job nets registered in the group.

Job net comment:

The Job net comment.

Status:

The current status of the job net.

Scheduled time:

The date and time of the next scheduled startup.

Start time:

The date and time of the previous startup.

Message:

Whether to wait for a message event occurrence as an Execution condition.

- Yes:

A message event occurrence which is waited for an Execution condition is available.

- None:

No message event is registered.

 

 Information

If verification is enabled in the Advanced Settings for Verification window and a group abends or is canceled, (Confirmation
required) will be displayed in the Status field.

 
The Group List window

This window displays the following information for the groups that can be browsed by client-connected users.

- Current status

- Scheduled start time

- Previous execution start time and end time
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Procedure

- Displaying the Group Management window

Select Group Management from the Tools menu of the Systemwalker Operation Manager window.

Figure 6.27 Group List window

Group comment:

The registered group comment.

Group name:

The registered group name.

Project Name:

The name of the project where the group is registered.

Status:

The current status. This can be displayed with a character string or by a color.

Scheduled time:

The next scheduled startup date and time.

Startup time:

The date and time on which the previous execution has been started.

End time:

The date and time on which the previous execution has been completed.

 
Displaying the Job Selection window

If you have already selected the Jobscheduler functions from the Systemwalker Operation Manager window, you can
rearrange and refresh the job selection tree of the Job Selection window. For the procedure, see "Displaying the Job Selection
window" of the "Displaying the Job Selection window"

 

 Note

Changing the group if its scheduled time has passed
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If the startup conditions are not satisfied when the scheduled time has come and if a non-started group is changed, the group
and job nets of this group are rescheduled and the next scheduled time is set for them. (The previous scheduled time is
cleared.)

6.6 Monitoring Queues
When an error has occurred to a job or when job execution has been delayed after submission, the status of the submission
destination queue can be monitored. The status of each queue on the relevant server is listed in the View Queue Status/Operate
window. Detailed information on each queue is displayed in the View Queue Details dialog box.

 
Procedure

1. Displaying the View Queue Status/Operate window

Select Queue from the Job Selection window of the Systemwalker Operation Manager window. The View Queue
Status/Operate window will appear in the main window. This window lists the status of all the queues registered on the
relevant server.

Figure 6.28 View Queue Status/Operate window

Default queue name:

Displays the default queue.

All run jobs/System Max jobs:

Displays the total number of jobs currently executed and multiplexity of the whole system.
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Queue name:

Displays the queue name.

Status:

Displays the Active status (Active or Inactive) of the queue.

Max Execution Jobs:

Displays the multiplexity (number of jobs that can be executed simultaneously) of the queue.

Executing Jobs:

Displays the number of jobs being executed on the relevant queue.

Waiting Jobs:

Displays the number of jobs waiting to be executed on the relevant queue. The jobs being held are not included.

Host Group:

Displays the distribution destination host group name for the distributed execution queue. For other queues than the
distributed execution queue, nothing is displayed.

2. Displaying the View Queue Details dialog box

In the View/Operate Queue Status window, select the desired queue, then select Open from the File menu. The detailed
information on the queues can be browsed in the Details sheet, and the list of submitted jobs can be browsed in the Job
List sheet.

Figure 6.29 View Queue Details dialog box - Details sheet

Queue Name:

Displays the queue name.
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Queue Status:

Displays the queue status.

Default Execution Priority:

Displays the default execution priority ranking defined for the queue.

Default Execution Priority:

Displays the default execution priority defined for the queue.

Max Execution Jobs:

Displays the multiplexity (number of jobs that can be executed simultaneously) defined for the queue.

Max Submit Jobs:

Displays the number of jobs that can be submitted defined for the queue.

Time Lapse Limit:

Displays the elapsed time limit defined for the queue.

Executing Jobs:

Displays the number of running jobs.

Hold Jobs:

Displays the number of holding jobs.

Waiting Jobs:

Displays the number of waiting jobs.
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Total Jobs:

Displays the total number of jobs existing in the queue.

Figure 6.30 View Queue Details dialog box - Job List sheet

Job Name:

Displays the job name.

Job Number:

Displays the job number.

Execution Priority:

Displays the execution priority ranking.

 

 Information

Monitoring on the server

When monitoring queue from the server side, use the qstat command. For details of the command, see the Systemwalker
Operation Manager Reference Guide.

 

 Information

Changing the display order of the queue list

The order of the queue in the list in the View Queue Status/Operate window can be changed to the following (ascending)
order. Select any of the following in the View menu >> Sort Queues or Sort Queues from the pop-up menu. Selecting the same
item again aligns in the descending order.
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by Queue Name:

Aligns in the order of queue names (in alphabetical order).

by Status:

Aligns in the order of Active >> Inactive.

by Max Execution Jobs:

Aligns from the high multiplexity.

by JobsRun:

Aligns in the order of the current number of execution jobs.

by JobsQueue:

Aligns in the order of the current number of waiting jobs.

by Host Group:

Aligns in the order of host group names.

6.7 Reference Information Relating to Job Monitoring
This section explains the following useful functions for monitoring jobs.

- Automatic Update Interval for Window Displays

- Displaying the Connection Destination Host Name

- Automatic Gantt Chart Scrolling

6.7.1 Automatic Update Interval for Window Displays
The following windows are automatically updated with the latest information at fixed intervals. The following table shows
the default refresh intervals for each window.

 
Window title Refresh interval

Gantt Chart window
Job Net Management window
Job Nets Management window
Monitor Group window
Group Management window
Multi-server Monitoring window

5 minutes

Monitor Job Net window 60 seconds

The refresh interval can be changed as follows:

 
For the Gantt Chart, Job Net Management, Monitor Group, and Group Management windows

You can change the refresh interval. To do so, select Auto Update Interval from the View menu, and specify the desired
interval in the Specify Auto Update Interval window. Any changes made in this way will be applied to all servers.
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Figure 6.31 Specify Auto Update Interval window

Auto Update Interval:

Specifies the refresh interval. The value must be within the range of 1 to 1440 minutes.

 
For the Monitor Job Net window

You can change the refresh interval. To do so, select Auto Update Interval from the View menu, and specify the desired
interval in the Specify Auto Update Interval window. Any changes made in this way will be applied to all servers.

Figure 6.32 Specify Auto Update Interval window

Auto Update Interval:

Specifies the refresh interval. The value must be within the range of 10 to 60 seconds.

 
For the Multi-server Monitoring and Job Nets Management windows

Select Specify Auto Update Interval from the Options menu of the window to be changed, and make the changes using the
Specify Auto Update Interval window that is then displayed.

Figure 6.33 Specify Auto Update Interval window
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Auto Update Interval:

Specifies the refresh interval. The value must be within the range of 1 to 1440 minutes.

 

 Information

Suppressing the display of Specify Auto Update Interval window

You can suppress to display the Specify Auto Update Interval window.

To make settings so that the Specify Auto Update Interval window is not displayed on Systemwalker Operation Manager
clients and multi-server monitoring clients, edit the definition in the following directory on the clients: Systemwalker
Operation Manager installation directory\MpWalker.JM\mpjmcl\etc.

- Edit the Jobschr.ini file (for Systemwalker Operation Manager clients) or the mltisvmn.ini file (for multi-server
monitoring clients), as shown below.

Section name: SET_LIMIT

Key name: UPDATE_INTERVAL

Value: 0 (Do not suppress.) or 1 (Suppress the display.)

- An example to suppress the display of Specify Auto Update Interval window:

 
[SET_LIMIT]
UPDATE_INTERVAL=1

6.7.2 Displaying the Connection Destination Host Name
The title bar of the following windows will now contain the connection destination host, the subsystem number and the project
name. Note that for the Add/Change-Job window and the Monitor-Job net window, this information will appear only if such
display settings are made.

- Recovery Change Job Net window

- Monitor Job Net window

- Monitor Group window

- Job Net Management window

- Group Management window

- Add/Change-Job window (*1)

- Monitor-Job net window

*1:

This information is displayed only when the Add/Change-Job window is invoked from the Recovery Change Job Net
window.

The information is displayed after the name of the window (in the title bar) in the following format.

The connection destination host name is the Display name shown in the Host Properties window that is displayed from the
Monitored Host Configuration window where "DEFAULT" is displayed in the Monitored host configuration name field. The
project name is not displayed in the title bar of the Job Net Management window and the Group Management window. Note
also that the subsystem number is not displayed when using the Standard Edition.

 
Project name <Connection destination host name: Subsystem number (Comment
(*1))

*1:

"(Comment)" is displayed only when the Command Wizard is enabled in the Add/Change-Job window.
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The following methods can be used to switch between display and non-display in the Add/Change-Job window and Monitor-
Job net window. (Non-display is selected by default.)

 
Add/Change-Job window (when invoked from the Recovery Change Job Net window)

Select the Detailed Properties Title check box in the View menu of the Recovery Change Job Net window.

 
Monitor-Job window

Select the Detailed Properties Title check box in the View menu of the Monitor Job Net window.

 
Monitor-Job net window

Select the Detailed Properties Title check box in the View menu of the Monitor Group window.
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6.7.3 Automatic Gantt Chart Scrolling
The update time and job nets whose execution time is closest to the update time can be constantly auto-scrolled in the center
of the Gantt Chart window.

The update time is the system time when information is updated. However, if a virtual time is set, the update time becomes
the virtual time.

Horizontal auto-scrolling

The update time is situated at the center of the horizontal axis of the Gantt chart.

The status of job nets or groups that are scheduled to run or have already finished can quickly be identified in the vicinity
of the update time.

Vertical auto-scrolling

The center of the Gantt chart in the vertical direction is occupied by those waiting job nets or groups whose execution time
is closest to the update time.

The job nets or groups that are currently running can be seen at a glance, and it is also easy to spot job nets or groups close
to the update time whose execution has been delayed.

Automatic scrolling can be used in the following cases:

- When today's Gantt chart is displayed

- When job nets or groups are sorted according to their execution time (in the case of vertical scrolling)

The next section explains how to set up automatic scrolling.

 
Procedure

1. Display the Auto Scroll Settings window

Select Auto Scroll Settings from the View menu of the Gantt Chart window.

2. Set auto-scrolling

Select the relevant auto-scroll check boxes in the Auto Scroll Settings window.

Auto scroll horizontally to display the update time at the center of the view:

This check box is used to automatically scroll horizontally so that the update time remains in the center of the view.

Auto scroll vertically when items are sorted by start time:

This check box is used to automatically scroll vertically so that the job nets or groups that are closest to the update
time remain in the center of the view.

Note that if the Gantt chart is scrolled manually after auto-scrolling has been enabled in the Auto Scroll Settings window,
auto-scrolling will be temporarily disabled. In such cases, automatic scrolling can be resumed by clicking the Horizontal Auto
Scroll button and/or the Vertical Auto Scroll button in the upper-right of the Gantt chart.
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 Information

Auto scroll buttons

If automatic scrolling is enabled with the Auto Scroll Settings window, it is easy to enable or disable automatic scrolling with
the Horizontal Auto Scroll and Vertical Auto Scroll buttons.

Note, however, that the settings performed with the Horizontal Auto Scroll and Vertical Auto Scroll buttons will be cleared
when the Gantt chart is closed. If the Gantt chart is displayed again, the content it shows will conform to the options selected
in the Auto Scroll Settings window.
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Chapter 7 Operating Jobs
This chapter provides a description of job operation.

7.1 Operating Job Nets
The job nets can be operated as necessary. There are 11 types of operations (cancel, start, restart, pause, continue, disable,
enable, confirm, reinstate, revoke and start with variable parameters). For the job nets belonging to groups and the child job
nets, six operations (cancel, restart, pause, continue, disable and enable) can be executed.

The only operations that can be performed on master linked job nets, and the job nets at levels below the master linked job
nets, are pause, continue, disable and enable. For linked job nets, and the job nets at levels below the linked job nets, the
operations that can be performed are the same as for child job nets, namely cancel, restart, pause, continue, disable and enable.

The following describes the four types of operation methods and types of operations for job nets.

Before operating any scheduled job, it is possible to prevent any operational errors from occurring by displaying the dialog
box to confirm the operation. For details on setting, see "7.10 Preventing Operational Errors on Job Nets, Jobs and Groups".

 
Procedure (four types)

- Select the desired job net from the Gantt Chart window. Then, select the desired operation item from the Schedule
Operation of the File menu (or select the desired operation item from the Operation pop-up menu displayed by right-
clicking).

- Select the desired job net from the Job Selection window of the Systemwalker Operation Manager window, then select
the desired operation item from the Schedule Operation of the File menu (or select the desired operation item from the
Operation pop-up menu displayed by right-clicking).

- Select the desired job net from the Monitor Group window. Then, select the desired operation item from the Operation of
the File menu (or select the desired operation item from the Operation pop-up menu displayed by right-clicking).

- Select the desired job net from the Job Net Management window. Then, select the desired operation item from the
Schedule Operation of the File menu (or select the desired operation item from the Operation pop-up menu displayed by
right-clicking). It is possible to select and operate multiple operation items simultaneously.

 
Operation types

The types of the job net operations are as follows.

Cancel:

Cancels the job net being executed.

Start:

Starts the job net immediately. However, the job net cannot be started while in any of warning, executing, paused, disabled
and end delayed statuses. Therefore start the job net after canceling, pausing or enabling it.

Note that if Start is performed on a job net containing a "@.VPARAM@" variable, the job will run with "@.VPARAM@"
replaced by an empty character string.

Restart:

Restarts the job net.

Pause:

Pauses the job net. The paused job net cannot be executed even if the execution conditions are satisfied. If the job net is
a child job net or linked job net, or belongs to a group, the succeeding job nets will not be executed either.
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Continue:

Cancels the paused status of the job net. The job net resumes the status before pausing. If the execution conditions are
satisfied while the job net is being paused, the job net will be executed after resuming.

Disable:

Disables the job net. The disabled job net is considered to be completed pseudo-normally and will not be executed even
if the execution conditions are satisfied. However, for child job nets, linked job nets, or the job nets belonging to a group,
the succeeding job nets will be executed if the execution conditions are satisfied.

Enable:

Cancels the disabled status of the job net. The job net resumes the status before disabling. If it was paused before disabling
operation, it resumes the status before pausing. If the execution conditions are satisfied while the job net is being disabled,
the job net will be completed normally after enabling.

Confirm:

Brings the job nets which have been abnormally terminated or canceled at the previous execution to the confirmed status.
The confirmation operation is enabled when Validate job net confirmation is selected in the Advanced Settings for
Verification window. When Validate job net confirmation Option is selected and the job net remains in an abended state,
the job net will not be executed even if the next execution conditions are satisfied.. After confirmation operation on the
abended job net, the job net will be executed when the next execution conditions are satisfied.

Note that to enable verification with respect to canceled job nets, it is necessary to select Check canceled as well as
Validate job net confirmation in the Advanced Settings for Verification window.

Revoke:

Cancels the carried over status of the job net. The job net for which the scheduled time has been carried over from the
previous day or any day before will be brought to the waiting status upon cancellation of carry over, and the schedule will
be reset at the next scheduled time.

Reinstate:

Cancels the execution results of the job nets (Completed, Pseudo-normal, Abended or Canceled) which have been
executed for the day. After revoke, the job net will be in the waiting status and be able to wait for a message event
occurrence as the execution condition again. This operation is available when Start only when message event has occurred
is selected in Execution condition in the Job Net Properties window and Once in a day is specified.

Start with variable parameters:

Starts a job net with variable parameters specified. The "@.VPARAM@" variable in the job definition of the target job
net will be replaced with a variable parameter before the job net is started.

 

 Note

- When connected to any server with Systemwalker OperationMGR V10.0L21 or V10.1 or older, the reinstate or revoke
cannot be operated.

- Startup with variable parameters cannot be used when connected to Systemwalker Operation Manager V13.2.0 or earlier.

 

 Information

All of the job nets/groups in a project can be Paused / Continued / Disabled / Enabled simultaneously on the per-project basis.
For details, see "7.2 Batch Process of Job Nets/Groups".

 
Job net status transitions

The figure below illustrates the basic status transition of scheduled job nets.

Refer to "Operation types" and "Chapter 14 Status and Operations of Scheduled Jobs" for details.
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Relationship between job net status and operations

The following shows the operations that can/cannot be carried out for each job net status.
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(*1)

The pseudo-normal is the status of job net including any job with of which the completion code is between 1 and the
normal completion code upper limit. If jobs in the pseudo-normal status and the abended status exist in the same job net,
the status of the job net will be abended.

If the Validate pseudo-normal option is not enabled in the Use function1 sheet of the Define Jobscheduler Startup
Parameters window, the indication of the pseudo-normal status will be changed to the normal completion status.

(*2)

The warning status is the status in which jobs in the abended status and the executing status, or jobs in the canceled status
and the executing status exist in the same job net.

If the job net in the warning status is canceled, the job net will be in the canceled status when not including any abended
job, or the abended status when including.

When a child or linked job net is in the warning status, its parent job net will also be in the warning status.

(*3)

These operations cannot be performed for child or linked job nets.

(*4)

The job nets belonging to a group can only be restarted while the group is in the warning status.

(*5)

This operation is available when Start only when message event has occurred is selected in Execution condition in the
Standard information sheet of the Job Net Properties window and Once in a day is specified.

(*6)

These operations cannot be performed for master linked job nets.
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Restarting job nets

When restarting job nets, jobs to be executed can be selected as follows.

- Start execution from the abended job

If the restart point is set for a job before the abended job or a job of another system (not having preceding/succeeding
relationship with the abended job), cancel the restart point setting and restart the job net.

- Start execution from an optional job before the abended job

Set the restart point to an optional job before the abended job, and restart the job net.

- Start execution from the next job skipping the abended job

Specify the Invalid at next restart in the Control information sheet of the Monitor-Job window for the abended job, and
restart the job net.

 

 Note

Cautions when starting/restarting the job net

- When the target job net is in the executing or warning status, the job net cannot be started or restarted. Start or restart after
completion. In this case, the status of the newly-started job net will be displayed in the Gantt Chart window and the Job
List window. To browse the results of the old job nets, see the Job Net History window or the Job History window.

- When a job net with the "Interstage" attribute has been started or restarted, it will be in the Executing status until the stop
time. If it is started or restarted after the stop time of the day, it will be in the Executing status until the stop time of the
next day.

 

 Note

Cautions when canceling the job net

- When a job net is executed, the work file will be created in the work directory under the database directory of the
Jobscheduler for Windows system.

For Unix system, if the directory specified in the directory field in the Standard information sheet of the Add/Change-Job
window is not available or if nothing is specified in the directory field, the work file will be created in the home directory
of the project owner who has registered the job.

Normally, the work file will be deleted when the job net is completed. However, if the job net is canceled, the work file
may remain. Therefore, the system administrator should check the directory in which the work files are created
periodically and delete the remaining work files if any.

When Delete job output file is selected in the Output file sheet of the Define Jobscheduler Startup Parameters window,
all files under the directory in which the work files are created will be deleted at the time of Jobscheduler service startup.

- If a job net with the "Interstage" attribute is canceled, the status will be Normal Termination (completion code: 0).

 
Operation of layered job nets

This section explains the behavior of parent job nets, child job nets and linked job nets when a cancel or restart operation is
performed on a layered job net.

- When a parent job net is canceled

If a "cancel" operation is performed on a parent job net where a child or linked job net is running, the child or linked job
net that is running will be canceled.

- When a child job net is canceled

If a "cancel" operation is performed on a child job net that is running, both the child job net and the job that is running
within the child job net will be canceled. However, if the child job net contains a job that has already abended, the child
job net will also be abended (so that even if a recovery job has been specified, the recovery job will not start).
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- When a linked job net is canceled

If a "cancel" operation is performed on a linked job net that is running, both the linked job net and the job that is running
within the linked job net will be canceled. However, if the linked job net contains a job that has already abended, the
linked job net will also be abended (so that even if a recovery job has been specified, the recovery job will not start).

- When a parent job net is restarted

If a "restart" operation is performed on a parent job net, any child or linked job nets that have terminated abnormally or
that have been canceled will be restarted. However, if a restart point has been specified for a job earlier in the job flow
than the child or linked job net that terminated abnormally or was canceled, the status of that child or linked job net will
be "waiting" when the parent job net is restarted. (The jobs within the child job net will remain in the same status.)

- When a child job net is restarted

When the abended or canceled child job net is restarted, the abended or canceled job in the child job net will be restarted
first. However, if the restart point is set, the restart point setting takes priority.

- When a linked job net is restarted

If a "restart" operation is performed on a linked job net that has terminated abnormally or been canceled, the linked job
net will be restarted from the job within the linked job net that has terminated abnormally or been canceled. However,
if a restart point has been specified, the restart point settings will take precedence.

 
Operations on linked job nets or master linked job nets

The only operations that can be performed on master linked job nets, and the job nets at levels below the master linked job
nets, are pause, continue, disable and enable. For linked job nets, and the job nets at levels below the linked job nets, as is the
case with normal child job nets, only the following six types of operation can be performed, namely cancel, restart, pause,
continue, disable and enable.

Even if a master linked job net, or a job net at levels below a master linked job net, is paused, continued, disabled, or enabled,
these operations will not be reflected to the status of the linked job nets that refer to the job net that has been operated on.
However, if a job net at levels below a master linked job net is paused or disabled, new linked job nets that are to be registered
thereafter can be registered with the status set to Paused or Disabled.

 
Operations on jobs within a linked job net

The only operations that can be performed on jobs within master linked job nets, or job nets at levels below the master linked
job nets, are pause, continue, disable and enable. All types of operations can be performed on jobs within linked job nets and
job nets at levels below the linked job nets.

Even if a job within a master linked job net, or a job net at a level below the master linked job net, is paused, continued,
disabled, or enabled, these operations will not be reflected to the status of the jobs within the linked job nets that refer to the
job net that has been operated on.

 
Starting or restarting a job net or group containing jobs (child or linked job nets) with the "Valid
only on startup days" settings

The configuration information used when starting or restarting a job net or group containing jobs (child or linked job nets)
with the Valid only on startup days settings varies depending on the status as described below:

- When the started job net or group has the startup time scheduled on the previous day or before and is in the Carried over/
Paused/Waiting status:

It is started up with the configuration information shown in the Process flow sheet of the Monitor Job Net window.

- When the started job net or group has been abended or canceled while the "confirmation" operation in the Abended/
Canceled status is enabled:

It is started up with the configuration information shown in the Previous process result sheet of the Monitor Job Net
window.
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- When the restarted job net or group has been put to the Abended, Canceled or Confirmed status while the "confirmation"
operation in the Abended/Canceled is enabled:

It is started up with the configuration information shown in the Previous process result sheet of the Monitor Job Net
window.

If the startup day of a job net containing jobs (child or linked job nets) with the Valid only on startup days setting has been
carried over, whether the child or linked job nets are started up is determined based on the scheduled startup days of the
carried-over parent job net.

7.2 Batch Process of Job Nets/Groups
All of the job nets/groups in a project can be Paused/Continued/Disabled/Enabled simultaneously on the per-project basis.

 
Procedure

Select the target project from the job selection window in the Systemwalker Operation Manager window. Then, select the
operation item from Batch Processing of the File menu (alternately, select the operation item from Batch Processing of the
pop-up menu by right-clicking the mouse).

You can also perform batch process with the jobschoperate command. For more information about the jobschoperate
command, refer to the "Systemwalker Operation Manager Reference Guide".

 
Operation types

The following operations are available for the batch process.

Pause All:

Pauses all of the job nets/groups in the project.

Continue All:

Continues all of the paused job nets/groups in the project.

Disable All:

Disables all of the job nets/groups in the project.

Enable All:

Enables all of the disabled job nets/groups in the project.

 

 Note

The following job nets/groups are excluded from the target of batch process:

- Job nets/groups excluded from the Pause All operation

- Job nets in a group

- Child job nets

- Linked job nets

- Job nets/groups that cannot be paused because they are stopped, executed, warned, end-delayed or disabled.

- Job nets that have been copied and started

- Job nets/groups excluded from the Continue All operation

- Job nets in a group

- Child job nets

- Linked job nets

- Job nets/groups that cannot be continued because they are not paused.
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- Job nets that have been copied and started

- Job nets/groups excluded from the Disable All operation

- Job nets in a group

- Child job nets

- Linked job nets

- Job nets/groups that cannot be disabled because they are being executed, warned, end-delayed or disabled.

- Job nets that have been copied and started

- Job nets/groups excluded from the Enable All operation

- Job nets in a group

- Child job nets

- Linked job nets

- Job nets/groups that cannot be enabled because they are not disabled.

- Job nets that have been copied and started

 

 Information

Batch process cannot be selected in the following cases:

- When the selected project does not include job nets.

- When the connecting user has only the Reference Right.

- When the item selected in the job selection window is not a project.

7.3 Batch Process of Job Nets Management on Multiple
Servers

When multi-server monitoring is executed on the multi-server monitoring client, it is possible to filter the job nets distributed
over multiple target servers and manage only the desired job nets in a batch.

Before operating any scheduled job, it is possible to prevent any operational errors from occurring by displaying the dialog
box to confirm the operation. For details on setting, see "7.10 Preventing Operational Errors on Job Nets, Jobs and Groups".

 
Procedure

Select a job net from the job net information list of Job Nets Management window. Then, select operation items from the
Operation of File menu (or select operation items from the Operation of pop-up menu displayed by right-clicking). It is
possible to select multiple job nets to manage in a batch.

 
Operation types

The following operations are available.

- Cancel

- Start

- Restart

- Pause

- Continue

- Disable
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- Enable

- Confirm

- Reinstate

- Revoke

- Start with variable parameters

 
To execute operations by connecting to the target server

It is also possible to execute operations by starting up the Systemwalker Operation Manager client on the target server from
the Job Nets Management window.

For the procedure to startup the Systemwalker Operation Manager client on the target server, see "6.4.2 Confirming Details
by Connecting to the Server to be Monitored".

7.4 Starting a Job Net with Variable Parameters
Startup with variable parameters allows a job net to be started by dynamically specifying variable parameters. It can be used
when an operator wants to start a job net with variable parameters specified, or when an operator wants to specify variable
parameters manually during operations such as recovery from an error.

Note that startup with variable parameters cannot be used when the connection destination server is running Systemwalker
Operation Manager V13.2.0 or earlier.

 
Procedure

To pass a variable parameter to a job, it is necessary to specify the variable "@.VPARAM@" in the job definition, just as in
the case when startup with variable parameters is initiated by a message event. The following procedure can be used to replace
the variable "@.VPARAM@" with the specified variable parameter. Refer to "4.3.13.1 Using variable parameters to start a
job net" for information about the "@.VPARAM@" variable.

1. Select the target job net.

Select the target job net in the Systemwalker Operation Manager window, the Job Net Management window or the Job
Nets Management window.

2. Display the Set Variable Parameters window.

Use one of the following methods to display the Set Variable Parameters window:

- Select Start with variable parameters from Schedule Operation or Operation in the File menu.

- Right-click and select Operation and then Start with variable parameters from the pop-up menu.

- Click the Start with variable parameters button in the toolbar.

3. Specify the variable parameters.

Specify the variable parameters in the Set Variable Parameters window and click the OK button.

Figure 7.1 Set Variable Parameters window

Variable parameters:

Specify the variable parameters.

- 311 -



7.5 Operating Scheduled Jobs
The scheduled jobs can be operated as necessary. There are 6 types of operations (cancel, restart, pause, continue, disable and
enable). If the execution attribute is "Interstage" or "normal" (UNIX version), operations are not available.

The following describes how to operate the scheduled jobs and types of operations.

Before any scheduled job operation is carried out, a dialog box to confirm the operation will be displayed to prevent any
operational errors from occurring. For details on setting, see "7.10 Preventing Operational Errors on Job Nets, Jobs and
Groups".

 
Procedure

Select the desired job from the Monitor Job Net window, then select the desired operation item from the Operation of the File
menu (or select the desired operation item from the Operation pop-up menu displayed by right-clicking).

 
Operation types

The types of the job operations are as follows.

Cancel:

Cancels jobs that are running, in a warning state or have been delayed.

Restart:

Restarts jobs that have abended or been canceled. Note, however, that a restart cannot be performed if a recovery job is
running, in a warning state or has been delayed.

When connected to any server with Systemwalker OperationMGR V10.0L21 or V10.1 or older, the job net can only be
restarted when it is in the warning status. Also, the recovery jobs cannot be restarted. The operation will be ignored.

 

 Point

Information specified by a temporary job change

Job nets that are running as a result of a restart operation and higher-order job nets are handled in the same way as job nets
started by a restart operation. This means that any information specified by a temporary job change is valid.

 

 Point

Behavior when a restart operation is performed on a recovery job

If a restart operation is performed on a recovery job and the recovery job completes normally, the Restart previous job
check box in the Control information sheet of the Add/Change - Job window will determine whether the original job of
the recovery job will be restarted.

For the abended or canceled jobs, more specific operations can be carried out by recovery operations. For details, see "7.6
Recovering Scheduled Jobs".

Pause:

Pauses the waiting jobs and completed jobs. Once a job is paused, it cannot be executed even if the preceding job is
normally completed. The succeeding jobs will not be executed either.

Continue:

Cancels the paused status of the job. The job resumes the status before pausing. If the preceding job is normally completed
while the job is being paused, the job will be started after resuming. For the recovery job of which the preceding job is
abended while the job is being paused, the job will be started after resuming.
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Disable:

Disables the waiting, paused and completed jobs. The disabled jobs cannot be started even if the preceding job is normally
completed (as it is considered to be pseudo-normally completed). The succeeding job is started when the preceding job
is normally completed. When a recovery job for which Restart previous job is specified is disabled, the original job will
not be restarted.

Enable:

Cancels the disabled status of the job. The job resumes the status before disabling. If it was paused before disabling
operation, it resumes the status before pausing. If the preceding job is completed while the job is in the disabled status,
the job will be in the completed status.

 
Relationship between job status and operations

The following shows the operations that can/cannot be carried out for each job status.

 
Operation

Cancel Restart
(*3)

Pause Contin
ue

Disable Enable

Job Status

(Previous time)
Normally completed

B B A B A B

(Previous time) Pseudo-
normal(*1)

B B A B A B

(Previous time)
Abnormally ended

B C A B A B

(Previous time)
Cnaceled

B C A B A B

Running A B B B B B

Execution delayed (*2) A B B B B B

Waiting B B A B A B

Paused B B B A A B

Disabled B B B B B A

A: Can operate 
B: Cannot operate 
C:Depends on conditions

(*1)

The pseudo-normal is the status of job including any job with of which the completion code is between 1 and the normal
completion code upper limit.

If the pseudo-normal status is not validated in the Define Jobscheduler Startup Parameters window, the pseudo-normal
status will be indicated as the normal completion.

(*2)

The execution delayed is the status in which the job is connected to the queue but has not been executed.

(*3)

The relationship between the status of jobs and higher-order job nets and restart operations is as follows:

Restart is not possible when the status of a higher-order job net is "Waiting"

A restart operation cannot be performed if the status of a higher-order job net, including the parent job net, is
"Waiting".
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Restart is not possible when Invalid at next restart is specified for a higher-order job net

A restart operation cannot be performed if Invalid at next restart is specified for a higher-order job net, including the
parent job net.

Restart is not possible when the succeeding job is running or has terminated

A restart operation cannot be performed if the status of the next job is "Delayed", "Executing", "Warning",
"Completed", "Pseudo-normal", "Abended" or "Canceled". (This includes when the job status has changed to Paused
or Disabled after being any of the statuses listed here.)

Jobs in a group can be restarted only when the status of a job net is "Warning"

When a higher-order job net, including the parent job net, is contained in a group, a restart operation can be performed
only when the status of a job net containing jobs is "Warning".

 
Relationship between the status of the parent job net and the operation of the job

The relationship between the status of the parent job net of the operation target job and whether the job operation is permitted
or not is as follows.

 
Operation

Cancel Restart Pause Contin
ue

Disable Enable

Status of the parent job net 

Normally
completed

B B A B A B

Abnormally
ended

B C A B A B

Canceled B C A B A B

Running A B B B B B

Start delayed
End delayed

A B B B B B

Waiting B B A B A B

Paused B B B A A B

Disabled B B B B B A

A: Can operate 
B: Cannot operate
C: Depends on conditions

7.6 Recovering Scheduled Jobs
By specifying Recovery Operations for a job, more specific job recovery operations can be carried out.

The recovery operation can be carried out for the jobs with the Job Execution Control attribute. It is also necessary that the
job nets of higher-level layer including the parent job nets do not belong to any group.

The following describes how to carry out recovery operations and types of operations.

Before carrying out any recovery operation, it is possible to prevent any operational errors from occurring by displaying the
dialog box to confirm the operation. For details on setting, see "7.10 Preventing Operational Errors on Job Nets, Jobs and
Groups".

 
Procedure

Select the desired job from the Monitor Job Net window, then select the desired operation item from the Recovery of the File
menu (or select the desired operation item from the Recovery pop-up menu displayed by right-clicking).
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 Note

When connected to any server with Systemwalker Operation Manager V10.0L21 or V10.1 or older, no scheduled job can be
recovered. The menu options are grayed out.

 
Operation types

The types of the recovery operations are as follows.

Start from Specified Job

Starts from the specified job. When the job is completed normally or pseudo-normally, the succeeding job will be
executed.

Restart from Specified Job

This operation is available only for the jobs with the job net icon or linked job net icon. Restarts from the specified job.
When the job is completed normally or pseudo-normally, the succeeding job will be executed.

Start from Next Job

This operation is available only for jobs other than the jobs with the job net icon or linked job net icon. Starts from the
succeeding job leaving the specified job as it is. When the succeeding job is completed normally or pseudo-normally, the
next succeeding job will be executed.

However, if the succeeding jobs include any recovery job, the recovery job will not be carried out. Also, if no succeeding
job exists (including recovery job) or if only recovery jobs exist, this operation is not available.

Furthermore, if any of the succeeding jobs has Execution condition specified in the Standard information sheet of the Job
Net Properties window, this operation is not available.

Specified Job Only

This operation is available only for jobs other than the jobs with the job net icon or linked job net icon. Start specified Job
Only. Even when the job is completed normally or pseudo-normally, the succeeding job will not be executed. Or, even
when the job is abended, the recovery job will not be executed.

This is an operation to start the jobs which remain in the abended or canceled status as a result of carrying out "Start from
Next Job." Therefore, this operation is not available for the jobs with no succeeding job or the jobs for which the
succeeding jobs are in the waiting status (including the jobs which are in the paused or disabled status and are previously
in the waiting status) including the recovery jobs.

 

 Point

Information specified by temporary change of jobs

The job nets brought to be in the executing status by the recovery operation and the job nets of higher-level layers are treated
in the same way as they are started by the restart operation. Therefore, the information specified by the temporary change will
be valid.

 

 Point

Operations when a recovery operation is carried out for a recovery job

When the "Start from Specified Job" is carried out for a recovery job, or when the "Restart from Specified Job" is carried out
for a recovery job with the job net icon or linked job net icon, whether to restart the original job of the recovery job after normal
completion of the recovery job will depend on the "Restart previous job" setting in the job properties.

 
Relationship between job status and operations

The following describes relationship between the status of jobs and the higher-level layer job nets and operations.
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Operation available only for the abended or canceled jobs

The recovery operations are available only when the job has been abended or canceled.

Operation not available for the higher-level layer job nets in the waiting status

The recovery operations are not available when the higher-level layer job nets including the parent job net are in the
waiting condition.

Operation not available when Invalid at next restart is specified for the higher-level layer job nets

The recovery operations are not available when Invalid at next restart is specified for the higher-level layer job nets
including the parent job net.

Operation other than "Specified Job Only" not available when the succeeding job is in the executing or
completed status

The following recovery operations are not available when the status of the succeeding job is either of the
delayed ,executing, warning, normal completion, pseudo-normal, abended and cancellation status (including when it is
currently in the paused or disabled status and previously in any of the before mentioned status).

- Start from Specified Job

- Restart from Specified Job

- Start from Next Job

The "Specified Job Only" operation not available when the succeeding job is in the waiting status

The following recovery operations are not available when the status of the succeeding job is the waiting status (including
when it is currently in the paused or disabled status and previously in any of the before mentioned status).

- Specified Job Only

Operation not available while the recovery operation (in the executing or warning status) is being carried
out

While the recovery job is in operation (in the delayed, executing or warning status), no recovery operation is available for
the original job of the recovery job.

Jobs in a group can be recovered only when the status of the job net is "Warning"

When a higher-order job net, including the parent job net, is contained in a group, a recovery operation can be performed
only when the status of a job net containing jobs is "Warning". Furthermore, only Start from Specified Job can be specified
for jobs in job nets that are not child or linked job nets, and only Restart from Specified Job can be specified for child or
linked job nets.

7.7 Operating Demand Jobs
The operation of demand jobs submitted under Jobs in the Job Selection window of the Systemwalker Operation Manager
window can be carried out in the View Job Status/Operate window. The View Job Status/Operate window enables not only
the demand jobs but also the following operations for all jobs including scheduled jobs.

- Holding execution

- Releasing execution hold

- Moving execution queues

- Deleting jobs

- Changing job data (execution priority ranking and Dispatch Priority)
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Procedure

1. Selecting the job to be operated

Select Jobs from the Job Selection window of the Systemwalker Operation Manager window. The View Job Status/
Operate window will appear in the main window. Select the desired job from the View Job Status/Operate window.

Figure 7.2 View Job Status/Operate window

2. Operating jobs

Operate as follows.

Holding execution:

Select Hold from the Job Operation of the File menu (or select Hold from the Job Operation pop-up menu displayed
by right-clicking).

Releasing execution hold:

Select Release from the Job Operation of the File menu (or select Release from the Job Operation pop-up menu
displayed by right-clicking).

Moving execution queues:

Select Move from the Job Operation of the File menu (or select Move from the Job Operation pop-up menu
displayed by right-clicking). The Move Job dialog box will appear. Specify the destination queue according to the
settings of the Move Job dialog box shown below.

Deleting jobs:

Select Delete from the Job Operation of the File menu (or select Delete from the Job Operation pop-up menu
displayed by right-clicking).
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Changing the job information:

Select Change from the Job Operation of the File menu (or select Change from the Job Operation pop-up menu
displayed by right-clicking). The Change Job Information dialog box will appear. Change the information referring
to the settings of the Change Job Information dialog box shown below.

Setting the Move Job dialog box

Make the necessary settings in the Job Transfer dialog box displayed by selecting Move from Job Operation in the File
menu of the View Job Status/Operate window.

Figure 7.3 Move Job dialog box

Move From:

Displays the queue name in which the relevant job currently exists.

Move To:

Specifies the destination queue name.

 

 Note

Move Job

It is not possible to move jobs from the distributed execution queue to another queue and vice versa.

Setting the Change Job Information dialog box

Make the necessary settings in the Change Job Information dialog box displayed by selecting Change from Job Operation
in the File menu of the Display/Operate Job Status window.
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Figure 7.4 Change Job Information dialog box

Execution Priority:

Changes the execution priority ranking of the relevant job.

Dispatch Priority:

Changes the Dispatch Priority of the relevant job.

 
Relationship between job status and operations

The following table shows the operations that can and cannot be carried out for each scheduled job status.

If the job status is Execution held or Output held, the jobs which have been held by the administrator can only be released by
the administrator.

 

 Note

Operating network jobs

If you have requested another server to execute a network job, control this job from the server that submitted it, not the
execution server. If you control it from the execution server, the results are unpredictable.

 

 Information

Job operation on the server

It is also possible to operate the jobs from the server. To operate the jobs from the server, use the qhold (hold execution), qrls
(release), qmove (move execution queue), qdel (delete job) and qjalter (change job information) commands. For details of
each command, see the Systemwalker Operation Manager Reference Guide.
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 Note

Job operations if the Operation Manager user has been specified (in UNIX system)

If the Extended User Management function is valid and if the Operation Manager user is specified in the User Name, he or
she can operate the job with the authority of the OS user who has been assigned to that Operation Manager user. In addition
to the specified Operation Manager user, the job information of all Operation Manager users associated with the OS users is
displayed. The users can operate the displayed job information.

7.8 Operating Queues
The system administrator (the user belonging to the Administrators group in the Windows system, or the superuser in the
UNIX system) can carry out the following operations to queues.

- Pausing queues

- Releasing queue pausing

- Temporarily changing definitions

 
Procedure

1. Selecting the queue to be operated

Select Queue from the Job Selection window of the Systemwalker Operation Manager window. The Display/Operate
Queue Status window will appear in the main window. In this window, select the queue to be operated.

Figure 7.5 Display/Operate Queue Status window
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2. Operating the queue

Operate as follows.

Pausing queues:

Select Pause from the Queue Operation of the File menu (or select Pause from the Queue Operation pop-up menu
displayed by right-clicking).

Releasing queue pausing:

Select Start from the Queue Operation of the File menu (or select Start from the Queue Operation pop-up menu
displayed by right-clicking).

Temporarily changing definitions:

Select Change from the Queue Operation of the File menu (or select Change from the Queue Operation pop-up
menu displayed by right-clicking) to display the Change Queue Definition Temporarily dialog box.

In the Change Queue Definition Temporarily dialog box, the definition items shown below can be temporarily
changed in response to situations such as a job execution delay caused by the congestion of the executing queue.
The attributes of the temporarily changed queue will be retained until the Job Execution Control is restarted in the
initialization mode.

- Job multiplexity in a queue

- Max Submit Jobs

- Time Lapsed Limit

- Default Execution Priority

- Default Dispatch Priority

Figure 7.6 Change Queue Definition Temporarily dialog box

 
Relationship between queue status and operations

The following shows the operations that can/cannot be carried out for each queue status.
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 Information

Queue operation on the server

It is also possible to operate the queues from the server. To operate the queues from the server, use the qstop (stop queue),
qstart (release queue pausing) and qalter (temporarily change) commands. For details of each command, see the
Systemwalker Operation Manager Reference Guide.

7.9 Operating Groups
The group can be operated as necessary. There are 8 types of operations (cancel, start, restart, pause, continue, disable, enable
and confirm).

The following describes how to operate the groups (three methods) and types of operations.

Before operating any group, it is possible to prevent any operational errors from occurring by displaying the dialog box to
confirm the operation. For details on setting, see "7.10 Preventing Operational Errors on Job Nets, Jobs and Groups".

 
Procedure (three types)

- Select the desired group from the Gantt Chart window. Then, select the desired operation item from the Schedule
Operation of the File menu (or select the desired operation item from the Operation pop-up menu displayed by right-
clicking).

- Select the desired group from the Job Selection window of the Systemwalker Operation Manager window. Then, select
the desired operation item from the Schedule Operation of the File menu (or select the desired operation item from the
Operation pop-up menu displayed by right-clicking).

- Select the desired group from the Group Management window. Then, select the desired operation item from the
Operation of the File menu (or select the desired operation item from the Operation pop-up menu displayed by right-
clicking). It is possible to select and operate multiple operation items simultaneously.

 
Operation types

The types of the group operations are as follows.

Cancel:

Cancels the group being executed or in the warning status. All the job nets being executed or in the warning status will
be canceled. The job nets which have not been executed as they do not satisfy the execution conditions will remain in the
waiting status.

If the canceled groups are newly scheduled, they will be in the waiting status.

Start:

Starts the group immediately. Among the execution conditions for the job nets in the group started with the startup
operation, the conditions other than the normal completion of the preceding job net will be ignored. Therefore, the job net
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will be started immediately after the preceding job net is normally completed. The job net configuration at the group
startup is as follows depending on the group status.

For a group which has already been completed for the current day:

The group will be started from the beginning with the job net configuration of the completed group.

For a group which is scheduled to be executed for the current day:

The group will be started with the job net configuration of the scheduled group. In this case, the group will not be
started again at the originally-scheduled startup time.

For a group which is not scheduled to be executed for the current day:

The group will be started with all the job net configurations in the group. In this case, this group will be able to be
monitored in the Monitor Group window.

Restart:

Restarts the group when it has been abended due to the abended job net in the group or canceled during the previous
execution. When restarted, execution will be started from the abended or canceled job net and the group will be in the
executing status. If no abended or canceled job net exist, execution will be started from the waiting job nets which satisfy
the execution conditions. The execution conditions of the job nets in the restarted group vary as follows, depending on
the conditions of the previous execution of the group.

If previously executed according to the schedule:

The normal completion of the preceding job net, the startup time and the message event waiting will be valid.

If previously executed with the start operation:

Only the normal completion of the preceding job net will be valid.

Pause:

Pauses the group. The paused group cannot be executed even if the execution conditions are satisfied.

Continue:

Cancels the paused status of the group. The group will resume the status before the pause operation (if newly scheduled,
however, the group will be in the waiting status). If the execution conditions are satisfied while the pause of the group is
being, the group will be started after resuming.

Disable:

Disables the group. The disabled group is considered to be completed pseudo-normally and will not be executed even if
the execution conditions are satisfied.

Enable:

Cancels the disabled status of the group. The group will resume the status before the disable operation (if newly scheduled,
however, the group will be in the waiting status). If it was in the paused status before the disable operation, it resumes the
status before pausing. Or, if it was in the abended or canceled status before the disable operation, it changes to the
completed status. If the execution conditions are satisfied while the job net is being disabled, the group will be in the
completed status after enabling.

Confirm:

Brings the group which have been abended or canceled at the previous execution to the confirmed status. Confirmation
is enabled when Validate group confirmation is selected in the Advanced Settings for Verification window. When the
Validate group confirmation option is selected, no scheduling will be executed for the group in the abended status at the
day change time or the startup time of the server beyond the day change time. After confirmation is carried out for the
abended group, the scheduling for the current day will be executed at the day change time or the startup time of the server
beyond the day change time.

Note that to enable verification with respect to canceled groups, it is necessary to select Check canceled as well as Validate
group confirmation in the Advanced Settings for Verification window.
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 Information

All of the job nets/groups in a project can be Paused / Continued / Disabled / Enabled simultaneously on the per-project basis.
For details, see "7.2 Batch Process of Job Nets/Groups".

 
Relationship between group status and operations

The following shows the operations that can/cannot be carried out for each group status.

(*1)

The pseudo-normal status is the status of the group which includes any job net of the pseudo-normal status. If job nets in
the pseudo-normal status and the abended status exist in the same group, the group will be in the abended status.

If the pseudo-normal status is not validated in the Use function1 sheet of the Define Jobscheduler Startup Parameters
window, the pseudo-normal will be indicated as the normal completion.

(*2)

In the warning status, any job net in the warning, abended or canceled status exists in the group but the group has not been
completed yet.

The group will remain in the warning status even if the job nets are not in the warning, abended or canceled status any more
after restart.

 

 Point

Starting groups

- When you start up a group, it is operated as follows.

a. If no job net of the group is scheduled to start today, all job nets registered in this group are started.

b. Otherwise, only the job nets of the group scheduled to start today are started. If you try to start a group before its
scheduled time, the group is considered to have already started up, and the group is not started at the scheduled time
of the day. Note that a group can be started up any number of times in a day.
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- If you tried to "start up" a group, the job nets registered in the group start without waiting for a occurrence of message
events or the scheduled time.

For group startup details, see "14.1.7 Group Operations and Actions."

 

 Note

Operating groups including job nets with the Interstage attribute

If a group, in which any job net with the Interstage attribute is in execution, is canceled, the job net with the Interstage attribute
in execution will be normally completed (completion code: 0) and no succeeding job net will be executed. The group will be
in the canceled status.

7.10 Preventing Operational Errors on Job Nets, Jobs and
Groups

Before operating any job, job net or group on the client, it is possible to prevent any operational errors from occurring by
displaying the dialog box to confirm the operation. Confirmation of operation can be done in the Operation Confirmation
dialog box.

The Operation Confirmation dialog box can be displayed for the following operations.

- For Systemwalker Operation Manager clients:

- Job net/group operations in the Job Selection window

- Job net/group operations in the Gantt Chart window

- Job net operations in the Job Net Management window

- Group operations in the Group Management window

- Job net operations in the Monitor Group window

- Flow restart in the Monitor Group window

- Job operations in the Monitor Job Net window

- Flow restart in the Monitor Job Net window

- Job recovery operations in the Monitor Job Net window

- For multi-server monitoring clients:

- Job net operations in the Job Nets Management window

The following shows a display example of the Operation Confirmation dialog box.

Figure 7.7 Operation Confirmation dialog box

 

- 325 -



Setting to display or hide the Operation Confirmation dialog box

You can specify to display or not to display the Operation Confirmation dialog box from the Confirmation Settings window.
You can set a combination of operation targets (jobs, job nets or groups) and settings of the Confirm before performing
operations in display or no display of Confirmation Settings window dialog for each client.

 
Procedure

- For Systemwalker Operation Manager clients:

1. Select the Confirmation Settings from Tools menu of the Systemwalker Operation Manager window.

2. When the Confirmation Setting window appears, check the check box of the operation target (jobs, job nets or
groups) in "Confirm before performing operations" and click OK.

- For multi-server monitoring clients:

1. Select Confirmation Settings from the Options menu of Job Nets Management window.

2. When the Confirmation Setting window appears, check the check box in "Confirm before performing operations"
and click OK.

The following gives an example of Confirmation Settings window (for Systemwalker Operation Manager clients).

Figure 7.8 Confirmation Settings window

Confirm before performing operations:

Select a type of operation to display the Operation Confirmation dialog box.

 

 Information

Suppressing the display of the Confirmation Settings window

You can suppress to display the Confirmation Settings window.

To do so, add or change the contents of "Jobschr.ini" file (for Systemwalker Operation Manager clients) or "mltisvmn.ini"
file (for multi-server monitoring clients) locating under the Systemwalker Operation Manager installation directory
(\MpWalker.JM\mpjmcl\etc) at the client as follows:

Section name: SET_LIMIT

Key name: OPERATE_CHECK

Value: 0 (Do not suppress.) or 1 (Suppress the display.)
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- An example to suppress the display of the Confirmation Settings window:

 
[SET_LIMIT]
OPERATE_CHECK=1
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Chapter 8 Browsing Job History
This chapter describes how to browse job net and job histories.

8.1 Displaying Job Net History
The following describes how to browse the job net execution result history. The history information in the log files
(jobdb1.log/jobdb2.log/jobdb3.log) can be browsed in the Job Net History window. This window displays the execution
result (Completed, Abended, etc.) and the completion code of the job net. The following describes the display methods and
the display contents of the Job Net History window.

 
Procedure

- Displaying the Job Net History window

Display the Job Net History window by performing one of the following operations.

- Select the desired Jobscheduler, project, group or job net from the Job Selection window of the Systemwalker
Operation Manager window. Then, select Job Net History from the Tools menu.

- Select a job net or a group in the project having the job net for which you wish to monitor in the Gantt Chart window.
Then, select Job Net History from the Tools menu.

Figure 8.1 Job Net History window

Project Name:

Displays the project name.

Job net comment:

Displays the job net comment.

Status:

Displays the execution result history (Completed, Pseudo-normal, Abended, Canceled, Executing, Closed, Refused
or Skipped) for each job net.

Startup time:

Displays the start date and time of the job net.

Ended On:

Displays the end date and time of the job net.
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Code:

Displays the largest value among the completion codes of the jobs in the job net.

Additional information:

Displays additional information about a job net in the format Key = "value".

 
Key Value

VPARAM Displays a variable parameter that is
specified when the job net starts.

8.2 Displaying Scheduled Job History
The following describes how to browse the scheduled job execution result history. The history information in the log files
(jobdb1.log/jobdb2.log/jobdb3.log) can be browsed in the Job History window.

The following describes the display methods and the display contents of the Job History window.

 
Procedure

- Displaying the Job History window

Display the Job History window by performing one of the following operations.

- Select the desired job net from the Job Selection window of the Systemwalker Operation Manager window. Then,
select Job History from the Tools menu.

- Select the desired job net from the Job Net Management window. Then, select Job History from the Tools menu.

- Select the desired job net from the Gantt Chart window. Then, select Job History from the Tools menu.

- While the history is displayed in the Gantt Chart window, double-click the desired job net name.

Figure 8.2 Job History window

 
Display format of the job history

The following shows the display format of the job (command) history.
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4-digit-year/month/date hour:minute:second JOB host name job net ID, project
name, job net name, job name, comment message.

- When the job name is omitted, the command will be displayed.

- When the job net has the "Compatible with the earlier versions (old and standard)" attribute, the process group ID will
be displayed instead of the job net ID. [UNIX version]

(Example)

 
1996/04/21 19:00:05 JOB SERVER NET00001,SALES
PRJ,jobnet20,JOB_1,comment started.
1996/04/21 19:14:32 JOB SERVER NET00001,SALES
PRJ,jobnet20,JOB_1,comment normal end code=0.

 
Display format of the job net start/end history

The following shows the display format of the job net start/end history.

 
4-digit-year/month/date hour:minute:second JOB host name job net ID, project
name, job net name, job name, comment message, additional information.

- When the job net has the "Compatible with the earlier versions (old and standard)" attribute, the process group ID will
be displayed instead of the job net ID. [UNIX version]

- If any variable parameters were specified when the job net started, they will be displayed as additional information in the
following format:

VPARAM="variable parameter";

(Example)

 
1996/04/21 19:00:04 NET SERVER NET00001,SALES PRJ,jobnet20,POS
CONTROL started, VPARAM="BBB".
1996/04/21 19:30:18 NET SERVER NET00001,SALES PRJ,jobnet20,POS
CONTROL normal end code=0.

 
Display format of the child job net start/end history

The following shows the display format of the child job net start/end history.

 
4-digit-year/month/date hour:minute:second JOB host name job net ID, project
name, job net name, job name, comment message.

(Example)

 
1996/04/21 19:00:04 NJB SERVER NET00001,SALES PRJ,Pjobnet,cjobnet,POS
CONTROL started.
1996/04/21 19:30:18 NJB SERVER NET00001,SALES PRJ,Pjobnet,cjobnet,POS
CONTROL normal end code=0.

 
Display format of the linked job net start/end history

The following shows the display format of the linked job net start/end history:

 
4-digit-year/month/date hour:minute:second LJB host name parent job net ID, project name,
parent job net name, job net name, job net comment message

(Example)
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1996/04/21 19:00:04 LJB SERVER NET00001,SALES PRJ,Pjobnet,cjobnet,POS CONTROL
started.1996/04/21 19:30:18 LJB SERVER NET00001,SALES PRJ,Pjobnet,cjobnet,POS
CONTROL normal end code=0

 

 Note

Host name

The host name of the Job History window indicates the name of the host which has executed the job net. If the host name
exceeds 16 bytes, the first 16 bytes of the host name are displayed.

 

 Note

Job Net ID

If no job net ID is assigned, the job net ID column in the Job History window will be as follows.

Failed:

Displayed when execution is rejected.

Disabled:

Displayed when execution is skipped.

 
Contents and meanings of message indications

The contents and meanings of message indications are as follows.

Started:

The job net execution has started.

Restarted:

The job net execution has restarted.

Normal end:

The job net has been executed normally. The completion code is indicated.

Pseudo-normal end:

The job net execution was pseudo normally terminated. The completion code is indicated.

Abnormal end:

The job net execution was terminated abnormally. The completion code is indicated.

Cancel end:

The job net execution was forcibly terminated. The completion code (any of the following 248, 249, or 256) is indicated.

Normal restart-end:

The job net was restarted and terminated normally. The completion code is indicated.

Pseudo-normal restart-end:

The job net was restarted and pseudo normally terminated. The completion code is indicated.

Abnormal restart-end:

The job net was restarted but terminated abnormally. The completion code is indicated.

Cancel restart-end:

The job net was restarted but forcibly terminated. The completion code (256) is indicated.
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Passed:

The job is in the passed status. The completion code (any of the following 0, 248, or 249) is indicated.

Skipped:

The execution conditions are satisfied while the job net or the job is in the disabled status.

Refused:

The job net execution was rejected.

Closed:

The job net execution or job execution was interrupted. The code (239) is indicated.

Not scheduled:

A child or linked job net, for which Valid only on startup days has been specified, did not start because it was not a
scheduled startup day.

8.3 Displaying Previous Log of Scheduled Jobs
This section describes how to browse the previous history (standard outputs and standard error outputs) of scheduled jobs.
Standard outputs and standard error outputs for scheduled jobs can be browsed using the Previous log sheet of the Monitor-
Job window.

The following describes the display methods and the display contents of the Previous log sheet of the Monitor-Job window.

 

 Information

The method used to record the previous execution log of jobs varies depending on the method used to start the job net or job.

a. When a job net is started:

Recording of a new log is started, and the results are treated as the "previous execution log".

b. When a job net or job is restarted:

Additional log information is appended to the existing previous execution log.

 
Procedure

1. Displaying the Previous log sheet of the Monitor-Job window

Double-click the target job in the Monitor Job Net window, or select the target job and select Properties from the File
menu (or select Properties from the pop-up menu displayed by right-clicking).
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2. Selecting the Previous log sheet

Select the Previous log sheet in the Monitor-Job window.

Figure 8.3 Monitor-Job window - Previous log sheet

Startup time:

The date and time on which the previous execution has been started.

End time:

The date and time on which the previous execution has been completed.

Code:

The completion code for the previous execution.

If the actual completion code for jobs in job nets (where the execution attribute is either the Job Execution Control
attribute or the Interstage attribute) is 256 or more, the value for the actual completion code will be displayed as
shown below. However, this will not be displayed for child or linked job nets.
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255 (actual completion code)

Description:

When the job is completed, the meaning of the Code will be explained here. However, this will not be displayed
for child or linked job nets.

Job net variable:

Displays the job net variable, and parameter information specified for startup with variable parameters.

Job result (Default log or default error log):

Displays the standard output/standard error output for the previous execution. For child job nets, nothing will be
displayed.

Copy All button:

Copies all the contents displayed as the output data.

Font button:

Displays the Font dialog box.

 

 Information

The previous history of scheduled jobs can also be browsed using the Job Output Info window. To display the Job Output Info
window, select the target job in the Monitor Job Net window, then select Output Info from the File menu (or select Output Info
from the pop-up menu displayed by right-clicking).

 

 Information

When Systemwalker Operation Manager is linked to Systemwalker Centric Manager and Systemwalker Centric Manager is
used to monitor the execution status of job nets, the Send Mail action used in event monitoring can be used to send the previous
log of a scheduled job at the same time as an abnormal termination notification.

Refer to the Systemwalker Centric Manager User's Guide - Monitoring Functions and "jobschgetoutput Command" in the
Systemwalker Operation Manager Reference Guide for details.

8.4 Making Job History Output
The history and operation result information of jobs submitted to Systemwalker Operation Manager can be output to files.

 
Displaying demand job history

Demand job execution histories can be output to log files. In these log files, histories of all jobs including scheduled jobs are
output.

 
Outputting Log Files

The history of jobs submitted from the Systemwalker Operation Manager window is saved in log files.

The log files are created on daily basis, which means that one file is created per day. The log files are kept for seven days by
default. The log files are automatically created after installing Systemwalker Operation Manager. To change the directory
where the log files are created or the range of time the log files are kept, use the Log sheet of the Define Operating Information
window.

 
Procedure

1. Displaying the Define Operating Information window

Click Operating Information in the Systemwalker Operation Manager Environment Setup window.
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2. Selecting the Logging sheet

Select the Logging sheet to define the execution history information and operation result information of jobs.

Figure 8.4 Define Operating Information window - Logging sheet

Save job execution history information:

This check box is always checked. Saved Directory and Retention of the log files can be specified.

Save operation results information:

Use this option to save the operation result information. Saved Directory and Retention of the operation result
information can be specified.

Since the log files have binary attributes, they cannot be browsed directly. To browse the log files, format and output them
as standard output using the mjsview command. For details of the command, see the Systemwalker Operation Manager
Reference Guide.

 
Output of operation result information files

Operation result information for jobs can be output in the CSV format as operation result information files. To save operation
result information files, specify in the Log sheet of the Define Operation Information for the Job Execution Control.
Operation result information files are created on daily basis, which means that one file is created per day. For how many days
the operation result information files should be stored can also be specified in the Log sheet of the Define Operation
Information for the Job Execution Control. For details on the operation result information files, see the Systemwalker
Operation Manager Reference Guide.
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Chapter 9 Printing Jobscheduler Information
This chapter describes how to print the Jobscheduler information.

 

 Note

If any of the printer properties is modified in the Print dialog box, the Jobscheduler information may not be printed properly.

For verified printers, see the relevant documentations including the Systemwalker Operation Manager Software Guide.

9.1 Selecting a Print Type
The Jobscheduler information can be printed. The print types that can be printed as Jobscheduler information are as follows.

- Gantt Chart:

Prints a Gantt chart.

- Group Monitoring Map:

Prints a group monitoring map.

- Job Net Monitoring Map:

Prints a job net monitoring map.

- Group List:

Prints a group list.

- Job net list:

Prints a job net list.

- Job Net History:

Prints a job net history.

- Job History:

Prints a job history.

To print the Jobscheduler information, select the print type and then specify the necessary print output items. The following
describes how to select a print type. For procedures for setting up the print output items, see the respective print output items.
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Procedure

1. Displaying the Print Jobscheduler Info [Login] window

Select Start/App >> Systemwalker Operation Manager >> Print Jobscheduler Info. The Print Jobscheduler Info
[Login] window will be displayed.

Figure 9.1 Print Jobscheduler Info [Login] window

Host:

Specifies the host name of the server to connect to.

User ID:

Specifies the ID of the user connecting to the server.

Password:

Specifies the password for the user ID that was specified in the User ID field.

 

 Note

You cannot connect to the destination server with the Windows version of Systemwalker/OperationMGR V5.0L2.0 or
earlier or the UNIX version of Systemwalker/OperationMGR 5.1 or earlier.
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2. Displaying the Print Jobscheduler Info window

Specify the destination host name and user ID in the Print Jobscheduler Info [Login] window to display the Print
Jobscheduler Info window.

Figure 9.2 Print Jobscheduler Info window

Preview area:

Displays a Gantt chart or monitoring map on a printed page basis. The contents displayed in this area will be printed.

 

 Information

When operating multiple subsystems

When operating multiple subsystems, specify the destination host name and user ID in the Print Jobscheduler Info
[Login] window to display the Specify Subsystem Connection window. Specifying a subsystem number here displays
the Print Jobscheduler Info window.
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3. Selecting the print type

Select the print type in the Print Jobscheduler info window using one of the following operations.

- Select Gantt Chart, Monitoring Map, List or History from the View menu.

- Click the Gantt Chart, Group Monitoring Map, Job Net Monitoring Map, Group List, Job Net list, Job History or
Job Net History button in the toolbar.

9.2 Printing a Gantt Chart
It is possible to set the print output items for the Gantt chart and print them.

 
Procedure

1. Acquiring the Gantt chart

Selecting Gantt Chart as the print type displays the Obtain Gantt Chart window. Specify conditions in the Obtain Gantt
Chart window, then click OK.

Figure 9.3 Obtain Gantt Chart window

Project Name:

Specifies the project to output.

When omitted, all the projects will be output.

Browse:

Displays the Browse Registration Info window. See Displaying the Browse Registration Info window below to
confirm the registered information.

Display condition:

Switches between displaying and hiding the child or linked job nets. This cannot be specified when connected to
the destination server with the Windows version of Systemwalker OperationMGR V10.0L21 or earlier or the
UNIX version of Systemwalker OperationMGR 10.1 or earlier..

Date:

Specifies the date to display in the Gantt chart.
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Time:

Specifies the time to display in the Gantt chart. Select the display starting time and display time.

Displaying the Browse Registration Info window

Click Browse in the Obtain Gantt Chart window, and the Browse Registration Info window will appear. The
available hierarchies are displayed in a tree structure.

Figure 9.4 Browse Registration Info window

You can browse the projects, groups and job nets registered in the Jobscheduler.

Specifiable layers vary depending on the print type. For details, see the Systemwalker Operation Manager Online
Help.
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The Print Jobscheduler Info window displays a print image of the Gantt chart.

Figure 9.5 Print Jobscheduler Info window (Gantt chart)

2. Specifying filtering conditions

Set the filtering conditions as necessary. Select Filtering from the View menu of the Print Jobscheduler Info window
(or, select Filtering on the toolbar).
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Specify the filtering conditions in the Filtering Conditions Setup window, then click OK. The Gantt chart print image
in the Print Jobscheduler Info window will be refreshed according to the specified filtering conditions.

Figure 9.6 Filtering Conditions Setup window

Status:

Filters the status of the group and job nets to output. Select one or more items.

3. Setting print items

Specify the print items as necessary. Select Print Items from the Setup menu in the Print Jobscheduler Info window.
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Specify the output items in the Gantt chart sheet of the Specify Print Items window, then click OK. The Gantt chart print
image in the Print Jobscheduler Info window will be refreshed according to the specified print items.

Figure 9.7 Specify Print Items window - Gantt chart sheet

Required items:

Selects whether the groups and job nets are displayed in their names, comments or in both. Be sure to select one
or more items.

Arrange:

Selects the order in which the groups and job nets are displayed in the Preview area in the Print Jobscheduler Info
window (in the order they are registered, in the order of their names, their starting times, or by status).

Time axis interval:

Specifies the interval of time axis on the Gantt chart.

Optional items:

Selects the items to include in the Gantt chart.

- Project Name:

Displays the project name.

- Status:

Displays the status of the group or job net. Whether to display with color coding or character strings can be
selected.

- Condition:

Displays the progress of the jobs making up a job net in the form of "number of jobs started/total number of jobs
making up a job net". Not displayed for groups.

4. Printing

After setting up the print output contents, select Print from the File menu in the Print Jobscheduler Info window. The
contents displayed in the Preview area will be printed by the printer connected to the client machine.
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9.3 Printing a Group Monitoring Map
It is possible to set the print output items for the group monitoring map and then print it.

 
Procedure

1. Acquiring the group monitoring map

Selecting a print type displays the Obtain Group Monitoring Map window. Specify conditions in the Obtain Group
Monitoring Map window, then click OK.

Figure 9.8 Obtain Group Monitoring Map window

Project Name:

Specifies the project to output. Cannot be omitted.

Group name:

Specifies the group to output. Cannot be omitted.

Browse:

Displays the Browse Registration Info window. For details, see "Displaying the Browse Registration Info window"
in "Displaying the Browse Registration Info window."
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The Print Jobscheduler Info window displays a print image of the group monitoring map.

Figure 9.9 Print Jobscheduler Info window (group monitoring map)

2. Setting print items

Specify the print items as necessary. Select Print Items from the Setup menu in the Print Jobscheduler Info window.

Specify the output items in the Group monitoring map sheet of the Specify Print Items window, then click OK. The
group monitoring map print image in the Print Jobscheduler Info window will be refreshed according to the specified
print items.
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Figure 9.10 Specify Print Items window - Group monitoring map sheet

Box size:

Specifies the width of the box to be displayed on a job net basis.

Output items:

Selects the output items (Icon, Job net name, Status, Code, Messages, Job net comment, Scheduled time, Start time,
End time) to be displayed in the box for the group monitoring map on a job net basis.

3. Printing

After setting up the print output contents, select Print from the File menu in the Print Jobscheduler Info window. The
contents displayed in the Preview area will be printed by the printer connected to the client machine.

9.4 Printing a Job Net Monitoring Map
It is possible to set the print output items for the job net monitoring map and then print it.
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Procedure

1. Acquiring the job net monitoring map

Selecting a print type displays the Obtain Job Net Monitoring Map window. Specify conditions in the Obtain Job Net
Monitoring Map window, then click OK.

Figure 9.11 Obtain Job Net Monitoring Map window

Project name:

Specifies the project to output. Cannot be omitted.

Job net name:

Specify the job net to output. Cannot be omitted.

Browse:

Displays the Browse Registration Info window. For details, see "Displaying the Browse Registration Info window"
in "Displaying the Browse Registration Info window."
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The Print Jobscheduler Info window displays a print image of the job net monitoring map.

Figure 9.12 Print Jobscheduler Info window (job net monitoring map)

2. Setting print items

Specify the print items as necessary. Select Print Items from the Setup menu in the Print Jobscheduler Info window.

Specify the output items in the Job net monitoring map sheet of the Specify Print Items window, then click OK. The
job net monitoring map print image in the Print Jobscheduler Info window will be refreshed according to the specified
print items.
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Figure 9.13 Specify Print Items window - Job net monitoring map sheet

Box size:

Specifies the width of the box to be displayed on a job basis.

Output items:

Selects the output items (Icon, Command, Status, Code, Job name, Directory, Comment, Host name, Start time,
End time, Startup criteria) to be displayed in the box for the job net monitoring map on a job basis.

These output items are applied when the job net execution attribute is Job Execution Control. The output items vary
as follows depending on the job net attribute.

- If the job net execution attribute is Interstage:

- When you select Command, the work unit name appears.

- When you select Job name, the system name appears.

- When you select Directory and Startup criteria, no information appears.

- If the job net execution attribute is PowerAIM [UNIX version]:

- When you select Command, the work unit name appears.

- When you select Job name, the system name appears.

- When you select Directory and Host name, no information appears.

- If the job net execution attribute is Normal [UNIX version]:

- When you select Job name and Host name, no information appears.

3. Printing

After setting up the print output contents, select Print from the File menu in the Print Jobscheduler Info window. The
contents displayed in the Preview area will be printed by the printer connected to the client machine.
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9.5 Printing a Group List
It is possible to set the print output items for the group list and then print it.

 
Procedure

1. Acquiring the group list

Selecting a print type displays the Obtain Group List window. Specify conditions in the Obtain Group List window,
then click OK.

Figure 9.14 Obtain Group List window

Project name:

Specifies the project to output. When omitted, all the projects will be output.

Browse:

Displays the Browse Registration Info window. For details, see "Displaying the Browse Registration Info window"
in "Displaying the Browse Registration Info window."
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The Print Jobscheduler Info window displays a print image of the group list.

Figure 9.15 Print Jobscheduler Info window (group list)

2. Specifying filtering conditions

Set the filtering conditions as necessary. Select Filtering from the View menu of the Print Jobscheduler Info window
(or, select Filtering on the toolbar).
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Specify the filtering conditions in the Filtering Conditions Setup window, then click OK. The group list print image
in the Print Jobscheduler Info window will be refreshed according to the specified filtering conditions.

Figure 9.16 Filtering Conditions Setup window

Group name:

Specifies the group name to output. A wild card (*) can be specified. When omitted, all the groups will be output.

Group comment:

Specifies the group comment to output. A wild card (*) can be specified. When omitted, all the groups will be
output.

Status:

Filters the status of the group to output. Select one or more items.

3. Setting print items

Specify the print items as necessary. Select Print Items from the Setup menu in the Print Jobscheduler Info window.

Specify the output items in the Group list sheet of the Specify Print Items window, then click OK. The group list print
image in the Print Jobscheduler Info window will be refreshed according to the specified print items.
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Figure 9.17 Specify Print Items window - Group list sheet

Required items:

Selects whether to output the group name and the group comment. Select one or more items.

Arrange:

Selects the order in which groups are aligned. When anything other than "by Entry" has been selected, you can
select the ascending or descending order of alignment.

Optional items:

Selects the output items (Project name, Status, Scheduled time, Start time, End time) to be displayed in the group
list.

4. Printing

After setting up the print output contents, select Print from the File menu in the Print Jobscheduler Info window. The
contents displayed in the Preview area will be printed by the printer connected to the client machine.

9.6 Printing a Job Net List
It is possible to set the print output items for the job net list and then print it.
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Procedure

1. Acquiring the job net list

Selecting a print type displays the Obtain Job Net List window. Specify conditions in the Obtain Job Net List window,
then click OK.

Figure 9.18 Obtain Job Net List window

Project name:

Specifies the project to output. When omitted, all the projects will be output.

Browse:

Displays the Browse Registration Info window. For details, see "Displaying the Browse Registration Info window"
in "Displaying the Browse Registration Info window."

The Print Jobscheduler Info window displays a print image of the job net list.

Figure 9.19 Print Jobscheduler Info window (job net list)
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2. Specifying filtering conditions

Set the filtering conditions as necessary. Select Filtering from the View menu of the Print Jobscheduler Info window
(or, select Filtering on the toolbar).

Specify the filtering conditions in the Filtering Conditions Setup window, then click OK. The job net list print image
in the Print Jobscheduler Info window will be refreshed according to the specified filtering conditions.

Figure 9.20 Filtering Conditions Setup window

Job net name:

Specifies the job net name to output. A wild card (*) can be specified. When omitted, all job nets are output.

Job net comment:

Specifies the job net comment to output. A wild card (*) can be specified. When omitted, all job nets are output.

Remarks:

Use this option to filter the output contents by remarks. A wild card (*) can be specified.

Status:

Filters the status of the job net to output. Select one or more items.

3. Setting print items

Specify the print items as necessary. Select Print Items from the Setup menu in the Print Jobscheduler Info window.

Specify the output items in the Job net list sheet of the Specify Print Items window, then click OK. The job net list print
image in the Print Jobscheduler Info window will be refreshed according to the specified print items.

- 355 -



Figure 9.21 Specify Print Items window - Job net list sheet

Required items:

Selects whether to output the job net name and the job net comment. Select one or more items.

Arrange:

Selects the order in which job nets are aligned. When anything other than "By Entry" has been selected, you can
select the ascending or descending order of alignment.

Optional items:

Selects the output items (Project name, Remarks, Status, Scheduled time, Estimated end time, Start time, End time,
Executing condition, message, Upper level) to be displayed in the job net list.

4. Printing

After setting up the print output contents, select Print from the File menu in the Print Jobscheduler Info window. The
contents displayed in the Preview area will be printed by the printer connected to the client machine.

9.7 Printing a Job Net History
It is possible to set the print output items for the job net history and then print it.
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Procedure

1. Acquiring the job net history

Selecting a print type displays the Obtain Job Net History window. Specify conditions in the Obtain Job Net History
window, then click OK.

Figure 9.22 Obtain Job Net History window

Project name:

Specifies the project to output. When omitted, all the projects will be output.

Browse:

Displays the Browse Registration Info window. For details, see "Displaying the Browse Registration Info window"
in "Displaying the Browse Registration Info window."

Display date:

Specifies the date to output.
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The Print Jobscheduler Info window displays a print image of the job net history.

Figure 9.23 Print Jobscheduler Info window (job net history)

2. Setting print items

Specify the print items as necessary. Select Print Items from the Setup menu in the Print Jobscheduler Info window.
Note that the additional information displayed in the Job Net History window is not printed.

Specify the output items in the Job net history sheet of the Specify Print Items window, then click OK. The job net
history print image in the Print Jobscheduler Info window will be refreshed according to the specified print items.
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Figure 9.24 Specify Print Items window - Job net history sheet

Required items:

Selects whether to output the job net name and the job net comment. Select one or more items.

Optional items:

Selects the output items (Project name, Status, Start time, End time, End code) to be displayed in the job net history.

3. Printing

After setting up the print output contents, select Print from the File menu in the Print Jobscheduler Info window. The
contents displayed in the Preview area will be printed by the printer connected to the client machine.

9.8 Printing a Job History
It is possible to set the print output items for the job history and then print it.
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Procedure

1. Acquiring the job history

Selecting a print type displays the Obtain Job History window. Specify conditions in the Obtain Job History window,
then click OK.

Figure 9.25 Obtain Job History window

Project name:

Specifies the project to output. Cannot be omitted.

Job net name:

Specify the job net name to output. Cannot be omitted.

Browse:

Displays the Browse Registration Info window. For details, see "Displaying the Browse Registration Info window"
in "Displaying the Browse Registration Info window."

Display date:

Specifies the date to output.
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The Print Jobscheduler Info window displays a print image of the job history.

Figure 9.26 Print Jobscheduler Info window (job history)

2. Setting print items

Specify the print items as necessary. Select Print Items from the Setup menu in the Print Jobscheduler Info window.
Note that the additional information displayed in the Job History window is not printed.

Specify the output items in the Job history sheet of the Specify Print Items window, then click OK. The job history print
image in the Print Jobscheduler Info window will be refreshed according to the specified print items.
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Figure 9.27 Specify Print Items window - Job history sheet

Required items:

Selects whether to output the date and time, the job name and the message. Select one or more items.

Optional items:

Selects the output items (Type, Host name, Job net ID, Project name, Job net name) to be displayed in the job
history.

These output items are applied when the job net execution attribute is Job Execution Control. The output items vary
as follows depending on the job net attribute.

- If the job net execution attribute is Interstage:

- When you select Job name, the workunit name appears.

- When you select Host name, the destination host name appears.

- If the job net execution attribute is PowerAIM [UNIX version]:

- When you select Job name, the system name appears.

- When you select Host name, the destination host name appears.

- If the job net execution attribute is Normal [UNIX version]:

- When you select Job name, the command name appears.

- When you select Host name, the destination host name appears.

3. Printing

After setting up the print output contents, select Print from the File menu in the Print Jobscheduler Info window. The
contents displayed in the Preview area will be printed by the printer connected to the client machine.
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Chapter 10 Scheduling Services and Applications
This chapter describes the startup functions for services and applications.

10.1 Procedure for Scheduling Services and Applications
By using the service and application startup functions, it is possible to automatically start services and applications [Windows
version] or applications [UNIX version] upon OS startup, according to the specified operation schedule (startup order). These
services and applications can be changed based on weekdays and holidays, or for specific days, which enables various setups
for different days. When the server is shut down, these services and applications are terminated in the reverse of the startup
sequence.

The following describes the procedure for scheduling services and applications.

1. Setting up the calendar

No set up is needed when using an already-set calendar. For details, see "Chapter 2 Setting Up The System Calendar".

2. Registering the Standard Schedule

3. Registering the Holiday Schedule

4. Registering the User-Specific Definition Patterns

5. Confirming the startup type of services

 

 Note

Only a system administrator can set service and application schedules.

10.2 Registering the Standard Schedule
You need to register basic operation patterns as the standard schedule. The standard schedule is the operation schedule
(startup sequence) for services and applications (only applications for UNIX system) set as default.

Upon server startup, the services and applications (only applications for UNIX system) are started according to the operation
schedule.

The following describes procedure to set a standard schedule for services and applications.
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Procedure

1. Displaying the Service/Application Execution Pattern dialog box

Select Service/Application Execution from the Job Selection window of the Systemwalker Operation Manager
window. Then, select Service/Application Execution Pattern from the Options menu.

Figure 10.1 Service/Application Execution Pattern dialog box

Execution Pattern:

Displays the currently-selected execution pattern names (Standard Schedule/Holiday Schedule/User-specific
definition patterns (up to seven)).

Pattern Setup:

Displays the Service/Application Execution Pattern Definition dialog box.

Add Separately:

Displays the Service/Application Execution Pattern Definition dialog box.

Calendar Reference:

Check this option to use the calendar.

Calendar List:

Displays the list of calendars registered.

Window Display at Application Start:

Specifies the display method (normal display, no display or icon display) when starting up the application. This
option is not selectable for UNIX.
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2. Displaying the Service/Application Execution Pattern Definition dialog box

Select Standard Schedule in the Service/Application Execution Pattern Definition dialog box. Then, click Pattern
Setup.

Figure 10.2 Service/Application Execution Pattern Definition dialog box - Execution Pattern
Name sheet

3. Setting the standard schedule information for services and applications

Make the following settings using the Service Execution sheet or the Application Execution sheet of the Service/
Application Execution Pattern Definition dialog box.
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- The Service Execution sheet [Windows version]

Define the types and startup sequence (execution pattern) of services which are executed upon server startup.

Figure 10.3 Service Execution sheet

Service List:

Displays the list of types and startup sequences of services executed upon server startup.

Add:

Adds the services. Clicking this button displays the Define Service Information dialog box.

Change:

Changes the service information selected with the cursor. Clicking this button displays the Define Service
Information dialog box.

Change the information referring to the settings of the Define Service Information dialog box shown below.

Delete:

Deletes the service selected with the cursor.

Setting the Service Information dialog box
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Make the necessary settings in the Service Information dialog box displayed by clicking Add or Change in the Service
Execution dialog box.

Figure 10.4 Service Information dialog box

Service Name:

Specifies a service name registered in Services in the Control Panel.

Preceding Service:

Specifies a service name registered in Services in the Control Panel.

Parameter:

Specifies the parameter at service execution.

Action when Pr-Service is Inactive:

Checks the preceding service status and determines whether to execute the services when the preceding service is
specified.
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- Application Execution sheet

Specifies the execution file name, parameter and execution directory.

Figure 10.5 Application Execution sheet

Application List:

Displays the list of types and startup sequences of applications executed upon server startup.

Add:

Adds an application definition. Clicking this button displays the Define Application Information dialog box.

Change:

Changes the application information selected with the cursor. Clicking this button displays the Define Application
Information dialog box. Change the information according to the settings of the Define Application Information
dialog box shown below.

Delete:

Deletes the application selected with the cursor.

Setting the Application Information dialog box
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Make the necessary settings in the Application Information dialog box displayed by clicking Add or Change in the
Application Execution dialog box.

Figure 10.6 Application Information dialog box

Execution File:

Specifies the application execution file.

Parameter:

Describes the parameter to be passed to the execution file.

Execution Directory:

Specifies the directory where the application is executed.

4. Completing the Service/Application Execution Pattern Definition dialog box

Click OK in the Service/Application Execution Pattern Definition dialog box.

5. Applying a calendar

Select one of the following to use a calendar.

- To apply the standard schedule only to weekdays:

Check the Use Calendar check box to select the calendar to use. The standard schedule will automatically be
applied only to weekdays, according to the calendar information.

- To apply the standard schedule regardless of weekdays or holidays:

Do not check the Use Calendar check box. The standard schedule will automatically be applied to all days.

6. Saving the standard schedule

Click OK in the Service/Application Execution Pattern dialog box to save the standard schedule.

 

 Note

Using calendars

- When the calendar to be used is changed

All the specified information on the process dates of service/application execution will be disabled. If the execution
patterns are assigned on daily basis in the Service/Application Execution Pattern window, the process dates of services
and applications must be specified again.

- When the contents of the calendar to be used are changed

The process dates of service and application execution are set, linked with the changed contents of the calendar.

Registering applications [Windows version]
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If an application that displays a window is registered in Windows operating system, the window will not appear on the desktop
where the user who has logged in. To run an application with a window displayed, register the application as a startup
program.

 

 Information

The applied schedule can be temporarily disabled. Select the desired service/application execution days, then select Disable
Schedule from the pop-up menu displayed by right-clicking. This disables the schedule on all the selected days, and no service
or application is started.

10.3 Registering the Holiday Schedule
To operate the server in different patterns depending on weekdays or holidays, it is necessary to register the holiday schedule.
The holiday schedule is the operation schedule (startup sequence) automatically set for services and applications that run on
days defined in a calendar. Upon server startup, the services and applications (only applications for UNIX system) are started
according to the operation schedule.

To apply the standard schedule regardless of weekdays or holidays, it is not necessary to create the holiday schedule.

The following describes the procedure for specifying holiday schedule for services and applications.
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Procedure

1. Displaying the Service/Application Execution Pattern dialog box

Select Service/Application Execution from the Job Selection window of the Systemwalker Operation Manager
window. Then, select Service/Application Execution Pattern from the Options menu.

Figure 10.7 Service/Application Execution Pattern dialog box

Execution Pattern:

Displays the currently-selected execution pattern names (Standard Schedule/Holiday Schedule/User-specific
definition patterns (up to seven)).

Pattern Setup:

Displays the Service/Application Execution Pattern Definition dialog box.

Add Separately:

Displays the Service/Application Execution Pattern Definition dialog box.

Calendar Reference:

Check this option to use the calendar.

Calendar List:

Displays the list of calendars registered.

Window Display at Application Start:

Specifies the display method (normal display, no display or icon display) when starting up the application.

2. Changing the application pattern of the standard schedule

Check the Use Calendar check box in the Service/Application Execution Pattern dialog box. When not checked, the
standard schedule will be applied regardless of weekdays or holidays.
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3. Displaying the Service/Application Execution Pattern Definition dialog box

Select Holiday Schedule in the Service/Application Execution Pattern dialog box. Then, click Pattern Setup.

The setting procedure for the holiday schedule hereafter is the same as the setting procedure for the standard schedule.
For details, see "10.2 Registering the Standard Schedule".

10.4 Registering the User-Specific Definition Patterns
To operate the server in a pattern that does not apply to either the standard schedule or the holiday schedule, it is necessary
to register a user-specific definition pattern. Select a pattern other than Standard Schedule or Holiday Schedule from the
Service/Application Execution Pattern dialog box, then use the Service Execution sheet or the Application Execution sheet
(only the Application Execution sheet for UNIX system) of the Service/Application Execution Pattern Definition dialog box
to register a user-specific definition pattern.

The following describes how to register a user-specific definition pattern for services and applications.

 
Procedure

1. Displaying the Service/Application Execution Pattern dialog box

Select Service/Application Execution from the Job Selection window of the Systemwalker Operation Manager
window. Then, select Service/Application Execution Pattern from the Options menu.

Figure 10.8 Service/Application Execution Pattern dialog box

Execution Pattern:

Displays the currently-selected execution pattern names (Standard Schedule/Holiday Schedule/User-specific
definition patterns (up to seven)).
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Pattern Setup:

Displays the Service/Application Execution Pattern Definition dialog box.

Add Separately:

Displays the Service/Application Execution Pattern Definition dialog box.

Calendar Reference:

Check this option to use the calendar.

Calendar List:

Displays the list of calendars registered.

Window Display at Application Start:

Specifies the display method (normal display, no display or icon display) when starting up the application.

2. Displaying the Service/Application Execution Pattern Definition dialog box

Select a pattern other than the Standard Schedule or the Holiday Schedule in the Service/Application Execution Pattern
dialog box, then click Pattern Setup.

Figure 10.9 Service/Application Execution Pattern Definition dialog box - Execution Pattern
Name sheet

Execution Pattern Name:

Specifies the service/application execution pattern name.

3. Setting the user-specific definition pattern

Make the following settings using the Service Execution sheet or the Application Execution sheet of the Service/
Application Execution Pattern Definition dialog box.
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- Service Execution sheet [Windows version]

Specifies the service name, the preceding service name, the parameter and operation when the preceding service
has not been executed.

- Application Execution sheet

Specifies the execution file name, parameter and execution directory.

4. Saving the user-specific definition pattern

Click OK in the Service/Application Execution Pattern Definition dialog box. The newly-registered user-specific
definition pattern name will be added to the Execution Pattern List in the Service/Application Execution Pattern
Definition dialog box. Up to seven patterns can be registered as the user-specific definition patterns.

5. Selecting the day to change from the standard schedule or the holiday schedule to the user-specific definition pattern

Carry out one of the following operations in the Service/Application Execution window to select the date to apply the
pattern.

- Selecting a day of week

Clicking a day (of week) section selects all the dates of that day (of week).

- Selecting a date

Select using one of the following methods.

- Clicking a date section selects the button. Clicking again cancels the selection.

- Clicking date sections while pressing down the Shift key selects the range from the previously-selected date
to the clicked date.

- Clicking date sections while pressing down the Ctrl key selects the clicked date in addition to the previously-
selected date.

6. Changing to the user-specific definition pattern

Select a registered user-specific pattern from the pop-up menu displayed by right-clicking on the Service/Application
Execution window.

The service/application execution pattern will be applied to the selected dates. By carrying out these operations in the
same way, it is possible to change patterns to apply among the standard schedule, the holiday schedule and the user-
specified schedule.

 

 Note

The applied schedule can be temporarily disabled. Select the desired dates, then select Disable Schedule from the pop-up
menu displayed by right-clicking. This disables the schedule on all the selected days, and no service or application is started.

10.5 Confirming the Startup Type of Services [Windows
version]

The startup type of the services to be executed with the service/application execution function must be set to "Manual" on
Windows operating system. The confirmation methods are as follows.

Confirmation methods

Select Control Panel >> Management Tools >> Services. Then, in the service/application execution function, confirm that
the startup type of the service to be executed is set to "Manual."
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Chapter 11 Monitoring Events and Managing Actions
[Windows version]

This chapter describes the event monitoring and action management functions.

 

 Information

When Systemwalker Centric Manager coexists, use the event monitoring and action management functions on the
Systemwalker Centric Manager.

11.1 Setting Automatic Actions for an Event Occurrence
Using the event monitoring function, when an event such as outputting messages to notify a system error occurs, actions such
as sending a Short Mail to the system administrator and starting applications to handle events can be carried out automatically.
Actions to be automatically executed can be changed depending on weekdays or holidays, or time zone.

The following describes setting procedure to automatically execute actions at event occurrences.

- Registering Monitoring Events

- Defining Action Execution Conditions

- Registering Execution Actions

 

 Information

The grayed out items in the dialog box can be specified only when the Systemwalker Centric Manager has been installed.

11.1.1 Registering the Monitoring Events
To automatically execute actions at an event occurrence, it is necessary to monitor the event occurrences with the event
monitoring function. Events to be monitored can be defined in the Define Event dialog box.

The following shows the types of events that can be monitored using the event monitoring function.

- Event log

The messages output to the event log files.

The formats can be checked with the event viewer in Windows(R).

- Log file monitoring

The added parts of text output to log files.

Up to the Line Feed code of the added text is monitored as a single message. The format is "label name + message (in each
line)." The monitoring interval is set to 30 seconds.

- Monitoring messages

The messages handled by Systemwalker Centric Manager (System Monitor).

They are the relayed messages transferred from the system monitoring agent locating in a lower level of the logical
hierarchy than the definition destination system. They can be monitored when Systemwalker Centric Manager is
installed.

The formats can be checked in the event list in the Systemwalker Centric Manager Monitoring window.

For details, refer to the Systemwalker Centric Manager User's Guide or the Systemwalker Centric Manager Online
Help.
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Procedure

1. Displaying the Monitored Event Table window

Select Calendar from the Systemwalker Operation Manager window, then select Event Monitoring Conditions
Definition from the Options menu.

Figure 11.1 Monitored Event Table window

2. Displaying the Define Event dialog box

Select the event type (NT Event Log/Application Logfile) from the Add Event in the Event menu of the Monitored
Event Table window.

Or, select an event and select Update Event from the Event menu of the Monitored Event Table window.
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3. Defining the events to be monitored

In the Define Event dialog box, define the events to be monitored. After defining, click OK to save the definition. Up
to 1024 events can be defined.

Figure 11.2 NT Event Log dialog box

Specify Log:

Specifies the log to specify events.

Not Specified:

Not specify by log.

Log:

Specifies by log. The type of log (system log, security log or application log) to specify events can be selected.

Specify ID:

Specifies the event ID to specify events.

Not Specified:

Not specify by event ID.

Event ID:

Specifies by event ID.

Specify Type:

Specifies the type to specify events.

Not Specified:

Not specify by type.

Type:

Specifies by type. The event type (error, warning, information, success inspection or failure inspection) can be
selected.

Specify Source:

Specifies the source name to specify events. This can be specified when the log is specified for log specification.

Not Specified:

Not specify by source name.
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Source Name:

Specifies by source name.

Specify Category:

Specifies the category to specify events. This can be specified when the event ID is specified for event ID
specification.

Not Specified:

Not specify by category.

Category:

Specified by category.

Figure 11.3 Application Logfile dialog box

Logfile Label:

Specifies the log file monitoring message label.

Not Specified:

Not specify by label.

Label Name:

Selects a label name defined in the Set Monitoring Log File dialog box from the combo box.

Logfile Message:

Specifies the log file monitoring message text.

Not Specified:

Not specify by text.

Message Text:

Specifies the message text to specify the log file message.

 

 Note

Notes on Event Log Monitoring

- Events with the source name MpAosfB are not subject to monitoring except for ones with the event ID 9999.

- If Microsoft(R) ClusterServer is used, event logs are output to the event log files for all the nodes of the same cluster at
event occurrences. However, only the nodes in which events have occurred are targeted for monitoring.
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In this case, no action is taken even if defined.

 

 Note

Suppression of identical message output

If the same message is output multiple times within 60 seconds, the second and subsequent messages are abandoned. If it has
occurred, the automatic actions defined by those messages are not taken.

If the suppression of identical message output is specified, up to 100 types of messages are suppressed. If 100 types or more
of messages are issued within 60 seconds, the latest 100 types of messages are suppressed.

 
Regular Expression

The regular expression can be used in the Specify message text column of Define Event [Log File Monitoring] dialog box.

The regular expression can be used in the following syntax rules.

 
Regular expression Meaning

. Represents any single character (including changing line).

* Represents zero (0) or more times of iteration of the
immediately preceding character (including the regular
expression).

^ Represents the beginning of a line.

$ Represents the end of a line.

[Character string] Represents any single character in the character string.

[^ character string] Represents any single non-literal character used in the
character string.

[character "a" - character
"b"]

Represents any single character within the range from
character "a" to character "b".

The following syntax rules cannot be used.

 
Regular expression Meaning (Note)

? Represents zero (0) or 1 time of iteration of the
immediately preceding character (including the regular
expression).

| Represents it matches to either before or after.

+ Represents 1 or more times of iteration of the immediately
preceding character.

\ Represents specific character by the character that follows
\.
(Example)

Null character is \s, Changing line is \n etc.

(Character string) The character string in () becomes one group.

{Number} Represents an iteration of Number specified in {}

Note) The meaning value may vary depending on the OS and software.
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 Note

- If you want to use one of the characters above (including the characters that can be used in regular expression and those
that cannot) as an ordinary character, add character "\" before each of these characters.

Examples are "\.", "\*", "\?" and "\|"

- A character string enclosed by a pair of "[" and "]" characters is considered to be "$" characters instead of the special
characters in regular expression.

 

 Information

The meaning of regular expression is identical between the time when characters ".*" are set at the beginning of a character
string and when they are omitted.

For example, ".*error occurred" and "error occurred" are both considered to be a character string containing characters "error
occurred". In this way, the process speed of the character string comparison may sometimes increase if the regular expression
is not used. In such case, avoid using the regular expression.

 
Regular expression examples

 
Regular expression

example
Meaning

abc Represents a character string containing "abc". It matches
"aabc" and "abcd".

abc.ef Any single character can be entered between "abc" and "ef". It
matches "abcdef" and "abc5ef".

a*b Represents an iteration of character "a" zero (0) or more times.
It matches "b", "ab", "aab" and "aaab".

.* Represents any character string which consists of any character
"." and "*" referred to an iteration of the immediately preceding
character zero (0) or more times.

^abc Represents that the line begins with characters "abc". It matches
"abcdef" and "abcxyz".

xyz$ Represents that the line ends with "xyz". It matches "123xyz"
and "ABCxyz".

3001[IWEH] Represents any of characters "I", "W", "E" and "H". It matches
"3001I", "3001W", "3001E" and "3001H".

3500[^IN] Represents a character other than "I" or "N". It matches "3500a"
and "3500n" but does not match "3500I" and "3500N".

[0-9] TIMES Represents any character from "0" to "9". It matches "0
TIMES" and "2 TIMES".

 
Sample definitions

The following gives sample definitions which can be used to define event monitoring conditions.

Example 1: Monitor a message whose error number ends with character "A".

Messages monitored:    error no 1000A : detail is ...

Messages monitored:    error no 1002A : detail is ...

Messages not monitored:    error no 1234E : detail is ...

- 380 -



If string "error no" is follows by a four-digit character, and if you define the subsequent character as "A":

Correct definition example: error no [0-9][0-9][0-9][0-9]A : detail is ...

Incorrect definition example: error no *A

Character "*" represents an iteration of the immediately preceding character zero or more 

times. It is NOT any character string. To define the error number as any character string, 

specify "error no.*A".

Example 2: Monitor a message containing character string "error occurred".

Messages monitored:    file control error occurred

Messages monitored:    system error occurred

Messages not monitored:    file control succeeded

To define any character string followed by string "error occurred":

Sample definition: .* error occurred

To define a character string which ends with string "error occurred":

Sample definition: error occurred$

Example 3: Monitor a message which begins with string "Check system".

Messages monitored:    Check system -> Server01.

Messages monitored:    Check system -> Server02.

Messages not monitored:    Check database -> Server02.

To define a character string which begins with string "Check system":

Sample definition: ^Check system

11.1.2 Defining Action Execution Conditions
For actions that are automatically executed at event occurrences by the event monitoring function, their execution conditions
can be defined. The execution conditions that can be defined include weekdays, holidays, time, and combinations of those.
The execution conditions are defined for each event. This section describes how to specify the action execution conditions.

 
Procedure

1. Displaying the Monitored Event Table window

Select Event Monitoring Conditions Definition from the Options menu of the Systemwalker Operation Manager
window.

2. Displaying the Action Schedule dialog box

Select an event by which the action conditions are to be specified in the Monitored Event Table window. Then, select
Set Action Execution Conditions from the Actions menu of the Monitored Event Table window (or select Set Action
Execution Conditions from the pop-up menu displayed by right-clicking).
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3. Defining the action conditions for the event to be monitored

In the Action Schedule dialog box, define the action conditions for the event to be monitored. After defining, click OK
to save the definition.

Figure 11.4 Action Schedule dialog box

Schedule:

Specifies the action conditions.

Not specified:

Always executes the actions.

Execute the action in the schedule below:

Executes actions when matching the specified date and time.

Execute the action outside of the schedule below:

Executes actions when not matching the specified date and time.

Days:

Specifies the condition range with dates.

Daily:

Selects all days as the condition range.

Work Week:

Selects weekdays (process dates) as the condition range. The name of the calendar can be selected from
Calendar Name. Only weekdays (process dates) in the specified calendar will be targeted as the condition range.

Holidays:

Selects holidays as the condition range. The name of the calendar can be selected from Calendar Name.
Holidays in the specified calendar will be targeted as the condition range.

Time Period:

Specifies the condition range with time span.
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24 hours:

Selects all time (0:00 - 23:59) as the condition range.

Time Period:

Specifies the start and end times of the condition range between 0:00 and 23:59. The specified time span will
be the condition range.

 

 Note

The time spans to execute actions do not regard the day change time. A day is from 0:00 to 23:59 regardless of the day change
time settings. When the process dates or holidays of the calendar are specified as the execution conditions of actions, the time
span for the action execution will be from 0:00 to 23:59 of the specified day.

11.1.3 Registering Execution Actions
To automatically execute actions at an event occurrence, actions to be executed for the event must be registered. The actions
to be executed can be defined using the Define Action dialog box. Multiple automatic actions can be set for one same event.

The following describes the automatic actions provided by the event monitoring function.

- Audio notification

Notifications are made by message readout (text-to-voice), WAV file playing or a beep sound.

- Electronic mail transmission (e-mails )

Notifications are made by e-mail messages.

- Pop-up message notification

Notifications are made by pop-up messages.

- Short Mail notification

Notifications are sent via Short Mail

- SNMP trap transmission

Notifications are made by issuing SNMP traps.

- Application call

Notifications are made by starting applications.

- Event log output

Notifications are made by outputting messages to event log files.

 
Procedure

1. Displaying the Monitored Event Table window

Select Event Monitoring Conditions Definition from the Options menu of the Systemwalker Operation Manager
window.

2. Displaying the Define Action dialog box

Select an event by which actions are to be specified in the Monitored Event Table window. Then, select Set Actions
from the Actions menu of the Monitored Event Table window (or select Set Actions from the pop-up menu displayed
by right-clicking).
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3. Defining actions to be automatically executed

In the Define Action dialog box, define the actions to be automatically executed. After defining, click OK or Apply to
save the definition.

Figure 11.5 Action Definition dialog box - Audio Notification sheet

Enable Audio Notification:

Carries out the audio notification.

Execution Method:

Specifies the action execution method (execute and halt/execute and continue) when the event is specified in
multiple lines of the message filtering definition.

Destination List:

Information on the audio notification destination. It is normally grayed out, as it is available only when
Systemwalker Centric Manager is installed.

Notification Type:

Defines the audio notification method.

Sound:

Notifies by reading out the message text.

WAV File:

Notifies by playing the WAV file.
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Beep:

Notifies by a beep sound.

Repeated:

Specifies the number of repetitions.

Figure 11.6 Action Definition dialog box - Mail sheet

Sound notification by Mail:

Carries out notifications by mails.

Execution Method:

Specifies the action execution method (execute and halt/execute and continue) when the event is specified in
multiple lines of the message filtering definition.

Definition Details:

Defines the destination of notification mails.

Destination List:

Lists the destination names registered the mail notification destinations.

Add button:

Registers a new mail destination. Clicking Add displays the Add Destination dialog box.
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Change button:

Changes an already-registered destination. Clicking Change displays the Add Destination dialog box.

Delete button:

Deletes the destination name selected in the Destination List.

Contents:

Specifies information on mail transmission.

Include Event Contents:

Sends information on the specified message. The issuing host (computer) name, the date and time of issue and
the message body will be sent.

Details button:

Specifies information to send by mail. Clicking this button displays the Mail Details dialog box.

Send Data for Mail link:

Sends information on the events which have occurred on the system to the Systemwalker Centric Manager
system monitoring function via e-mails. It is normally grayed out, as it is available only when Systemwalker
Centric Manager is installed.

Figure 11.7 Mail-Details dialog box

Subject:

Specifies the mail subject.
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Body:

Specifies a character string to be sent.

Attachment:

Specifies the name of the file to be sent.

Figure 11.8 Action Definition dialog box - Pop-up sheet

Display a Pop-up Message:

Carries out notifications by pop-up messages.

Execution Method:

Specifies the action execution method (execute and halt/execute and continue) when the event is specified in
multiple lines of the message filtering definition.

Definition Details:

Defines the notification destination of pop-up messages. The destination must be a PC name or a user name. No IP
address is allowed.

Destination List:

Lists the destination names registered the pop-up message notification destinations.

Add button:

Adds a notification destination of pop-up messages. Clicking Add displays the Add Destination dialog box.
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Change button:

Changes an already-registered notification destination of pop-up messages. Clicking Change displays the Add
Destination dialog box.

Delete button:

Deletes the destination name selected in the Destination List.

Message:

Specifies a character string to display in the pop-up message.

Figure 11.9 Action Definition dialog box -Short Mail sheet

Enable Short Mail:

Enables message notification by Short Mail.

Execution Method:

Specifies the action execution method (execute and halt/execute and continue) when the event is specified in
multiple lines of the message filtering definition.

Definition Details:

Defines the Short Mail destination.

Destination List:

Displays addresses that are registered as Short Mail destinations.
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Add button:

Adds a Short Mail destination. Clicking the Add button displays the Mail Destination dialog box to add a Short
Mail destination.

Change:

Changes a Short Mail destination that has already been registered. Clicking the Change button displays the Mail
Destination dialog box to change a Short Mail destination.

Delete:

Deletes the destination name selected in the Destination List.

Message:

Defines the message information to be sent as Short Mail.

Text:

Select this option to enter text format character strings in the message input area.

Number:

Select this option to enter number format character strings in the message input area.

Message:

Specifies the message to send.

The length of the character string that can be sent varies according to the type of modem used and the type of
Short Mail available at the destination. See appropriate manuals to determine the length of messages.

- 389 -



Figure 11.10 Action Definition dialog box - SNMP Trap sheet

Generate an SNMP Trap:

Specifies to issue SNMP traps.

Execution Method:

Specifies the action execution method (execute and halt/execute and continue) when the event is specified in
multiple lines of the message filtering definition.

Trap Destination:

Specifies the action execution method when the event is specified in multiple lines of the message filtering
definition.

Community Name:

Specifies the community name used in the SNMP traps.

Host Name:

Specifies the host name where the SNMP manager exists.

Message:

Specifies the notification message text.

Send Messages As Traps:

Select this option when sending traps with the PDU data of the traps sent by a lower-level server, or when sending
event messages using traps. It is normally grayed out, as it is available only when Systemwalker Centric Manager
is installed.
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Figure 11.11 Action Definition dialog box - Program Invocation sheet

Invoke a Program:

Carries out application startup.

Execution Method:

Specifies the action execution method (execute and halt/execute and continue) when the event is specified in
multiple lines of the message filtering definition.

Program Settings:

Executes the specified execution file with the specified parameter when an action is executed.

Filepath:

Specifies the execution file name of the application to be started.

Program Arguments:

Specifies the parameter to be passed to the execution file.

If you specify "%MSG", "%DATE", or "%HOST" as parameters, they will be replaced as follows. When they
are replaced, content exceeding 4096 bytes are not output.

 
Parameter Replaceable content

%MSG Generated message
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Parameter Replaceable content

%DATE Date and time when the message was
generated

%HOST Host name that generated the message

When using "%MSG", "%DATE", or "%HOST", blank spaces are required before % symbols and after
respective character strings. Also, messages that are passed with "%MSG" are messages that have not yet been
edited with the script specified for message editing for the message monitoring action.

Working Directory:

Specifies the directory where the application is executed.

Program Appearance:

Specifies the display method (normal display, no display or icon display) when starting up the application.

Figure 11.12 Action Definition dialog box - NT Event Log Output sheet

Create a Record in the Event Log:

Outputs messages to the event log files.

Execution Method:

Specifies the action execution method (execute and halt/execute and continue) when the event is specified in
multiple lines of the message filtering definition.
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NT Event Record:

Specifies the event type (error, warning or information) and the messages to be output.

 

 Note

- The event monitoring function is defined no to execute actions when the same event occurs again within the specified
period of time, taking the server loads and necessity into account. The time in which actions are suppressed after previous
execution of actions is called "block time." For Systemwalker Operation Manager, the action block time is one minute.

- To display a pop-up message, the Messenger Service must be running on the action execution destination host and the
notification destination computer. If the notification destination computer is a Windows Vista(R), Windows Server 2008
or Windows(R) 7 machine, one of the following products must be installed:

- Systemwalker Centric Manager

- Client [Selected option: Action Execution (Audio Notification)]

- Operation Management Client [Selected option: Action Execution (Audio Notification)]

- Job Server

- Section Management Server

- Asset Management Server

- Operation Management Server

- Systemwalker Operation Manager

- Client [Selected option: Action Execution (Audio Notification)]

- Server

- To define popup message notification actions in the Monitored Event Table for a Systemwalker Operation Manager
server running on the Server Core, specify either a client or an Operation Management Client where one of the following
products has been installed on the computer in the Destination List:

- Systemwalker Centric Manager

- Client [Selected option: Action Execution (Audio Notification)]

- Operation Management Client [Selected option: Action Execution (Audio Notification)]

- Systemwalker Operation Manager

- Client [Selected option: Action Execution (Audio Notification)]

- If the popup message action is specified for the destination of inactive computer or non-registered computer, the popup
message is not notified. However, the action is terminated normally. Also, if a communication error such as disconnected
LAN cable has occurred, the popup message is not notified. However, the action is terminated normally. If no popup
message is notified although the popup message action is terminated normally, execute the NETSEND command in the
Windows(R) system and check that the environment to allow popup message notification has been established.

- Popup messages can only be used on Microsoft networks. Whether messages can be sent to a specified recipient
(computer name or user name) or not can be confirmed by executing a Windows(R) "NET SEND" command on the host
specified in Action Execution Host of the Action Environment Setup dialog box.

- An IP address cannot be specified as the recipient of a popup message. Specify a computer name, user name or domain
name.

- If the computer on which a popup message is displayed is connected via a WAN, the host name search may time out and
the popup message may not be displayed. Do not specify computers which are connected via WAN.

- When playing a WAV file, specify the file name using the full path to the file.
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- A product equipped with a Microsoft Speech API (SAPI) compatible voice synthesizer engine is necessary to execute
voice notification actions.

- Audio notification actions cannot be executed on a server in the Server Core.

- If the Repeated on the Audio Notification is set to 0, the notification will repeat indefinitely until stopped.

- If audio notification, pop-up message notification or short mail notification is used in Windows Vista(R), Windows
Server 2008 or Windows(R) 7 environments, log in to the operating system as a user that belongs to the "Users" group.
Action execution can only be used once the user has logged in to the operating system. To allow action execution to be
used by simply starting the operating system, automatic login settings need to be specified. 
If Systemwalker Operation Manager coexists with Systemwalker Centric Manager, the privileges required for action
execution varies depending on the type of Systemwalker Centric Manager server that has been installed. Refer to the
Systemwalker Centric Manager User's Guide - Monitoring Function for more information.

- Event log output can only be specified for monitored hosts running Windows(R).

- Ending of commands is not being waited during application startup. If multiple application startup events occur, all the
applications will be executed at the same time. Perform an exclusive control on applications being executed if the
simultaneous execution of multiple commands causes problems.

- If a server specified for an action is a Windows(R) server, the application will be run with System-level account
privileges. Therefore, commands which cannot be executed with System-level privileges will generate an error when
being executed.

- For applications which output a message for standard output and standard error output, describe a batch file to redirect
the application output to a separate file and set the batch file name to the application name in Action Definition-Program
Invocation.

- Application startup users and environment variables will be the same as the operating environment for Systemwalker
Operation Manager. If the executed application requires special environment variables (library paths, etc.), create a batch
program with the required environment variables for the relevant application.

- If the mail subject is not specified it will be set to "Event Monitor Report".

11.1.4 Inhibiting Action Execution Server Startup
If you select Action Execution [Audio Notification] in the installation options during installation, the action execution server
will start at log in.

The action execution server does not need to be started on Windows(R) computers that are not specified as an action execution
host for short mail, pop-ups, audio notification, etc.

As the action execution server startup status is enabled after installation is complete, inhibit the startup of the action execution
server on servers that are not specified as action execution hosts, as required. By inhibiting the startup of the action execution
server, you can inhibit the display of the following error message at login:

 
The action execution server cannot be started.

 
Method for inhibiting action execution server startups

Inhibit the startup of the action execution server on Windows(R) computers that are not specified as an action execution host
for short mail, pop-ups, and audio notification using the following procedure.

Action execution server startup inhibition procedure (Disabling the startup)

1. Start the msconfig command

In Windows Run, enter "msconfig" and click OK.

2. Disable the action execution service startup

Select the Startup tab of the System Configuration Utility that you started.

Clear the Startup Item checkbox for the following item, and click OK.
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Command Name

 
<Systemwalker Operation Manager installation directory>\MPWALKER\bin
\strmpaosfx.exe -startup

3. Restart the system

A pop-up appears asking if you want to restart. To enable the settings, restart the system.

If this procedure is used, you will not be able to execute the actions below on the executing server:

- Audio notification

- Short mail

- Pop-ups

11.2 Operating Actions
This section explains how to use the different actions provided by Systemwalker Operation Manager.

11.2.1 Procedure for Operating Actions
Among actions automatically executed by the event monitoring function, the action management function enables the
operations described below for Short Mail, audio notification, mail, and popup messages. When an action cannot be executed
because, for example, there are too many actions to be executed, it is possible change the action execution sequence and have
the actions executed earlier than other actions.

- Changing the execution waiting order for waiting actions

- Halting execution of waiting actions

- Releasing the halted actions to resume execution

- Deleting waiting actions

- Stopping executing actions (for audio notification)

The following describes the procedure to operate actions.

1. Confirming the Action Execution Status

2. Operating Actions

11.2.2 Confirming the Action Execution Status
It is possible to confirm the execution status of the actions executed at event occurrences. The following describes the
procedure.
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Procedure

1. Displaying the Action control window

Select Action Control from the Options menu of the Systemwalker Operation Manager window.

Figure 11.13 Action control window

Type:

Displays actions such as audio notification, pop-up message, mail and Short Mail with relevant icons.

Status:

Displays the action status (executing, waiting, abended or paused).

Control Number:

Displays the management number specified by the action control function.

Requested by:

Displays the request source application name.

Sent to:

Displays the action destination address or name.

Received on:

Displays the date and time when the action execution has been accepted by the action control function.

Waiting number:

Displays the waiting order number of the action.

Executing Host:

Displays the name of the host executing the action.

2. Filtering the actions to be displayed

When too many actions are displayed, it is possible to filter the actions by their types. Select the action type to be
displayed from the View menu of the Action control window.

3. Confirming the action execution status

Confirm the action execution status in the Action control window.

4. Displaying the Action Details dialog box

Select the action for which the detailed information is to be displayed in the Action control window. Then, select
Properties from the File menu of the Action control window.
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5. Confirming the action details

Confirm the action details in the Action Details dialog box.

Figure 11.14 Property dialog box

11.2.3 Operating Actions
It is possible to operate the actions executed at event occurrences. The following describes the procedure.

 
Procedure

1. Displaying the Action control window

Select Action Control from the Options menu of the Systemwalker Operation Manager window.

2. Selecting the action to be operated

Select the action to be operated in the Action control window.

3. Operating the action

Select Execute, Pause, Resume or Delete from the Operate menu of the Action control window.

Execute:

Sets the waiting order number of the selected action to the first.

Pause:

Pauses the selected action.

Continue:

Cancels the paused status of the selected action.
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Delete:

Deletes the selected action. For audio notification, the action can be deleted even during execution. The system will
stop the audio notification as soon as the action is deleted.

The following shows the operations that can/cannot be carried out for each action status.
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Chapter 12 Analyzing Audit Logs
This chapter describes analyzing audit logs.

12.1 Audit log information
The following records are saved as audit logs in audit log files.

Note that only operating system administrators can view the content of audit log files.

- Records of schedule definition changes and operations

- Records of job/queue definition changes and operations

- Records of command/API/Web API operations

- Records of the service/daemon starting

- Records of login authentication to Systemwalker Operation Manager

- Records of definition changes and operations from Systemwalker Operation Manager environment setup clients

- Records of client usage

Refer to "Appendix B List of Search Keywords for Audit Logs" for details on the operation content that is recorded as audit
logs.

 

 Note

Audit logs for connections from Systemwalker Operation Manager clients

Audit logs for Systemwalker Operation Manager clients will not be recorded in the following situations:

- If the client machine shuts down or logs off

- If there is a network error between the client machine and the server machine

To record the history of client operations in audit logs on the server, change the version of the client to V13.2.0 or later.

If a connection is made using a V13.0.0 or V13.1.0 client, no information will be recorded in audit logs other than the version
information for the client that made the connection.

12.2 Example Operation Using Audit Logs
Administrators can look up and analyze audit logs using text editors or spreadsheet software such as Microsoft(R) Excel.

This section describes the procedure for looking up and analyzing audit logs, and also presents a usage example.

 
Procedure for looking up and analyzing audit logs

Use the following procedure to look up and analyze audit logs.

Operation procedure

1. Import the audit log file from the output destination on the Systemwalker Operation Manager server specified in the
audit log definitions to a text editor or a spreadsheet program such as Microsoft(R) Excel.

Audit logs are recorded in audit log files in CSV format as shown below, with each item separated by a comma.

 
"2006/09/26 11:25:12.672
+0900","10.90.100.100","host1","user1","ADD_PROJECT","SUBSYSTEM=0;PR
OJECT=PRJ01;"," The project is added.",S,"MPJOBSCH","PID=8045;",
"2006/09/26 11:30:41.835
+0900","10.90.100.100","host1","user1","ADD_JOBNET","SUBSYSTEM=0;PROJ
ECT=PRJ01;JOBNET=JOBNET01;"," The job net is
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added.",S,"MPJOBSCH","PID=8045;",
"2006/09/26 11:30:45.390
+0900","10.90.100.100","host1","user1","START_JOBNET","SUBSYSTEM=0;PR
OJECT=PRJ01;JOBNET=JOBNET01;"," The job net is
started.",S,"MPJOBSCH","PID=8045;",

2. Look up and analyze audit logs by using the search and sort functions of the text editor or spreadsheet program (such
as Microsoft(R) Excel) to extract the desired audit logs.

Audit logs can be analyzed efficiently using Microsoft(R) Excel's filter and sorting functions.

 
Audit log usage examples

Several audit log usage examples are shown below.

Examples utilizing records that include specific information that matches the analysis objectives

To isolate information relating to changes and operations on a particular job net, use the job net name as a keyword to search
for and extract audit logs that include the specific job net name, and then analyze the content of these audit logs.

For details on search keywords, see "Appendix B List of Search Keywords for Audit Logs."

The main information contained in audit logs is as follows:

 
Date The date that the operation was performed

Operation location The location where the operation was performed

Execution host The name of the host where the operation was actually executed

Operator The name of the user that performed the operation

Operation type The category for the content of the operation performed
(addition, change, deletion, etc.)

Operation target Information that identifies the operation (project name,
subsystem number, job net name, calendar name, etc.)

Operation content The content of the operation

Execution result Whether the executed operation was successful

For details on audit logs, see the Systemwalker Operation Manager Reference Guide.

- Example 1

Objective: To identify the user who changed job net "AAA", because an error in the definitions has been found

Method: Extract all lines containing "AAA" for the job net from the audit log file, and then identify the user from the
"Operator" and "Operation content" fields.

- Example 2

Objective: To check whether operations have been performed strictly according to the operation procedure guide

Method: Extract all lines containing the user name for the operator ("BBB") to be checked from the audit log file, and then
check whether the operations in these lines have been performed according to the operation procedure guide.

- Example 3

Objective: To extract only those records relating to job net "CCC" in subsystem 1 in a multi-subsystem operation

Method: Extract lines where the "Operation target" field contains the following strings, and then extract those lines that
contain the job net name "CCC".

- SUBSYSTEM=1

- SUBSYSTEM=all

- Example 4

Objective: To check whether there are any users connected to the server using a lower version client
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Method: Extract lines where the "Operation type" field contains the string "ADMIT_OMGR", and then check the
"CL_VERSION=XXX" in the "Additional information" part.

If "V13.0 or V13.1" is displayed in the "XXX" part, this indicates a connection from a V13.0.0 or V13.1.0 client. If
"V13.2 or later" is displayed, this indicates a connection from a client running V13.2.0 or later.

Examples of how to use audit logs when problems occur

When problems occur, checking the following records (in addition to the event log/syslog and job execution histories) can
be a useful way to isolate the cause of problems.

- Records of the service/daemon starting

Logs of start/stop operations for the Systemwalker Operation Manager common infrastructure, the calendar function, the
Jobscheduler function, the Job Execution Control function, and the service/daemon for the ACL manager are recorded
with the "Operation content" part in the following format:

[Windows]

- "Started <function name> daemon/service."

- "Stopped <function name> daemon/service."

The name of the function (Systemwalker Operation Manager common infrastructure, calendar function, etc.) will be
output in the <function name> part.

[UNIX]

- "Executed a command. (COMMAND=<command name command arguments>)"

However, for the ACL manager, the following messages will be output.

- "Started the ACL Manager daemon/service."

- "Stopped the ACL Manager daemon/service."

- Records of login authentication to Systemwalker Operation Manager

Logs of login authentications to Systemwalker Operation Manager are recorded with the "Operation content" part in the
following format:

- "Admitted user."

If a function that spans multiple servers (such as the multi-server monitoring function or distributing policies to multiple
servers) is used, authentication on the other servers will be performed automatically. At this point, the user ID and
password used to log in to the first server will automatically be used as the user ID and password for authentication on
the other servers, and a record of the authentication will be recorded in the audit logs on each server.

- Records of definition changes and operations from Systemwalker Operation Manager environment setup clients

Logs of policy application operations are recorded with the "Operation content" part in the following format:

- "The policy is applied." or "Applied policies."

- Records of client usage

Logs indicating which clients have been used are recorded with the "Operation content" part in the following format:

- "Logged in <window name>"

One of the following will be output in the <window name> part:

- Systemwalker Operation Manager window

- Systemwalker Operation Manager Environment Setup window

- Multi-Server Monitoring window

- Print Jobscheduler Info window

- Master Schedule Management window

- Master Schedule Management Environment Setup dialog box
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Chapter 13 Changing According to Operations
This chapter describes procedure for changing the Systemwalker Operation Manager operating environment according to the
intended operations.

13.1 Continuing Job Operations at Schedule Server System
Down

Whether to continue network job and distributed execution job operations during the schedule server down time can be
defined using the continuous execution mode switching command (jmmode command). The following describes how to
define the continuous execution mode switching command (jmmode command). Note that the following operations should
be performed in the same way, on all of the linked schedule servers and execution servers.

 
Procedure

1. Stopping the services or the daemon

Terminate the following services/daemons.

- Jobscheduler service/daemon

- Job Execution Control service/daemon

2. Executing the continuous execution mode switching command (jmmode command)

Execute the jmmode command for which the continue operand has been specified to validate the continuous execution
mode for network and distributed execution jobs. For details on the jmmode command, see the "Shared Commands"
section of the Systemwalker Operation Manager Reference Guide.

3. Starting the services or the daemons

Start the following services/daemons.

- Job Execution Control service/daemon

- Jobscheduler service/daemon

 

 Note

- For Windows system, only network and distributed execution jobs can be continued at schedule server system down. The
jobs that are executing on the schedule server cannot be continued.

For UNIX system, only network and distributed execution jobs within the job nets with the Job Execution Control
attribute can be continued at schedule server system down. The jobs in the job nets with other attribute or the jobs that
are executing on the schedule server cannot be continued.

- If the JCL file is used, the job execution cannot be continued at schedule server system down.

- If a Jobscheduler command (other than the jobschprint command) has been used to register job nets or groups, the
schedule file will not be duplicated. The schedule file may be corrupted if the schedule server system down has occurred
while any of these commands is in execution.

- Use the same continuous execution mode on both the schedule server and all of the execution servers to which execution
requests are sent. The following problems sometimes occur when the same continuous execution mode is not used:

- During schedule server system downs, "Executing" may be displayed even though the jobs have terminated

- Jobs may output an error message and terminate abnormally

- Network job execution may be duplicated
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- Continuous job execution is possible only in environments where updates are reliably reflected in the physical disk. In
environments where updates are reflected only in the cache, information on jobs that were running when the system fails
does not remain in the disk, so continuous job execution is not guaranteed.

- In the UNIX version, continuous job execution applies to abnormal stop of the Job Execution Control daemon, but in the
Windows version, it applies both to abnormal stop and to normal stop of the service.

This difference is intended to handle the following discrepancy in stop operations when failover is performed in a cluster
system, in order to enable continuous job execution in the Windows version as well:

- UNIX version: A stop of the Job Execution Control daemon is regarded as an abnormal stop.

- Windows version: A stop of the Job Execution Control service is regarded as a normal stop.

 

 Note

Continuous execution mode for network jobs and distributed execution jobs

As a default, the continuous execution mode is specified to cancel network jobs and distributed execution jobs if the schedule
server system down has occurred. In such cases, the job execution will be considered to be interrupted (completion code =
239) at the schedule server startup after the system down.

 

 Note

Duplication of schedule files

When schedule information file redundancy is specified with the jmmode command, write operations to the backup file will
be synchronized as well as write operations to the schedule information file. Synchronization of write operations to the
backup file helps prevent inconsistencies from occurring in the schedule information file, but it also adversely affects the
scheduling and execution performance of groups, job nets and jobs. Before deciding to use this function, carry out thorough
performance validation tests to determine whether job nets are running correctly according to schedule. Even when
redundancy is specified, schedule information file discrepancies can still occur in some situations, such as when a power
failure occurs while the operating system is writing to the hard disk. Consider making regular backups to guard against such
situations.

Degradation of scheduling and execution performance can be avoided by not implementing schedule information file
redundancy with the jmmode command. However, this will increase the risk of schedule information file inconsistencies due
to events such as unexpected power outages, so regular backups should be made to facilitate recovery in the event of such
problems.

 

 Note

Policy distribution [Windows version]

To extract the policy information (the execution parameter information for the Jobscheduler) from a server environment
where the continuous execution mode for network and distributed execution jobs has been validated and distribute and apply
it to another server environment where the continuous execution mode has not been validated, distribute the policy
information, execute the jmmode command with the continue operand specified on the distribution server and validate the
continuous execution mode.

Conversely, to extract the policy information (the execution parameter information for the Jobscheduler) from a server
environment where the continuous execution mode for network jobs has not been validated and to distribute and apply it to
another server environment where the continuous execution mode has been validated, distribute the policy information,
execute the jmmode command with the cancel operand specified on the distribution server and validate the continuous
execution mode.
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13.2 Duplicating the Network Job Execution Server
To duplicate the network job execution server, the following definitions are required.

 
Specifying the secondary execution server

When duplicating a network job execution server, the primary and secondary execution servers must be defined in one of the
following three methods. When duplicating execution server, you may not use execution subsystem name as the primary and
secondary host name.

- Defining in the Standard information sheet of the Add/Change-Job window

In the Request host field in the Standard information sheet of the Add/Change-Job window, specify the primary and
secondary execution servers in the form of "primary host name, secondary host name."

- Defining in the Standard information sheet of the Job Net Properties window

In the Default host name field in the Standard information sheet of the Job Net Properties window, specify the primary
and secondary execution servers in the form of "primary host name, secondary host name."

- Defining with the jobschsetnet command

For details on the Add/Change-Job window and the Job Net Properties window, see "4.2.3 Registering Job Nets," "4.2.4
Registering Jobs," and "4.2.5 Job Net Information Settings".

The following describes how to define the primary and secondary execution servers using the jobschsetnet command.

 
Procedure

1. Specify the primary and secondary execution servers using the req_host operand of the job control statement or the
defaulthost operand of the job net control statement. Specify in the form of "primary host name, secondary host name."

2. Specify either a -nent operand, a -nche operand or -ncheall operand to execute the jobschsetnet command. Specify the
file name having the job control statement or the job net control statement edited in Step 1 in the definition file.

For details on the jobschsetnet command, job control statements and job net control statements, see the "Jobscheduler
Commands" section of the Systemwalker Operation Manager Reference Guide.

13.3 Distributing the Database Directory and the Spool
Directory

The following describes how to distribute the database directory and the spool directory to optional disks for such cases as
executing a large numbers of jobs in a subsystem environment.

 
Directory storage location

When a subsystem environment is created, the database directory and the spool directory are stored in the following locations.

Database directory

 
Windows Installation directory\MpWalker.JM\mpjobsch\jobdbn

Solaris /var/opt/FJSVJOBSC/JOBDBn

HP-UX /opt/FHPJOBSCH/db/JOBDBn

AIX /usr/FAIXJOBSC/db/JOBDBn

Linux /var/opt/FJSVJOBSC/JOBDBn

Spool directory
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Windows Installation directory\MpWalker.JM\mpmjessv\mjesn\mjespool

Solaris /var/opt/FJSVMJS/var/spool/mjes/mjesn

HP-UX /opt/FHPMJS/var/spool/mjes/mjesn

AIX /opt/FAIXMJS/var/spool/mjes/mjesn

Linux /var/opt/FJSVMJS/var/spool/mjes/mjesn

"n" in "JOBDBn", "jobdbn" and "mjesn" above corresponds to the subsystem number from one to nine. When the subsystem
number is zero, the same directory as when not using multiple subsystems will be used.

 
Procedure to distribute directories [UNIX version]

Distribution of database directory and spool directory in the UNIX system environment can be carried out by moving the
database and spool directories to optional disks and creating symbolic links in the default storage location when the subsystem
environment has been created.

The following provides an example of moving the database directory to "/disk1" and the spool directory to "/disk2" in the
Solaris environment.

1) Moving to disks

Move the database directory and the spool directory to different disks.

 
# mv /var/opt/FJSVJOBSC/JOBDBn /disk1/JOBDBn
# mv /var/opt/FJSVMJS/var/spool/mjes/mjesn /disk2/mjesn

2) Creating symbolic links

Create symbolic links as follows.

 
# ln -s /disk1/JOBDBn /var/opt/FJSVJOBSC/JOBDBn
# ln -s /disk2/mjesn /var/spool/mjes/mjesn

Remark: Replace "n" in the example above with the actual subsystem number.

 
Procedure to distribute directories [Windows version]

Distribution of database directory and spool directory in the Windows system environment can be carried out by specifying
the database directory and the spool directory on the distribution destination disks in the sheet displayed from the
Systemwalker Operation Manager Environment Setup window.

Database directory:

Display the Database sheet of the Define Jobscheduler Startup Parameters window from the Systemwalker Operation
Manager Environment Setup window. In this window, change the default drive name to a drive name on another disk.

Spool directory:

Display the Define Operating Information window from the Systemwalker Operation Manager Environment Setup
window. In the Spool directory field in the Cluster settings sheet of the Define Operating Information window, change
the directory to a directory on another disk.

 

 Note

If you specify the spool directory, its files and directories are deleted when you start up the system in the Initialization mode.
This is because the spool directory is used as the work directory by Job Execution Control. Always specify an empty directory
as the destination of spool directory.
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Chapter 14 Status and Operations of Scheduled Jobs
This chapter describes status and operation of scheduled jobs.

14.1 Status and Operations of Jobs, Job Nets and Groups
This section explains the status and operation of jobs, job nets and groups.

14.1.1 Job Status
The following describes the status of jobs registered in the Jobscheduler.

The job status is any of the following. The display color is the color in which the status is displayed in the Monitor Job Net
window.

 
Completed

Displayed in blue.

The job is considered to be completed when either of the following is satisfied.

- When the completion code is not higher than the normal completion code upper limit value specified in the Add/Change-
Job window.

However, the Validate pseudo-normal option is checked in the Define Jobscheduler Startup Parameters window, the job
is considered to be completed only when the completion code is zero. When the completion code is within the range of
one and the upper limit, it is considered as pseudo-normal.

- When Ignore completion code is specified in the Add/Change-Job window (the job is always considered to be completed
regardless of the completion code, even if Validate pseudo-normal is checked).

 
Pseudo-normal

Displayed in light blue.

The pseudo-normal status of the job is indicated when Validate pseudo-normal is checked in the Define Jobscheduler Startup
Parameters window.

The completion code is between one and the normal completion code upper limit.

 
Abended

Displayed in red. When icon animation is enabled, an "x" symbol will flash on an off within the red circle.

The job is considered to be abended when the completion code has exceeded the normal completion code upper limit.

 
Cancelled

Displayed in yellow.

The job is considered to be cancelled when the user has executed the cancel operation.

 
Warning

Displayed in brown. When icon animation is enabled, an animation will be displayed in the lower part of the brown circle.

If the job is a child job net or linked job net, the status indicates that the child job net or linked job net is in warning status.
For details on the warning status for job nets, see "14.1.3 Job Net Status".

 
Executing

Displayed in green. When icon animation is enabled, an animation will be displayed in the lower part of the green circle.

The job is considered to be executing when the job is in execution.
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Waiting

Displayed in pink.

The job is considered to be waiting when it is scheduled for execution today and waiting to be executed.

 
Start delayed

Displayed in purple.

The job is considered to be delayed when the job is connected to the queue and has not been executed.

For example, this status occurs when multiple jobs exceeding the execution multiplexing are waiting to be executed.

 
Paused

Displayed in orange.

The job is considered to be paused when the user has executed the pause operation. Once the job is paused, it will not be started
until the continue operation is executed. The succeeding jobs will not be executed either.

 
Disabled

Displayed in gray.

The job is considered to be disabled when the user has executed the disable operation. The job must be disabled when you
want to skip the job execution. The disabled job will be considered to be pseudo-normal when the preceding job is completed.
Therefore, the succeeding job will be executed without being paused.

 
Passed status

The icon frame is displayed with a dot circle and the icon is displayed in a light color.

The passed status is the status of the following jobs:

- Jobs that were skipped without being started because they did not satisfy the execution conditions in a case where the
completion code of the preceding job is used to determine the execution conditions for the succeeding job. Other jobs that
were stopped during processing because "wait with OR" condition was used for multiple preceding jobs and one of those
preceding jobs satisfied the conditions and completed normally or ended abnormally

The icon frame of the passed job is indicated as follows:

Waiting job has been passed: Waiting (passed status)

The icon frame is indicated with a pink dot circle.

Stopped job has been passed: Paused (passed status)

The icon frame is indicated with an orange dot circle.

Disabled job has been passed: Disabled (passed status)

The icon frame is indicated with a gray dot circle.

Preceding job with OR condition has been passed: Canceled (passed status)

The icon frame is indicated with yellow dots.

 
Connection line indicating relationship between preceding and succeeding jobs

Depending on the relationship between preceding and succeeding jobs, connection line is indicated as follows.

Connection relationship of normal jobs

Connected by a black solid line.

Connection relationship of recovery jobs

Connected by a red solid line.
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Connection relationship when succeeding jobs are determined by completion code

Connected by a blue line. When the job has been passed without satisfying the conditions, however, the connection line
between the preceding job and the passed job will be changed to a gray line.

Connection relationship of jobs with "wait with OR" condition

Connected by an orange solid line. Even after the job has been passed, the connection line will be an orange solid line.

14.1.2 Job Operations and Actions
This section describes the job operations and the actions following the job operations. The following operations can be
executed for jobs.

 
Cancelled

Cancels the jobs under execution and the jobs of which the execution has been delayed. The job will be in the cancelled status.

 
Restart

Restarts the abended or cancelled jobs. If the recover job is in execution, however, the jobs cannot be restarted.

When connected to any server with Systemwalker OperationMGR V10.0L21/10.1 or older, the job net can only be restarted
when it is in the warning status. Also, the recovery jobs cannot be restarted. The operation will be ignored.

 
Pause

Pauses the waiting jobs and completed jobs. The paused job will not be executed even if the execution conditions are satisfied
upon normal completion of the preceding job. The succeeding jobs will not be executed either.

 
Continue

Cancels the paused status of the job. The job status will be as follows.

- If resumed before the job execution conditions are satisfied, the paused job will resume the status before the pause
operation.

- If the execution conditions are satisfied while the job is being paused, the job will be started after resuming.

The figure below shows an example when completion of the preceding job is specified as the execution condition.

When the recovery job is being paused when the preceding job is terminated abnormally, the recovery job will be started after
resuming.
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Disable

Disables the waiting, paused and completed jobs. The disabled jobs will be skipped and the succeeding job will be started if
the execution conditions are satisfied. When the execution conditions are satisfied while the job is being paused, the job will
be skipped when disabled.

The figure below shows an example when completion of the preceding job is specified as the execution condition.

When a recovery job for which Restart previous job is specified is disabled, the recovery job will be skipped when the
preceding job is terminated abnormally and the original job will not be restarted.

 
Enable

Cancels the disabled status of the job. The job status will be as follows.

- If enabled before the execution conditions are satisfied, the job will resume the status before the disable operation. If the
job was in the paused status before the disable operation, however, it will resume the status before the pause operation.

- If the execution conditions are satisfied while the job is in the disabled status, the job will be skipped and will be in the
completed status.

The figure below shows an example when completion of the preceding job is specified as the execution condition.
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14.1.3 Job Net Status
The following describes the status and actions of job nets registered in the Jobscheduler.

The job net status is any of the following. The display color is the Gantt chart color in which the status is displayed in the Gantt
Chart window.

 
Completed

Displayed in blue.

The job net is considered to be completed when all the jobs have been normally completed. For the normal end of a job status,
see "14.1.1 Job Status".

 
Abended

Displayed in red.

The job net is considered to be abended when a job belonging to the job net has been abnormally terminated and the job net
has been terminated. The following shows an example.
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Cancelled

Displayed in yellow.

The job net is considered to be cancelled when the user has executed the cancel operation to the executing job nets or the job
nets in the warning status which include cancelled jobs.

The job net is also considered to be cancelled when the user has executed the cancel operation to a job belonging to the job
net and the job net has been terminated. The following shows an example.
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Warning

Displayed in brown.

The job net is considered to be warning when the job net includes any abended or cancelled job, and a job is in execution on
another route.
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 Note

The status of the job net will continue to be warning even if there are no longer any abended jobs in the job net as a result of
the abended jobs being restarted. When the job net completes, the status display will return to the normal status display (such
as completed or pseudo-normal).

 
Executing

Displayed in green.

The job net is considered to be executing when the job net is in execution. In other words, when jobs belonging to the job net
is in execution.

The job net is also considered to be executing when the user has executed the pause operation to a job belonging to the job
net and the job has been paused.
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Waiting

Displayed in pink.

The job net is considered to be waiting when the job net has been scheduled for execution for the current day.

 
Paused

Displayed in orange.

The job net is considered to be paused when the user has executed the pause operation.

If the execution conditions are satisfied while the job net is being paused, the job net will be started after resuming. If the
execution conditions for the job net are satisfied for the second time while the job net is being paused, the execution reject
message "refused" will be output to the log file jobdb*.log and the job net with the second execution conditions will not be
executed. The first job net will be executed upon resuming.

 
Disabled

Displayed in gray.
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The job net is considered to be disabled when the user has executed the disable operation.

If the startup time comes while the job net is in the disabled status, it will be skipped and will be in the pseudo-normal status.
When the next startup schedule exists for the day, the job net will be in the waiting status. If the next startup time comes while
the job is in the disabled status, the job net will be skipped at every startup time and will be in the completed status after the
enable operation.

If the job net has been registered as a job in another job net, it will be skipped and the status will be pseudo-normal after the
preceding job, child job net, or linked job net completes. The succeeding job, child job net or linked job net will then be
executed.
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If the disabled job net belongs to a group, the disabled job net will be skipped and be in the pseudo-normal status upon
completion of the preceding job. The succeeding job will be executed continuously.

 
Confirmed

Displayed in dark blue.

The job net is considered to be checked when the user has executed the confirm operation to the abended job nets (including
cancelled job nets when Check canceled Option is checked in the Define Jobscheduler Startup Parameters window) while the
confirm operation is enabled.

If the Validate job net confirmation check box is selected in the Advanced Settings for Verification window (which is
displayed by clicking the Advanced Settings button in Verification at error occurrence in the Use function1 sheet of the
Define Jobscheduler Startup Parameters window), abended job nets will not start until the confirmation process is complete,
even if the subsequent startup conditions are satisfied. Also, the job net will not be displayed in the startup schedule for the
day even after the day change time.

By coping with abended job nets and executing the confirm operation, the job net will be executed when the execution
conditions are satisfied as scheduled.

 
Pseudo-normal

Displayed in light blue.

The job net is considered to be pseudo-normal when all the executable jobs have been completed and pseudo-normal jobs and
completed jobs or only pseudo-normal jobs exist in the job net.

 
Start Delayed

Displayed in pink in the time chart, which is the same as waiting status. Displayed with dot arrow in pink rectangle in the status
field.

The job net is considered to be start delayed when the job net remains the waiting condition after the scheduled startup date
and time. When the job net is started while in the start delayed status, the job net will be in the executing status.

 
End Delayed

Displayed in green in the time chart, which is the same as executing status. Displayed with a dot arrow in green rectangle in
the status field.

The job net is considered to be end delayed when the job net does not end after the scheduled end date and time. When the
job net ends while in the end delayed status, the job net will be in the executed status.

 
Carried Over

Displayed in pink in the time chart, which is the same as waiting status. Displayed with a vertical line and an arrow in pink
rectangle in the status field.

When a job net scheduled to be executed on the day has not been executed even after the day change time and has not been
re-scheduled, the job net is considered to be carried over. Upon the day change time, the status changes from start delayed
to carried over.

The job net can be carried over only if it satisfies all of the following conditions and has not been executed beyond the day
change time as no message event has occurred.

- The Execution condition is set to "Execute at(run once per day)" or "Start only when message event has occurred" on the
Standard information sheet of the Job Net Properties window.
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- The "Carry over the process regardless of the day change time" are checked on the Message sheet of the Job Net
Properties window.

 
Not executed

Displayed in white.

The "Startup on Power-on if power is off during scheduled execution" box is unchecked on the Standard information sheet
of the Job Net Properties window, and the job net was not started because the scheduled time has passed during server power-
on.

 
Closed:

A message that is output to the event log or SYSLOG. It is not displayed in the Gantt Chart window.

The Jobscheduler service or the Jobscheduler daemon has been terminated during job or job net execution.

 
Refused:

A message that is output to the event log or SYSLOG. It is not displayed in the Gantt Chart window.

The execution has been refused. The scheduled job nets are not executed.

Possible causes are as follows.

- When a job net was being executed or in the warning status, new startup conditions of job net were satisfied.

- When new startup conditions were satisfied while a job net was in "Abended" status in an environment in which the
Validate job net confirmation check box was selected in the Advanced Settings for Verification window.

- When a job net was "paused," multiple startup conditions were satisfied.

 
Skipped:

A message that is output to the event log or SYSLOG. It is not displayed in the Gantt Chart window.

The job or job net was "disabled" when its startup conditions were satisfied and, therefore, it was not executed.

14.1.4 Job Net Operations and Actions
This section describes the job net operations and the actions following the job net operations. The following operations can
be executed for job nets.

 
Cancelled

Cancels the job net being executed.

 
Start

Starts the job net immediately. The job nets will be executed from the first one.

The configuration information used at the startup of a job net including the jobs (child or linked job nets) with the Valid only
on startup days settings varies depending on the status as described below.
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- When the started job net has the startup time scheduled on the previous day or before and is in the Carried over/Paused/
Waiting status, it is started up with the configuration information shown in the Process flow sheet of the Monitor Job Net
window.

- When the started job net has been abended or canceled while the "confirmation" operation in the Abended/Canceled
status is enabled, it is started up with the configuration information shown in the Previous process result sheet of the
Monitor Job Net window.

 

 Note

The message event occurrence status will not be cleared after the startup operation. For details, see "14.4 Message Events and
Job Net Actions".

 
Restart

Restarts the job net. Basically, execution of jobs starts from the abended job. It is possible to specify the first job to start by
setting the restart point.

For details, see "Restarting job nets".

 
Pause

Pauses the job net. The paused job net cannot be executed even if the execution conditions are satisfied. If the job net belongs
to a group, the group will be in the executing status.

 
Continue

Cancels the paused status of the job net. When resumed the job net acts as follows.

- If the job net was in the waiting or finished (Completed, Pseudo-normal, Abended or Cancelled) status before the pause
operation and is resumed before the execution conditions are satisfied, the job net will resume the status before the pause
operation. However, if paused while in any finished status and is newly scheduled, the job net will be in the waiting status.

- If the job net was in the waiting or finished (Completed, Pseudo-normal, Abended or Cancelled) status before the pause
operation and is resumed after the execution conditions are satisfied, the job net will be executed after the continue
operation.
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- If the execution conditions are satisfied while the job net is being paused, and the next scheduled startup time has come,
the execution reject message "refused" will be output to the log file jobdb*.log and the job net will not be executed. The
paused job net will be executed upon the continue operation.

 
Disable

Disables the job net. The disabled job net is considered to be pseudo-normal when the startup time has come and will be
skipped. When the execution conditions are satisfied while the job net is being paused, the job net will be considered to be
pseudo-normal and skipped when disabled.

When the job net belongs to a group, the succeeding job net will be executed when the disabled job net is skipped.

If a carried over job net is disabled, the schedule will be re-created upon the disable operation and the job net will be disabled
while the next scheduled startup date and time is specified.

 
Enable

Cancels the disabled status of the job net. When the disabled status is cancelled after the startup time of the job net, it will be
terminated normally. The job net has already been skipped and will not start unless started manually.

When enabled, the job net acts as follows.
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- If the job net was in the waiting or finished (Completed, Pseudo-normal, Abended or Cancelled) status before the disable
operation and is enabled before the startup time has come, the job net will resume the status before the disable operation.

- If the job net was in the paused status before the disable operation and is enabled before the startup time has come, the
job net will resume the status before the pause operation.

- If the job net was in the carried over status before the disable operation and is enabled before the startup time has come,
the job net will be in the waiting status.

- Even if the job net was in the waiting, finished (Completed, Pseudo-normal, Abended or Cancelled) or carried over status
before the disable operation and is enabled after the startup time has come, the job net will not be executed since it has
already been skipped.

- Even if the job net was in the paused status before the disable operation and is enabled after the startup time has come,
the job net will not be executed since it has already been skipped.

 
Confirm

Brings the previously-abended job nets (including cancelled job nets when Check canceled option is checked in the Define
Jobscheduler Startup Parameters window) to the confirmed status. Confirmation is enabled when Validate job net
confirmation is selected in the Advanced Settings for Verification window (which is displayed by clicking the Advanced
Settings button in Verification at error occurrence in the Use function1 sheet of the Define Jobscheduler Startup Parameters
window). When the Validate job net confirmation option is selected and the job net remains in an abended state, the job net
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will not be executed even if the next execution conditions are satisfied. After confirm operation on the abended job net, the
job net will be executed when the next execution conditions are satisfied.

Note that to enable verification with respect to canceled job nets, it is necessary to select Check canceled as well as Validate
job net confirmation in the Advanced Settings for Verification window.

 
Reinstate

Cancels the execution results of the job nets (Completed, Pseudo-normal, Abended or Cancelled) which have been executed
for the day. This operation is available only when Start only when message event has occurred is selected in the Job Net
Properties window and Once in a day is checked.

After cancellation, the job net will be in the waiting status and be able to wait for a message event occurrence as the execution
condition again. If Scheduled start time is specified, the scheduled startup date and time will be set for the day. If not specified,
the current date will be set.

If Scheduled start time is specified and the reinstate operation is executed after the estimated start time, the job net will be in
the waiting status upon execution of the reinstate operation. In such cases, delay monitoring via the delay monitoring
specifications for the job or job net will not be carried out. When a message event occurs after the reinstate operation, the job
net will be started and be in the executing status.

 
Revoke

Cancels the carried over status of the job net.

The scheduled startup date and time will be re-scheduled to the next ones upon execution of the revoke operation and the job
net will be in the waiting status.

If the next scheduled startup date and time is passed while in the carried over status since the message event has not occurred,
the execution reject message "refused" will be output to the log file jobdb*.log. The job net will remain in the carried over
status, and the execution schedule for the current day will be ignored. The scheduled startup date and time will be re-
scheduled to the next ones upon execution of the revoke operation and the job net will be in the waiting status.
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Start with variable parameters

When a job net receives a variable parameter, it will start up with a preset variable replaced by the variable parameter.

Refer to "7.4 Starting a Job Net with Variable Parameters" for details.

 
Restarting job nets

When restarting job nets, jobs to be executed can be selected as follows.

- Start execution from the abended job

If the restart point is set for a job before the abended job or a job of another system (not having preceding/succeeding
relationship with the abended job), cancel the restart point setting and restart the job net.

- Start execution from an optional job before the abended job

Set the restart point to an optional job before the abended job, and restart the job net.

- Start execution from the next job skipping the abended job

Specify the Invalid at next restart in the Control information sheet of the Monitor-Job window for the abended job, and
restart the job net.

When a job net contains jobs (child or linked job nets) with the Valid only on startup days setting, and the status of an abended
or canceled job net becomes "Confirmed" since the "confirmation" operation for the abended or canceled status is enabled,
it is restarted with the configuration information shown in the Previous process result sheet of the Monitor Job Net window.

14.1.5 Status and Behavior of Linked Job Nets and Master Linked
Job Nets

This section explains the statuses for a job net that becomes a master linked job net when a linked job net referring to it is
registered, the behavior of the master linked job net after it is registered as such, and the statuses of linked job nets.

 
Status and behavior of master linked job nets

When registering a linked job net, the status of the job net that is specified as the reference destination of the linked job net
must be one of the following: "completed", "abended", "canceled", "waiting", "paused", "disabled", "confirmed" or "pseudo
normal". The status of the job net that becomes a master linked job net as a result of registering a linked job net will change
from its previous status to "waiting", unless the previous status was "paused" or "disabled". If the previous status was
"paused" or "disabled", the status of the job net will continue to be "paused" or "disabled" even after it becomes a master
linked job net. Similarly, the status of any job nets at lower levels below the master linked job net will also become "waiting",
unless their previous status was "paused" or "disabled".

Similarly, the status of jobs within a master linked job net or jobs within any job nets at lower levels below the master linked
job net will also become "waiting", unless their previous status was "paused" or "disabled".

A job net whose status is "executing", "warning" or "end delayed" cannot be specified as a master linked job net from linked
job nets until it finishes executing.
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Status of linked job nets

Immediately after a job net is registered as a linked job net, its status is "waiting". The status of any job nets at lower levels
inherit the status of the master linked job net. The same applies to jobs.

14.1.6 Group Status
The following describes the group statuses.

Groups have the following characteristics.

- Only the job nets for which one startup time is specified per day in Execute at in the Execution condition can be registered
in a group.

- A group is executed once a day (from the day change time to the day change time). Regardless of whether the group is
executed automatically (scheduled) or manually, it is counted as one execution.

- In case of waiting for message events, the message events will be cleared if the group is executed automatically upon the
estimated start time or will not be cleared if executed manually.

The group status is any of the following. The display color is the Gantt chart color in which the status is displayed in the Gantt
Chart window.

 
Completed

Displayed in blue.

The group is considered to be completed when all the job nets belonging to the group have been completed normally.

 
Abended

Displayed in red.

The group is considered to be abended when the group has been completed and any abended job net exists in the group.

- 423 -



 
Cancelled

Displayed in yellow.

If the cancellation operation has been executed to the group, the group will be in the cancelled status. However, if any abended
job net exists in the cancelled group, the group will be in the abended status.
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Warnings

Displayed in brown.

The group is considered to be warning when the group is in execution and any warning, abended or cancelled job net exists
in the group.
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 Note

Even if the warning, abended or cancelled job net has been eliminated as a result of restarting the abended or cancelled job
net, the group will remains in the warning status. The group will be in the normal status such as Completed or Pseudo-normal
when the group has been completed.

 
Executing

Displayed in green.

The group is considered to be executing when the group is in execution.

 
Waiting

Displayed in pink.

The group is considered to be waiting when the group has been scheduled for execution.

If the expected message event does not occur, the group is carried over after the day change time. If it has been scheduled to
start in the carried over day, it is executed only after the group of the preceding day (carried over group) has been executed.

 
Paused

Displayed in orange.

The group is considered to be paused when the user has executed the pause operation.

- 426 -



If the execution conditions are satisfied while the group is being paused, the group will be started after resuming.

 
Disabled

Displayed in gray.

The group is considered to be disabled when the user has executed the disable operation.
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If the startup time comes while the group is in the disabled status, it will be skipped and will be in the pseudo-normal status.

 
Confirmed

Displayed in dark blue.

The group is considered to be checked when the user has executed the confirm operation to the abended groups (including
cancelled groups when Check canceled Option is checked).

If the Validate group confirmation check box is selected in the Advanced Settings for Verification window (which is
displayed by clicking the Advanced Settings button in Verification at error occurrence in the Use function1 sheet of the
Define Jobscheduler Startup Parameters window), abended groups will not be scheduled until the confirmation process is
complete, even if the day change time arrives.

By carrying out the confirm operation to the abended group, the group will be scheduled normally.

 
Pseudo-normal

Displayed in light blue.

The group is considered to be pseudo-normal when all the executable job nets have been completed and pseudo-normal job
nets and completed job nets or only pseudo-normal job nets exist in the group.

14.1.7 Group Operations and Actions
This section describes the group operations and the actions following the group operations. The following operations can be
executed for groups.

 
Cancelled

Cancels the group being executed or in the warning status. All the job nets being executed or in the warning status will be
cancelled. The job nets which have not been executed as they do not satisfy the execution conditions will remain in the waiting
status.

If the cancelled groups are newly scheduled, they will be in the waiting status.

However, if Check canceled Option is specified in addition to Validate group confirmation Option, the group will remain in
the cancelled status and will not be newly scheduled.

 
Start

Starts the group immediately. Among the execution conditions for the job nets in the group started with the start operation,
the conditions other than the normal completion of the preceding job net will be ignored. Therefore, the job net will be started
immediately after the preceding job net is completed normally.
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The job net configuration at the group startup is as follows depending on the group status.

For a group which has already been completed for the current day:

The group will be started from the beginning with the job net configuration of the completed group.

For a group which is scheduled to be executed for the current day:

The group will be started with the job net configuration of the scheduled group. In this case, the group will not be started
again at the originally-scheduled startup time.

For a group which is not scheduled to be executed for the current day:

The group will be started with all the job net configurations in the group. In this case, this group will be able to be
monitored in the Monitor Group window.

 
Restart

Restarts the group when it has been abnormally terminated or cancelled due to the abended job net in the group during the
previous execution. When restarted, execution will be started from the abended or cancelled job net and the group will be in
the executing status. If no abended or cancelled job net exist, execution will be started from the waiting job nets which satisfy
the execution conditions. The execution conditions of the job nets in the restarted group vary as follows, depending on the
conditions of the previous execution of the group.

If previously executed according to the schedule:

The normal completion of the preceding job net, the startup time and the message event waiting will be valid.

If previously executed with the start operation:

Only the normal completion of the preceding job net will be valid.

 
Pause

Pauses the group. The paused group cannot be executed even if the execution conditions are satisfied.

 
Continue

Cancels the paused status of the group. The group will resume the status before the pause operation (if newly scheduled,
however, the group will be in the waiting status). If the execution conditions are satisfied while the group is being paused, the
group will be started after resuming.
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Disable

Disables the group. The disabled group is considered to be pseudo-normal when the startup time has come and will be
skipped. When the execution conditions are satisfied while the group is being paused, the group will be considered to be
pseudo-normal and skipped when disabled.

 
Enable

Cancels the disabled status of the group. The group will resume the status before the disable operation (if newly scheduled,
however, the group will be in the waiting status). If the job was in the paused status before the disable operation, however,
it will resume the status before the pause operation. Or, if it was in the abended or cancelled status before the disable operation,
it changes to the completed status. If the execution conditions are satisfied while the job net is being disabled, the group will
be in the completed status after enable operation.
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Confirm

Brings the group which have been terminated abnormally or cancelled at the previous execution to the confirmed status.
Confirmation is enabled when Validate group confirmation is selected in the Advanced Settings for Verification window
(which is displayed by clicking the Advanced Settings button in Verification at error occurrence in the Use function1 sheet
of the Define Jobscheduler Startup Parameters window). When the Validate group confirmation option is selected, no
scheduling will be executed for the group in the abended status at the day change time or the startup time of the server beyond
the day change time. After confirm operation is carried out for the abended group, the scheduling for the current day will be
executed at the day change time or the startup time of the server beyond the day change time.

Note that to enable verification with respect to canceled groups, it is necessary to select Check canceled as well as Validate
group confirmation in the Advanced Settings for Verification window.

14.1.8 Job Recovery Operations and Actions
This section describes the job recovery operations and the actions following the operations.

 
Recovery operations

The following recovery operations can be executed for jobs.

Start from Specified Job

The specified job will be started and be in the executing status. When the job is completed normally or pseudo-normally,
the succeeding job will be executed.

Restart from Specified Job

This operation is available only for the jobs with job net or linked job net icons. The specified job will be restarted and
be in the executing status. When the job is completed normally or pseudo-normally, the succeeding job will be executed.
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Start from Next Job

This operation is available only for jobs other than the jobs with job net or linked job net icons. The status of the specified
job will not be changed and the succeeding job will be started and be in the executing status. When the succeeding job is
completed normally or pseudo-normally, the next succeeding job will be executed.

If the succeeding jobs include any recovery job, the recovery job will not be carried out. If no succeeding job exists
(including recovery job) or if only recovery jobs exist, this operation is not available.

Furthermore, if any of the succeeding jobs has Execution condition specified in the Standard information sheet of the Job
Net Properties window, this operation is not available.

Specified Job Only

This operation is available only for jobs other than the jobs with job net or linked job net icons. The specified job will be
started and be in the executing status. Even when the job is completed normally or pseudo-normally, the succeeding job
will not be executed. Or, even when the job is terminated abnormally, the recovery job will not be executed.

This is an operation to start the jobs which remain in the abended or cancelled status as a result of carrying out "Start from
Next Job." Therefore, this operation is not available for the jobs with no succeeding job or the jobs for which the
succeeding jobs are in the waiting status (including the jobs which are in the paused or disabled status and are previously
in the waiting status) including the recovery jobs.

 
Status of job nets on higher-level layers after recovery operation

When jobs in a job net are in the executing status after recovery operation, the job net including these jobs and the job nets
of higher-level layers will be in the executing status.
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If the job net is in the warning status, however, the status of the job nets and the job nets of higher-level layers will not change
even after recovery operations.

 
Completion status and completion code after recovery operation

When the job net which was brought to the executing status by the recovery operation and its higher-level layer job nets have
been completed, the status and the completion code for these job nets will be as follows.

Start from Specified Job/Restart from Specified Job

Determined by the statuses and the completion codes of all the jobs included in the job net.

Start from Next Job/Specified Job Only

Determined by the statuses and the completion codes of all the jobs included in the job net. However, the specified job
status is excluded.

It is the same for the status and the completion code when the recovery operations have been executed to the jobs in a job net
which has already been in the warning status.

 

 Information

When the Specified Job Only operation is executed, only the specified job will work. The status and the completion code
when this job net is completed will be determined by the statuses and the completion codes of the jobs other than the specified
job.
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14.2 Operations of Jobs with "Wait with OR" Condition
This section explains the operations of jobs with "wait with OR" condition.

 
Operations of succeeding jobs with "wait with OR" condition

Succeeding jobs with "wait with OR" condition are started when all the following conditions are satisfied:

- All preceding jobs (event wait jobs) connected immediately before the job satisfy the execution conditions

- One of the preceding jobs connected immediately before the job satisfied the queuing condition and has completed
normally

For example, if there is another job before the preceding job, the succeeding job waits until the other job completes normally.

The example below shows that while job X is executing, the succeeding job waits even if job A satisfies the conditions and
completes normally. The succeeding job starts when job X completes normally and the execution conditions for job Y are
satisfied.

 
Operations of preceding jobs with "wait with OR" condition

The following describes the operations of the remaining jobs and succeeding jobs when "wait with OR" condition is used and
the status of any of the preceding jobs A, B, and C changes from Executing to Completed, Abended, Canceled, Paused, or
Disabled.

 
Status of 
A, B, or C

Operations of the remaining
preceding jobs (A, B, C)

when they enter the status in the
previous column

Operations of succeeding jobs

Completed Completes with the completion
code 248
(*1)(*2)

Executed

Abended Completed with the completion
code 249
(*2)

Not executed

Canceled Continues executing the flow Executed if preceding jobs other
than the canceled one terminate
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Status of 
A, B, or C

Operations of the remaining
preceding jobs (A, B, C)

when they enter the status in the
previous column

Operations of succeeding jobs

normally and the OR condition is
satisfied

Paused Continues executing the flow Not executed even if preceding jobs
other than Paused jobs terminate
normally and the OR condition is
satisfied

Disabled Continues executing the flow Executed if preceding jobs other
than the disabled one terminate
normally and the OR condition is
satisfied

*1:

Jobs that terminated with the completion code 248 cannot be restarted or recovered (Start from Specified Job/Start from
Next Job/Specified Job Only), even if restart or recovery is performed for a job net containing a job that terminated with
the completion code 248.

*2:

In the flow chart, the status is Canceled (passed status) and the status frame is displayed in yellow dots.

Refer to "Jobscheduler Completion Code" in the Systemwalker Operation Manager Reference Guide for information on
the completion codes.

The following shows an example of operations when multiple preceding jobs are in Executing status and one of them
terminates normally.

When Job A terminates normally, the succeeding job E is executed. Unlike job A, which terminates normally, preceding jobs
B and C in Executing status as well as preceding job D, which was not yet started, terminate with the status Canceled (passed
status).

Job A terminates normally with the completion code 0. Preceding jobs B, C and D, which became Canceled (passed status)
terminate with the completion code 248.

 
How to restart the preceding jobs with "wait with OR" condition after canceling them manually

If the preceding jobs with "wait with OR" condition are canceled manually, they will be started first when the job net is
restarted. If you want to start from the canceled jobs, restart the job net. If the jobs after the ones with "wait with OR" condition
abended and you want to start from the abended job, select the abended job and perform the recovery operation.

Restarting from the following state is used as an example for an explanation.

- 435 -



To start from Job A that was canceled

To start from Job A that was canceled, restart the job net. The orange dotted line indicates the range to start. Jobs will be
started from Job A to Job C, then Job D and Job E.

Note that Job C will be executed twice in this case.

To start from Job D that abended

To start from Job D that abended, specify the Job D and click Start from Specified Job. The orange dotted line indicates
the range to start. Job D will be started first, followed by Job E.

14.3 Day Change Time and Job Net/Group Actions
When the day change time comes or when the Systemwalker Operation Manager server is started after the day change time,
schedule for the current day will be created. This section describes how job nets or groups are scheduled depending on their
conditions when creating schedules.

Schedules will be created again when the day change time is changed. However, it is not desirable to change the day change
time during job operation, since it may affect the job operations because a group cannot be scheduled upon re-scheduling once
it is started, or because the relationship between the scheduled startup times may be changed resulting in changes in the
execution days. If the day change time is changed, already occurred message events are cleared that belong to the job net for
which Once in a day under the Start only when message event has occurred check box has been specified.
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14.3.1 Job Net Scheduling Method
For job nets, when the day change time comes, schedules for the current day will be created for the job nets other than the ones
for which the carried over process is to be executed. The job net status indication varies as follows, depending on the previous
day status.

 
When job net is Completed normally or Pseudo-normal

Upon the day change time, the job nets for the current day will be in the waiting status.

 
When job net is Executing, End delayed or Warning

Upon the day change time, the job nets for the current day will be scheduled. However, if a job net is being executed beyond
the day change time while in the end delayed or the warning status, the job nets for the current day will be displayed depending
on the end status (Completed, Pseudo-normal, Abended or Cancelled) when the continuous job net execution ends.

When in the completed normally or pseudo-normal status, the job net will be in the waiting status.

When in the abended or cancelled status, the status will depend on whether the confirm operation is enabled. See "When job
net is abended" and "When job net is cancelled".

 
When job net is paused

When the day change time comes while the job net is in the paused status, the job net will remain in the paused status.

The job net action depends on the time of the continue operation as follows.

- If resumed before the scheduled execution conditions for the current day are satisfied, the job net will be executed at the
same time when the continue operation is executed. The job nets scheduled for execution for the current day will be in
the waiting status and they will be executed when the execution conditions are satisfied.

- If resumed after the scheduled execution conditions for the current day are satisfied, the execution reject message
"refused" will be output to the log file jobdb*.log and the job net scheduled for execution for the current day will not be
executed. The job nets continued from the previous day will be executed at the same time when the continue operation
is executed.

The following shows an example of a job net scheduled to be started at 17:00 as the execution condition.
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When job net is disabled

When the job net is in the disabled status, the job net will skip and be in the pseudo-normal status at every startup time. Also,
since the next startup time is set when the job net has been skipped, the startup schedules for the current day will not be carried
over to the next day.

 
When job net is abended

When the job net has been completed abnormally, the job net operation will vary depending on whether the confirm operation
is enabled.

The Advanced Settings for Verification window (which is displayed by clicking the Advanced Settings button in Verification
at error occurrence in the Use function1 sheet of the Define Jobscheduler Startup Parameters window) is used to enable or
disable the confirm operation.

When confirm operation is not enabled

The abended job net will be scheduled at the day change time and be in the waiting status.

When confirm operation is enabled

When the confirm operation is enabled, the job net status will be as follows.

- When confirm operation is executed before the day change time

The job net will be scheduled at the day change time and changed from the checked status to the confirmed status.

- When confirm operation is executed for a job net which remains in the abended status after the day change time

The status of the job net will continue to be abended, and will not switch to waiting even if the day change time arrives.
It will be re-scheduled and be in the waiting status when the confirm operation is executed.
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However, if an abended job net is scheduled for the current day execution before executing the confirm operation, the
execution reject message "refused" will be output to the log file jobdb*.log and the job net will not be executed.

If the restart operation is executed to the job net which remains in the abended status beyond the day change time, the
job net will start execution, upon the restart operation, from the abended job or the job where the restart point is
specified. When the job net execution is completed, the job net status will change.

 
When job net is cancelled

When Systemwalker Operation Manager on the schedule server is V10.0 or earlier, the status of the cancelled job net will
change from cancelled to waiting at the day change time.

For V10.1 or later versions, whether the confirm operation is enabled affects the scheduling method.

Whether confirmation operations are enabled is specified using the Check canceled checkbox and the Validate job net
confirmation checkbox in the Advanced Settings for Verification window (which is displayed by clicking the Advanced
Settings button under Verification at error occurrence in the Use function1 sheet of the Define Jobscheduler Startup
Parameters window).

When the confirm operation is enabled, the scheduling method is the same as when the job net is in abended status. Just
replace "abended" with "cancelled."

When the confirm operation is not enabled, the cancelled job net will be scheduled at the day change time.
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When job net is waiting

At the day change time, the job net will be re-scheduled with the next scheduled startup date and time and the job net will be
in the waiting status.

 
When job net is Start delayed

At the day change time, the job net will be re-scheduled with the next scheduled startup date and time and the job net will be
in the waiting status.

However, if Carry over the process regardless of the day change time is specified in the Message sheet of the Job Net
Properties window, the job net will not be re-scheduled and will be carried over. In such cases, the job net will not be re-
scheduled at the day change time. The scheduled startup date and time of the previous day will be carried over.

The carried over job net will not be re-scheduled unless any of the following is satisfied.

- The job net is brought into the executing status since all the remaining messages waited are issued

- The job net is brought into the executing status by the start operation.

- The job net is brought into the waiting status by the revoke operation.

- The job net is brought into the disabled status by the disable operation.

14.3.2 Group Scheduling Method
For groups, the status of the previous day affects the scheduling method.

 
When group is completed normally or pseudo-normal

Upon the day change time, the groups for the current day will be scheduled and be in the waiting status.

 
When group is executing or warning

If the group remains in the executing or the warning status beyond the day change time, the groups for the current day will
be scheduled at the time of the group completion depending on the completion status (Completed, Pseudo-normal, Abended
or Cancelled).

When in the normally completed or pseudo-normal status, the group will be in the waiting status.

When in the abended or cancelled status, the scheduling method will depend on whether or not the confirm operation is
enabled. See "When group is abended" and "When group is cancelled".

 
When group is paused

When the day change time comes while the group is in the paused status, the group will remain in the paused status and will
not be scheduled for the current day.

If the execution conditions for the paused group are satisfied when it is resumed, the group will be executed and then
scheduled for the current day. Furthermore, if the execution conditions for the current day are satisfied, the groups for the
current day will continuously be executed.

- If the execution conditions for the paused group are satisfied and the group is resumed beyond the day change time, the
paused group will be executed after resuming and then the group will be scheduled for the current day. If the group
execution conditions for the current day are satisfied, the groups will continuously be executed. If not, the group will
resume the waiting status.

- If the execution conditions of the paused group are not satisfied during paused and if the day change time comes, this
group is released from being paused and waited to be executed. When the execution conditions are satisfied, the group
is executed. After its execution, the group for the current day is re-scheduled. If the group execution conditions for the
current day are satisfied, the groups will continuously be executed. If not, the group will resume the waiting status.
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- If the group remains in the paused status beyond two day change times and the execution conditions for the paused group
are satisfied, the paused group will be started upon resuming and then scheduled for the current day. The groups of the
past date (previous day, for example) will not be scheduled or executed.

 
When group is disabled

When the startup time comes while the group is in the disabled status, the group will be skipped and be pseudo-normal. Also,
since the scheduled startup time for the current day is set when the group has been skipped, the startup schedules for the
current day will not be carried over to the next day.
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When group is abended

When the group has been abended, the scheduling method will vary depending on whether the confirm operation is enabled.

Whether confirmation operations are enabled is specified using the Advanced Settings for Verification window (which is
displayed by clicking the Advanced Settings button under Verification at error occurrence in the Use function1 sheet of the
Define Jobscheduler Startup Parameters window).

When confirm operation is not enabled

The abended group will be scheduled at the day change time and be in the waiting status.

When confirm operation is enabled

When the confirm operation is enabled, the job net status will be as follows.

- When confirm operation is executed before the day change time

The group will be scheduled at the day change time and changed from the Confirmed status to the waiting status.

- When confirm operation is executed for a group which remains in the abended status after the day change time

The group will remain in the abended status and will not be rescheduled even after the day change time arrives. The group
will be re-scheduled and be in the waiting status when the confirm operation is executed.

If the confirm operation is executed after the execution conditions for the group are satisfied (when the group startup time
for the current day comes, for example) while the group is in the abended status, the group for the current day will be
started immediately.

If the restart operation is executed to the group which remains in the abended status beyond the day change time, the group
will start execution, upon the restart operation, from the abended job in the abended job net or from the restart point. After
the group completion, it will be re-scheduled depending on the group status.
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When group is cancelled

When Systemwalker Operation Manager on the schedule server is V10.0 or earlier, the canceled group is re-scheduled after
the day change time. The group status is changed from canceled to waiting to be executed.

For V10.1 or later versions, whether the confirm operation is enabled affects the scheduling method.

The Check canceled and the Validate group confirmation check boxes in the Advanced Settings for Verification window
(which is displayed by clicking the Advanced Settings button in Verification at error occurrence in the Use function1 sheet
of the Define Jobscheduler Startup Parameters window) determine whether confirmation is enabled.

When the confirm operation is enabled, the scheduling method is the same as when the group is in abended status. Just replace
"abended" with "cancelled."

When the confirm operation is not enabled, the cancelled group will be scheduled at the day change time.

 
When group is waiting

When the day change time comes while the group is in the waiting status, the group will remain in the waiting status.

If the execution conditions for the waiting group are satisfied, the group will be executed and then scheduled for the current
day.

14.4 Message Events and Job Net Actions
This section describes how to count the message event occurrences when the message event occurrence is specified as a
execution condition of job nets.

For job nets, how to count or clear the message event occurrences vary depending on whether the job nets are started by
schedule or manually, or whether to wait only for message events or for message events and startup times. Counting method
also varies depending on the operation to be executed to job nets or groups when counting message event occurrences.

The following describes occurrences and counting method of message events and job net/group action following them.

 

 Note

Changing startup days after a message event occurred

Message events that occurred on job nets for which a startup day was changed are all cleared. Therefore, these message events
must be reissued if a startup day is changed after message events occur.

14.4.1 How to Count Message Event Occurrences
The following describes how to count message event occurrences.

 
Counting start timing for message event occurrences

The number of message event occurrences is counted from the time the job nets which wait for messages are defined in the
Queuing message event in the Message sheet of the Job Net Properties window. The message event occurrences are not
cleared even if the job net goes beyond the day change time and is re-scheduled. The number of message event occurrences
currently waiting for the job net execution can be checked in the Message Event window. To clear the occurrence count for
the message events, use the jobschmsgclear command. For details of the jobschmsgclear command, see the Systemwalker
Operation Manager Reference Guide.

 
Counting message event occurrences when started by schedule

When job nets are started by schedule, the message event occurrences can be decremented or cleared.

For job nets waiting for only message events

For job nets waiting for only message events, the message event occurrences will be decremented when the job net is
started.
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Example 1:

If Start when all message events have occurred is specified in the Queuing condition in the Message sheet of the Job
Net Properties window, the job net will be started when all the message event occurrences are notified. The message
event count is decremented at job net startup. All the message event occurrences will not be cleared upon job net
startup.

Example 2:

If Start when a message event occurs is specified in the Queuing condition in the Message sheet of the Job Net
Properties window, the job net will be started and the message event count will be decremented every time any of the
message events occurs. All the message event occurrences will be cleared upon job net startup.

For job nets waiting for only message events and startup times

For job nets waiting for only message events and startup times, the message event occurrences will be cleared when the
job net is started.

When the message event occurrence specified as the waiting condition is notified and the startup time comes, the job net
will be started.

If the startup time has not come yet when the message event conditions are satisfied, the job net will wait until the startup
time comes. Also, if the message event conditions have not been satisfied when the startup time comes, the job net will
wait until the message event conditions are satisfied.
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Counting message events when started manually

When a job net or a group is started manually, the message event occurrences are not cleared as the job net or the group is not
started according to schedules.

A group is started only once a day. Therefore, if a group is started manually the message event occurrences registered in the
job nets belonging to the group will not be cleared but the group itself is considered to have already been started for the current
day.

 
Job net status and message event count

Message events which occur while a job net is in the following statuses are not recognized by the job net even if a message
event occurs. Therefore, they will not be counted as message event occurrences.

- Message events which occur while the job net is in the executing or the warning status. Note that the message events are
counted when Valid during job net execution is specified.

- Message events which occur while the job net is in the disabled status.

- Message events which occur while the job net is in the abended status and Validate job net confirmation Option is
specified. Note that job nets included in a group are counted.

- Message events which occur while the job net is in the cancelled status and Validate job net confirmation Option and
Check canceled Option are specified. Note that job nets included in a group are counted.

While the job net is in the paused status, the message event occurrences which occurs while the job net is in the paused status
are counted. Also, the message event occurrences which have occurred in the past will not be cleared at any operational timing
such as disable/enable or pause/continue operations.

Even if the status of a job net differs from any of those listed above, message events may still not be recognized by a job net.
Refer to "14.4.3 Receiving Message Events" for details.
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 Note

When Once in a day (Start only when message event has occurred) is selected

When Once in a day is specified for Start only when message event has occurred in the Standard information sheet of the Job
Net Properties window, the message event occurrences will be counted as follows.

- All the message event occurrences will be cleared at a job net startup. Also, the message event occurrences will be cleared
at a job net startup if started manually before the first message event conditions are satisfied. After being cleared, the
message events will not be counted for the current day.

- When the day change time comes before the job net is started, all the message event occurrences will be cleared at the
day change time.

If a carryover job net for which Carry over the process regardless of the day change time is selected reaches the day change
time without having started, the job status of the previous day will be carried over. The job nets will also be carried over with
the message event count status retained.

14.4.2 Operation Examples of Job Nets Waiting for Message Events
The following describes the job net statuses and provides examples of counting the message event occurrences.

 
When a job net only waiting for message events is paused

Even while the job net is in the paused status, message event occurrences are notified to the job net and counted for the number
of occurrences. In the example below, msg1 and msg2 have occurred at the time of resuming, therefore, the job net will be
started upon resuming. The message event occurrences will be cleared when the job net is started.

 
When a job net waiting for message events and startup time is paused

Here is an example in which the job net is started when both msg1 and msg2 have occurred and the startup time has come.
Suppose the job net was in the waiting status before it was brought into the paused status.

The job net will remain in the paused status until it is resumed. If the execution conditions are satisfied when resumed, the
job net will be started immediately and all the message event occurrences will be cleared.

In the example below, the job net has not been started as it is in the paused status, even though both msg1 and msg2 have been
notified and the startup time has come. The job net will be started upon resuming and the message event occurrences will be
cleared.
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In the example below, the job net is in the waiting status as the startup time has not come yet at the time of resuming, even
though both msg1 and msg2 have been notified while the job net is in the paused status. The job net will be started when the
startup time comes.

 
When a job net only waiting for message events is disabled

The message event occurrences are not counted while the job net is in the disabled status. If the job net is disabled while msg1,
which has occurred before the disable operation, is counted, the job will be started after the job net is enabled and msg2 is
notified.

 
When a job net waiting for message events and startup time is disabled

Here is an example in which the job net is started when both msg1 and msg2 have occurred and the startup time has come.
Suppose the job net was in the waiting status before it was brought into the disabled status.

The message events which has occurred while the job net is in the disabled status will not be counted.

The disabled job net will be skipped at the startup time.
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In the example below, the message event occurrence conditions will not be satisfied even when the startup time comes after
the enable operation, because msg2 is not counted while the job net is in the disabled status even though msg1 is stored. The
job net will be started and the message event count will be cleared when the message event occurrence conditions are satisfied.

 
When carried over of a job net waiting for message events and startup time is revoked

Here is an example in which the job net is started when both msg1 and msg2 have occurred and the startup time has come.
It is supposed that the job net is in the carried over status before revoking the carried over.

The scheduled startup date and time will be re-scheduled to the next ones upon execution of the revoke operation and the job
net will be in the waiting status. All the message event occurrences will be cleared when carried over is revoked. In the
example below, msg1 is stored but the count for msg1 will be cleared when carried over is revoked. The job net brought into
the waiting status by revoking carried over will be started when the next startup time comes and the message event conditions
are satisfied. Then, the message event count will be cleared.
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14.4.3 Receiving Message Events
In some cases message events will fail to be received by a job net.

Message events will fail to be received by a job net if any of the following conditions applies. The following conditions that
determine whether a job net can receive message events apply on a first-match basis in the order listed.

1. When the job net is a master information or operation change information job net.

2. When the job net is disabled.

3. When Validate job net confirmation is selected and the job net has abended but not yet been confirmed. Note, however,
that the message events will be received if the job net is contained in a group.

4. When Validate job net confirmation and Check canceled are selected and the job net has been canceled but not yet been
confirmed. Note, however, that the message event will be received if the job net is contained in a group.

5. When the Once in a day check box is selected in the Start only when message event has occurred option in the Standard
information sheet of the Job Net Properties window and execution has already been confirmed on the day concerned.

6. When the status of a job net is "Executing", "End delayed" or "Warning". Note, however, that message events will be
received if Valid during job net execution is selected.

7. When the Valid only on startup days check box is selected in the Message sheet of the Job Net Properties window and
the day concerned is not a startup day.

8. When the "@.VPARAM@" variable is used in the job definition and the status of the job net is "Executing", "End
delayed", "Warning", or "Paused". Message events will not be received even if Valid during job net execution is
selected.

The Job List window can be used to check if a job net is receiving message events during operation. Refer to "6.1 Monitoring
Job Nets" for details.
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Appendix A Important Notes
This appendix provides an overview of important notes concerning Systemwalker Operation Manager.

A.1 Tuning of Performance
The following describes how to tune the performance when registering a large number of job nets and jobs.

A.1.1 Notes When Registering a Large Number of Job Nets
When registering a large number of job nets in a project and there are multiple job nets scheduled to be started simultaneously
in the project, startup of the job nets may be delayed. Also, if a job is executed under such a heavy load, there may be a time
lag between the job execution history that is recorded in Jobscheduler logs (jobdb1.log, jobdb2.log, or jobdb3.log) and the
job execution history that is output with the mjsview log file output command.

The Jobscheduler manages these job nets in the unit of projects. This cause to increase the range to be searched when you
register a large number of job nets in a single project. When searching for an individual job net and starting a large number
of job nets simultaneously will put a heavy demand on a certain management log.

When registering a large number of job nets, distribute the job nets to multiple projects. This distributes accesses to
management logs and prevents the schedule performance from being reduced.

If there are only a limited number of job net operations to be performed per day, such as when there are a large volume of jobs
and job net definitions, but many of those are executed only once a month, the Master Schedule Management function can
be used to prevent the schedule performance from deteriorating. This is achieved because the Master Schedule Management
function extracts only the data required for the operation day from the master information to create the management book,
so the size of the management book that is accessed when a job net is started is reduced.

Refer to the Systemwalker Operation Manager User's Guide - Master Schedule Management for details on the Master
Schedule Management function.

 
Guides when registering a large number of job nets

Estimate the registered number of job nets and make sure that they are started as scheduled.

A maximum of 15000 is recommended as the number of job nets to be registered per project. However this will vary
depending on the execution environment. For example, use a provisional business model in which an estimated number of
job nets and the scheduled startup times are specified, and confirm in advance that the job nets are started without any problem
as scheduled.

[Example] Business model

 
Number of registered job nets 1,000

Scheduled startup time 10:00

Number of job nets to be started 100

If startup of any job net is delayed as a result of executing the above business model, change the business model by distributing
the job nets to be started simultaneously to multiple projects and test again.

 
Solutions when a large number of job nets are registered

When a large number of job nets have already registered, confirm the numbers of registered job nets per project and their
scheduled startup time and distribute the job nets to different projects if necessary.

Confirming the number of registered job nets

To confirm the number of registered job nets per project and their scheduled startup times, use the jobschprint -N command.
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For details on the jobschprint -N command, see the Systemwalker Operation Manager Reference Guide.

Distributing job nets to multiple projects

To move job nets to different project, take the following into account.

- When the job nets are started by issuing message events by the jobschmsgevent command, review the jobschmsgevent
command project name.

- To move the job nets registered in a group, copy all the job nets registered in the group, then configure the group again.

The following describes how to move job nets.

1. Copy the job nets to another project using one of the following methods.

- Copy by the jobschsetnet -ncpy command

- From the Systemwalker Operation Manager client's screen, select Copy Job Nets.

2. Among the source and destination job nets having preceding and succeeding relationship, review the job nets which
can issue message events. When the job nets are registered in groups, configure again the group in which the destination
job net belongs to.

3. Delete the job nets of the copy source project.

4. Enable the copy destination job nets.

If the job nets are multiple levels, use the following procedure to move them.

1. Output all the job nets on the first level and lower to an optional file as the definition statement, using the jobschprint -r
command.

2. Specify the file output in the Step 1 above as the jobschsetnet command argument, and register the job nets from the
lower levels to the destination project.

3. Delete the copy source job nets from the first level.

For details on the jobschmsgevent, jobschsetent and jobschprint commands, see the Systemwalker Operation Manager
Reference Guide.

A.1.2 Notes When Registering a Large Number of Jobs
When registering a large number of jobs, design the system so that multiple job processes are executed in a single job reducing
the number of jobs.

Since queue control, exclusive control and job execution environment configuration are carried out for each job, more jobs
can result in larger overheads. If the schedule server and the execution server are different, communication and transfer of job
output files between the servers will also result in overheads.

 
Guides when registering a large number of jobs

Estimate registered number of jobs and process time of each job and make sure that they are processed within the operation
time. For network jobs, carry out confirmation in the network job environment.

Confirm in advance that the jobs are processed within operation time: for example, use a business model in which provisional
jobs are set to "sleep" status, during the time estimation process.

[Example] Business model

 
Number of registered jobs 3,000

Operation time 1 hour

Job process time 1 sec each

If all the jobs have not been completed within the operation time as a result of executing the above business model, change
the business model by putting multiple jobs into a single job to reduce the registered number of jobs and test again.
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Reducing the number of jobs

Create jobs as follows and make settings so that the number of jobs is as less as possible.

Example 1: Register multiple commands as one shell script.

(Before reduction) One command is described as one job

Job 1: date>>/var/tmp/gyoumu.log

Job 2: gyoumushori.exe

Job 3: date>>/var/tmp/gyoumu.log

(After reduction) Multiple processes are described in a shell script as one job.

Job 1:

date>>/var/tmp/gyoumu.log

gyoumushori.exe

date>>/var/tmp/gyoumu.log

Before improvement, each of three commands (log date, process and log date again) is registered as one job. Overheads by
queue control processes such as the limit set for Max Execution Jobs, authentication processes, internal processes and job
execution environment generation processes such as preparation of standard output/error output files increase the CPU usage,
and as a result, it may be possible that the CPU cannot be used for the original job processes. Putting three jobs into one
reduces the processes executed for each job.

Example 2: Use the job step of JCL (Job Control Language).

In Systemwalker Operation Manager, it is possible to create jobs in the job step configuration, using the JCL (Job Control
Language).

Multiple job steps can be described in one job and shell scripts can be executed corresponding to the job steps. Therefore
multiple shell scripts can be configured as one job.

For example, if there are 100 processes and each process is made up of 10 shell scripts as one job net, 1000 jobs will be needed
without using job steps. However, by using job steps, 10 shell scripts can be described as one job, reducing the number of jobs
to 100.

However, when using JCL to describe network jobs, it is possible to specify the execution destination server for each job step,
which may result in additional overheads due to processes such as communication with the destination server per job step and
transferring output files. Therefore, putting multiple shell scripts into one job may not improve performance.

For details on the JCL, see the Systemwalker Operation Manager Reference Guide.

A.1.3 Client Response Performance
If an Operation Manager server where a large number of job nets and groups are registered is monitored from the Operation
Manager client, the server response such as display indication may be delayed.

This section explains a number of possible measures for improving the response. Take the appropriate action according to
your operation environment as required.

 
Restricting users who can access a project

Response can be improved by limiting the display indication on the client and projects to be targeted for operation.

Register and connect users for which the projects to be displayed and operated are limited, to improve response.

1. In the Set Permissions window, assign users with reference or operation rights to a minimum number of projects to be
monitored. Do not give users any rights to projects that are not going to be monitored.

2. Connect to the Operation Manager server as the user registered in Step 1.

For details on setting, see "4.2.2 Setting up Access Permissions for Projects".
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Restricting the number of connected clients

Up to 62 Operation Manager clients (Note 2) can be connected to the Operation Manager server (schedule server (Note 1)).
However, more clients result in lower server response to individual client. Up to approximately eight Operation Manager
clients can be simultaneously connected to a certain Operation Manager server (schedule server (Note 1)). Limit the number
of connectable clients as necessary.

Note 1: Schedule server for each subsystem during multi-subsystem operation
Note 2: The maximum value may vary depending on the OS.

The number of connected clients can be limited by specifying Limit the Number of connected clients in the Use function2
sheet of the Define Jobscheduler Startup Parameters window on the environment setup client.

 

 Note

Window refresh requests (pressing the F5 key)

Some users may request a refresh operation (press the F5 key) frequently to cope with deteriorated client response. However,
such operation may prevent display indication to other users. Try not to request a refresh operation (press the F5 key)
frequently even if response is deteriorated.

A.1.4 Notes When Executing a Large Number of Jobs in Multiple
Subsystems

It may result in performance deterioration if you create multi-subsystems environment using the createsubsystem command
and starting a large number of jobs immediately after that, since environment created on a same disk.

When operating a large number of jobs, it is recommended to distribute the Jobscheduler database directory and the Job
Execution Control spool directory to different disks for each subsystem.

For details on how to distribute the database directory and spool directory to different disks for each subsystem, see "13.3
Distributing the Database Directory and the Spool Directory ".

A.1.5 Performance of Systemwalker Operation Manager Web
Console

This section explains the system scale that is recommended when the Systemwalker Operation Manager Web Console is
used.

If there are multiple subsystems, web console response times will slow down as the number of subsystems and job nets being
monitored increases.

Use the following figures as rough guides when creating monitoring targets:

Subsystems: 30

Job nets: 1,000

Depending on the server and client being used, it may not be possible to extract full performance from the system. In this case,
further limit the number of subsystems and job nets.

To monitor even more systems from the Web Console, prepare multiple web servers, and assign each web server to monitor
a different group of subsystems and job nets.

A.2 Precautions before Operations
The following describes precautions you should use before operating Systemwalker Operation Manager.

A.2.1 Cautions on Changing Time
Be sure to read this section before changing date or time.
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Prohibition of changing date and time during operation

Do not carry out the following operations when Systemwalker Operation Manager is operating.

- Changing the time, date, month, year, etc.

If you use NTP (time server) and slew mode (time is gradually adjusted by time progression), it does not matter if
Systemwalker Operation Manager is operating.

- Calling Date and Time in the Control Panel [Windows version]

- Changing system settings (i.e., host name, computer name, etc.)

Before carrying out the operations above, be sure to stop the Systemwalker Operation Manager's services and daemons.

 
Cautions when adjusting the system time

Do not change the system time while the Jobscheduler is operating. Since the Jobscheduler performs scheduling processing
based on the current system time, changes in the system time during operation may cause an execution failure of job nets and
operational errors in services and daemons.

Before changing the system time, terminate the Jobscheduler services and daemons.

If the system time and date are set back to the past, the output sequence to the Jobscheduler log files will not be in order in
terms of time. As a result, problems such as inaccurate display of Jobscheduler history information or irregular message
waiting operation may occur. If the system time and date are set back to the past, clear all the log information that would be
output in a chronological manner as described above, then reboot the system.

Specifically, remove the following log files.

- jobdb1.log, jobdb2.log and jobdb3.log in the Jobscheduler database directory.

- All files under the net.spool subdirectory in the Jobscheduler database directory

- Job execution history information files

- Operation result information files (if it is set to be saved)

- Event logs [Windows version]

 
Cautions when changing the system year or replacing the motherboard

Prior to changing the system year or replacing the motherboard, carry out the following backup operations. Following
completion of the relevant task, restore backed-up files and restart the system (if the system year has been changed, return it
to the current year).

- Back-up the files including subdirectories under the Jobscheduler database directory.

- Windows system: MpWalker.JM\mpjobsch\jobdb of the Systemwalker Operation Manager installation directory

- Solaris: /var/opt/FJSVJOBSC

- HP-UX system: /opt/FHPJOBSCH/db

- AIX system: /usr/FAIXJOBSC/db

- Linux: /var/opt/FJSVJOBSC

- Back-up the whole directory having the calendar information.

- Windows system: MpWalker.JM\mpjmcal\caldb of the Systemwalker Operation Manager installation directory

- Solaris: /var/opt/FJSVjmcal/caldb

- HP-UX system: /opt/FHPjmcal/caldb

- AIX system: /opt/FAIXjmcal/caldb

- Linux: /var/opt/FJSVjmcal/caldb
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A.2.2 Cautions when Using Back-up Products [Windows version]
If you want to carry out backup of the following directories and files under these directories using the commercial backup
products, do so after terminating Systemwalker Operation Manager services. For the system in which Systemwalker Centric
Manager is used together, terminate Systemwalker Centric Manager services as well.

- Job Execution Control directory

mpwalker.jm\mpmjessv in Systemwalker Operation Manager installation directory

- Job Execution Control spool directory

The default is mpwalker.jm\mpmjessv\mjespool under the installation directory.

- Jobscheduler database directory

The default is mpwalker.jm\mpjobsch\jobdb under the installation directory.

- Calendar information directory

mpwalker.jm\mpjmcal\caldb under the installation directory

- Master Schedule Management function database directory

Mpwalker.jm\mpstemsv under the installation directory

Carrying out backup of the above-listed resources without terminating the Systemwalker services may result in abnormal
operation of Systemwalker Operation Manager.

 

 Note

Important notes in this section apply to the cases where the Arcserve function is used from the backup cooperation function.

A.2.3 Cautions when Using Virus Detection Products
If a virus detection product is used, Windows versions of Systemwalker Operation Manager may not operate properly.
However, UNIX versions of Systemwalker Operation Manager operate normally, but scanning errors may occur in virus
detection products.

If using a virus detection product, ensure that the directories below, including any subdirectories and files, are excluded from
the search target of the product.

[Windows version]

- Job Execution Control directory

MpWalker.JM\mpmjessv in Systemwalker Operation Manager installation directory

- Job Execution Control spool directory

The default is MpWalker.JM\mpmjessv\mjespool under the installation directory.

- Jobscheduler database directory

The default is MpWalker.JM\mpjobsch\jobdb under the installation directory.

- Calendar information directory

MpWalker.JM\mpjmcal\caldb under the installation directory

- Master Schedule Management function database directory

Mpwalker.jm\mpstemsv under the installation directory

[UNIX version]
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- Job Execution Control spool directory

- /var/opt/FJSVMJS/var/spool/mjes

If the installation directory has been changed from the default, exclude FJSVMJS/var/spool/mjes from the changed
directory.

- Jobscheduler database directory

- /var/opt/FJSVJOBSC

If the installation directory has been changed from the default, exclude FJSVJOBSC from the changed directory.

- Calendar information directory

- /var/opt/FJSVjmcal/caldb

If the installation directory has been changed from the default, exclude FJSVjmcal/caldb from the changed directory.

- Master Schedule Management function database directory

- /var/opt/FJSVstem

If the installation directory has been changed from the default, exclude FJSVstem from the changed directory.

 

 Note

If the location of the directories below has been changed, such as when moving to a shared disk in a cluster environment, all
of the changed directories must also be removed from the search target for virus detection.

- Job Execution Control spool directory

- Jobscheduler database directory

- Master Schedule Management function database directory

A.2.4 Cautions when Operating on Windows Server [Windows
version]

The following describes cautions when operating Systemwalker Operation Manager on Windows Server.

- When using this software product on domain user, operations invalidating NetBIOS over TCP/IP cannot be performed.

If the setting has been changed, enable [Enable NetBIOS over TCP/IP] using the procedure described in the "Notes After
Installation" section of the Systemwalker Operation Manager Installation Guide.

- You cannot control project access using the user principal name.

- When controlling project access with the domain user, the user must be registered under the domain's Users object.

Also in Windows Server 2008, if the domain functional level is registered in the domain controller as "Windows 2000
native", "Windows Server 2003", or "Windows Server 2008", the user's User logon name (pre-Windows 2000) should
match the Display name.

A.2.5 Cautions when Operating a Large Job
If the default number of files that can be opened concurrently is limited and if a large job is operated, a system error may result
from the system resources exhaustion.

When operating a large job, estimate the required value by referring to the following and fine tune the kernel parameters.

- Maximum number of files that Systemwalker Operation Manager can simultaneously open for each job: 23
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 Information

Depending on the jobs that are registered, it may be necessary to take into account the files opened by the jobs themselves,
in which case the total number of open files can be calculated as 23 x <number of jobs> + <total number of files opened by
jobs themselves>.

A.2.6 Notes about Desktop Heap [Windows]
In a Windows system, the desktop heap is a memory area which is used whenever a process is activated.

Regardless of Systemwalker Operation Manager usage, the desktop heap may run out if a large number of processes are
activated.

When using Systemwalker Operation Manager, you should pay attention to the desktop heap in the following cases:

- Operating multiple subsystems

The number of Systemwalker Operation Manager service processes increases according to the number of subsystems,
causing more of the desktop heap to be used.

- Executing many jobs at a time

As the desktop heap is consumed when executing jobs, the more jobs are executed, the more desktop heap is consumed.

If the desktop heap is exhausted when multiple jobs are running concurrently, jobs are abnormally terminated with
exception code 0xC0000142 or 0x40000999.

A value from 1 to 999 can be set for Max Execution Jobs. For a stable system operation, it is recommended to set this value
within 30.

- Compressing a large number of files at a time by using the File Compression/Expansion Command (fprssvr/fprscli)

When compressing multiple files, the more files are compressed, the more desktop heap is consumed because much
temporary memory is used for compression processing.

If the desktop heap is exhausted while compressing multiple files, the following messages are displayed and the file
compressions by file compression/expansion (fprssvr/fprscli) commands are failed.

- For fprssvr:

 
0x2997(0x8): The heap for creating file table is not enough.

- For fprscli:

 
0xa997(0x8): The heap for creating file table is not enough.

It is recommended to control the number of files to be compressed at a time within 500. To compress more files, divide
compression work into multiple times.

A.3 Cautions during Operations
This section describes cautions during Systemwalker Operation Manager operations.

A.3.1 When Shutting Down the Jobscheduler Server
When shutting down the Jobscheduler server (schedule server), confirm that any job net in executing, end-delayed or warning
status does not exist. Shutting down the system or the schedule server during job net execution may result in destruction of
data base information managed by the Jobscheduler. Also, when the server is started next time, the job nets may be indicated
as executing in the job net or job history display of the Jobscheduler or by the history display commands (jobschprint -G, -g, -F
or -f option) even though the job nets have been finished.

How the job nets have been finished at shutdown can be browsed using the Job Net Management window or the job net status
display command (jobschprint -N or -n option) upon the schedule server restart.
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A.3.2 When the Disk Space of File System Is Insufficient
If any addition, change, or deletion of job nets or groups are processed when the remaining file system space is insufficient,
the schedule file for the user may be corrupted. If the schedule pattern information has been written at this time, it may also
be lost. Also, output data and history information for jobs in operation cannot be written.

In such cases, terminate the Jobscheduler operation, carry out restoration of the following information files and take the
appropriate action to ensure that a larger amount of file space will be available.

 
Restoring schedule files

For recovery of the schedule information file, see the "A.3.5 Restoring Schedule Files" section.

 
Restoring system information, schedule pattern information and project information files

The Jobscheduler carries out backup on system information files (sysfile.sys), schedule pattern information files
(db_calendar_ex.default) and project information files ("name of project".jsp) in the following timings.

- When a Jobscheduler service starts

The backup of information will be created in the jobschbackup directory under the database directory.

If a file space insufficiency has occurred while updating information, copy the file from the jobschbackup directory to the
database directory.

 
Deleting unnecessary files from the backup directory

Files in the jobschbackup directory will never be deleted. Consequently, even if all schedule information for a project is
deleted and schedule files for that project no longer exist in the database directory, these schedule files for that project still
remain in the jobschbackup directory. Therefore, the system administrator should check the contents of the jobschbackup
directory regularly, and delete schedule files for projects that are no longer using the Jobscheduler if any.

 
Deleting unnecessary files from the work directory

The files contained in the work directory in the database directory are work files that the Jobscheduler uses on a temporary
basis. Normally, these files are deleted when they are no longer needed. However, the work files might remain if a job net is
cancelled or delete operation is not performed in the corresponding exit program. Therefore, the system administrator should
check the contents of the work directory regularly and delete work files with old dates.

When Delete job output file is selected in the Output File sheet of the Define Jobscheduler Startup Parameters window, all
files under the work directory will be deleted at the time of Jobscheduler service startup.

 
Moving the database directory [Windows version]

The default database directory is MpWalker.JM\mpjobsch\jobdb (MpWalker.JM\mpjobsch\jobdb1-9 during subsystem
operations) under the Systemwalker Operation Manager installation directory. The database directory can be changed as
necessary. If the disk space is insufficient, move the database directory to a different drive. When operating subsystems,
specify a different directory for each subsystem. Make the database directory settings using the Database sheet of the Define
Jobscheduler Startup Parameters window.

 
Deleting the storage file of abended job nets [UNIX version]

Every time a job net is abnormally terminated, the job net information is added to the abended job net storage file
(jobnetabend.log) under the database directory. Since these files are never deleted automatically, it should be regularly
checked and deleted.

A.3.3 Cautions when Using the Jobscheduler Commands
The following explains the cautions when using a Jobscheduler command during operation.

 
Cautions when changing the registry Information using the Jobscheduler commands

If the Jobscheduler commands are used to change job net registration information while the Jobscheduler on the
Systemwalker Operation Manager client is being displayed, these changes will not be shown on the client screens.
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In such case, select Refresh Tree from the View menu of Systemwalker Operation Manager window, and refresh the Job
Selection window.

However, do not operate the Systemwalker Operation Manager client when the job net registration information has been
changed by the Jobscheduler command. Otherwise, the Systemwalker Operation Manager client may be terminated
abnormally.

A.3.4 Currently Operating Database Directories
If a user-created file is stored under the database directory, a problem may occur in the Jobscheduler operations. Therefore,
do not create or copy a user-created file under the database directory.

Also, do not access to a file locating under the database directory when the Jobscheduler services [Windows version] or
Jobscheduler daemons [UNIX version] are operating as it may cause a logical inconsistency of Jobscheduler operations.

A.3.5 Restoring Schedule Files
The Jobscheduler backs up schedule files ("project name.dbz" and "project name.grz" files) at the following timings.

- When a job net or a group is added, changed or deleted

- When a Jobscheduler service starts

The backup of the schedule file will be created in the jobschbackup directory under the database directory.

If a file space insufficiency has occurred while updating job nets, a writing error will be generated for the current schedule
file or the backup schedule file under the jobschbackup directory.

When a writing error has occurred in the schedule file under the database directory, use the following procedure to restore
it from the backup under the jobschbackup directory.

1. Confirm the registration information of job nets in the Job Selection window. If an error message appears instead of
the registration information, there may be a writing error for the schedule file in the database directory. Take the
following actions.

2. Terminate the Jobscheduler services [Windows version] or daemons [UNIX version].

3. Copy the schedule file in the database directory to another directory in case it is needed for failure investigation.

4. Copy the schedule file in the jobschbackup directory to the database directory.

5. Restart the Jobscheduler services [Windows version] or daemons [UNIX version].

After the above operation, confirm the registration information of job nets in the Job Selection window again. If an error
message still appears instead of the registration information, there may be a writing error for the schedule file in the
jobschbackup directory. In this case, carry out restoration from the pre-backup operation environment. If restored, the
information becomes the same as that obtained when it was backed up.

For details on backup and restoration, see "Backing Up or Restoring Operation Environment" in the Systemwalker Operation
Manager Installation Guide.

A.3.6 Cautions on Changing the Group Account Information of the
OS [UNIX version]

For a group whose access rights are set to a project, when the users belonging to the group are changed by using an OS
command or other method, the changed group account information of the OS may not be applied to the access rights of the
project.

After changing the users belonging to a group by using an OS command or other method, use the following command to apply
the changed group account information of the OS to the project access rights. This command should be executed by the system
administrator (superuser).

mpsetacl -a -t mpjobsch/schedule -u root -p w
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A.3.7 Notes on Setting the Validity Period for OS User's Password
There is the following note on setting the validity period for password of OS users who use the Systemwalker Operation
Manager Task Link function:

- The user's password that has been set in the password management book for Task Link must also be updated when the
password is due to expire and needs changing.

Refer to "LGMANAGE.EXE Password Management Command" or "lgmanage Password Management Command" in the
Systemwalker Operation Manager Reference Guide for the method of changing password management book.

A.3.8 Notes on Executing Commands in Windows [Windows
version]

 
Behavior under different user privileges

If a command is executed in Windows with User Account Control (UAC) enabled, the operation will depend on the privileges
of the user logged into the operating system.

When logging into the operating system as an administrator

If the user has logged into the operating system using the user name "Administrator", commands that require
administrator privileges can be executed directly.

When logging into the operating system as a user who is a member of the Administrators group (but is
not the Administrator)

If the user who has logged into the operating system is a member of the Administrators group but does not have the user
name "Administrator", a dialog box requesting elevation of privileges will appear when that user attempts to execute a
command, regardless of whether the command requires administrator privileges or general user privileges. This dialog
box allows the user to decide whether to execute the command using Administrator privileges. If authorization is
provided, a separate command prompt will appear temporarily and the command will run in the new command prompt
window. This temporary command prompt window will close automatically once the command has finished running.

When logging into the operating system as a general user

When the command that requires administrator privileges is executed, or depending on the group the user belongs to, a
dialog box requesting elevation of privileges will appear and the user will be asked to enter the name and password of a
user with administrator privileges. If a correct user name and password are entered, a separate command prompt will
appear temporarily and the command will run in the new command prompt window. This temporary command prompt
window will close automatically once the command has finished running.

If the dialog box requesting elevation of privileges and the command prompt window following privilege elevation disappear
automatically, perform the following procedure:

1. Right-click the Windows Command Prompt in the Start menu and select Run as from the pop-up menu.

The Command Prompt window will appear.

Execute the command from the Command Prompt window.

A.3.9 Restricting Jobscheduler display in the job selection tree
If a large number of job nets and groups are registered, displaying Jobscheduler in the job selection tree of the Operation
Manager client may take time.

In such cases, configuring the settings to expand just one of the projects you want to display from Jobscheduler in the job
selection tree may improve the display performance of the job selection tree.

After enabling these settings, you can expand only one project at a time in the job selection tree. In addition, if you have
expanded one project and then you select a different project, the expanded project will be closed.

Perform the following procedure to configure these settings.

Method
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To expand just one project from Jobscheduler in the job selection tree, add to or change the content of the client operating
environment file (Jobschr.ini) in \MpWalker.JM\mpjmcl\etc in the Systemwalker Operation Manager installation directory
on the Systemwalker Operation Manager client to reflect the following values:

 
Section name: REFRESH_MODE

Key name: Control_Refresh

Value: 0 (initial value, single project display disabled)
1 (single project display enabled)

Example of displaying information for a single project only

 
[REFRESH_MODE]
Control_Refresh=1

You can define mode switching while the client is displayed, but the defined values will not take effect until the next time the
Jobscheduler is connected.

 

 Note

Export

If you enable these settings, you cannot export definition information while Jobscheduler is selected in the job selection tree.
In addition, if you select an unexpanded project for export, the following error message will be output:

 
There are no groups or job nets that can be exported.

A.4 Cautions on Job Scheduling
This section describes cautions on job scheduling.

A.4.1 Restrictions on the Jobscheduler
The following describes the restrictions on the Jobscheduler.

 
Available user names

The length of the user name is restricted as follows. Also, do not include any space in user name.

For Windows system

Up to 36 bytes including the domain name can be used. In case of specifying user name only, up to 20 bytes can be used.
The domain name and the user name must be divided by "\" symbol and specified in the form of "domain name\user
name."

For UNIX system

Up to 20 bytes can be used for a user name. In case of using a job net with the PowerAIM attribute, specify a user name
with up to 8 bytes.

 
Unusable project names

The project names "temp" and "core" are already reserved in the Jobscheduler. Therefore, "temp" or "core" cannot be used
as a project name.

 
Restrictions on the database directory

Do not create user-specific files under the database directory.

- 461 -



A.4.2 Standard Output and Standard Error Output for Jobs
The standard output (stdout) and the standard error output (stderr) for each job registered in the Jobscheduler are stored in the
following file under the database directory.

- For Windows system: "project name_job net name_cccccccccccccccc.log" where "cccccccccccccccc" is an arbitrary
character string.

- For UNIX system: "project name_job net name_nn.log, "where "nn" is an arbitrary number.

Users can view the standard output and the standard error output files on the Job Output Info window or via the Previous log
sheet of the Monitor-Job window.

This file stores the standard outputs and the standard error outputs for all jobs in a job net and formats these outputs with the
job number managed by the Jobscheduler assigned at the beginning of each individual line. This file will be deleted when the
next job net is started. Therefore, only the results of the previous (most recent) execution can be reviewed. To save the results
of the past executions, take appropriate measures such as outputting the results to a file during the execution of the job.

The following provides cautions on standard outputs and standard error outputs.

- DO NOT output binary data to the standard outputs and the standard error outputs. If binary data is output by the jobs,
do not save the output results (to do so, select "Do not save standard/error output" from the Add/Change - Job window).
If binary data are saved, the output data may not be displayed or the Jobscheduler may terminate abnormally.

- Ensure that data including any line exceeding 996 bytes is not output for the standard outputs and the standard error
outputs. When any data exceeding 1000 bytes including the job number area is output, the part exceeding 1000 bytes will
not be displayed in the Previous log sheet of the Monitor-Job window or the Job Output Info window.

- Ensure that data exceeding 20000 lines is not output for the standard outputs and the standard error outputs. When any
data exceeding 20000 lines is output, the part exceeding 20000 lines will not be displayed in the Previous log sheet of the
Monitor-Job window or the Job Output Info window.

- If the total data size of standard output and standard error output exceeds the limit defined by the OS, such data cannot
be output to the file.

- If a user application outputs data in UNICODE format to standard output or standard error output, the following
symptoms will occur in the Systemwalker Operation Manager GUI (the Previous log sheet of the Monitor - Job window,
Job Output Info window, and the Web Console):

- Characters will appear garbled.

- The displayed status will be empty.

- An error message stating that there is no output information will appear and the window will close.

To display the information correctly, take countermeasures such as converting the data to a character encoding that is
supported by Systemwalker Operation Manager.

A.4.3 When Registering a Backup Command as a Job [Windows
version]

If you want to register the backup command as a job, use Wbadmin provided by Windows Server 2008 or later. Wbadmin
is a backup command that can be used from the command line, and can be registered as a Jobscheduler job without any
modification. Refer to the Online Help for details on backups in the relevant operating system using Wbadmin.

A.4.4 When Registering the lfmt Command as a Job [UNIX version]
When registering the lfmt command as a Jobscheduler job in Solaris, note the following.

Do not specify "Ignore output" as the attribute of the job as which the lfmt command is registered. If "Ignore output" is
specified, the lfmt command itself may be abnormally terminated and the lfmt command message may not be output.
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A.4.5 Cautions when Copying Schedule Information
The schedule information of the Jobscheduler is saved as files ("project name".jsp, "project name".dbz, "project name".grz)
in the database directory (jobdb). However, the security data for the corresponding project is saved in the file as the ACL
manager internal data.

Accordingly, if you wish to duplicate the schedule information registered on another server, use the following procedure to
duplicate the security information as well.

1. Create an acldata.bat file using the mkbat command.

 
mkbat -f acldata.bat -j

2. Duplicate the created acldata.bat file on the other node.

3. Assign execution rights to the acldata.bat file on the other server where the file has been duplicated, then execute.

However, if user account information is not the same on the original server and the other server holding the duplicated file,
the security information for the project cannot be duplicated in the above procedure to be used together. In such cases, take
the following actions on the duplication destination server.

1. Change to an existing user in the Change Owner window.

2. Reset the access rights in the Set Permissions window.

A.5 Cautions on Job Execution
This section describes cautions on job execution.

A.5.1 Restrictions on Job Execution Control
The following describes the restrictions applied to Job Execution Control.

 
Renaming a job file in the job folder directory

If the name of a job file in the job folder is changed using Explorer or a UNIX command, job submission information (job
name, submission queue name, etc.) will be lost. This does not affect the job file itself.

 
Shells guaranteed to operate in Linux version [UNIX version]

Only the following shells are guaranteed to operate for Job Execution Control of Systemwalker Operation Manager in the
Linux versions.

- sh ( = bash)

- csh ( = tcsh)

A.5.2 Job Execution Environment
 

Job execution directory [UNIX version]

In UNIX system, when a job is registered to a job net without specifying the directory and the job net has the "Compatible
with the earlier versions (old and standard)" attribute, the job will be executed in the home directory of the user who has
registered it. In case of the " Job Execution Control" attribute, the job will be executed in the home directory of the owner of
the project where the job net has been registered.

 
Environment variables [UNIX version]

In UNIX system, the environment variables (HOME, SHELL, LOGNAME, USER, MAIL and PWD) are specified from the
password file before the job is started. The directory name is set as the PWD environment variable. The home directory name
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is set as the HOME environment variable. The value of the SHELL environment variable is set according to "Considering the
shell strategy" described later.

 
Environment variables set by the Jobscheduler

Prior to starting jobs, the Jobscheduler assigns values to the following environment variables. Use these environment
variables to change processing procedure for the succeeding job depending on the type or the completion code of the
preceding job.

USERNAME environment variable [Windows]/ USER environment variable [UNIX]

Stores the owner of project.

PWD environment variable [UNIX]

Stores the job directory name. If it is not specified, this variable stores the home directory name of the project owner.

HOME environment variable [UNIX]

Stores the home directory name of the project owner.

LOGNAME environment variable [UNIX]

Stores the owner name of project.

MAIL environment variable [UNIX]

Stores "/usr/mail/owner name of project". For AIX, stores "/usr/spool/mail/owner name of project". For Linux, stores "/var/
spool/mail/owner name of project".

USERDOMAIN environment variable

When connecting to a Windows server, the domain name of the project owner is stored as the USERDOMAIN environment
variable. If the domain name is not specified, the value of this environment variable will be omitted.

When connecting to a UNIX server, the value of this environment variable will be omitted, too.

JOBSCH_SUB_SYSTEM environment variable

Stores the subsystem number in an environment where multiple subsystems operate.

JOBSCH_PROJECT environment variable

Stores the name of the project where the job net is registered.

JOBSCH_JOBNET environment variable

Stores the name of the job net.

JOBSCH_JOBNAME environment variable

If the job name to be passed to the Job Execution Control is registered in the job registration information, this variable stores
that job name. If the job name is not registered, this variable stores the execution file information (including the qsub
command options and the execution file parameters) registered in the Add/Change - Job window.

JOBSCH_JOBNET_DATE environment variable

Stores the value indicating the date of the configuration with which the job net is started up. The value is stored in the
"yyyymmdd" format.

JOBSCH_ENVIRONMENT environment variable

Stores the character string "BATCH."

In addition, values are set for the following environment variables when any preceding job exists. If there are multiple
preceding jobs, however, the information on the job that triggers the startup of these jobs (the most recently executed
preceding job) will be stored.

JOBSCH_PRE_JOBNAME environment variable
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If the job name to be passed to the Job Execution Control is registered in the preceding job registration information, this
variable stored that job name. If the job name is not registered, this variable stores the execution file information (including
the qsub command options and the execution file parameters) registered in the Add/Change - Job window. If there are
multiple preceding jobs, however, the information on the job that triggers the startup of these jobs (the most recently
completed preceding job) will be stored.

JOBSCH_PRE_JOBCODE environment variable

Stores the completion code of the preceding job.

If there are multiple preceding jobs, however, the information on the job that triggers the startup of these jobs (the most
recently completed preceding job) will be stored.

JOBSCH_ROOT_JOBNET environment variable

If the job net is nested, this variable stores the name of the job net in the first layer. If the job net is not nested, this variables
store the job net name (the value will be the same as the JOBSCH_JOBNET environment variable).

If the job net has the " Job Execution Control" attribute and the job execution is to be requested to another host (for network
jobs) and the job net has the "PowerAIM" execution attribute, this environment variable will not be set.

 
Environment variables set by the Job Execution Control

Prior to starting jobs, the Job Execution Control assigns values to the following environment variables. Use these
environment variables to change processing procedure for the succeeding job depending on the type or the completion code
of the preceding job.

JC_CHOST environment variable

Stores the client host name. This is set when submitted from the Edit/Submit Job Information window or the Select/Submit
Jobs window.

JC_CUSER environment variable

Stores the name of the job owner.

JC_COMMENT environment variable

Stores the job comment.

JC_EXHOST environment variable

Stores the execution host name.

JC_JOBID environment variable

Stores the job number.

JC_JOBNAME environment variable

Stores the job name.

JC_QUEUE environment variable

Stores the queue name.

QSUB_WORKDIR environment variable

Stores the name of the job submission directory.

JC_SUBSYSID environment variable

Stores the subsystem number in an environment where multiple subsystems operate.

JC_TRANSFILEDIR environment variable

If I/O file transfer has been performed in network jobs and distributed execution jobs, the directory in which the files sent/
received on the execution server have been stored is set in the environment variable for the job process that is executed
on the execution server.
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JC_SCHEDULESERVER environment variable

For network jobs and distributed execution jobs, the host name of the schedule server is set in the environment variable
for the job process that is executed on the execution server.

 
Environment variables that can be browsed by applications [Windows version]

In the following, the environment variables that can be browsed by applications started from Systemwalker Operation
Manager are listed according to the job submission method (scheduled jobs, qsub command or Mp_SubmitJob API).

- Scheduled jobs

a. Environment variables registered in the Detail information sheet of the Add/Change - Job window.

b. Environment variables enumerated in "Environment variables set by the Jobscheduler".

c. Environment variables enumerated in "Environment variables set by the Job Execution Control".

d. System environment variables at the moment of startup by the OS.

If an environment variable name exists in more than two of a to d above, the first-enumerated environment variable can
be browsed.

- Jobs started with the qsub command

a. Environment variables of the application or batch file executing the qsub command.

They can be browsed only when the -x option is specified in the qsub command.

b. Environment variables enumerated in "Environment variables set by the Job Execution Control"

c. System environment variables at the moment of startup by the OS.

If an environment variable name exists in more than two of a to c above, the first-enumerated environment variable
can be browsed.

- Jobs started by the Mp_SubmitJob API

a. Environment variables of the application calling the Mp_SubmitJob API.

They can be browsed only when the -x option is specified for the qsub command in the second argument of the
Mp_SubmitJob API.

b. Environment variables enumerated in "Environment variables set by the Job Execution Control".

c. System environment variables at the moment of startup by the OS.

If an environment variable name exists in more than two of a to c above, the first-enumerated environment variable
can be browsed.

The user environment variables which include individual information of the user and the environment variables set in
"autoexec.bat" cannot be browsed by applications started from Systemwalker Operation Manager.

When an application uses an environment variable registered as the user environment variable, any of the following actions
must be taken to execute the application from Systemwalker Operation Manager.

- Register the user environment variables required to execute the application to the system environment variables (in
System of the Control Panel).

- Create a batch file to start the application, and set the environment variables required to execute the application at the
beginning of the batch file.

- Register the environment variable in the Detail information sheet of the Add/Change - Job window.

If an application uses environment variables that have been set by either the Jobscheduler or Job Execution Control, the
following action must be taken to execute the application from Systemwalker Operation Manager:

Up to 512 environment variables can be browsed.

When the number of environment variables exceeds 512, certain undetermined environment variables may become unable
to be browsed. To prevent this, delete the unnecessary environment variables from the following so that the total number of
environment variables is no more than 512.
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- Scheduled jobs

a. Environment variables registered in the Detail information sheet of the Add/Change - Job window.

b. System environment variables

The system should be rebooted after updating of the system environment variables.

- Jobs started with the qsub command

a. Environment variables of the application or batch file executing the qsub command.

These environment variables need not be deleted because they are not adopted if the -x option was omitted with
the qsub command.

b. System environment variables

The system should be rebooted after updating of the system environment variables.

- Jobs started by the Mp_SubmitJob API

a. Environment variables of the application calling the Mp_SubmitJob API.

These environment variables need not be deleted because they are not adopted if the -x option was omitted with
the qsub command in the second argument of the Mp_SubmitJob API.

b. System environment variables

The system should be rebooted after updating of the system environment variables.

 
Environment variables inherited by network jobs

The environment variables enumerated in "Environment variables set by the Jobscheduler" and "Environment variables set
by the Job Execution Control" are not inherited. Moreover, the environment variables enumerated in "Environment variables
set by the Jobscheduler" cannot be referenced.

The environment variables set in Environment variables on the Detail information sheet of Add/Change - Job window are
inherited by the network jobs. To have the network jobs inherit environment variables, set them in Environment variables on
the Detail information sheet of Add/Change - Job window.

 
Storage location of temporary files created by application [Windows version]

Many applications create temporary files during execution in the following paths specified in the environment variables.

It is recommended to register these environment variables as the system environment variables.

 
Environment variable name Example of value set as an environment variable

temp c:\temp (Note)

tmp c:\temp (Note)

Note:

This is the path generally used as a directory where temporary work files are created. Create in a drive with a sufficient
disk space and register the path name in the TEMP and TMP environment variables.

 
Updating the system environment variables [Windows version]

Systemwalker Operation Manager starts an application using the registered system environment variables at the system
startup. Therefore, to browse added, updated or deleted environment variables from an application, the system must be
restarted.

 
Value of umask [UNIX version]

The Job Execution Control daemon functions by setting the value of umask to "0000". As a result, the application runs with
"0000" set as the value of umask if no value is specified for umask in the startup file in the shell of the job executing user (Note)
or in the application.
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To set a desired access right mode in the directory and files created by the application, set the desired value for umask in the
startup file of the shell or the application.

Note:

[When the login shell of the executing user is sh or ksh]

/etc/profile, or ".profile" in the executing user's home directory

[When the login shell of the executing user is csh]

/etc/.login, ".login" in the executing user's home directory and ".cshrc" in the same directory.

A.5.3 Job Flow from Its Startup to Termination
The following explains a process flow of jobs from the time when they are started to the time when terminated by Job
Execution Control.

 
For Windows system

1. Specifying the user who executes jobs

If the "Execute jobs under the respective job owner's authority" box is checked on the Options sheet of
Define Operating Information window:

Jobs are executed by the user having the project owner's right. If the execution user has been specified by Executive
user name on the Detail information sheet of Add/Change - Job window, jobs are executed under the specified user
right.
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If the "Execute jobs under the respective job owner's authority" box is unchecked on the Options sheet of
Define Operating Information window:

Jobs are executed by the logon account of Job Execution Control services.

2. Specifying the current directory at job execution time

If the "Directory" is specified on the Standard information sheet of Add/Change - Job window when jobs are
registered:

The jobs are moved to the specified directory and executed.

If the "Directory" is not specified on the Standard information sheet of Add/Change - Job window when jobs
are registered:

The jobs are moved to the temporary work area of Job Execution Control service and executed.

When the system was just installed, the Before job execution, change to directory specified at job registration box is
checked on the Backward compatibility sheet which is opened by Define Operating Information option. Usually, you
need not change this setup.

3. Job execution

Executes the job.

At execution time, the system environment variables which have been registered by "Environment variables" on the
Detail information sheet of Add/Change - Job window are referred to if necessary.

4. Job termination

Not only registered applications but all the other applications running under registered applications are monitored as
single jobs.

Therefore, when application A registered in Systemwalker Operation Manager starts residential application B, the job
will not be recognized as completed until application B is completed, even if application A has been completed.

5. Output of job log files

If "Delete job output file" has been selected on the Output file sheet of Define Jobscheduler Startup
Parameters window:

The output information file is first created in the work directory locating under the database directory, then it is
deleted.

If "Delete job output file" is not selected on the Output file sheet of Define Jobscheduler Startup Parameters
window:

The output information file is output to the directory which has been specified by Directory on the Standard
information sheet of Add/Change - Job window. If not specified by the Directory, the file is output to the work
directory under the database directory.
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For UNIX system

1. Specification of the user who executes jobs

If the execution user is specified in the Executive user name on the Detail information sheet of Add/Change
- Job window:

Jobs are executed under the specified user right.

If the execution user is not specified in the Executive user name on the Detail information sheet of Add/
Change - Job window:

Jobs are executed under the project owner right.

2. Specification of the current directory to be used during job execution

If the "Directory" has been specified on the Standard information sheet of Add/Change - Job window when
jobs are registered:

The jobs are moved to the specified directory and executed.

If the "Directory" has not been specified on the Standard information sheet of Add/Change - Job window:

The jobs are executed in the home directory of the project owner who has registered the job net.

3. Job execution

Execute the jobs.

At execution time, the system environment variables which have been registered by Environment variables on the
Details information sheet of Add/Change - Job window are referred to if necessary, and the user's login shell is
executed.
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4. Job termination

If a job other than the currently executing job is started in the background mode, the currently executing job may
terminate without waiting for the termination of the job being executed in the background mode.

5. Output of job log files

If "Delete job output file" has been selected on the Output file sheet of Define Jobscheduler Startup
Parameters window:

The output file information is first created in the work directory locating under the database directory, then it is
deleted.

If "Delete job output file" is not selected on the Output file sheet of Define Jobscheduler Startup Parameters
window:

The output information file is output to the directory which has been specified by Directory on the Standard
information sheet of Add/Change - Job window. If not specified by the Directory, the file is output to the home
directory of job project owner

A.5.4 Cautions on Jobs
 

Jobs executed in the background [UNIX version]

When described to be executed as a job in the background, the job will be terminated without waiting for the background
program to be completed.

 
Recognition of job end [Windows version]

Not only those applications registered with Systemwalker Operation Manager but all the other applications under registered
applications are monitored as single jobs. For this reason, a job is recognized as having completed when the applications
registered with Systemwalker Operation Manager and all the other applications under those registered applications have
terminated.

For example, if Application A, which is registered with Systemwalker Operation Manager, starts a resident application called
Application B and then Application A terminates, the job will not be recognized as having completed until Application B has
terminated.

 

 Example

Use the following method to avoid the need to wait for applications started from registered applications to finish:

- Use the application startup command EXECASVR.EXE.

The EXECASVR.EXE application startup command does not wait for termination of the started application. For the
EXECASVR.EXE application startup command, refer to the Systemwalker Operation Manager Reference Guide.

 
Applications for printing [Windows version]

When a printing application created with PowerCOBOL or VisualBASIC is executed as a job by Systemwalker Operation
Manager and when the destination printer is set as the standard printer in the print manager, note the followings. This includes
situations where the procedure for selecting a destination printer depends on the specifications of the development language
function, instruction, statement or API used in the application print processing.

- Log on to Windows locally with the Systemwalker MpMjes service logon account. In the Options sheet in the Define
Operating Information window, if the Execute jobs under the respective job owner's authority check box is selected, log
on locally to the Windows system using the job owner's user ID.

- In the application, print using function, instruction, statement or API not using the standard printer registered in the print
manager.
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Using network drives [Windows version]

It is recommended that all resources to be used by applications started from Systemwalker Operation Manager be placed on
the local drive. However, refer to the following notes when the use of resources on network drives is unavoidable:

- Use the UNC path so as to enable the application to reference the network path.

For example, suppose there is a job which displays the list of directories on the network drive "z:". As the condition to
execute the job, make settings for network connection by setting the computer name to "remote" and the shared name to
"share" for the drive "z:". An example of using the UNC path in that job command string is as follows.

    

  Example of drive "z":     cmd.exe /c dir z:\

  Example of UNC path:    cmd.exe /c dir \\remote\share

- For an application that cannot use the UNC path instead of the drive character, start the application from a batch file and
add the command for network connection/disconnection at the beginning and at the end of the batch file.

    

  Network connection:    net use z: \\remote\share

  Network disconnection:    net use z: /delete

While this batch file is being executed as a job, other jobs cannot assign and use the same drive character (drive "z:" in
the example above) to other network paths.

Also, even if another job is connected to the network, you cannot assign the same drive letter to a job that you are about
to start.

 
Current directory of jobs [Windows version]

When "Copy the script specified when registering jobs before execution" is checked in the Backward compatibility sheet of
the Define Operation Information window, the current directory of the jobs started from Systemwalker Operation Manager
is set as follows.

 
Systemwalker Operation Manager installation directory
\MPWALKER.JM\mpmjessv\mjespool\Queue-name\Job-number

Queue name: queue name at job submission

Job number: number assigned at job submission

To specify a certain path as the current directory, carry out the following operations.

Create the following batch files and start them from Systemwalker Operation Manager. In the batch file, the current directory
is changed to c:\temp by the cd command, and then the application is started.

 
rem Change the current directory.
cd /D c:\temp
rem Start the application.
appl.exe

appl.exe: User application

 
Starting Systemwalker Operation Manager

If the commands that involve starting Systemwalker Operation Manager are executed, the operations of Systemwalker
Operation Manager and Systemwalker Centric Manager cannot be guaranteed. For details, see "A.5.14 Commands that
Should Not Be Executed as Jobs."

A.5.5 Cautions on Network Job
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Network job names

The job names on an execution server that is used to run network jobs will become the job name on the submitting server +
"_" (an underscore character).

Example:

Job name on submitting server: Job1

Job name on execution server: Job1_

Job names can be verified using the following methods:

- Open the View Job Status/Operate window

- Run the qjstat command

- View the job execution history information

- View the operation result data

 
Privileges required when a Windows server sends a network job request to a UNIX server

When both of the following conditions are satisfied, jobs will run in a UNIX server with administrator (root) privileges:

- The network job request is sent from a Windows server to a UNIX server.

- The project owner (the effective user of the job) is a member of the Administrators group on the Windows server.

 
Notes when the submitting server and execution server are both running Windows

If the submitting server and the execution server are both running Windows and the user name of the job submitter is "root",
network jobs may not be able to be executed. You cannot execute network jobs in case a or b below, regardless of whether
the job submitter "root" is a system administrator.

To execute network jobs, specify a user other than "root" as the job submitter.

a. You cannot execute network jobs if all the following conditions are met:

- The execution server is V5.0L20 - V13.3.1.

- Execute jobs under the respective job owner's authority is specified on the execution server.

- The password of the "root" user (job submitter) and the password of the "Systemwalker MpMjes" service logon
account user on the execution server are different.

b. You cannot execute network jobs if all the following conditions are met:

- The execution server is V13.8.0 or later.

- Define Job Owner's Information is being used on the submitting server.

The combination of whether Execute jobs under the respective job owner's authority is specified on the submitting
server or execution server, and whether it is specified on both servers is irrelevant.

The term "job submitter" refers to the following:

- The owner of a project executed from the Jobscheduler

(However, if an effective user name has been specified for a job, the effective user name is the job submitter.)

- The client user name specified in the -cu option of the qsub command

If the option is not specified, then it refers to the submitting user.

- The user who ran the application that uses the job submission API

 
Notes on sending a network job request from a HP-UX or Linux server to an AIX server

Do not specify Transmission of execution command when sending a network job request from a HP-UX or Linux server to
an AIX server. If Transmission of execution command is specified, the following error may be output:
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Line length exceeds 1025 characters. Job not queued.

To send a network job request from a HP-UX or Linux server to an AIX server, do not specify Transmission of execution
command. Instead, either use the AIX resources or send resources (such as commands) to the AIX server beforehand.

 
Notes on requesting a network job that shuts down or reboots another server

After a network job that shuts down or reboots another server terminates, the following processes that run before the execution
result is obtained may generate an error and terminate abnormally:

- Processes that establish a network connection from the schedule server to the execution server (Error message:
MJS881S)

- User authentication processes on the execution server (Error message: MJS819E)

These processes generate an error because they run while the execution server is shutting down or when the system is
beginning to start up. The errors are the result of normal shutdown or reboot operations and do not affect the operation of
Systemwalker Operation Manager.

If network jobs that shut down or reboot another server are to be used, consider selecting the Ignore completion code check
box in the Standard Information sheet of the Add/Change - Job window to ignore all completion codes.

 
Jobs that cannot be submitted as network jobs

The Network Job function cannot be used in the following situations:

- If the job uses Job Control Language (JCL)

- If the following jobs and commands are used:

- Backup linkage command

- for SMS commands

- REST execution job [Windows version] [Linux version]

A.5.6 Preparation Required for Server Job Submission
For the standard output files and the standard error output files to be specified at job submission, specify the following paths.

For Windows system:

Path under the directory granting the full control access rights to the Administrators group.

For UNIX system:

Path under the directory granting the writing right as the job submitter rights.

When any other path is specified, the respective result files will not be available. System administrators should prepare the
directory for which the access rights are set so as to enable job submitters to store the result files.

A.5.7 Formatting Network Printers [Windows version]
When describing the printer full name in the Printing Format sheet of the Define Operation Information window of the Job
Execution Control, or the name of a network-connected printer in the prt operand to be specified in the JCL jobstart or file
control statement, describe in the following format.

 
\\server-name\shared-name

server-name: For a printer connected to the Windows system OS, specify the PC name of the OS. shared-name: Specify the
shared name set for the network printer.

For a printer connected to other print server, specify the server name of the print server.
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A.5.8 Operating Online Jobs
If online jobs and standard batch jobs are mixed in the same queue and executed, online jobs may not be executed at their
scheduled times due to the limit set for Max Execution Jobs within the queue.

Therefore, to operate online jobs, prepare queues exclusively for online job operations. If elapsed execution time limit is
defined for jobs in queues exclusively for online job operations, the online job operations may be cancelled in accordance with
the defined times. Do not define such elapsed execution time limit. For details on queue definition, see "Defining Operation
Information" in the Systemwalker Operation Manager Installation Guide.

If the limit set for Max Execution Jobs in the system is carried out, it is necessary to review the defined values. Ensure that
startup of online jobs is not suppressed by the limit set for Max Execution Jobs when the start time for these jobs has come.

A.5.9 Changing the Shell Startup File [UNIX version]
The Job Execution Control starts the shell to interpret the shell scripts of the job. The Job Execution Control reads the
following shell startup file as if it has logged in.

When the job submitter's login shell is the born shell or the K shell:

/etc/profile and .profile of the job owner's home directory

When the job submitter's login shell is the C shell:

/etc/.login and .login and .cshrc of the job owner's home directory

(The job submitter's login shell can be confirmed by password entry.)

A controlling terminal can be secured by usual login. However, the controlling terminal cannot be secured by the Job
Execution Control, because the job executed from the Job Execution Control can work as the child and grandchild process
of the Job Execution Control daemon; namely the job works as the process not having the controlling terminal. If commands
(*) in the startup file that require the controlling terminal are executed, jobs may not work correctly. Most of the time,
commands that require the controlling terminal can be unconditionally executed if the startup file has been used without
editing since the operating system was installed. Therefore, the startup file must be edited before job submission.

*) Some of the relevant commands that define terminal attributes and read inputs made from 

the terminal are listed below:

Example: ttytype, stty, tset, tty, eucset, script

When the Job Execution Control executes a job, the environment variable ENVIRONMENT is set to "BATCH" at job startup.
Therefore, when the environment variable ENVIRONMENT in the startup file has a value, the startup file must be edited so
that processes requiring the controlling terminal or the control of controlling terminal should not be executed.

The following provides an example of editing .profile and .login.

 
Example of editing .profile

      :

      :

if [ "$ENVIRONMENT" = "" ]

then

    stty erase '^H' intr ' ^C'

fi

      :

      :

 
Changing ".login" (Example):

      :

      :

if ( $?ENVIRONMENT == 0 ) then

      stty erase '^H' intr ' ^C'

endif
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      :

      :

A.5.10 Cautions when the Job Submitter's Login Shell is the C Shell
[UNIX version]

The Job Execution Control uses the job submitter's login shell (information registered in the password entry) at job startup.
If the login shell is the C shell, note the following.

 
Changing the .logout file

When the .logout file exists in the job submitter's home directory, care must be taken. When the Job Execution Control starts
the job, it executes the shell script by logging in internally. Therefore, when the ".logout" file exists, the commands described
in the ".logout" will be executed after the shell script execution. This will result in the completion code specified by the shell
script lost. To prevent this from occurring, it is necessary to change the .logout file as follows.

Example of changing the .logout file

@ sts = $status 

if ( $?ENVIRONMENT == 0 ) then

          clear

          echo 'Bye Bye'

          if(`tty ` == '/dev/console') echo "" 

else

          exit($sts)

endif

Save the completion code of the shell script execution specified as a job in the temporary variable sts. Then, when executing
the job with the Job Execution Control, skip the usual processes and complete with the saved completion code. Or, when not
executing the job with the Job Execution Control, carry out the usual processes.

Whether or not the job is executed with the Job Execution Control is determined by whether the environment variable
ENVIRONMENT is set to "BATCH." Therefore, when the environment variable ENVIRONMENT is set to "BATCH", the
job is assumed to be executed with the Job Execution Control.

 
When "Warning: No access to "tty"; thus no job control in this shell..." is output as the job output
result (previous history):

The above message is output when the C shell cannot obtain the terminal (tty) attribute.

Since this is from the C shell specifications, Operation Manager cannot prevent this message from being output.

With the Job Execution Control, the job is executed as if a logged-in user had executed the shell script.

Although the original login secures the terminal device, the Job Execution Control does not secure the terminal device
resulting in the above message as the C shell has not obtained the terminal attribute.

Unless the shell script started by the Job Execution Control executes any process depending on the terminal attribute, there
will be no other affect than the above message output.

A.5.11 Cancellation of a Job in the Job Execution Control [UNIX
version]

The Job Execution Control uses SIGKILL when cancelling a started job.

 

 Information

The Job Execution Control set a new process group when it starts a job so that all of processes can exist in a single process
group.
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When the job is canceled, a signal (SIGKILL) is sent to all of the processes in the set process group. For this reason, if
setpgrp(2) is executed in the processes generated from the job and the process group is changed, the signal (SIGKILL) is not
sent to the processes in the modified process group even if the job is canceled.

A.5.12 Cautions when Obtaining the Own File Name within the
Script File [UNIX version]

If the "Copy the script specified when registering jobs before execution" box is checked on Backward compatibility sheet of
Define Operating Information window, the Job Execution Control copies the script file to the spool, rename the copied file
to "job number" and starts this file by specifying its full path name. Therefore, the full path name having the "job number"
in the file name is set as shell variable $0 in the script file.

If you have obtained the own file name as shell variable $0 in the script file, cares must be taken.

However, if the "Copy the script specified when registering jobs before execution" box is unchecked on Backward
compatibility sheet of Define Operating Information window, the Job Execution Control directly starts the script file.
Therefore, the file name you have specified in Command Name of the General sheet in the Monitor-Job window is set as shell
variable $0 as it is.

A.5.13 Cancel of Jobs by Job Execution Control [Windows version]
If a job is canceled by Job Execution Control, it may be actually terminated after 10 seconds or later depending on the
applications being executed.

A.5.14 Commands that Should Not Be Executed as Jobs
Do not execute the following jobs. Otherwise, the operations of Systemwalker Operation Manager and Systemwalker Centric
Manager cannot be guaranteed.

- Startup commands of Systemwalker Centric Manager/Systemwalker Operation Manager.

- Termination commands of Systemwalker Centric Manager/Systemwalker Operation Manager

- Backup commands of Systemwalker Centric Manager/Systemwalker Operation Manager (when the option for avoiding
stoppage of services and daemons is not set).

- Restore commands of Systemwalker Centric Manager/Systemwalker Operation Manager.

- qsub command of Job Execution Control

- A command that causes a cluster system to stop if Systemwalker Operation Manager has been registered on the cluster
system

- Other commands that involve starting Systemwalker Operation Manager.

 

 Note

In environments that also include Systemwalker Centric Manager, Systemwalker Operation Manager is started by the
commands that involve starting Systemwalker Centric Manager (i.e., scentricmgr with -a option, swstart in Systemwalker
Centric Manager).

A.5.15 Job Result Files
The job result files (standard output file, standard error output file and job list file) are created with the following attributes.

- Owner

User executing the job
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- Group

- When Operation Manager user restrictions in the Define Operation Manager Shared Parameter window is not
specified:

Primary group to which the user executing the job belongs

- When Operation Manager user restrictions in the Define Operation Manager Shared Parameter window is specified:

swadmin group

- Access right

660

A.6 Mastering the Jobscheduler
This section provides information that enables the user to make the best use of Jobscheduler.

A.6.1 Shutting Down the System at Optional Times [Windows
version]

You can shut down the system automatically at any optional time. Specifically, register the termination processing job net in
the Jobscheduler, and start this job net at the date and time you wish to shut down the system.

 
Registering the termination processing job net

Just like usual job nets, add the termination processing job net using the Job Net window. For this job net, however, ensure
that you register a job net that satisfies the following conditions:

- Register the termination processing job net in the project with the same name as the startup account of the "Systemwalker
MpJobsch" service.

If the name has not been changed from the default since installing the startup account for this service, create a project with
the name "SYSTEM" and register it there.

- For the job net name, register one of the following names depending on the usage.

JSHEND:

If there is any executing job net when starting up the termination processing job net, it waits for the completion of the
job net and then starts the termination processing job net. However, the group termination is not waited.

JSHFORCE:

If there is any executing job net when starting up the termination processing job net, it cancels the executing job net
and then starts the termination processing job net.

You must register the above name on the job net name rather than registering the job net comment.

- In the termination processing job net, register jobs such as a backup job which must be executed when other jobs are not
operating or jobs which cease various services using the Check service status command. When not requiring any
particular process, register a dummy job which can be completed normally using a command such as the "setecode"
command.

For details on the Check service status command, see the Systemwalker Operation Manager Reference Guide. For details
on the setecode command, see "A.6.2 Using Batch Files as Jobs [Windows version]".

 

 Note

Do not register the jobs that may shut down the machine in the termination processing job net. Shutdown will be carried out
by the shutdown exit after the termination processing job net is normally completed.
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JSHEND/JSHFORCE

The following processing cannot be performed if the termination processing job net is started:

- Starting job nets that follow the termination processing job net

- Starting groups/job nets/jobs when startup time is reached or a message event occurred

- Starting groups/job nets/jobs by startup or restart operation

- Changing definition information for projects/groups/job nets/jobs/schedule pattern

For JSHEND:

If JSHEND is registered as the termination processing job net, JSHEND waits for the job nets in the following status to be
completed before starting.

- Executing job nets

- The job nets which are started by the job net execution API and connected to the job net execution queue.

 

 Note

For job nets belonging to a group, the group will be in the cancelled status after the executing job nets in the group are
completed. If you do not wish to cancel the executing group, start the JSHEND job net after the group is completed. For
example, wait for the group termination by using a message event, and start the JSHEND job net.

For JSHFORCE:

If JSHFORCE is registered as the termination processing job net, JSHFORCE waits for the following processes to be
completed before starting.

- The executing job nets will be cancelled.

- The job nets which are started by the job net execution API and connected to the job net execution queue will be cancelled.

 
Shutdown exits

When the execution of the termination processing job net is completed, the Jobscheduler calls up the following shutdown exit
programs according to the execution result (completed, pseudo-normal or abended) of the termination processing job net.

For normal termination or pseudo-normal:

"jobschendexit.bat" or "jobschendexit.exe"

These are the programs which terminate the Jobscheduler and the Job Execution Control services and calls the "end-of-
wait notification" command.

For details on the "end-of-wait notification" command, see the Systemwalker Operation Manager Reference Guide.

For abended:

"jobschnoendexit.bat" or "jobschnoendexit.exe"

These are the programs that do not perform any processing.

The f3crheet end-of-wait notification command is set in the exit program that is provided as standard. To shut down the
system at the desired time of the day, change the f3crheet end-of-wait notification command to the shutdown command
provided by the OS.

 

 Note

Changing the exit programs

The standard-offered exit program (batch file) will not carry out shutdown of system if the termination processing job net is
abnormally terminated. As the JSHEND/JSHFORCE was operated, a new job net is not started until the Jobscheduler service
is restarted.
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To carry out some processing according to the execution results of the termination processing job net, change the above-
mentioned exit program (batch file). Also, design system operations during error if a new job net is not started until the
Jobscheduler service is restarted as the JSHEND/JSHFORCE was operated.

When operating subsystems, be sure to change the exit program according to the operation configuration.

For details on the shutdown exits, see the Systemwalker Operation Manager Reference Guide.

Figure A.1 Process Flow from the Termination Processing Job Net to the Shutdown Exit

 

 Note

If the cluster system is used

If a service controlled by the cluster system is shut down without using the Service Shutdown function of the cluster system,
the service shutdown may be retried by the cluster system. If the cluster system is used, specify the shutdown of Jobscheduler
and Job Execution Control services at the shutdown exit by using the service shutdown function.

For more information about service startup and shutdown in the cluster system, see "Systemwalker Operation Manager
Cluster Application Guide."

A.6.2 Using Batch Files as Jobs [Windows version]
The following describes about creating the batch files to be processed by Jobscheduler easily.

Usually, when a certain operation is carried out, a series of processes are incorporated in sequence into one batch file.
However, when using the Jobscheduler, batch files can be divided by the processes so that respective status may be easily
monitored. This enables not only the monitoring but also the actions to be taken in response to abnormal situations to be
handled more smoothly.

The following would be helpful when creating batch files to be registered in the Jobscheduler.

- One batch file consists of a group of processes.

- When allocating the subsequent processes according to the return values of commands (programs), put the commands
and the subsequent processes in one batch file.

- If parallel processing is possible, create individual batch files for commands and subsequent processes, respectively.

- Limit the number of batch files to be registered as jobs in one job net to a certain level so that you can easily monitor them.
(Up to 255 jobs)

- When starting a child process from a batch file, make the parent process control the completion codes, etc. for the child
process.
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Completion codes for batch files

The return code for the last command (program) in a batch file will be carried over as the completion code for the batch file.
To set an optional value as the completion code for a batch file, use the setecode command provided by the Jobscheduler.
Specifically, manage the return code in the middle of the batch file and set the value as the final completion code of the batch
file using the setecode command. The setecode command is stored in the MpWalker.JM\bin directory under the
Systemwalker Operation Manager installation directory.

The following provides the command syntax of the setecode command and an example of a batch file using the setecode
command.

Command syntax of the setecode command

 
setecode completion code (0 to 200)

Example of a batch file using the setecode command

 
echo off

rem job execution

application.exe <--Executes the program.

if errorlevel 2 goto ERR2 <-- Checks the return code.

if errorlevel 1 goto ERR1
rem application return code = 0
echo application is normal ended.
setecode 0 <-- Sets completion code 0.

exit

:ERR2
rem application return code >= 2
echo application is abnormal ended, code is 2 or over.
setecode 2 <-- Sets completion code 2.

exit

:ERR1
rem application return code = 1
echo application is abnormal ended, code is 1.
setecode 1 <-- Sets completion code 1.

A.6.3 Considering Shell Scripts as Jobs [UNIX version]
The Jobscheduler can automatically start shell scripts and commands for a certain job net. Also, the Jobscheduler can monitor
status of the job net and each job in the job net or browse their histories.

The following describes shell scripts which registered in the Jobscheduler as jobs making up a job net and the Jobscheduler
to work with smoothly.

When a certain operation is carried out, a series of processes are incorporated in sequence into one shell script. However,
when using the Jobscheduler, shell scripts can be divided by the processes so that respective status may be easily monitored.
This enables browsing of execution statuses and logs for each process (shell script). Also, debugging will be much easier
compared to the cases where one job is created as one large shell script.

The following would be helpful when creating shell scripts to be registered in the Jobscheduler.

- One shell script consists of a group of processes.

- One shell script consists of processes to be monitored.

- When allocating the succeeding processes by the command return code, one shell script should consist of the command
and the succeeding process.

- If parallel processing is possible, create individual shell scripts for commands and subsequent processes, respectively.
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- Include a number of processes which can be easily browsed on the display in one shell script.

- When starting a child shell script from a shell script registered in the Jobscheduler, make the parent process control the
completion codes, etc. for the child process.

For the execution shells of the jobs under the Jobscheduler, use sh, ksh or csh. If a free shell such as "bash" is used, the
Japanese text may not output correctly as the free shell does not support the Japanese language display.

 
Considering the shell script completion code

For the system where the exit routine is started when the job net is abnormally terminated, the completion code must be
determined taking the exit routine processes into account.

Make sure that the completion codes for shell scripts and commands to be registered in the Jobscheduler are 200 or less. This
is because the Jobscheduler uses the completion codes from 201 to 256. For details on the completion codes to be used by the
Jobscheduler, see "Jobscheduler Completion Code" in the Systemwalker Operation Manager Reference Guide.

 
Considering the child and grandchild shell scripts

When starting a child shell script among the shell scripts registered in the Jobscheduler, the child process output can also be
browsed. However, the job status display shows the status of the shell scripts registered in the Jobscheduler, not the child
process status. When the registered shell script itself recognizes the completion code of the child process and set this as the
completion code of the parent process (registered shell script), the completion code of the child process can be obtained.

Note that operation when the parent process is completed during the child shell script execution is not guaranteed.

 
Considering the shell strategy

In the shell script which starts the Jobscheduler server, the SHELL environment variable and the server startup command are
set. When the Jobscheduler is installed, the SHELL environment variable is set as follows.

 
SHELL=/bin/ksh ; export SHELL

It is possible to specify the shell at job execution by changing the SHELL environment variable value. When not specifying
the SHELL environment variable like the following, the login shell of the user who has registered the job net will be the job
execution shell.

 
unset SHELL

When sh or ksh is specified as the startup shell, the .profile file will be read and executed. When csh is specified, the .cshrc
file and the .login file will be read and executed. For details on the dot files (files with ".") executed at startup, see the
descriptions of each shell.

When the JOBSCH_JOBNET environment variable is specified, the job will be executed under the Jobscheduler.

For the jobs with the Job Execution Control attribute, it will depend on the shell strategies of the Job Execution Control.

When the job is started, the dot file (file with ".") of the project owner of the project in which the job net is registered will be
read and executed. Whether to execute the dot file of the shell specified in the SHELL environment variable at the
Jobscheduler server startup or to execute the dot file of the login shell of the project owner of the project in which the job net
is registered depends on the shell strategies of the system administrator. When the Jobscheduler is installed, the SHELL
environment variable is set to ksh.

When operations such as terminal setting are carried out in the dot file, make sure these parts will not be executed. For the
jobs with the Job Execution Control attribute, make sure operations such as terminal setting in the dot file are not carried out.
The following provides an example of how to change the .profile file. In this example, stty and eucset are specified in
the .profile file as the terminal setting commands.

 
When using a job with the "Compatible with the earlier versions (old and standard)" attribute

From

stty erase '^h' intr  '^c' echo cs8 -istrip imaxbel

eucset
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To

if [ "$JOBSCH_JOBNET" = "" ]

    then

        stty erase '^h' intr  '^c' echo cs8 -istrip imaxbel

        eucset

fi

 
When using a job in the job execution control attribute

From

stty erase '^h' intr  '^c' echo cs8 -istrip imaxbel

eucset

To

if [ "$JOBSCH_JOBNET" = "" -a  "$ENVIRONMENT" = "" ]

    then

        stty erase '^h' intr  '^c' echo cs8 -istrip imaxbel 

        eucset

fi

 

 Information

Output of "Warning: no access to tty; thus no job control in this shell..." message to the job output result (previous history)

If the C shell cannot obtain the terminal (tty) attributes, it outputs the "Warning: No access to tty; thus no job control in this
shell..." message to the job output result (previous history). For details, see "A.5.10 Cautions when the Job Submitter's Login
Shell is the C Shell [UNIX version]" section.

 
Consider using the remote shell

Note the following when using the rsh command in the shell script of the job to be registered in the scheduler for execution
on a remote machine.

When executing a command or a shell script specified the rsh command argument, it will be executed in the job net
administrator's home directory even if the execution directory is specified in the Jobscheduler. For jobs to be registered in a
certain directory, change the directory using the cd command in the shell script.

Output when the command or shell script specified with the rsh command argument is executed will be displayed in the
Jobscheduler. However, the completion code (exit code) of the command or the shell script will not be displayed, and the
completion code of the rsh command will be the completion code displayed in the Jobscheduler.

As one of the methods to display the completion code of the shell script, the following is available. At the end of the shell script
executed on a remote machine, write the completion code to a file. Pass the contents of the file in which the remote machine
completion code has been written to the exit function at the end of the shell script (shell script including the rsh command)
registered in the Jobscheduler.

For example, when a shell script existing on machine B is executed from machine A, create the following shell script a.sh on
machine A, and b.sh in the home directory of machine B. In the following example, the shell script "calculation" on machine
B is executed.

Command to be registered in the Jobscheduler:

 
a.sh keisan /work/keisan_result

a.sh on machine A

 
rsh B b.sh $1 $2; exit `rsh B "cat $2;rm $2" `
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b.sh on machine B:

 
$1 ; echo $? > $2

A.6.4 Considering the Startup Time
You may wish to complete the execution of job nets at a predetermined time. In such cases, once a job net is started, you can
determine the estimated end time of the job net from the next startup by referring to the Monitor Job Nets window. Therefore,
you can set up the startup time based on the reverse calculation using the estimated end time. However, since the displayed
time is an estimate time from the previous execution, you must set the startup time allowing sufficient time.

The startup time registered in the Jobscheduler works only when the execution day is registered. When the execution day is
registered, the job net will be started at the startup time of the registered execution day.

A.7 Cautions when Linking with Other Products [UNIX
version]

This section describes cautions when linking with the following products.

- PowerAIM

A.7.1 Cautions when Linking with PowerAIM
By treating the work units which operate on the PowerAIM business system as jobs, it is possible to integrate the job nets
consisting of work units and monitor or operate them in the Jobscheduler.

When operating jobs with the PowerAIM attribute, note the following.

 
Registering jobs with the PowerAIM attribute

To use the job nets with the PowerAIM attribute, PowerAIM must have been installed.

The job system name and the work unit name can be registered as a job with the PowerAIM attribute. Note that there are the
following restrictions.

- Online work units cannot be used.

- Work unit list cannot be used.

- Remote job system cannot be used.

The Jobscheduler sends a request to the PowerAIM to execute the work units in the specified job system environment.

 
Recognizing status in the Jobscheduler

When any one of the jobs in the job net with the PowerAIM attribute is submitted, the job net status will be indicated as
"executing." The status of the job is "start-delayed" when the job is submitted to PowerAIM, and will change to "executing"
when the actual execution of the job is started. The execution time of the job net is from when the first job of the job net is
requested for execution and to when the last job is completed.

 
Completion code

The completion codes of the advanced programs in the work units are from 00000000 to 0xffffffff. When the completion code
is 256 or higher, the Jobscheduler treat it as 255, and the actual completion code will be output to the job history. However,
do not use the value between 201 and 256 as they are reserved by the Jobscheduler. For details on the completion codes to
be used by the Jobscheduler, see "Jobscheduler Completion Codes" in the Systemwalker Operation Manager Reference
Guide.
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Solution when the execution request fails

When the execution request of a work unit to PowerAIM fails, the Jobscheduler will treat it as the completion code is 243.
For details on the causes of the execution request failure, the Job Output Info window provides the completion information
of the execution request API.

If an error occurs at the work unit startup, the Job Output Info window may output an error message.

 
Handling work units

The Jobscheduler cannot monitor the work units executed anywhere other than the Jobscheduler.

 
Difference in log outputs

In the process group number area of the job nets with the PowerAIM attribute, the job net numbers managed by the
Jobscheduler are displayed. They are displayed in the form on "AIMxxxxx", where "xxxxx" is a value between 0 and 99999.

 
Completion exit of job nets and jobs

When using job nets with the PowerAIM attribute, do not execute any process which takes long in the exit routine at
completion of job net in the Jobscheduler (jobsch.exit.normal or jobsch.exit) or the exit routine at completion of job
(jobsch.job.exit). Executing a process which takes long may stop the other processes of the Jobscheduler since the process
is not returned to the Jobscheduler server.

If it is necessary to execute any process which takes long in the job net completion exit or the job completion exit, execute
that process as another process so that the completion routine itself does not take long.

 
Relationship with the PowerAIM commands

When the job (Work unit) with the PowerAIM attribute executed in the Jobscheduler is cancelled by the PowerAIM
command, the Jobscheduler will consider it to be cancelled.

When the Jobscheduler instructs all the job nets to cancel executions, cancellation of all the executing work units will be
requested to PowerAIM.

 
Job status when PowerAIM operation is stopped or when the Jobscheduler server is stopped

If PowerAIM operation is stopped after the Jobscheduler requests execution of the job with the PowerAIM attribute, the
Jobscheduler will consider it to be cancelled.

If the Jobscheduler server is stopped after the Jobscheduler requests execution of the job with the PowerAIM attribute, it will
be recognized to be abended at the next Jobscheduler server startup, even if the job has been normally completed by
PowerAIM.

 
Job status at the system down

When the PowerAIM system is stopped during work unit execution due to the system down, it is possible to define so that
the stopped work units will be restarted at the PowerAIM system restart (automatic restart of work units). However, if
requested by the Jobscheduler, the Jobscheduler cannot recognize the restart. Therefore do not define the automatic restart
for work units to be registered in the Jobscheduler.

- 485 -



Appendix B List of Search Keywords for Audit Logs
This appendix lists the search keywords for audit logs.

B.1 Search Keywords for Audit Logs Relating to Clients
The following table shows the search keywords for audit logs relating to clients.

 
Operation types

Operation Manager clients

 
Operating environment Operation type

OK button in the Login window LOGIN_OMGRCLIENT

OK button in the Login window (authentication) (*1) ADMIT_OMGR

OK button in the Login window 
(password specification authentication) (*1)

ADMIT_OMGR_USERPASSWD

OK button in the Enter Password of Connected Host
window

ADMIT_OMGR_USERPASSWD

Exit button LOGOUT_OMGRCLIENT

*1:

In the Systemwalker Operation Manager [Login] window, if you do not specify a user ID or password, the operating
environment will be "authentication." If you specify a user ID and password, the operating environment will be "password
specification authentication."

Multi-server monitoring clients

 
Operating environment Operation type

Login button in the Login window LOGIN_MLTSRVCLIENT

Login button in the Login window (authentication) (*1) ADMIT_OMGR

Login button in the Login window 
(password specification authentication) (*1)

ADMIT_OMGR_USERPASSWD

Exit button LOGOUT_MLTSRVCLIENT

*1:

In the Systemwalker Operation Manager [Login] window, if you do not specify a user ID or password, the operating
environment will be "authentication." If you specify a user ID and password, the operating environment will be "password
specification authentication."

Jobscheduler information printing clients

 
Operating environment Operation type

Login button in the Login window LOGIN_PRINTCLIENT

Login button in the Login window (authentication) (*1) ADMIT_OMGR

Login button in the Login window 
(password specification authentication) (*1)

ADMIT_OMGR_USERPASSWD

Exit button LOGOUT_PRINTCLIENT
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*1:

In the Systemwalker Operation Manager [Login] window, if you do not specify a user ID or password, the operating
environment will be "authentication." If you specify a user ID and password, the operating environment will be "password
specification authentication."

Environment setup clients

 
Operating environment Operation type

Login button in the Login window LOGIN_SETENVCLIENT

Login button in the Login window (authentication) (*1) ADMIT_OMGR

Login button in the Login window 
(password specification authentication) (*1)

ADMIT_OMGR_USERPASSWD

Close button LOGOUT_SETENVCLIENT

OK button in the Monitored Host Configuration window MOD_MONITOREDHOSTCONFIGURAT
ION (*3)

Delete button in the Select Monitored Host Configuration
window

DEL_MONITOREDHOSTCONFIGURATI
ON (*3)

OK button in the Operation Manager Shared parameter
window

MOD_SHAREDPARAMETER (*3)

OK button in the Define Jobscheduler Startup Parameters
window

MOD_STARTUPPARAMETER (*3)

OK button in the Define Message Table window
[Windows version]

MOD_MESSAGETABLE (*3)

OK button in the Define Monitoring Permission Host
window

MOD_MONITORINGPERMISSIONHOST
(*3)

OK button in the Define Operation Information window MOD_OPERATION_INFORMATION (*3)

OK button in the Define Trust Host window MOD_TRUST_HOST (*3)

Close button in the Define Job Owner's Information
window [Windows version]

MOD_JOB_OWNER (*3)

OK button in the Apply Policy window DISTRIBUTE_POLICY (*3)

OK button in the Apply Policy window (restarting the
daemon/service) (*2)

RESTART_DAEMON/SERVICE (*3)

OK button in the Apply Policy window (Jobscheduler
definitions)

APPLY_POLICY_JOBSCHDATA

OK button in the Apply Policy window (access right
definitions)

APPLY_POLICY_ACLDATA

OK button in the Apply Policy window (Operation
Manager user definitions)

APPLY_POLICY_ACLDATA

OK button in the Apply Policy window (Job Execution
Control definitions)

APPLY_POLICY_MJESDATA

OK button in the Apply Policy window (Job folder) APPLY_POLICY_MJESDATA (*3)

OK button in the Apply Policy window (Job file) APPLY_POLICY_MJESDATA (*3)

OK button in the Apply Policy window (calendar/
service/application startup)

APPLY_POLICY_JMCALDATA

OK button in the Apply Policy window (Master Schedule
Management)

APPLY_POLICY_STEMDATA

Start button in the Service/Daemon control START_DAEMON/SERVICE (*3)
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Operating environment Operation type

Stop button in the Service/Daemon control STOP_DAEMON/SERVICE (*3)

*1:

In the Systemwalker Operation Manager [Login] window, if you do not specify a user ID or password, the operating
environment will be "authentication." If you specify a user ID and password, the operating environment will be "password
specification authentication."

*2:

If Apply at once (restart the daemon/service) has been selected, an audit log will be output for the restart of the daemon/
service.

*3:

Two audit logs (for the start and the end) will be output for a single operation.

Master Schedule Management monitor client

 
Operating environment Operation type

Login button in the Login window LOGIN_STEMMONITORCLIENT

Login button in the Login window (authentication) (*1) ADMIT_OMGR

Login button in the Login window 
(password specification authentication) (*1)

ADMIT_OMGR_USERPASSWD

Exit button LOGOUT_STEMMONITORCLIENT

*1:

In the Systemwalker Operation Manager [Login] window, if you do not specify a user ID or password, the operating
environment will be "authentication." If you specify a user ID and password, the operating environment will be "password
specification authentication."

Master Schedule Management environment setup client

 
Operating environment Operation type

Login button in the Login window LOGIN_STEMSETENVCLIENT

Login button in the Login window (authentication) (*1) ADMIT_OMGR

Login button in the Login window 
(password specification authentication) (*1)

ADMIT_OMGR_USERPASSWD

Exit button LOGOUT_STEMSETENVCLIENT

Mode changed MOD_MODE (*2)

Mode/Set the virtual time/ Schedule server changed 
(restarting the daemon/service)

START_DAEMON/SERVICE (*2)

Mode changed (from "Daily schedule management" to
"Daily schedule management (Test mode)") [UNIX]

MOD_VIRTUALTIME (*4)

Mode changed (from "Daily schedule management (Test
mode)" to "Daily schedule management") [UNIX]

DEL_VIRTUALTIME (*4)

Add button in the Schedule server
[UNIX version]

MOD_SERVER (*3)

Add button in the Schedule server
[UNIX version]

ADMIT_OMGR_USERPASSWD

Modify button in the Schedule server [UNIX version] MOD_SERVER (*3)

Modify button in the Schedule server [UNIX version] ADMIT_OMGR_USERPASSWD

- 488 -



Operating environment Operation type

Release button in the Schedule server [UNIX version] DEL_SERVER (*3)

Release button in the Schedule server [UNIX version] ADMIT_OMGR_USERPASSWD

Apply button in the Change the virtual time MOD_VIRTUALTIME (*2)

Apply button in the Synchronize date/time only [UNIX
version]

SYNCHRONIZE_DATE/TIME (*2)

Apply button in the Distribution tab [UNIX version] MOD_STEMENV (*2)

Apply button in the Schedule tab MOD_STEMENV (*2)

Apply button in the Notification tab MOD_STEMENV (*2)

*1:

In the Systemwalker Operation Manager [Login] window, if you do not specify a user ID or password, the operating
environment will be "authentication." If you specify a user ID and password, the operating environment will be "password
specification authentication."

*2:

Two audit logs (for the start and the end) will be output for a single operation.

*3:

Audit logs are output on both the management server and the schedule server.

*4:

Audit logs are output to the schedule server.

 
Operation targets

The operation targets that are output for these operation types are as follows:

 
Operation target description Operation target

Subsystem number SUBSYSTEM=

Name of the host where the policy is distributed DISTRIBUTION=

Shared parameter SHAREDPARAMETER

Monitored host configuration name MONITOREDHOSTCONFIGURATION=

Define Jobscheduler Startup Parameters STARTUPPARAMETER

Define Message Table [Windows version] MESSAGETABLE

Monitoring permission host MONITORINGPERMISSIONHOST

Access right definitions PERMISSION_DATA

Operation Manager user definitions OMGR_USERS

Job Folder Name JOBFOLDER=

Job Folder Path JOBFOLDERPATH=

Calendar Name CALENDAR=

Power control information POWERCONTROL

Completion monitoring information COMPLETIONMONITORING

Service/application startup information SERVICE/APPLICATION

Name of the schedule server SCHEDULE_SERVER=

IP address of the schedule server SCHEDULE_SERVERIP=

Schedule configuration file STEMENV
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Operation target description Operation target

File Name FILE=

B.2 Search Keywords for Audit Logs Relating to the
Jobscheduler

The following table shows the search keywords for audit logs relating to the Jobscheduler.

 
Operation types

Projects

 
Operating environment Operation type

Adding a project ADD_PROJECT

Changing a project MOD_PROJECT

Deleting a project DEL_PROJECT

Pausing all projects PAUSE_PROJECT_ALL

Continuing all projects CONTINUE_PROJECT_ALL

Disabling all projects DISABLE_PROJECT_ALL

Enabling all projects ENABLE_PROJECT_ALL

Groups

 
Operating environment Operation type

Adding a group ADD_GROUP

Changing a group MOD_GROUP

Changing group properties MOD_GROUP_PROPERTY

Deleting a group DEL_GROUP

Moving a group MOVE_GROUP

Starting a group START_GROUP

Restarting a group RESTART_GROUP

Canceling a group CANCEL_GROUP

Pausing a group PAUSE_GROUP

Continuing a group CONTINUE_GROUP

Disabling a group DISABLE_GROUP

Enabling a group ENABLE_GROUP

Checking a group CONFIRM_GROUP

Job nets

 
Operating environment Operation type

Adding a job net ADD_JOBNET

Changing a job net MOD_JOBNET

Changing job net properties MOD_JOBNET_PROPERTY

Changing recovery for a job net MOD_JOBNET_DECISION
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Operating environment Operation type

Changing the memo for a job net MOD_JOBNET_MEMO

Deleting the memo for a job net MOD_JOBNET_MEMO_DELETE

Changing the execution days for a job net MOD_JOBNET_DAY

Temporarily changing a job net MOD_JOBNET_TEMP

Canceling temporary changes to a job net MOD_JOBNET_TEMP_DELETE

Temporarily changing the stop time for a job net MOD_JOBNET_STOPTIME

Changing the execution conditions for a job net
(execution days or message events)

MOD_JOBNET_DAY_MESSAGE_TEMP

Deleting the execution conditions for a job net
(execution days, message events or temporary
change information)

MOD_JOBNET_DAY_MESSAGE_TEMP_D
ELETE

Deleting the execution conditions for a job net
(execution days)

MOD_JOBNET_DAY_DELETE

Deleting the execution conditions for a job net
(message events)

MOD_JOBNET_MESSAGE_DELETE

Deleting the execution conditions for a job net
(temporary change information)

MOD_JOBNET_TEMP_DELETE

Deleting a job net DEL_JOBNET

Reusing a job net
Pasting a job net

COPY_JOBNET

Moving a job net MOVE_JOBNET

Moving a job net in a group MOVE_JOBNET_GROUP

Starting a job net START_JOBNET

Restarting a job net RESTART_JOBNET

Restarting a job net (from the next job) RESTART_JOBNET_NEXT

Restarting a job net (from the first job) RESTART_JOBNET_TOP

Canceling a job net CANCEL_JOBNET

Pausing a job net PAUSE_JOBNET

Continuing a job net CONTINUE_JOBNET

Disabling a job net DISABLE_JOBNET

Enabling a job net ENABLE_JOBNET

Checking a job net CONFIRM_JOBNET

Reinstating a job net REINSTATE_JOBNET

Revoking a job net REVOKE_JOBNET

Starting a job net with variable parameters START_JOBNET_VPARAM

A job net execution request in a job net execution
queue [Windows version]

ADD_JOBNET_QUEUE

Deleting a job net execution request from a job net
execution queue [Windows version]

DEL_JOBNET_QUEUE

Deleting all job net execution requests from a job
net execution queue [Windows version]

DEL_JOBNET_QUEUE_ALL

Jobs
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Operating environment Operation type

Temporarily changing a job MOD_JOB_TEMP

Restarting a job (except for child or linked job nets)
or starting from the specified job

START_JOB

Restarting a job (child or linked job nets) or
restarting from the specified job

RESTART_JOB

Canceling a job CANCEL_JOB

Pausing a job PAUSE_JOB

Continuing a job CONTINUE_JOB

Disabling a job DISABLE_JOB

Enabling a job ENABLE_JOB

Starting from the next job RESTART_JOB_NEXT

Starting only the specified job START_JOB_SINGLE

Monitoring job properties (Job output information) MONITOR_JOB

Message events

 
Operating environment Operation type

Generating a message event SEND_MESSAGE

Invalidating generated message events (for all job
nets)

DEL_MESSAGE_ALL

Invalidating generated message events (for only
targeted job nets)

DEL_MESSAGE_NET

Schedule patterns

 
Operating environment Operation type

Adding a schedule pattern ADD_SCHPATTERN

Changing a schedule pattern MOD_SCHPATTERN

Deleting a schedule pattern DEL_SCHPATTERN

Daemons/Services

 
Operating environment Operation type

Starting the Jobscheduler server START_MPJOBSCH

Stopping the Jobscheduler server STOP_MPJOBSCH

Starting the Operation Manager common
infrastructure server

START_MPJMSRV

Stopping the Operation Manager common
infrastructure server

STOP_MPJMSRV

Job definition variable

 
Operating environment Operation type

Adding, changing or deleting a job definition
variable

MOD_ JOB_DEFINITION_VARIABLE

Importing
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Operating environment Operation type

Importing IMPORT_JOBNET_GROUP_CSV

Credentials

 
Operating environment Operation type

Adding Credentials ADD_AUTHINFO

Deleting Credentials DEL_AUTHINFO

 
Operation targets

The operation targets that are output for these operation types are as follows:

 
Operation target description Operation target

Subsystem number SUBSYSTEM=

Project name PROJECT=

Group name GROUP=

Job net name JOBNET=

Job name JOB=

Message event name MESSAGE=

Schedule pattern name SCHPATTERN=

Credentials AUTHINFO=

B.3 Search Keywords for Audit Logs Relating to Access
Rights

The following table shows the search keywords for audit logs relating to access rights.

 
Operation types

Access rights

 
Operating environment Operation type

Adding access rights ADDSEC_PERMISSION

Deleting access rights DELSEC_PERMISSION

Setting, changing or deleting access rights
(Command)

ENTRYSEC_PERMISSION

Ownership

 
Operating environment Operation type

Setting access rights for the project owner (update
rights)

MODSEC_PERMISSION_OWNER

Extended User Management

 
Operating environment Operation type

Settings that enable or disable the Extended User
Management function

SETSEC_USER_MODE
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Operating environment Operation type

Adding an Operation Manager user ADDSEC_OMGR_USER

Changing an Operation Manager user MODSEC_OMGR_USER

Deleting an Operation Manager user DELSEC_OMGR_USER

Setting or deleting the password for an Operation
Manager user

CHANGESEC_OMGR_USER_PASSWD

Setting the policy distribution mode for an
Operation Manager user

SETSEC_POLICY_ACLDATA_MODE

Daemons/Services

 
Operating environment Operation type

Starting the ACL manager server START_MPACLMGR

Stopping the ACL manager server STOP_MPACLMGR

 
Operation targets

The operation targets that are output for these operation types are as follows:

 
Operation target description Operation target

Subsystem number SUBSYSTEM=

Project name PROJECT=

User name USER=

B.4 Search Keywords for Audit Logs Relating to Job
Execution Control

The following table shows the search keywords for audit logs relating to Job Execution Control.

 
Operation types

Two audit logs (for the start and the end) are output for each operation.

Queues

 
Operating environment Operation type

Starting a queue START_QUEUE

Pausing a queue STOP_QUEUE

Changing a queue MOD_QUEUE

Jobs

 
Operating environment Operation type

Submitting a job SUBMIT_JOB

Placing a job on hold HOLD_JOB

Releasing a job that is on hold RELEASE_JOB

Moving a job MOVE_JOB

Changing a job MOD_JOB

Deleting a job DEL_JOB
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Job folders

 
Operating environment Operation type

Creating a job folder ADD_JOBFOLDER

Changing a job folder MOD_JOBFOLDER

Deleting a job folder DEL_JOBFOLDER

Job files

 
Operating environment Operation type

Creating a job file (job file) ADD_JOBFILE

Creating a job file (job information file) ADD_JOBFILE

Distributed execution configuration hosts

 
Operating environment Operation type

Adding a distributed execution configuration host ADD_HOST

Modifying the definition of a distributed execution
configuration host

MOD_HOST

Deleting a distributed execution configuration host DEL_HOST

Daemons/Services

 
Operating environment Operation type

Starting the Job Execution Control server START_MPMJES (*1)

Starting Job Execution Control server operations START_MPMJES_OPERATION

Stopping the Job Execution Control server STOP_MPMJES (*1)

Stopping Job Execution Control server operations STOP_MPMJES_OPERATION

*1:

For the Windows version, only audit logs are output when each operation ends.

 
Operation targets

The operation targets that are output for these operation types are as follows:

 
Operation target description Operation target

Subsystem number SUBSYSTEM=

Queue name QUEUE=

Job name JOB=

Job Number JOBID=

Job Folder Name JOBFOLDER=

Job File Name JOBFILE=

File Name FILE=

Host group Name HOSTGROUP=

Host Name HOST=
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B.5 Search Keywords for Audit Logs Relating to Calendars
The following table shows the search keywords for audit logs relating to calendars.

 
Operation types

Calendars/day change times

 
Operating environment Operation type

Adding a holiday calendar ADD_CALENDAR_DATA

Adding a holiday calendar (command) ADD_CALENDAR

Updating the system calendar, holiday calendar or
day change time

MOD_CALENDAR_DATA

Updating the system calendar or holiday calendar
(command)

MOD_CALENDAR

Changing the day change time (command) MOD_DCTIME

Deleting the holiday calendar DEL_CALENDAR_DATA

Deleting the holiday calendar (command) DEL_CALENDAR

Power control

 
Operating environment Operation type

Updating power control information MOD_POWERCONTROL_DATA

Completion monitoring

 
Operating environment Operation type

Updating completion monitoring information MOD_COMPLETIONMONITORING_DATA

Service/application startup

 
Operating environment Operation type

Updating service/application startup information MOD_SERVICE/APPLI_DATA

Year change

 
Operating environment Operation type

Updating the system calendar when the year
changes

MOD_SYSTEMCALENDAR_DATA_BY_YE
ARLYCHANGE

Updating calendar information when the year
changes

MOD_CALENDAR_DATA_BY_YEARLYC
HANGE

Cluster environment (standby node)

 
Operating environment Operation type

Updating the system calendar 
(automatic reflection)

MOD_SYSTEMCALENDAR_DATA_BY_RE
FRECTION

Creating a new holiday calendar 
(automatic reflection)

ADD_CALENDAR_DATA_BY_REFRECTIO
N

Updating a holiday calendar 
(automatic reflection)

MOD_CALENDAR_DATA_BY_REFRECTI
ON
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Operating environment Operation type

Deleting a holiday calendar 
(automatic reflection)

DEL_CALENDAR_DATA_BY_REFRECTIO
N

Updating completion monitoring information
(automatic reflection)

MOD_COMPLETIONMONITORING_DATA
_BY_REFRECTION

Updating service/application information
(automatic reflection)

MOD_SERVICE/
APPLI_DATA_BY_REFRECTION

Shutting down servers

 
Operating environment Operation type

Shutting down a server (client operation) SHUTDOWN_SERVER_BY_CLIENT

Shutting down a server 
(power control schedule)

SHUTDOWN_SERVER_BY_SCHEDULE

Shutting down a server 
(batch power control from the control host)

SHUTDOWN_SERVER_BY_MANAGER

Daemons/Services

 
Operating environment Operation type

Starting the calendar server START_MPJMCAL

Stopping the calendar server STOP_MPJMCAL

 
Operation targets

The operation targets that are output for these operation types are as follows:

 
Operation target description Operation target

Name of the system calendar or a holiday calendar CALENDAR=

Power control information POWERCONTROL

Completion monitoring information COMPLETIONMONITORING

Service/application startup information SERVICE/APPLICATION

B.6 Search Keywords for Audit Logs Relating to Task Link
The following table shows the search keywords for audit logs relating to Task Link.

 
Operation types

Password management books

 
Operating environment Operation type

Adding a user name and password to the password
management book

ADD_LGMANAGE_DATA (*1)

Changing the password for a user name in the
password management book

MOD_LGMANAGE_DATA (*1)

Deleting a user name and password from the
password management book

DEL_LGMANAGE_DATA (*1)
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*1:

Two audit logs (for the start and the end) will be output for a single operation.

Daemons/Services

 
Operating environment Operation type

Starting the Task Link server [Windows version] START_MPNJSOSV

Stopping the Task Link server [Windows version] STOP_MPNJSOSV

 
Operation targets

The operation targets that are output for these operation types are as follows:

 
Operation target description Operation target

User name LGMNG_USER=

Login definition name LGMNG_GROUP=

B.7 Search Keywords for Audit Logs Relating to Master
Schedule Management

The following table shows the search keywords used for audit logs relating to Master Schedule Management.

 
Operation types

Environment creation

 
Operating environment Operation type

Creating an environment for the Master Schedule
Management function

SET_STEMENV (*1)

Canceling the environment settings for the Master
Schedule Management function

DEL_STEMENV (*1)

*1:

Two audit logs (for the start and the end) will be output for a single operation.

Projects

 
Operating environment Operation type

Making master settings for a project SET_MASTER (*1)

Canceling the master settings for a project DEL_MASTER (*1)

Deleting all the master project, the schedule by
dates project and the project for operation changes

DEL_PROJECT (*1)

*1:

Two audit logs (for the start and the end) will be output for a single operation.

Operation changes for master information

 
Operating environment Operation type

Making prior settings for operation changes for
master information

COPY_PROJECT (*1)
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Operating environment Operation type

Changing the release day for operation changes for
master information

MOVE_PROJECT (*1)

Canceling operation changes for master
information

BACK_PROJECT (*1)

*1:

Two audit logs (for the start and the end) will be output for a single operation.

Managing schedule information

 
Operating environment Operation type

Executing a schedule (current day) RUN_SCHEDULES (*1)

Executing a schedule (future) SCHEDULE_FUTURE (*1)

Re-executing a schedule RESCHEDULING (*1)

Canceling a schedule DEL_SCHEDULES (*1)

Changing operations for a schedule MOD_OPERATION (*1)

*1:

Two audit logs (for the start and the end) will be output for a single operation.

Carried-over job nets

 
Operating environment Operation type

Canceling a carried-over job net CANCEL_CARRIEDOVERJOBNET (*1)

Starting a carried-over job net START_CARRIEDOVERJOBNET (*1)

Restarting a carried-over job net RESTART_CARRIEDOVERJOBNET (*1)

Pausing a carried-over job net PAUSE_CARRIEDOVERJOBNET (*1)

Continuing a carried-over job net CONTINUE_CARRIEDOVERJOBNET (*1)

Disabling a carried-over job net DISABLE_CARRIEDOVERJOBNET (*1)

Enabling a carried-over job net ENABLE_CARRIEDOVERJOBNET (*1)

Checking a carried-over job net CONFIRM_CARRIEDOVERJOBNET (*1)

Revoking a carried-over job net REVOKE_CARRIEDOVERJOBNET (*1)

Running carried-over job nets concurrently RUNCONCURRENTLY_CARRIEDOVERJO
BNET (*1)

Prioritizing carried-over job nets PRIORITIZE_CARRIEDOVERJOBNET (*1)

Cutting off a carried-over job net CUTOFF_CARRIEDOVERJOBNET (*1)

*1:

Two audit logs (for the start and the end) will be output for a single operation.

Submitting job nets

 
Operating environment Operation type

Submitting an individual job net from master
information

ADD_JOBNET (*1)

*1:

Two audit logs (for the start and the end) will be output for a single operation.
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Message events

 
Operating environment Operation type

Generating a message event SEND_MESSAGE (*1)

*1:

Two audit logs (for the start and the end) will be output for a single operation.

When the day-change time arrives or when the daemon/service starts

 
Operating environment Operation type

Executing the schedule for the current day
(automatic)

RUN_SCHEDULES_AUTO

Executing a future schedule (automatic) SCHEDULE_FUTURE_AUTO

Creating a cluster environment

 
Operating environment Operation type

Changing the logical IP address [UNIX version] MOD_IP (*1)

Changing the database directory [Windows
version]

MOD_DBPATH (*1)

Registering the Master Schedule Management
service [Windows]

REG_STEMSERVICE (*1)

Deleting the Master Schedule Management service
[Windows]

DEL_STEMSERVICE (*1)

*1:

Two audit logs (for the start and the end) will be output for a single operation.

 
Operation targets

The operation targets that are output for these operation types are as follows:

 
Operation target description Operation targets

Subsystem number SUBSYSTEM=

Project name PROJECT=

Date DATE=

Date (after the change) NEWDATE=

Host Name HOST=

Job net name JOBNET=

Message event name MESSAGE=

B.8 Search Keywords for Audit Logs Relating to Common
Commands

The following table shows the search keywords for audit logs relating to common commands.

 
Operation types

Common commands

For common commands, two audit logs (for the start and the end) are output for each operation.
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Operating environment Operation type

soperationmgr service/daemon startup command START_OMGR

poperationmgr service/daemon termination
command

STOP_OMGR

mpbko backup command BACKUP_OMGR

mprso restoration command RESTOR_OMGR

swtrans conversion/registration command for
migration [UNIX version]

TRANS_OMGR

swmove backup command for migration [UNIX
version]

MOVE_OMGR

Credentials

 
Operating environment Operation type

Adding Credentials ADD_AUTHINFO

Deleting Credentials DEL_AUTHINFO

 
Operation targets

If the operation type is a common command, no operations are output.

The following operations are output when the operation type is credentials.

 
Operation target description Operation target

Credentials AUTHINFO=
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